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The U.S. Army Corps of Engineers' River Analysis System (HEC-RAS)
is software that allows you to perform one-dimensional steady and
unsteady flow river hydraulics calculations. The HEC-RAS software
supersedes the HEC-2 river hydraulics package, which was a one
dimensional, steady flow water surface profiles program. The HEC
RAS software is a significant advancement over HEC-2 in terms of
both hydraulic engineering and computer science. This software is a
product of the Corps' Civil Works Hydrologic Engineering Research
and Development Program.

The first version of HEC-RAS (version 1.0) was released in July of
1995. Since that time there have been several releases of this
software package, including versions: 1.1; 1.2; 2.0; 2.1; 2.2; 2.21; and
now version 3.0 in January of 2001.

Version 3.0 of HEC-RAS is a major advancement over the previous
2.21 version. This new version (3.0) includes unsteady flow routing,
as well as split flow optimization for steady flow modeling.

The HEC-RAS software was developed at the Hydrologic Engineering
Center (HEC), which is a division of the Institute for Water Resources
(IWR), U.S. Army Corps of Engineers. The software was designed by
Mr. Gary W. Brunner, leader of the HEC-RAS development team. The
user interface and graphics were programmed by Mr. Mark R. Jensen.
The steady flow water surface profiles module was programmed by
Mr. Steven S. Piper. The unsteady flow equation solver was
developed by Dr. Robert L. Barkau. The routines that import HEC-2
and UNET data were developed by Ms. Joan Klipsch. The cross
section interpolation routines were developed· by Mr. Alfredo Montalvo.
The routines for modeling ice cover and wide river ice jams were
developed by Mr. Steven F. Daly of the Cold Regions Research and
Engineering Laboratory (CRREL).

Many of the HEC staff made contributions in the development of this
software, including: Vern R. Bonner, Richard Hayes, John Peters, and
Michael Gee. Mr. Darryl Davis was the director during the
development of this software.

This manual was written by Mr. Gary W. Brunner.
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CHAPTER 1

Introduction

Welcome to the u.s. Army Corps of Engineers River Analysis System (HEC
RAS) developed by the Hydrologic Engineering Center. This software allows
you to perform one-dimensional steady flow, -unsteady flow calculations.
Sediment transport computations will be added in a future version.

The HEC-RAS modeling system was developed as a part of the Hydrologic
Engineering Center's "Next Generation" (NexGen) ofhydrologic engineering
software. The NexGen project encompasses several aspects of hydrologic
engineering, including: rainfall-runoff analysis; river hydraulics; reservoir
system simulation; flood damage analysis; and real~time river forecasting for
reservoir operations.

This chapter discusses the general philosophy ofHEC-RAS and gives a brief
overview of the capapilities of the modeling system. Documentation for
HEC-RAS is discussed, as well as an overView of this manual.

Contents

• General Philosophy of the Modeling System

• Overview of Program Capabilities

• HEC-RAS Documentation

• Overview of This Manual

1-1
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General Philosophy of the Modeling System

HEC-RAS is an integrated system of software, designed for interactive use in
a multi-tasking, multi-user network environment. The system is comprised of
a graphical user interface (GUI), separate hydraulic analysis components, data
storage and management capabilities, graphics and reporting facilities.

The HEC-RAS system will ultimately contain three one-dimensional
hydraulic analysis components for: (1) steady flow water surface profile
computations; (2) unsteady flow simulation; and (3) movable boundary
sediment transport computations. A key element is that all three components
will use a common geometric data representation and common geometric and
hydraulic computation routines. In addition to the three hydraulic analysis
components, the system contains several hydraulic design features that can be
invoked once the basic water surface profiles are computed.

The current version ofHEC-RAS supports Steady and Unsteady flow water
surface profile calculations. New features and additional capabilities will be
added in future releases.

Overview of Program Capabilities

HEC-RAS is designed to perform one-dimensional hydraulic calculations for
a full network ofnatural and constructed channels. The following is a
description of the major capabilities ofHEC-RAS.

User Interface

The user interacts with HEC-RAS through a graphical user interface (GUI).
The main focus in the design of the interface was to make it easy to use the
software, while still maintaining a high level of efficiency for the user. The
interface provides for the following functions:

• File management

• Data entry and editing

• Hydraulic analyses

• Tabulation and graphical displays of input and output data

• Reporting facilities

• On-line help

1-2
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Hydraulic Analysis Components

Steady Flow Water Surface Profiles. This component of the modeling system
is intended for calculating water surface profiles for steady gradually varied
flow. The system can handle a full network of channels, a dendritic system,
or a single river reach. The steady flow component is capable of modeling
subcritical, supercritical, and mixed flow regime water surface profiles.

The basic computational procedure is based on the solution of the one
dimensional energy equation. Energy losses are evaluated by friction
(Manning's equation) and contraction/expansion (coefficient multiplied by the
change in velocity head). The momentum equation is utilized in situations
where the water surface profile is rapidly varied. These situations include
mixed flow regime calculations (i.e., hydraulic jumps), hydraulics of bridges,
and evaluating profiles at river confluences (stream junctions).

The effects of various obstructions such as bridges, culverts, weirs, and
structures in the flood plain may be considered in the computations. The
steady flow system is designed for application in flood plain management and
flood insurance studies to evaluate floodway encroachments. Also,
capabilities are available for-assessIng the"changein water surface profiles
due to channel improvements, and levees.

Special features of the steady flow component include: multiple plan
analyses; multiple profile computations; multiple bridge and/or culvert
opening analysis; and split flow optimization.

~--'----

Unsteady Flow Simulation. This component of the HEC-RAS modeling
system is capable of simulating one-dimensional unsteady flow through a full
network of open channels. The unsteady flow equation solver was adapted
from Dr. Robert L. Barkau's UNET model (Barkau, 1992 and HEC, 1997).
This unsteady flow component was developed primarily for subcritical flow
regime calculations.

The hydraulic calculations for cross-sections, bridges, culverts, and other
hydraulic structures that were developed for the steady flow component were
incorporated into the unsteady flow module.

Sediment Transport/Movable Boundary Computations. This component of
the modeling system is intended for the simulation of one-dimensional
sediment transport/movable boundary calculations resulting from scour and
deposition over moderate time periods (typically years, although applications
to single flood events are possible).

The sediment transport potential is computed by grain size fraction, thereby
allowing the simulation of hydraulic sorting and armoring. Major features
will include the ability to model a full network of streams, channel dredging,
various levee and encroachment alternatives, and the use of several different
equations for the computation of sediment transport.

1-3
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The model will be designed to sllnulate long-term trends of scour and
deposition in a stream channel that might result from modifying the frequency
and duration of the water discharge and stage, or modifying the channel
geometry. This system can be used to evaluate deposition in reservoirs,
design channel contractions required to maintain navigation depths, predict
the influence of dredging on the rate of deposition, estimate maximum
possible scour during large flood events, and evaluate sedimentation in fixed
channels.

Data Storage and Management

Data storage is accomplished through the use of "flat" files (ASCII and
binary), as well as the HEC-DSS. User input data are stored in flat files under
separate categories of project, plan, geometry, steady flow, unsteady flow,
and sediment data. Output data is predominantly stored in separate binary
files. Data can be transferred between HEC-RAS and other programs by
utilizing the HEC-DSS.

Data management is accomplished through the user interface. The modeler is
requested to enter a single filename for the project being developed. Once the
project filename is entered, all other files are automatically-_created and
named by the interface as needed. The interface provides for renaming,
moving, and deletion of files on a project-by-project basis.

Graphics and Reporting

Graphics include X-Y plots of the river system schematic, cross-sections,
profiles, rating curves, hydrographs, and many other hydraulic variables. A
three-dimensional plot ofmultiple cross-sections is also provided. Tabular
output is available. Users can select from pre-defined tables or develop their
own customized tables. All graphical and tabular output can be displayed on
the screen, sent directly to a printer (or plotter), or passed through the
Windows Clipboard to other software, such as a word-processor or
spreadsheet.

Reporting facilities allow for printed output of input data as well as output
data. Reports can be customized as to the amount and type of information
desired.
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HEC-RAS Documentation

The HEC-RAS package includes several documents. Each document is
designed to help the modeler learn to use a particular aspect of the modeling
system. The documentation has been broken up into the following three
categories:

Documentation

User's Manual

Description

This manual is a guide to using HEC-RAS.
The manual provides an introduction and
overview of the modeling system, installation
instructions, how to get started, a simple
example, detailed descriptions of each of the
major modeling components, and how to view
graphical and tabular output.

•
Hydraulic Reference Manual This manual describes the theory and data

requirements for the hydraulic calculations
performed by HEC-RAS. Equations are
presented along with the assumptions used in
their derivation. Discussions are provided on
how to estimate model parameters, as well as
guidelines on various modeling approaches.

Applications Guide

Overview of This Manual

This document contains a series of examples
that demonstrate various aspects of HEC
RAS. Each example consists of a problem
statement, data requirements, general outline
of solution steps, displays ofkey input and
output screens, and discussions of important
modeling aspects.

•

This user's manual is the primary piece of documentation on how to use the
HEC-RAS system. The manual is organized as follows:

• Chapters 1-2 provide an introduction and overview ofHEC-RAS, as well
as instructions on how to install the software.

• Chapters 3-5 describe how to use the HEC-RAS software in a step-by
step procedure, including a sample problem that the user can follow along
with. Understanding how this system works with projects is also
discussed.

1-5
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:f • Chapters 6-8 explain in detail how to enter and edit data, and how to
perform the different types ,of analyses that are available,

4- • Chapter 9 provides detailed discussions on how to view graphical and
tabular output, as well as how to develop user-defined tables.

• Chapter 10 describes how to perfonn a floodway encroachment analysis.

• Chapter 11 provides discussions on "Trouble Shooting" and
understanding the most common Errors, Warnings, and Notes.

• Chapter 12 describes how to perform bridge scour computations from
within HEC-RAS.

• Chapter 13 describes how to perform channel modifications within HEC
RAS.

• Chapter 14 explains how to utilize GIS/CADD data in HEC-RAS, as well
as how to export HEC-RAS results back to the GIS/CADD system.

• Appendix A contains a list of references.

• Appendix B contains a detailed description of the file formats used for
importing and exporting GIS data to and from HEC-RAS.

• Appendix C contains a description of all the output variables available
from the HEC-RAS program.

1-6
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CHAPTER 2

Installing HEC-RAS

You install HEC-RAS using the program SETUP.EXE. The Setup program
installs the software, sample applications, and the Help system.

This chapter discusses the hardware and system requirements needed to use
HEC-RAS, how to install the software, and how to uninstall the software.

Contents

• Hardware and Software Requirements

• Installation Procedure

• Uninstall Procedure

Important

You cannot simply copy files from the distribution CD to your hard disk and
run HEC-RAS. You must use the Setup program, which decompresses and
installs the files to the appropriate directories.

2-1
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Hardware and Software Requirements

Before you install the HEC-RAS software, make sure that your computer has
at least the minimum required hardware and software. In order to get the
maximum performance from the HEC-RAS software, recommended
hardware and software is shown in parentheses. This version ofHEC-RAS
will run on a microcomputer that has the following:

• Intel Based PC or compatible machine with Pentium processor or higher
(a Pentium II or higher is recommended).

• A hard disk with at least 20 megabytes of free space (40 megabytes or
more is recommended).

• A CD Rom drive (or CD-R, CD-RW, DVD).

• A minimum of32 megabytes ofRAM if using Windows 95,98, ME or
48 megabytes ifusing Windows NT or 2000 (64 or more is
recommended).

• A mouse.

• Color Video Display (Recommend running in Super VGA (l024x768) or
higher, and as large a monitor as possible).

• MS Windows 95, 98, ME, NT 4.0, or 2000 (or later versions).

Installation Procedure

Installation of the HEC-RAS software is accomplished through the use of the
Setup program.

To install the software onto your hard disk do the following:

1. Insert the HEC-RAS CD into your CD drive.

2. The setup program should run automatically.

3. If the setup program does not run, use the windows explorer to start
the setup.exe program on the CD.

4. Follow the setup instructions on the screen.

The setup program automatically creates a program group called HEC. This
program group will be listed under the Programs menu, which is under the
Start menu. The HEC-RAS program icon will be contained within the HEC
program group. The user can create a shortcut icon by opening Windows

2-2
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Explorer and dragging the HEC-RAS executable onto the desktop. The
HEC-RAS executable can be found in the \hec\ras directory with the name
"RAS.EXE".

Uninstall Procedure

The HEC-RAS Setup program automatically registers the software with the
Windows operating system. To unistall the software, do the following:

• From the Start Menu select Settings and then Control Panel.

• From within the Control Panel folder select Add/Remove Programs.

• From the Tab marked as InstalIlUninstall select the HEC-RAS
program from the list of installed software, then press the
Add/Remove button.

• Follow the uninstall directions on the screen and the software will be
removed from your hard disk. It is up to the user to remove the HEC
RAS icon from the desktop.

2-3
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CHAPTER 3

Working With HEC-RAS - An Overview

HEC-RAS is an integrated package ofhydraulic analysis programs, in which
the user interacts with the system through the use of a Graphical User
Interface (GUI). The system is capable ofperforming Steady and Unsteady
Flow water surface profile calculations, and will include Sediment Transport
and several hydraulic design computations in the future.

In HEC-RAS terminology, a Project is a set of data files associated with a
particular river system. The modeler can perform any or all of the various
types of analyses, included in the HEC-RAS package, as part of the project.
The data files for a project are categorized as follows: plan data, geometric
data, steady flow data, unsteady flow data, sediment data, and hydraulic
design data.

During the course of a study the modeler may want to fonnulate several
different Plans. Each plan represents a specific set of geometric data and
flow data. Once the basic data are entered into the HEC-RAS, the modeler
can easily fonnulate new plans. After simulations are made for the various
plans, the results can be compared simultaneously in both tabular and
graphical form.

This chapter provides an overview ofhow a study is performed with the
HEC-RAS software. Special topics on how to import HEC-2 data,
reproducing HEC-2 results, and how to use on-line help are also covered.

Contents

• Starting HEC-RAS

• Steps in Developing a Hydraulic Model With HEC-RAS

• Importing HEC-2 Data

• Reproducing HEC-2 Results

• Getting and Using Help
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Starting HEC-RAS

When you run the HEC-RAS Setup program, you automatically get a new
program group called HEC and program icon called HEC-RAS. They
should appear in the start menu under the section called Programs. The user
also has the option of creating a shortcut on the desktop. If a shortcut is
created, the icon for HEC-RAS will look like the following:

HEC-RAS 3.0

Figure 3.1 The HEC-RAS Icon in Windows

To Start HEC-RAS from Windows:

• Double-click on the HEC-RAS Icon. If you do not have an HEC
RAS shortcut on the desktop, go to the Start menu and select
Programs, then select HEC, and then HEC-RAS.

When you first start HEC-RAS, you will see the main window as shown in
Figure 3.2 (except you will not have any project files listed on your main
window).

Figure 3.2 The HEC-RAS Main Window
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DSSData

Detailed Output Tables
Erofile Table...
Summary Err, Warn, Notes...

l5.ew
Cross Sections...
Water Surface Profiles...
General Profile Plot
Rating Curves
X-Y-Z Perspective Plots...

Stage and Flow Hydrographs
Hydraulic Property Plots

Help
Contents
Using REe-RAS Help

__._.AboutBEC:RAS

Run
Steady Flow Analysis...
Unsteady Flow Analysis. ..
Sediment Analysis...
Hydraulic Design Functions...

Edit
Geometric Data...
Steady Flow Data...
Unsteady Flow Data...

Eile
New Project. ..
Open Project...
Save Project
Save ProjectAs...
Rename Project. ..
Delete Pro;ect...
Project Summary

Import HEC-2 Data...
Irrport HEC-RAS Data...
Generate Report .
Export GIS Data .
Export to HEC-DSS...
Restore Data

•

Exit

•
d:\hec\ras\data\buffalo.prj
d:\hec\ras\data\example.prj
d:\hec\ras\data\onebox.prj

Figure 3.3 HEC-RAS Main Window Menu Bar Structure
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At the top of the HEC-RAS main window is a Menu bar (Figure 3.3) with the
following options:

File: This option is used for file management. Options available under the
File menu include: New Project; Open Project; Save Project; Save Project As;
Rename Project: Delete Project; Project Summary; Import HEC-2 Data;
Import HEC-RAS data; Generate Report; Export GIS Data; Export to HEC
DSS; Restore Data; and Exit. In addition, the most recently opened projects
will be listed at the bottom of the File menu, which allows the user to quickly
open a project that was recently worked on.

Edit: This option is used for entering and editing data. Data are categorized
into four types: Geometric Data; Steady Flow Data; Unsteady Flow Data;
and Sediment Data. In the current version, Sediment Data is not active.

Run: This option is used to perform the hydraulic calculations. The options
under this menu item include: Steady Flow Analysis; Unsteady Flow
Analysis; Sediment Analysis; and Hydraulic Design Functions. In the current
version, Sediment Analysis is not available.

View: This option contains a set of tools that provide for graphical and
tabular displays of the model output. The View menu item currently
includes: Cross Sections; Water Surface Profiles; General Profile Plot; Rating
Curves; X-Y-Z Perspective Plots; Stage and Flow Hydrographs; Hydraulic
Properties Plots; Detailed Output Tables; Profile Summary Tables; and
Summary Err, Warn, Notes.

Options: This menu item allows the user to change Program Setup options;
set Default Parameters; establish the Default Units System (U.S. Customary
or Metric); and Convert Project Units (U.S. Customary to Metric, or Metric to
U.S. Customary).

Help: This option allows the user to get on-line help, as well as display the
current version information about HEC-RAS.

Also on the HEC-RAS main window is a Button bar (Figure 3.4). The Button
bar provides quick access to the most frequently used options under the HEC
RAS menu bar. A description of each button is shown in Figure 3.4.
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Unsteady Flow Data:
Edit and/or enter
unsteady flow data

Geometric Data:
Edit and/or enter
geometric Data

Open Project:
Open an existing
project

Save Project:
Save an existing
project

Steady Flow Data:
Edit and/or enter
steady flow data

Unsteady Flow Analysis:
Perform an unsteady flow
simulation

Cross Sections:
View cross
section plots

General Profile Plot:
View computed
variables along the
channel

Rating Curve:
View computed
rating curves

Profile Plot:
View water surface
profile plots

Hydraulic Design Functions:
Perform hydraulic design
computations

XYZ Perspective Plot:
View 3D multiple cross
section plot

Hydraulic Properties:
Plots and tables of
hydraulic properties

Prome Summary Table:
View summary output at
multiple locations by profile

Sum Errs, Warn, Notes:
Summary of Errors,
Warnings, and Notes

Detailed Output Table:
View detailed output at cross
sections, bridges, culverts, etc ...

Stage and Flow Hydrographs:
Plot stage and flow hydrographs

•

Steady Flow Analysis:
Perform a steady flow
simulation

Figure 3.4 HEC-RAS Main Window Button Bar
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Steps in Developing a Hydraulic Model with HEC·RAS

There are five main steps in creating a hydraulic model with HEC-RAS:

• Starting a new project

• Entering geometric data

• Entering flow data and boundary conditions

• Performing the hydraulic calculations

• Viewing and printing results

Starting a New Project

The first step in developing a hydraulic model with HEC-RAS is to establish
which directory you wish to work in and to enter a title for the new project.
To start a new project, go to the File menu on the main HEC-RAS window
and select New Project. This will bring up a New Project window as shown
in Figure 3.5.

Dendritic data set
Multiple Opening Data Set
Twin Circular Pipe Data Set
Single Bridge Data Set
Three R~ach· With Hydraulic Structures

dendrit.prj
K1B1 ClPRJ
MULTPIPE.PRJ
NORMALBT.PRJ
THREE.prj

~C:\

~HEC
i,Ej Ras30
~ BasicRasCIass
~ DemoFiles

Figure 3.5 New Project Window

As shown in Figure 3.5, you first select the drive and path that they want to
work in (to actually select a path you must double click the directory you
want in the directory box), next enter a project title and file name. The
project filename must have the extension ".prj", the user is not allowed to
change this. Once you have entered all the information, press the "OK"
button to have the information accepted. After the OK button is pressed, a
message box will appear with the title of the project and the directory that the
project is going to be placed in. If this information is correct, press the OK
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button. If the infonnation is not correct, press the Cancel button and you will
be placed back into the New Project window.

Note: Before any Geometric data and Flow djlta are entered, the user
should select the Units System (English or Metric) thaf they would like to
work in. This step is accomplished by selecting Unit-System from the
Options menu of the main HEC-RAS window.

Entering Geometric Data

The next step is to enter the necessary geometric data, which consist of
connectivity infonnation for the stream system (River System Schematic),
cross-section data, and hydraulic structure data (bridges, culverts, weirs, etc.).
Geometric data are entered by selecting Geometric Data from the Edit menu
on the main HEC-RAS window. Once this option is selected, the geometric
data window will appear as show in Figure 3.6 (except yours will be blank
when you first bring this screen up for a new project).

l-l..U'-"---~--J..10.3

~9"
/

1> 10.2
t- 10.09

Upper Reach'\.'
. '\i. '10

Figure 3.6 Geometric Data Window
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The modeler develops the geometric data by first drawing in the river system
schematic. This is accomplished, on a reach-by-reach basis, by pressing the
River Reach button and then drawing in a reach from upstream to
downstream' (in the positive flow direction). After the reach is drawn, the
user is prompted to enter a "River" and a "Reach" identifier. The River and
reach identifiers can be up to 16 characters in length. As reaches are
connected together, junctions are automatically formed by the interface. The
modeler is also prompted to enter an identifier for each junction. For more
information on developing the river system schematic, see Chapter 6
"Entering and Editing Geometric Data."

After the river system schematic is drawn, the modeler can start entering
cross-section and hydraulic structure data. Pressing the Cross Section button
causes the cross section editor to pop up. This editor is shown in Figure 3.7.
As shown, each cross section has a River name, Reach name, River Station,
and a Description. The River, Reach and River Station identifiers are used
to describe where the cross section is located in the river system. The "River
Station" identifier does not have to be the actual river station (miles or '
kilometers) at which the cross section is located on the stream, but it does
have to be a numeric value (e.g., 1.1,2,3.5, etc.). The numeric value is used
to place cross sections in the appropriate order within a reach. Cross
sections are ordered within a reach from the highest river station
upstream to the lowest river station downstream.

Figure 3.7 Cross Section Data editor
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The basic data required for each cross section are shown on the Cross Section
Data editor in Figure 3.7. Additional cross section features are available
under Options from the menu bar. These options include: adding, copying,
renaming and deleting cross sections; adjusting cross section elevations,
stations, and nor k-values; skew cross section; ineffective flow areas; levees;
blocked obstructions; adding a lid to a cross section; add ice cover; add a
rating curve; horizontal variation ofn or k-values; and vertical variation ofn
values.

Also, available from the Cross Section Data editor is the ability to plot any
cross section or reach profile. Edit features are available to cut, copy, paste,
insert, and delete data from the Cross Section X-Y Coordinates grid.

Once the cross-section data are entered, the modeler can then add any
hydraulic structures such as bridges, culverts, weirs and spillways. Data
editors, similar to the cross section data editor, are available for the various
types of hydraulic structures. If there are any stream junctions in the river
system, additional data are required for each junction. The Junction data
editor is available from the Geometric Data window.

Once geometric data are entered, the data should be saved to a file on the hard
disk. This is accomplished by selecting the Save Geometric Data As option
from the File menu on the Geometric Data editor. This option allows the user
to enter a title for the geometric data. A filename is automatically established
for the geometric data, and then saved to the disk. Once a title is established,
geometric data can be saved periodically by selecting Save Geometric Data
from the File menu of the Geometric Data editor.

Entering Flow Data and Boundary Conditions

Once the geometric data are entered, the modeler can then enter either steady
flow or unsteady flow data. The type of flow data entered depends upon the
type of analyses to be performed. For the discussion in this chapter, it is
assumed that a steady flow analysis will be performed. The data entry form
for steady flow data is available under the Edit menu bar option on the HEC
RAS main window.

An example of the steady flow data entry form is shown in Figure 3.8, which
Jt. l("~"""I .....e::S is the Steady Flow Data Editor. As shown in Figure 3.8, steady flow data

Q.. consist of: the number ofprofiles to be computed; the flow data; and the river
f system boundary conditions. At least one flow must be en~ered for every

r--""'r-t~Y4>.-t~·T-'''~eachwithin the system. Additionally, flow can be changed at any location
within the river system. Flow values must be entered for all profiles.

•
~~~l"-l.wlc-~ - b$

$'V~(2.~I-r.~'-... ~J

Boundary conditions are required in order to perform the calculations. Ifa
.subcritical flow analysis is going to be performed, then only the downstream
boundary conditions are required. If a supercritical flow analysis is going to
be performed, then only the upstream boundary conditions are required. If
the modeler is going to perform a mixed flow regime calculation, then both
upstream and downstream boundary conditions are required. The Boundary
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Con.ditions g~m: ~~try f91-"m <f~,~e,9.r.9.u~t~P RY pr$l~sing the Enter
... J~ou.p~ary<;:9P4~tion,~:puttonfrorq, fu.~ .s!t.~ady J<Jo\y Data entry fonn.. .. '.;,.... '.... . '. ...', ,- .

.'.' ! ,1.1-" <':._~.\:'j: ,~-._ .' ..~ .:'. ~ ~~ :,;:' .•". \'3:;,~..i'tlq,1 ~~\,.;.'"

.on,c~,l,l~~t·~Op.~..~t~tl9¥ ,fl,9,f1qat!~ ,~!lqR!J]:P~9~f)( A9Mit,ions are entered, the

.ll,lo~~l~r s4911J~§.a,v.e the.9l!ta t9 .tA~~ar~;·g~~r<. J4is ,PllP be accomplished py
~ele9ting S?-:y~F!ow.Dat,a .¢\S froIp,., ~~f.JJ~. (lpt(Qn on the Steady Flow Data

. ~~ilU b~. N6~'da:ia i~ S~ye:~ ip,~.,s~par~t~)lfe:· Tli~ user is only required to
enter a title fOf the flow data, the filename is aut6.tJ?~tically assigned.

J,fi.gur~ 3.8 Steady FJowJ);ltawin4ow

Performing the Hydr~l,Ili~ Cornp..ytai.ions

Once all of the geometric data and flow data are entered, the modeler can
begin to perform the hydraulic calculations. As stated previously, there are
three types of calculations that can be performed in the current version of
fIEC-RA-S: §t~jldyFloWAn~y'sis, Un~t¢ady Flow Analysis, and Hydraulic
Design Futictiof?,s. The' modeler can sdect any of the available hydraulic
analyses from the RQn menu bar option on the HEC-RAS main window. An
exall.lple o:n~e Simulation Ma'nag~r window is shown in Figure 3.9, which is
the~teady Fro",,: Analysis window.
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Figure 3.9 Steady Flow Analysis window

As shown in Figure 3.9, the modeler puts together a Plan by selecting a
specific set of geometric data and flow data. A Plan can be put together by
selecting New Plan from the File menu bar option of the Steady Flow
Analysis window. Once a Plan Title and Short Identifier (Short ID) have
been entered, the modeler can select a Flow Regime for which the model will
perform calculations. Subcritical, Supercritical, or Mixed flow regime
calculations are available.

Additional features are available under the Options menu for: performing a
Floodway Encroachment Analysis; Setting locations for calculating flow
distribution output; conveyance calculation options; friction slope methods;
calculation tolerances; critical depth output; critical depth computation
method; split flow optimization; data checking; setting log file levels; and
viewing the log file output.

Once the modeler has selected a Plan and set all of the calculation options, the
steady flow calculations can be performed by pressing the Compute button at
the bottom of the Steady Flow Analysis window. When this button is
pressed, the HEC-RAS system packages up all the data for the selected plan
and writes it to a run file. The system then runs the steady flow model
(SNET) and passes it the name of the run file. This process is executed in a
separate window. Therefore, the modeler can work on other tasks while it is
executing.
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Viewing and Printing Results

Once the model has finished all of the computations, the modeler can begin
viewing the results. Several output features are available under the View
option from the main window. These options include: cross section plots;
profile plots; rating curve plots; X-Y-Z perspective plots; tabular output at
specific locations (Detailed Output Tables); tabular output for many locations
(Profile Summary Tables); and the summary of errors, warnings, and notes.

An example of a cross section plot is shown in Figure 3.10. The user can plot
any cross section by simply selecting the appropriate River, Reach and River
Station from the list boxes at the top of the plot. The user can also step
through the plots by using the up and down arrow buttons. Several plotting
features are available under the Options menu of the Cross Section plot.
These options include: zoom in; zoom out; full plot; pan; animate; selecting
which plans, profiles and variables to plot; velocity distribution; viewing
interpolated cross-sections; and control over the lines, symbols, labels,
scaling, and grid options.

Hard copy outputs of the graphics can be accomplished in two different ways.
Graphical plots can be sent directly from HEC-RAS to whichever printer or
plotter the user has defined under the Windows Print Manager. Graphical
plots can also be sent to the Windows clipboard. Once the plot is in the
clipboard it can then be pasted into other programs, such as a word processor.
Both of these options are available from the File menu on the various plot
windows.

An example of a profile plot is shown in Figure 3.11. All of the options
available in the cross section plot are also available in the profile plot.
Additionally, the user can select which specific reaches to plot when a
multiple-reach river system is being modeled.

An example of an X-Y-Z Perspective Plot is shown in Figure 3.12. The user
has the option of defining the starting and ending location for the extent of the
plot. The plot can be rotated left or right, and up or down, in order to get
different perspectives of the river reach. The computed water surface profiles
can be overlaid on top of the cross section data. The graphic can be sent to
the printer or plotter directly, or the plot can be sent through the Windows
Clipboard to other programs.
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Critical Creek - Example 1 Plan: Modified Geometry Conditions
Geom: Base Geometry Data + Interpolated Flow: 100 Year Profile - Up and Down Bndry.
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Figure 3.12 X-Y-Z Perspective Plot of River Reach with a Bridge
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Tabular output is available in two different formats. The first type of tabular
output provides detailed hydraulic results at a specific cross section location
(Detailed Output Table). An example of this type of tabular output is shown
in Figure 3.13.

0.100 0.040 0.100
100.00 100.00 100.00

2473.60 342.47 177.74
2473.60 342.47 177.74
5748.43 3068.15 183.42
699.71 45.00 170.59

2.32 8.96 1.03
3.54 7.61 1.04

85065.5 45402.7 2714.3
702.56 50.80 170.61

1.00 1.92 0.30

• 2.33 17.22 0.31
216.87 42.90 10.36
79.60 6.44 7.92

Figure 3.13 Tabular Detailed Output

•

The second type of tabular output shows a limited number ofhydraulic
variables for several cross sections and multiple profiles (Profile Summary
Tables). An example of this type of tabular output is shown in Figure 3.14.
There are several standard tables that are predefined and provided to the user
under the Tables menu from the profile output tables. Users can also define
their own tables by specifying what variables they would like to have in a
table. User specified table headings can be saved and then selected later as
one of the standard tables available to the project.

Tabular output can be sent directly to the printer or passed through the
clipboard in the same manner as the graphical output described previously.
This option is also available under the File menu on each of the table forms.
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9000.00 1803.60 1815.54 18l4.46 1816,02 0.004567 8.96 2993.81 915.30
9000.00 1800.70 1810.68 1810.42 1811.90 0.007043 11.20 1888.44 651.48
9000.00 1794.40 1804.64 1803.69 1805.08 0.008639 9.82 2641.12 960.56
9000.00 1788.70 1799.04 1799.31 1800.25 0.012377 13.19 2386.84 1209.91
9500.00 1784.30 1794.12 1793.89 1795.13 0.007246 11.60 2787.41 1171.16
9500.00 1777.20 1789.64 1788.87 1790.94 0.008716 14.02 2028.56 522.19
9500.00 1774.50 1784.29 1784.29 '1786.35 0.011143 13.38 1266.30 332.38
9500.00 1768.50 1777.26 1776.81 1778.26 0.009176 11.84 2096.09 595.69
9500.00 1763.00 1772.79 1772.23 1773.49 0.007974 11.29 2504.12 734.61
9500.00 1759.40 1767.85 1765.75 1769.14 0.011979 13.33 1961.46 653.51
9500.00 1753.60 176"1.54 1760.03 1762.10 0.009429 10.37 2322.20 682.66
9500.00 1747.40 1756.71 1755.71 1757.21 0.010002 9.91 2403.99 728.01

Figure 3.14 Profile Output Table

Importing HEC-2 Data

An important feature ofHEC-RAS is the ability to import HEC-2 data. This
feature makes it easy for a user to import existing HEC-2 data sets and start
using HEC-RAS immediately.

What You Should Know First

Before importing HEC-2 data, there are several things that you should be
aware of. First, not all of the options available in HEC-2 have been
incorporated into the current version of HEC-RAS. The following is a list of
HEC-2 options that are not available in the current version ofHEC-RAS:

- Compute Manning's n from high water marks (11)
- Archive (AC)
- Free Format (PR)
- Storage Outflow for HEC-l (14)

HEC-2 data sets containing these options can still be imported, but these data
options will be ignored.
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Another important issue to be aware of is how the cross sections are
identified., In HEC-RAS, each cross section is identified with a River name,
Reach name, and a River Station. The river stationing must be in order from
highest river stationing upstream to lowest river stationing downstream.
When the user goes to import HEC-2 data, a pop up window will appear
(Figure 3.15), asking the user to select a method for identifying the river
stationing of the cross sections. If you select "Use HEC-2 Section ill's," the
program will use the first field of the X 1 record for the river stationing of the
cross section. Ifyou choose this method, you must be sure that the cross
sections in the HEC-2 file are numbered with highest river stationing
upstream, and that no two cross sections have the same river station identifier.
If these two requirements are not met, the program will not import the data
correctly. An alternative is to select' "Use Sequential Counter." This method
simply assigns river stations as 1,2, 3, etc. in the order in which the cross
sections are found in the HEC-2 file (still maintaining highest numbers
upstream and lowest numbers downstream.

Figure 3.15 Method for Identifying River Stations from HEC-2 Data

After the HEC-2 data is imported into HEC-RAS, you may need to make
some modifications to the data. HEC-RAS is a completely new program. As
HEC-RAS was being developed, we tried to improve the hydraulic
computations in every way we could. Some of these improvements have
made it necessary to get more information and/or different information from
the user for a specific type of computation. The following is a list of features
in which the data requirements for HEC-2 and HEC-RAS have changed, and
it may be necessary for the user to modify the data after it is imported:

- Special Bridge (SB)
- Special Culvert (SC)
- Normal Bridge (X2, BT)
- Encroachments and Floodway Determination (X3, ET)
- Ineffective Flow Areas (X3)
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When bridge data are imported, the user must take special care to ensure that
the data are correctly representing the bridge. The bridge routines in BEC
RAS are more detailed than HEC-2, and therefore you may have to modify
some data and/or enter some additional data. Whenever you import an HEC
2 data set with bridge data, carefully review all the data for each bridge.
Chapter 6 of this user's manual describes the required data for bridges in
HEC-RAS. Appendix C of the HEC-RAS Hydraulic Reference Manual
contains a detailed discussion of the computational differences between
HEC-RAS and HEC-2. Some key differences between the bridge routines
ofHEC-2 and HEC-RAS are as follows:

1. Special Bridge Data Sets

BEC-RAS does not use a trapezoidal approximation for low flow through the
bridge opening. The actual bridge opening is used in both the Yamell method
and the momentum method. This could be a problem for HEC-2 special
bridge data sets that do not include low chord information on the BT data. If
you have a data set like this, you will need to modify the bridge deck
information after the data have been imported. This caD. be done from the
HEC-RAS Deck/Roadway editor.

The pressure flow equations in BEC-RAS use the actual bridge opening,
defined by the ground and the bridge data. In HEC-2, the user was required
to enter an area for pressure flow. If the actual bridge opening produces a
different area than what the user had entered in the HEC-2 data deck, the
program will get different results for pressure flow, and pressure and weir
flow answers.

Pier information from the SB record is incorporated as a single pier in the
BEC-RAS data set (this is how it was treated in BEC-2). Piers are treated as
separate pieces of data in HEC-RAS. For special bridges that have piers, you
may want to change the single pier to multiple piers, depending on what is
actually at the bridge. Pier information can be modified using the Pier editor.

2. Normal Bridge Data Sets

Because piers are treated as a separate piece of data in BEC-RAS, they must
not be included in the cross section data or the bridge deck. Since it is
common to include pier information as part of the cross section or bridge
deck in HEC-2, these data will need to be modified. For data sets that have
piers, you will need to remove the pier information from the cross section or
bridge deck, and then add the information back in using the Pier editor.
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Steps for Importing HEC-2 Data

To import HEC-2 data, do the following:

1. Start a new project by selecting New Project under the File menu
option on the HEC-RAS main window (Figure 3.16). When this
option is selected a window will appear allowing you to select the
drive and directory for the new project, then enter a project title and
filename. Press the OK button, and then a pop up window will appear
asking you to confirm the information.

2. Select the Import HEC-2 Data option under the File menu on the
main window (Figure 3.16). A pop up window will appear (Figure
3.17), which will allow you to select a drive, path, and filename for
the HEC-2 data file. In addition to the filenames being listed, the first
line of each HEC-2 data file is shown under the title field on the
window. Once you have selected the file you want, press the OK
button.

Figure 3.16 HEC-RAS Main Window With File Menu Options Shown

•
3. Once you have selected an HEC-2 file and pressed the OK button, a

pop up window will appear asking you to select a method for
identifying the river stationing of the cross sections (this was
discussed under the "What You Should Know First" section). Select
a method and press the Import HEC-2 button.
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TEST 3 INTERPOLATED CROSS SECTIO BDAT I~
TEST 4 DIRECT SOLUTION OF MANNIN T4.DAT
TEST 5 SPECIAL AND NORMAL BRIDGE T5.DAT
TEST 5 SPECIAL AND NORMAL BRIDGE T56.. DAT
TEST SNORMAL BRIDGLSUPERCRITIC TS.DAT
TEST 7 NORMAL BRIDGE ,CRITICAL D T7.DAT
TEST 8 SPECIAL BRIDGE,METRIC UNI T8.DAT
TEST 9 SPECIAL BRIDGE,CLASS AAN T9.DAT

START AT SECTION TJC3.DAT
YOLO.DAT

T1
T1
T1
T1
T1
T1
T1
T1
T1
T1---

Figure 3.17 Window for Importing HEC-2 Data

4. If the HEC-2 data file contains any bridges or culverts, a note will
appear reminding you to look at the imported data of all of the bridges
and culverts to ensure the data is complete and correct.

The data are automatically saved in HEC-RAS format with default names and
titles. The user can change the titles at any time by using the Rename
feature, which is available from the File menu of the various data editors
(Geometric data, flow data, and plan data).

Reproducing HEC-2 Results

The HEC-RAS program is a completely new piece of software. None of the
hydraulic routines from HEC-2 were used in the HEC-RAS software. When
HEC-RAS was being developed, a significant effort was spent on improving
the computational capabilities over those in the HEC-2 program. Because of
this, there are computational differences between the two programs.

Appendix C, of the HEC-RAS Hydraulic Reference Manual, outlines in
detail the computational differences between the two programs. Please
review this closely!

When importing HEC-2 data, and attempting to reproduce the results of a
previous study, the following is a list of items that should be considered:
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1. First, is the data that you have imported good data? In other words,
did it come from a working HEC-2 model, and was that model
considered as being hydraulically sound. Are there an adequate
number of cross sections? And are there any mistakes in the cross
section data? Review the data closely, before you assume that it is
good!

•

2. The default method for calculating conveyance in HEC-RAS is
different from HEC-2. However, HEC-RAS has the ability to
compute conveyance with the HEC-2 methodology. Ifyo!1 are trying
to reproduce HEC-2 results, you may want to switch HEC-RAS to the
HEC-2 method of computing conveyance. To do this, from the
Steady Flow Analysis window select Options from the menu bar then
select Conveyance Calculations. When this is selected, a pop up
window will appear as shown in Figure 3.18. There are two options
available, the HEC-RAS default method (break in n-value method)
and the HEC-2 style method. Select the HEC-2 style method if you
are trying to reproduce HEC-2 results. For more information on the
differences in conveyance calculations, see Appendix C of the HEC
RAS Hydraulic Reference manual.

•

Figure 3.18 HEC-RAS Conveyance Calculation Methods

3. The HEC-RAS bridge routines are more comprehensive than the
HEC-2 bridge routines, and therefore differences can occur at bridge
locations. First, review the bridge data closely and make sure it
accurately represents the bridge you are trying to model. If you feel it
is necessary to match the results of a previous study at the bridge,
then your only alternative is to adjust the coefficients that are being
used in the bridge modeling approach (i.e., pressure and weir flow
coefficients, low flow coefficients, contraction and expansion
coefficients, etc...). For detailed information on the differences
between the HEC-RAS and HEC-2 bridge routines, please review
Appendix C of the Hydraulic Reference manual.
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4. Sometimes differences can occur at locations where the programs
have defaulted to a critical depth solution. First you should ask
yourself if critical depth is an appropriate solution for this location. It
is a common problem for both programs to default to critical depth
when the cross sections are spaced too far apart. If you feel critical
depth is an appropriate solution, then in general the HEC-RAS answer
will be better than HEC-2. The critical depth routines in HEC-RAS
are much more comprehensive than HEC-2. HEC-RAS has tighter
error limits for locating critical depth, as well as the ability to find
multiple critical depths and detect which is the most appropriate.

5. Differences can also occur at locations where floodway
encroachments are being computed. The HEC-RAS floodway
encroachment routines have been improved over those available in
HEC-2. Also, the default at bridges in HEC-RAS is to perform the
encroachment analysis, while the default in HEC-2 was to not
encroach at bridges. For more details on differences between
encroachment routines, please review Appendix C of the HEC-RAS
Hydraulic Reference Manual.

6. After carefully reviewing items one through five above, if you still
have computational differences in the computed profiles, you may
need to modify Manning's n values in order to reproduce the previous
study results. In general, this is not suggested. If you do decide to
modify the n values,' try to keep them within a realistic range of what
is appropriate for the stream you are working on.

Getting and Using Help

On-line help is available from within the HEC-RAS software. Help can be
accessed by selecting the Help menu option at the top of each window, or by
pressing the Fl function key.
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CHAPTER 4

Example Application

This chapter provides an example application of how to perform steady flow
water surface profile calculations with HEC-RAS. The user is taken through
a step-by-step procedure of how to enter data, perform calculations, and view
the results.

In order to get the most out of this chapter, you should perform each of the
steps on your own computer. Also, before you try the example application,
you should have read the first three chapters in this manual.

Contents

• Starting a New Project

• Entering Geometric Data

• Entering Steady Flow Data

• Performing the Hydraulic Calculations

• Viewing Results

• Printing Graphics and Tables

• Exiting the Program
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Starting a New Project

To begin this example, let's first start the HEC-RAS program. Double click
the HEC-RAS icon in Windows. The main window should appear as shown
in Figure 4.1 (except yours will be blank the first time you start the program).

Figure 4.1 HEC-RAS Main Window

The first step in developing an HEC-RAS application is to start a new project.
Go to the File menu on the main window and select New Project. The New
Project window should appear as shown in Figure 4.2 (except the title and file
name fields will be blank when it first comes up).

-------
--------~--

Stream Junction -Example 10
Looped Network· Example 8
Mixed Flow Project
Mixed Flow· Example 9
Multiple Culverts· Example 4
Multiple Openings· Example 5
Napa Cr. Bridge Project - Example 7
Neil Nelson's Property
Inline Weir and Gated Spillay· Ex 12
Brid e Scour' Exam Ie 11

JUNCTlON.prj
LOOP prj
MIXED.PRJ
MIXFLOW.prj
MULTCULV.prj
MULTOPEN.prj
NAPA.prj
Nelson.prj
NIT.prj
SCOUR.PRJ

Figure 4.2 New Project Window

First set the drive (e.g., C:) and the directory that you would like to work in.
Next enter the project title and filename as shown in Figure 4.2. Once you
have entered the infonnation, press the OK button to have the data accepted.
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Entering Geometric Data

The next step in developing a steady flow model with HEC-RAS is to enter
the geometric data. This is accomplished by selecting Geometric Data from
the Edit menu on the HEC-RAS main window. Once this option is selected
the geometric data window will appear, except yours will be blank when you
first bring it up (Figure 4.3).

Drawing the Schematic of the River System

In this example we are going to develop a two-river (three hydraulic reaches)
system as shown in Figure 4.3. Draw the river system schematic by
performing the following steps:

I. Click the River Reach button on the geometric data window.

2. Move the mouse pointer over to the drawing area and place the
pointer at the location in which you would like to start drawing the
first reach.

•
3. Press the left mouse button once to start drawing the reach. Move the

mouse pointer and continue to press the left mouse button to add
additional points to the line segment. To end the drawing of the
reach, double click the left mouse button and the last point of the
reach will be placed at the current mouse pointer location. All
reaches must be drawn from upstream to downstream (in the positive
flow direction), because the program assumes this to be true.

•

4. Once the reach is drawn, the interface will prompt you to enter an
identifier for the River name and the Reach name. The River
identifier can be up to 32 characters, while the reach name is limited
to 12 characters. In this example, there is one river named Fall River
and another one named Butte Cr. Fall river contains two hydraulic
reaches, which are labeled Upper Reach and Lower Reach. Butte
Cr. has been entered as a single hydraulic reach, and the reach name
is Tributary.

5. Repeat steps one through four for each reach. After you enter the
identifiers for Butte Cr., you will also be prompted to enter an
identifier for the junction. Junctions in HEC-RAS are locations
where two or more reaches join together or split apart.
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Once you have finished drawing in the river system, there are several options
available for editing the schematic. These options include: change name,
move object (objects are labels, junctions, and points in the reaches), add
points to a reach, remove points from a reach, delete a reach, and delete a
junction. The editing features are located under the Edit menu on the
Geometric Data window. Note: when you first draw your schematic there
will not be any tic marks representing cross sections as shown in Figure
4.3. The tic marks only show up after you have entered cross sections.

/'A O.2

/
I Tributary

b O.1
(;1

Il)....
"3

lI)

Figure 4.3 Geometric Data Window with example river schematic

Entering Cross Section Data

The next step is to enter the cross section data. This is accomplished by
pressing the Cross Section button on the Geometric Data window (Figure
4.3). Once this button is pressed, the Cross Section Data editor will appear as
shown in Figure 4.4 (except yours should be blank). To enter cross section
data do the following:

4-4



• 1.

Chapter 4 Example App!jcaUoo

Select a River and a Reach to work with. For this example start with
the Fall River, Upper Reach.

•

2. Go to the Options menu and select Add a new Cross Section. An
input box will appear to prompt you to enter a river station identifier

for the new cross section. The identifier does not have to be the
actual river station, but it must be a numeric value. The numeric
value describes where this cross section is located in reference to all
the other cross sections within the reach. Cross sections are located
from upstream (highest river station) to downstream (lowest river
station). For this cross section enter a value of 10.0.

Figure 4.4 Cross Section Data Editor with example data

3. Enter all of the data for this cross section as it is shown in Figure 4.4.

4. Once all the data are entered press the Apply Data button. This
button is used to tell the interface that you want the data to be
accepted into memory. This button does not save the data to your
hard disk, which can only be accomplished from the File menu on the
Geometric Data window.

• 5. Plot the cross section to visually inspect the data. This is
accomplished by pressing the Plot Cross Section option under the
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Plot menu on the Cross Section Data Editor. The cross section
should look the same as that shown in Figure 4.5.

In general, the five steps listed would be repeated for every cross section that
is entered. In order to reduce the amount of data entry for this example, the
current cross section will be copied and adjusted to represent other cross
sections within the river system.

Legend

•
Ground

•
Bank Sta

400350300250

Station (ft)

200150

Steady Flow Example from Chapter 4 Plan: Existing Conditions Run
Geom: Base Geometry Data Flow: 10.2 and'1 % chance evenls

Upstream Boundary 01 Fall River

---.06 ~1-.035~~ ..05 )1
95

I~

90

g
e5c:
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;:>.. eoiii

75

70
100

~.
Figure 4.5 Cross Section Plot for river mile 10.0 of Fall Creek

The following steps should be followed to copy the current cross section:

1. Go to the Options menu on the Cross Section Data Editor and select
Copy Current Cross Section. An input box will appear to prompt
you to select a river and a reach, and then enter a river station for the
new cross section. For this example, keep the river and reach as Fall
River and Upper Reach, then enter a new river station of9.9. Press
the OK button and the new cross section will appear in the editor.

2. Change the cross section description to "River Mile 9.9 of Fall River."

3. Adjust all the elevations of the cross section by -0.5 feet. This is
accomplished by selecting the Adjust Elevations feature from the
Options menu on the Cross Section Data Editor.

4. Adjust the cross section stationing to reduce the overbanks by 10%.
This is accomplished by selecting the Adjust Stations feature from
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the Options menu on the Cross Section Data Editor, then select
Multiply by a Factor. When the input box appears for this option,
three data entry fields will be available to adjust the stationing of the
left overbank, channel, and the right overbank separately. Enter
values of 0.90 for the right and left overbanks, but leave the main
channel field blank. This will reduce the stationing of both overbanks
by 10%, but the main channel will not be changed.

5.

6.

7.

Downstream reach lengths remain the same for this cross section.

Press the Apply Data button.

Plot the cross section to visually inspect it.

•

These seven steps should be repeated to enter all the data for Fall River
(Upper and Lower Reach). The necessary adjustments are listed in Table 4.1.
Perform the cross section duplications in the order that they are listed in the
table. Make sure to change the description of each cross section, and also
press the Apply Data button after making the adjustments for each cross
section.

Table 4.1 Cross Section adjustments for duplicating sections

Cross Section Adjusted Adjusted Stationing Downstream Reach Lengths
Elevation

Reach River Left Channel Right a.B. Left a.B. Channel Right a.B.
Sta. a.B.

Upper 9.8 -0.4 0.80 - 0.80 0.0 0.0 0.0

Lower 9.79 -0.1 1.20 1.20 1.20 500 500 500

Lower 9.7 -0.5 1.20 1.20 1.20 500 500 500

Lower 9.6 -0.3 - - - 500 500 500

Lower 9.5 -0.2 - - - 0.0 0.0 0.0

This completes all the cross section data for Fall River (upper and Lower
reach). Now let's work on entering the data for the Butte Creek tributary. To
enter the first cross section in the Butte Creek tributary do the following:

1. Go to the River text box on the Cross Section Data Editor and select
the Butte Cr. river. The Reach of "Tributary" will automatically be
selected since it is the only reach in Butte Creek.

•
2. Select Add a new Cross Section from the Options menu. When the

popup box appears to prompt you to enter a new river station, enter a
value of 0.2.
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3. Enter all the data for this cross section as shown in Figure 4.6.

4. Once all the data are entered for this section, press the Apply Data
button.

5. Plot the cross section to inspect the data.

Figure 4.6 Cross Section Editor with river mile 0.2 of Butte Creek

There are two other cross sections that need to be developed for the Butte
Creek tributary. These two cross sections will be developed by duplicating
the cross section that you just entered, and then adjusting the elevations and
stationing. The necessary adjustments are listed in Table 4.2. Perform the
cross section adjustments in the order that they are listed in the table. Make
sure to change the description of each cross section and press the Apply Data
button after editing is complete.

4-8



•

•

•

Chaoter 4 Examole Apolication

Table 4.2 Cross Section adjustments for Butte Creek sections

Cross Section Adjusted Adjusted Stationing Downstream Reach Lengths
Elevation

Reach River Sta. Left Channel Right O.B. Left O.B. Channel IRight a.B.
O.B.

Butte Cr. 0.1 -0.6 - - - 500 500 500

Butte Cr. 0.0 -0.3 - - - 0.0 0.0 0.0

Now that all of the cross section data are entered, save the data to a file before
continuing. Saving the data to a file is accomplished by selecting the "Save
Geometry Data As" option from the File menu on the Geometric Data
window. After selecting this option you will be prompted to enter a Title for
the geometric data. Enter "Base Geometry Data" for this example, then press
the OK button. A file name is automatically assigned to the geometry data
based on what you entered for the project filename.

Entering Junction Data

The next step is to enter the junction data. Junction data consist of a
description, and reach lengths across the junction. In this example there is
only one junction, which is labeled Sutter. To enter Junction data, press the
Junction button on the Geometric Data window. Enter the junction data as
shown in Figure 4.7.

Figure 4.7 Junction Data Editor, with Sutter junction data
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Reach lengths across the junction are entered in the junction editor, rather
than in the cross section data. This allows for the lengths across very
complicated confluences (Le., flow splits) to be accommodated. In the cross
section data, the reach lengths for the last cross section of each reach should
be left blank or set to zero.

In this example the energy equation will be used to compute the water surface
profile through the junction. If the momentum equation is selected, then an
angle can be entered for one or more of the reaches flowing into or out of a
junction. The momentum equation is set up to account for the angle of the
flow entering the junction.

Once you have all of the data entered for the junction, apply the data and
close the window by pressing the OK button.

Saving the Geometry Data

At this point in the example, all of the geometric data has been entered.
Before we continue with the example, you should save the geometric data to
the hard disk. Since the data have already been saved once, you simply have
to select Save Geometry Data from the File menu on the Geometric Data
window. We can now go on to enter the Steady Flow data.

Entering Steady Flow Data

The next step in developing the required data to perform steady flow water
surface profile calculations is to enter the steady flow data. To bring up the
steady flow data editor, select Steady Flow Data from the Edit menu on the
HEC-RAS main window. The Steady Flow Data editor should appear as
shown in Figure 4.8.

The first piece of data to enter is the number of profiles to be calculated. For
this example, enter "3" as shown in Figure 4.8. The next step is to enter the
flow data. Flow data are entered from upstream to downstream for each
reach. At least one flow rate must be entered for every reach in the river
system. Once a flow value is entered at the upstream end of a reach, it is
assumed that the flow remains constant until another flow value is
encountered within the reach. Additional flow values can be entered at any
cross section location within a reach.
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Figure 4.8 Steady Flow Data Editor, with example problem data

In this example, flow data will be entered at the upstream end of each reach.
An additional flow change location will be entered at river mile 9.6 of the Fall
River in the Lower Reach. To add an ad4itional flow change location into the
table, first select the Fall River, Lower Reach from the Reach list box. Next,
select the desired river station location (9.6 in this example) from the River
Sta. list box. Finally, press the Add a Flow Change Location button. The
new flow location should appear in the table. Now enter all of the flow data
into the table as shown in Figure 4.8. Profile labels will automatically default
to "PF#I," "PF#2," etc. You can change these labels to whatever you want.
In this example they have been changed to "10 yr," "50 yr," and "100 yr," to
represent the statistical return period of each of the events being modeled.

The next step is to enter any required boundary conditions. To enter
boundary conditions, press the Enter Boundary Conditions button at the top
of the Steady Flow Data editor. The boundary conditions editor will appear
as shown in Figure 4.9, except yours will be blank the first time you open it.

Boundary conditions are necessary to establish the starting water surface at
the ends of the river system. A starting water surface is necessary in order for
the program to begin the calculations. ~ subcritical flow regime, boundary
conditions are only required at the downstream endSOfThe river system. If a \
supercritical flow regime is going to be calculated, boundary conditions are
only necessary at the upstream ends of the river system. If a mixed flow
regime calculation is going to be made, then boundary conditions must be
entered at all open ends of the river system.
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Figure 4.9 Steady Flow Boundary Conditions

The boundary conditions editor contains a table listing every river and reach.
Each reach has an upstream and a downstream boundary condition.
Connections to junctions are considered internal boundary conditions.
Internal boundary conditions are automatically listed in the table, based on
how the river system is connected in the geometric data editor. The user is
only required to enter the necessary external boundary conditions.

In this example, it is assumed that the flow is subcritical throughout the river
system. Therefore, it is only necessary to enter a boundary condition at the
downstream end of the Fall River, Lower Reach. Boundary conditions are
entered by first selecting the cell in which you wish to enter a boundary
condition. Then the type ofboundary condition is selected from the four
available types listed above the table. The four types of boundary conditions
are:

• Known water surface elevations

• Critical depth

• Normal depth

• Rating curve

For this example, use the normal depth boundary condition. Once you have
selected the cell for the downstream end ofFall River, Lower Reach, press
the Normal Depth button. A pop up box will appear requesting you to enter
an average energy slope at the downstream end of the Fall River. Enter a
value of 0.0004 (ftlft) then press the Enter key. This completes all of the
necessary boundary condition data. Press the OK button on the Boundary
Conditions form to accept the data.
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The last step in developing the steady flow data is to save the data to a file.
To save the data, select the Save Flow Data As option from the File menu on
the Steady Flow Data Editor. A pop up box will prompt you to enter a
description of the flow data. For this example, enter "10,2, and 1% chance
events." Once the data are saved, you can close the Steady Flow Data Editor.

Performing the Hydraulic Calculations

Now that all of the data have been entered, we can calculate the steady water
surface profiles. To perform the simulations, go to the HEC-RAS main
window and select Steady Flow Analysis from the Simulate menu. The
Steady Flow Analysis window should appear as shown in Figure 4.10, except
yours will not have any plan titles yet.

Figure 4.10 Steady Flow Analysis Simulation Window

The first step is to put together a Plan. The Plan defmes which geometry and
flow data are to be used, as well as providing a title and short identifier for the
run. To establish a plan, select New Plan from the File menu on the Steady
Flow Analysis window. Enter the plan title as "Existing Conditions Run" and
then press the OK button. You will then be prompted to enter a short
identifier. Enter a title of "Existing" in the Short ID box.

The next step is to select the desired flow regime for which the model will
perform calculations. For this example we will be performing Subcritical
flow calculations only. Make sure that Subcritical is the selected flow
regime. Additional job control features are available from the Options menu
bar, but none are required for this example. Once you have defmed a plan
and set all the desired job control information, the plan information should be
saved. Saving the plan information is accomplished by selecting Save Plan
from the File menu of the Steady Flow Analysis window.
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Now that everything has been set, the steady flow computations can be
performed by pressing the Compute button at the bottom of the Steady Flow
Simulation window. Once the compute button has been pressed, a separate
window will appear showing you the progress of the computations. Once the
computations have been completed, the computation window can be closed
by double clicking the upper left comer of the window. At this time the
Steady Flow Simulation window can also be closed.

Viewing Results

Once the model has fmished all of the computations successfully, you can
begin viewing the results. Several output options are available from the View
menu bar on the HEC-RAS main window. These options include:

• Cross section plots

• Profile plots

• General Profile Plot

• Rating curves

• x-Y-Z Perspective Plots

• Detailed tabular output at a specific cross section (cross section table)

• Limited tabular output at many cross sections (profile table)

Let's begin by plotting a cross section. Select Cross Sections from the View
menu bar on the BEC-RAS main window. This will automatically bring up a
plot of the first cross section in Butte Cr., as shown in Figure 4.11. Any cross
section can be plotted by selecting the appropriate river, reach, and river
station from the list boxes at the top of the cross section plot window. The
user can also step through the plots by using the up and down arrow buttons.
Several plotting features are available from the Options menu bar on the
cross section plot window. These options include: zoom in; zoom out;
selecting which plans, profiles and variables to plot; and control over lines,
symbols, labels, scaling, and grid options.
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Figure 4.11 Cross Section Plot for Example Application

Select different cross sections to plot and practice using some of the features
available under the Options menu bar.

Next let's plot a water surface profile. Select Water Surface ProfIles from
the View menu bar on the HEC-RAS main window. This will automatically
bring up a water surface profile plot for the first reach, which is Butte Cr. in
our example. To plot more than one reach, select Reaches from the Options
menu bar on the profile plot. This option brings up a list of available rivers
and reaches from which to choose. Select the Upper and Lower reaches of
the Fall river. This should give you a profile plot as shown in Figure 4.12.
Plot the additional profiles that were computed and practice using the other
features available under the Options menu bar on the profile plot.

•
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Figure 4.12 Prome Plot for Example Application

Now let's plot a computed rating curve. Select Rating Curves from the View
menu on the HEC-RAS main window. A rating curve based on the computed
water surface profiles will appear for the first cross section in Butte Cr., as
shown in Figure 4.13. You carl iook at the computed rating curve for any
location by selecting the appropriate river, reach, and river station from the
list boxes at the top Qf tqe plot. Plotting options similar to the cross section
and profile plots are available for the rating curve plots. Plot rating curves for
various locations and practice using the avaiiable plotting options.
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Steady Flow Example from Chapter 4 Plan: Existing Conditions Run
Geom: Base Geometry Data Flow: 10,2 and 1% chance events

Upstream Boundary of Butte Cr.

Figure 4.13 Computed Rating Curve for Example Application•
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Next look at an X-Y-Z Perspective Plot of the river system. From the View
menu bar on the HEC-RAS main window, select X-Y-Z Perspective Plots.
A multiple cross section perspective plot should appear on the screen. From
the Options menu, select Reaches. A pop up window will appear allowing
you to select which rivers and reaches you would like to have on the plot.
Press the Select All button and then the OK button. Also, under the Options
menu, select the ProfIles option. Select profile two to be plotted from the
three available profiles. Once you have selected these options, and X-Y-Z
perspective plot should appear on the screen, similar to the one shown in
Figure 4.14. Try rotating the perspective view in different directions, and
select different reaches to look at.

Now let's look at some tabular output. Go to the View menu bar on the HEC
RAS main window. There are two types of tables available, a cross section
specific table and a profile table. Select Cross Section Table to get the first
table to appear. The table should look like the one shown in Figure 4.15.
This table shows detailed hydraulic information at a single cross section.
Other cross sections can be viewed by selecting the appropriate reach and
river mile from the table.
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Now bring up the profile table. This table shows a limited number of
hydraulic variables for several cross sections. There are several types of
profile tables listed under the Tables menu bar of the profile table window.
Some of the tables are designed to provide specific information at hydraulic
structures (e.g., bridges and culverts), while others provide generic
information at all cross sections. An example of this type of table is shown in
Figure 4.16.

Steady Flow Example from Chapter 4 Plan: Existing Conditions Run
Geom: Base Geometry Data Flow: 10, 2 and 1% chance events

Legend
I

VIIS 50 yr

Ground
•

Bank Sla

Figure 4.14 X-Y-Z Perspective Plot of All Three River Reaches
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Figure 4.15 Detailed Tabular Output at a Cross Section
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81.61 0.000646 751.37 232.22
81.30 0.000602 752.73 213.33
80.97 0.000633 689.03 178.77
80.91 0.000643 837.35 214.61
80.75 0.000362 1091.85 258.22
80.55 0.000400 1117.60 258.43
80.35 74.20 0.000400 1117.53 258.43
82.30 0.001180 189.38 71.58 :.
81.71 0.001170 190.39 71.77 1
81.00 0.001503 162.38 64.36 i

)

Figure 4.16 Tabular Output in Prome Format
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Printing Graphics and Tables

All of the plots and tables can be sent directly to a printer/plotter or passed
through the Windows clipboard to another program (e.g., a word processor).
The printer or plotter that gets used is based on what you currently have
selected as the default printer for Windows. The user has the ability to
change many of the default printer settings (e.g., portrait to landscape) before
printing occurs.

Sending Graphics Directly to the Printer

To send a graphic to the printer/plotter, do the following:

1. Display the graphic of interest (cross section, profile, rating curve, or
river system schematic) on the screen.

2. Using the available options (scaling, labels, grid, etc.), modify the
plot to be what you would like printed out.

3. Select Print from the File menu of the displayed graphic. Once Print
is selected, a Printer Options window will appear, giving the user
the opportunity to change any of the default printer settings. Once
you have the print settings the way you want them, press the Print
button on the Printer Options window and the plot will
automatically be sent to the Windows Print Manager. From that point
the Windows Print Manager will control the printing.

Sending Graphics to the Windows Clipboard

To pass a graphic to the Windows clipboard and then to another program, do
the following:

1. Display the graphic of interest on the screen.

2. Using the available options, modify the plot to be what you want it to
look like.

3. Select Copy to Clipboard from the File menu of the displayed
graphic. The plot will automatically be sent to the Windows
clipboard.

4. Bring up the program that you want to pass the graphic into (e.g.,
word processor). Select Paste from the Edit menu of the receiving
program. Once the graphic is pasted in, it can be resized to the
desired dimensions.
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Sending Tables Directly to the Printer

To send a table to the printer, do the following:

1. Bring up the desired table from the tabular output section of the
program.

2. Select Print from the File menu of the displayed table. Once the
Print option is selected, a Printer Options window will appear. Set
any print options that are desired then press the Print button. This
will send the entire table to the Windows Print Manager. From this
point the Windows Print Manager will control the printing of the
table.

The profile type of table allows you to print a specific portion of the table,
rather than the whole thing. If you desire to only print a portion of the table,
do the following:

1. Display the desired profile type table on the screen.

'.
2. Using the mouse, press down on the left mouse button and highlight

the area of the table that you would like to print. To get an entire row
or column, press down on the left mouse button while moving the
pointer across the desired row or column headings.

•

3. Select Print from the File menu of the displayed table. Only the
highlighted portion of the table and the row and column headings will
be sent to the Windows Print Manager.

Sending Tables to the Windows Clipboard

To pass a table to the Windows clipboard and then to another program, do the
following:

1. Display the desired table on the screen.

2. Select Copy to Clipboard from the File menu of the displayed table.

3. Bring up the program that you want to pass the table into. Select
Paste from the Edit menu of the receiving program.

Portions of the profile table can be sent to the clipboard in the same manner
as sending them to the printer.

Practice sending graphics and tables to the printer and the clipboard with the
example data set that you currently have open.
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Exiting the Program

Before you exit the HEC-RAS software, make sure you have saved all the
data. This can be accomplished easily by selecting Save Project from the
File menu on the HEC-RAS main window. Any data (geometric, flow, and
plan data) that have not been saved will automatically be saved for you.

To exit the HEC-RAS software, select Exit from the File menu of the HEC
RAS main window. The program will prompt you to save the project if the
data have not been saved previously.
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CHAPTER 5

Working With Projects

To create a river hydraulics application with HEC-RAS, you work with
projects. A project is a collection of files that are used to build a model.
This chapter describes projects and how you build and manage them.

Contents

• Understanding Projects

• Elements of a Project

• Creating, Opening, Saving, Renaming, and Deleting Projects

• Project Options

Understanding Projects

As you develop an application, the management of all the files that get
created is accomplished through the user interface.. When a new project is
started, the user is requested to enter a title and filename for the project. All
other data are automatically stored by the user interface using the same name
as the project file, except for the three character extension. A project consists
of:

• One Project file (.PRJ) .

• One file for each Plan (.POI to .P99)
. 1

• One Run file for each plan (.ROI to .R99)

• One Output file for each plan (.,Q.~)l to .099)

• One file for each set of Geometry data (.GOI to .G99)

• One file for each set ofSteady Flow data (.FOI to .F99)

• One file for each set ofUnsteady Flow data (.UOI to .U99)

• One file for each set of Sediment data (.SOI to .S99)

• One file for each set ofHydraulic Design data (.HOI to .H99)
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The Project File contains: the title of the project; the units system of the
project; a list of all the files that are associated with the project; and a list of
default variables that can be set from the interface. Also included in the
project file is a reference to the last plan that the user was working with. This
information is updated every time you save the project.

Elements of a Project

The following sections describe the various types of files that can be included
in a project. All of these files are either created by the user interface or the
various computation engines. The modeler interacts with the data through thel
user interface, and is not required to create or edit any of these files directly. j

Plan Files

Plan files have the extension .POI to .P99. The lip" indicates a Plan file,
while the number represents the plan number. As plans are created, they are
numbered from 01 to 99. The plan file contains: a description and short
identifier for the plan; a list of files that are associated with the plan (e.g.,
geometry file and steady flow file); and a description of all the simulation
options that were set for the plan. The plan file is created automatically by
the interface each time the user selects New Plan or Save Plan As from the
simulation windows.

Run Files

Run files have the extension .ROI to .R99. The "R" indicates a Run file,
while the number represents an association to a particular plan file. A file
with an extension of .ROI is the run file that corresponds to the plan file with
the extension .POL The run file contains all of the necessary data to perform
the computations that are requested by the associated plan file. For example,
if a steady flow analysis is requested, the run file will contain geometry data,
steady flow data, and all the necessary computational options that are
associated with the plan file. The run file contains the input to any of the
computational engines available in the HEC-RAS system. The run file is
automatically generated by the interface whenever the user presses the
Compute button on the Simulation windows. The run file is in an ASCII
format, but it is not self explanatory.

5-2



,

•

•

•

Chapter 5 Workjn~ Wjth Projects

Output Files

Output files have the extension .001 to .099. The "0" indicates an Output
file, while the number represents an association to a particular plan file. A
file with the extension .012 is the output file that corresponds to the plan file
with an extension .P12. The output file contains all of the computed results
from the requested computational engine. For example, if a steady flow
analysis is requested, the output file will contain results from the steady flow
computational engine. The output files are in a binary file format and can
only be read from the user interface.

Geometry Files

Geometry files have the extension .GOI to .G99. The "G" indicates a
Geometry file, while the number corresponds to the order in which they were
saved for that particular project. Geometry files contain all of the geometric
data for the river system being analyzed. The geometric data consist of: cross
section information; hydraulic structures data (e.g., bridges and culverts);
coefficients; and modeling approach information. The geometry data are
stored in an ASCII format. The file contains key words to describe each
piece of data, and is for-the-most-part self explanatory. A geometry file is
created by the user interface whenever the modeler selects New Geometry
Data or Save Geometry Data As from the Geometric Data window.

Steady Flow Data Files

Steady flow data files have the extension .FOI to .F99. The "F" represents
that it is a steady Flow data file, while the number corresponds to the order in
which they were saved for that particular project. Steady flow data files
contain: the number of profiles to be computed; flow data; and boundary
conditions for each reach. The steady flow data files are stored in an ASCII
format. The file contains key words to describe each piece of data, and is for
the-most-part self explanatory. Steady flow data files are automatically
created by the user interface when the modeler selects New Flow Data or
Save Flow Data As from the Steady Flow Data window.

Unsteady Flow Data Files

Unsteady flow data files have the extension .UOI to .U99. The "U"
represents that it is an Unsteady flow data file, while the number corresponds
to the order in which they were saved for that particular project. Unsteady
flow data files contain: flow hydrographs at the upstream boundaries; starting
flow conditions; and downstream boundary conditions. The unsteady flow
data files are stored in an ASCII format. The file contains key words to
describe each piece of data, and is for-the-most-part selfexplanatory.
Unsteady flow data files are automatically created by the user interface when
the modeler selects New Flow Data or Save Flow Data As from the
Unsteady Flow Data window. Currently, the unsteady flow data option is not
available in HEC-RAS. This option will be included in a future version.
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Sediment Data Files

Sediment data files have the extension .SOI to .S99. The "S" represents that it
is a Sediment data file, while the number corresponds to the order in which
they were saved for that particular project. Sediment data files contain: flow
data; boundary conditions for each reach; and sediment data. The sediment
data files are stored in an ASCII format. The file contains key words to
describe each piece of data, and is for-the- most-part self explanatory.
Sediment data files are automatically created by the user interface when the
modeler selects New Sediment Data or Save Sediment Data As from the
Sediment Data window. Currently, the sediment option is not available in
HEC-RAS. This option will be included in a future version.

Hydraulic Design Data Files

Hydraulic design data files have the extension .HOI to .H99. The "H"
represents that it is a Hydraulic design data file, while the number
corresponds to the order in which they were saved for that particular project.
Hydraulic design data files contain information corresponding to the type of
hydraulic design calculation that is requested. The Hydraulic design data
files are stored in an ASCII format. The file contains key words to describe
each piece of data, and is for-the most-part self explanatory. Hydraulic
Design data files are automatically created by the user interface when the
modeler selects New Hydraulic Design Data or Save Hydraulic Design
Data As from the File menu of the Hydraulic Design Functions window.

A schematic diagram of how the data files fit together is shown in Figure 5.1
on the next page. In this example there are three plans in the project. Each
plan represents a specific set of steady flow data and geometry data. In this
example there are three geometry files and one steady flow file. The first
geometry file could represent the existing conditions of the stream. The
second and third geometry file could represent some modification of that base
geometry file, such as adding a bridge or culvert crossing; a channel
modification; different roughness coefficients; or any other change to the base
geometry file. A plan is formulated by selecting a steady flow file and a
geometry file, and then saving that plan with a specific title and short
identifier. For more information about formulating plans, see Chapter 7 of
the HEC-RAS User's Manual and Chapter 7 of the HEC-RAS Applications
Guide.
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I Proiect File: filename.ori

~~
Geometry Data GeometrY Data Geometry Data Steady Flow Data
filename.gO I filename.g02 filename.g03 filename.fO I

\ ~
Plan I Plan 2 Plan 3
filename.pOI filename.p02 filename.p03

Rllll File I Rllll File 2 Rllll File 3

filename.rO I filename.r02 filename.r03

Output File 1 Output File 2 Output File 3

filename.oOl filename. 002 filename. 003

Figure 5.1 Schematic of Project Data Files.
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Creating, Opening, Saving, Renaming, and Deleting
Projects

The following commands from the File menu of the HEC-RAS main window
allow you to create, open, save, rename, and delete projects.

File menu command

New Project

Open Project

Save Project

Save Project As

Rename Project

Delete Project

Description

Closes the current project, prompting you to
save the data if anything has been changed.
The user is then prompted to enter a title and
filename for the new project.

Closes the current project, prompting you to
save the data if anything has been changed.
Opens an existing project and all of the
associated files.

Updates the project file and all other files in
which data have been modified.

Updates the project file and all other
associated data, saving all the information to a
new filename that you specify.

Allows the user to rename the title of the
currently opened project.

Deletes the project file and all other files
associated with the selected project. The user
is prompted to make sure that they really want
to delete all of the files.

These commands are the same for all of the other data types that get created
by the user interface (Plan data, geometry data, steady flow data, unsteady
flow data, sediment data, and hydraulic design data).

Project Options

From the Options menu of the main HEC-RAS window, the user can set
several default project options. These options include: setting default margins
and color control for printing; setting default hydraulic variables; establishing
the default units system (English or Metric); and converting existing projects
to a different units system (English to Metric or Metric to English). The
following four options are available from the Options menu:
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Program Setup

- BW to Printer

- BW to Clipboard

- Default Margins

Chanter 5 Workjng With proiects

Description

When this option is set all graphics are sent to
the printer/plotter in Black and White. When
this option is turned off, all graphics are sent
as color drawings. Color drawings that are
sent to a black and white printer will come out
in grey scale shadings.

When this option is set all graphics are sent to
the Windows Clipboard in a Black and White
mode. When this option is turned off, the
graphics are sent to the Clipboard as color
drawings.

This option allows the user to change the
default margins for printing graphics and
tables. The default settings are 1 inch margins
on all four sides.

'. - Default File Viewer This option allows the user to change which
program is used for viewing the report
generator and logfile output. The default is
the Windows Write program. The user can
change this to any file viewer on their system.

- Open last project When this option is selected, the program will
automatically open the last project worked on,
during startup.

- Automatically backup
data When this option is checked, the program will

automatically make a backup of the currently
opened project, plan, geometry, and flow files.
The backup files are updated at specific timed
intervals, which is user controlled. The
backup files are stored in the \HEC\RAS
directory, with the titles RasBackup.prj,
RasBackup.pOI, RasBackup.gOI, and
RasBackup.fO 1.

•
- Set time for

automatic backup This option allows the user to control the time
interval between updating the backup files.
The default value is 20 minutes.
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Options menu command

Default Parameters

Unit System

Convert Project Units

5-8

Description

This option allows the user to set defaults for
some of the hydraulic variables.

This option allows the user to set the default
units system to either English or Metric. Once
the units system is set, the program assumes
that all input data are entered in that units
system. Likewise, the display of all output
data will be done in the default units system.

This option allows the user to convert an
existing project from one units system to
another. Projects can be converted from
English to Metric or from Metric to English.
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CHAPTER 6

Entering and Editing Geometric Data
Geometric data consist of establishing the connectivity of the river system
(River System Schematic), entering cross-section data, defining all the
necessary junction information, adding hydraulic structure data (bridges,
culverts, weirs, etc.) and cross section interpolation. The geometric data is
entered by selecting Geometric Data from the Edit menu on the HEC-RAS
main window. Once this option is selected, the Geometric Data window will
appear as shown in Figure 6.1. The drawing area will be blank on your
screen, until you have drawn in your own river system schematic.

This chapter describes how to enter and edit all of the necessary geometric
data for a river system.

Contents

• Developing the River System Sche~atic

• Cross Section Data

• Stream Junctions

• Bridges and Culverts

• Multiple Bridge and/or Culvert Openings

• !nline Weirs and Gated Spillways

• Lateral Weirs and Gated Spillways

• Cross Section Interpolation

• River Ice

• Viewing and Editing Data Through Tables

• Importing Geometric Data

• Geometric Data Tools

• Attaching and Viewing Pictures

• Saving the Geometric Data
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Developing the River System Schematic

Building The Schematic

The modeler develops the geometric data by first drawing in the river system
schematic on the Geometric Data window (Figure 6.1). The River System
Schematic is a diagram ofhow the stream system is connected together. The
river system is drawn on a reach-by-reach basis, by pressing the River Reach
button and then drawing in a reach from upstream to downstream (in the
positive flow direction). Each reach is identified with a River Name and a
Reach Name. The River Name should be the actual name of the stream,
while the reach name is an additional qualifier for each hydraulic reach within
that river. A river can be comprised of one or more reaches. Reaches start or
end at locations where two or more streams join together or spilt apart.
Reaches can also start or end at the open ends of the river system being
modeled. In other words, the first and last cross section that will be modeled
in a particular river will be the start or end of a particular reach.

Figure 6.1 Geometric Data Editor Window
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Reaches are drawn as multi-segmented lines. Each reach must have at least
two points, defining the start and end of the reach. However, it is more
typical to draw a reach with several points that would follow along the main
channel invert of the stream. To draw a reach, first press the River Reach
button on the upper left side of the Geometric Data editor. Move the mouse
pointer to the location on the drawing area that you would like to have the
reach begin (upstream end of the reach). Click the left mouse button once to
define the first point of the reach. Move the mouse and continue to click the
left mouse button to add additional points to the reach. To end a reach, move
the mouse pointer to the location in which you would like the last point of the
reach to be located, then double click the left mouse button. After the reach is
drawn, the user is prompted to enter the River Name and the Reach Name to
identify the reach. The river and reach identifiers are limited to sixteen
characters in length. If a particular River Name has already been entered for
a previously defined reach of the same river, the user should simply select
that river name from the list of available rivers in the river name text box. As
reaches are connected together, junctions are automatically formed by the
interface. The modeler is also prompted to enter an identifier for each
junction. Junctions are locations where two or more streams join together or
split apart. Junction identifiers are also limited to sixteen characters. An
example of a simple stream system schematic is shown in Figure 6.1.

In addition to river reaches, the user can draw Storage Areas and Hydraulic
Connections to storage areas. A storage area is used to define an area in
which water can flow into and out of. The water surface in a storage area is
assumed to be a level pool. Storage areas can be connected to river reaches
as well as other storage areas. The user connects a storage area to a reach by
using the lateral weir option or the hydraulic connections option. Storage
areas can be connected to other storage areas by using a hydraulic connection
between the storage areas. Hydraulic connections consist of culverts, gated
spillways and a weir. The user can set up a hydraulic connection as just a
weir, a weir and culverts, or a weir and gated spillways. For connections
between a storage area and a river reach, if you are going to use a weir and/or
gated spillways, the lateral weir/spillway option should be used instead of a
hydraulic connection. However, for connecting two storage areas, the
hydraulic connection option is the only means of doing this in HEC-RAS.

To draw a Storage Area, select the storage area button at the top of the
geometric editor window. Storage areas are drawn as polygons. Move the
mouse pointer to the location in which you would like to start drawing the
storage area. Press the left mouse button one time to start adding points to
define the storage area. Continue using single left mouse clicks to define the
points of the storage area. To end the storage area use a double left mouse
click. The storage area will automatically be closed into a polygon. Once
you have finished drawing the storage area, a window will appear asking you
to enter a name for the storage area. To enter and edit the data for a storage
area, use the storage area editor button on the left panel of the geometric data
window.
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To enter a Hydraulic Connecpon, select the hydraulic connection button at
the top of the Geometric data editor. Move the mouse pointer to the storage
area or the area of a river reach that you want to connect. Then click the left
mouse pointer one time to start the drawing of the connection. You can
continue to use single mouse clicks to add as many points as you want into
the line that represents the hydraulic connection. When you want to end the
connection, place the mouse pointer over the storage area or reach that you
want to connect to, and then double click the mouse pointer. A window will
pop up asking you to enter a name for the hydraulic connection. The
direction in which you draw the hydraulic connection is important for
establishing the positive flow direction for the flow. Ifyou want the program
to output positive flow when the flow is going from a river each to a storage
area, then you must draw the hydraulic connection from the river reach to the
storage area. This is establishing the positive flow direction for the hydraulic
connection. If flow happens to go in the other direction during the
calculations, that flow will be output as negative numbers. To enter and edit
the data for a hydraulic connection use the hydraulic connection data editor
on the left panel of the geometric data window.

Adding Tributaries into an Existing Reach

If you would like to add a tributary or bifurcation into the middle of an
existing reach, this can be accomplished by simply drawing the new reach,
and connecting it graphically to the existing reach at the location where you
would like the new junction to be formed. Once the new reach is connected
into the middle of an existing reach, you will first be prompted to enter a
River and Reach identifier for the new reach. After entering the river and
reach identifiers, you will be asked ifyou want to "Split" the existing reach
into two reaches. If you answer "yes", you will be prompted to enter a Reach
identifier for the lower portion of the existing reach and a Junction name for
the newly formed stream junction.

Editing The Schematic

There are several options available for editing the river system schematic.
These options include: changing labels, moving objects (such as labels,
junctions, and points in a reach), adding points to a reach, deleting points in a
reach, deleting entire reaches, deleting junctions, numerically editing the
reach schematic lines, and numerically editing the cross section schematic
lines. Editing functions for the schematic are found under the Edit menu of
the geometric data window. When a specific editing function is selected, the
interaction of the user with the schematic is restricted to performing that type
of operation. When the user is finished performing that editing function they
should tum off that editing function by selecting it again from the Edit menu.
When none of the editing functions are turned on, the schematic goes back to
the default mode of interaction. The default interaction mode for the
schematic is described in the "Interacting with the Schematic" section of this
document. A description of each editing function follows:
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Change Name: This option allows the user to change the identifiers of any
reach or junction. To change an identifier, you must be in the Change Name
edit mode. This is accomplished by selecting the Change Name option from
the Edit menu. Once you are in the Change Name edit mode, you then select
the particular label that you would like to change by clicking the left mouse
button over that label. When a label is selected, a pop up window will appear
allowing you to enter a new label. The user can continue to change names by
simply selecting the next label to be changed. The Change Name option can
only be turned offby re-selecting it from the edit menu or by selecting any
other edit option.

Move Object: This option allows you to move any label, junction, or point
in a reach. This is accomplished by first selecting Move Object from the
Edit menu, then selecting the particular object that you would like to move.
To select an object and then move it, simply place the mouse pointer over the
object, then press the left mouse button down. Move the object to the desired
location and then release the left mouse button. The Move Object option
will remain in effect until the user either turns it off (which is accomplished
by re-selecting it) or selects any other edit option.

Add Points to a Reach: This option allows the user to add additional points
to the line that defines a reach. This allows the user to make the schematic
look more like the actual river system. To add additional points, first select
Add Points to a Reach from the Edit menu. Move the mouse pointer to the
location in which you would like to add an additional point on the reach line,
then click the left mouse button. After you have finished adding points to a
reach, you can move them around by selecting the Move Object option from
the Edit menu. To turn the "Add Points to a Reach" mode off, simply re
select it from the Edit menu, or select any other edit function.

Remove Points in a Reach: This option allows the user to remove points
from a reach line. To use this option, first select Remove Points in a Reach
from the Edit menu. Move the mouse pointer over the point that you would
like to delete and then click the left mouse button. This option can only be
turned offby either re-selecting the option from the Edit menu or by selecting
another edit function.

Delete Reach: This option is used to delete a reach. This is accomplished by
selecting the Delete Reach option from the Edit menu. A list box containing
all the available reaches will appear allowing you to select those reaches that
you would like to delete. Warning - Be careful when you delete reaches.
When you delete a reach, all of its associated data will be deleted also.

Delete Junction: This option is used to delete ajunction. This is
accomplished by selecting the Delete Junction option from the Edit menu. A
list box containing all the available junctions will appear allowing you to
select those junctions that you would like to delete.

Delete Storage Area: This option is used to delete a storage area. This is
accomplished by selecting Delete Storage Area from the Edit menu. A
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selection box will appear allowing you to pick the storage areas that you
would like to delete.

Delete Hydraulic Connection: This option is used to delete a hydraulic
connection. This is accomplished by selecting the Delete Hydraulic
Connection option from the Edit menu. A list box containing all the
available hydraulic connections will appear allowing you to select the ones
that you would like to delete.

Reach Schematic Lines: This option allows the user to numerically edit the
coordinates of the river reach schematic lines. When the river system
schematic is hand drawn on the screen, the coordinates of the river reach lines
are put into a simple coordinate system that ranges from 0.0 to 1.0 in both the
X and Y direction. However, the user has the option of taking real world
coordinates (such as UTM or State Plane coordinates) off of a map and
entering them into this table. If the user decides to use real world
coordinates, real world coordinates must be added for all of the reaches of the
schematic. If this is not done, the schematic will still be displayed in the
simple 0.0 to 1.0 coordinate system (the hand drawn coordinates). Once real
world coordinates have been entered for all of the river reaches, then the
schematic will be drawn in that coordinate system. To enter/edit the reach
schematic lines, select the Reach Schematic Lines option from the Edit
menu. Once this option is selected, a window will appear allowing the user to
enter/edit the coordinates of any ofthe reaches defined in the schematic.

XS Schematic Lines: This option allows the user to numerically edit the
coordinates of the cross section schematic lines. When the river system is
hand drawn on the screen, the default coordinate system is a simple 0.0 to 1.0
range for both the X and Y direction. As cross sections are entered, they are
automatically scaled based on the coordinates of the river reach line and the
main channel distance between cross sections. Each cross section is drawn as
a straight line perpendicular to the river reach schematic line. The user has
the option of entering the real world coordinates (UTM or State Plane) of the
cross section schematic lines. Each cross section schematic line must have at
least two points, a start and an end, but additional points can be added if the
cross section was taken as a multi segmented line. In order for the cross
section schematic lines to be plotted in the real world coordinate system, the
user must enter real world coordinates for all of the cross sections in the
reach. To enter/edit the cross section schematic lines, select the XS
Schematic Lines option from the Edit menu. Once this option is selected, a
window will appear allowing the user to enter/edit the coordinates of any of
the cross section schematic lines.

Interacting With The Schematic

In addition to modifying the river schematic, there are options available to .
zoom in, zoom out, display the cross section river stationing, and reset the
viewing extent of river system schematic. Additionally, the user has the
ability to use the mouse to interact with the schematic. This is accomplished
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by moving the mouse pointer over an object (river reach line, junction,
bridge, culvert, etc.) on the schematic and pressing down the left mouse
button. Once the left mouse button is pressed down, a pop up menu will
appear with options that are specific to that type of object. For example,
when the left mouse button is pressed down over a cross section, a menu will
appear allowing the user to select options to: edit the cross section, plot the
cross section, plot the profile for the reach that the cross section is in, display
tabular output for the cross section, and plot the computed rating curve for
that cross section. Another way of interacting with the schematic is to press
the right mouse button while the mouse pointer is located any where over the
schematic drawing area. This will bring up a pop up menu that is exactly the
same as the View menu at the top of the drawing. This option is providing
for convenience in getting to the View menu options. The options available
from the View menu are as follows:

Zoom In: This option allows the user to zoom in on a piece of the schematic.
This is accomplished by selecting Zoom In from the View menu, then
specifying the area to zoom in on with the mouse. Defining the zoom area is
accomplished by placing the mouse pointer in the upper left corner of the
desired area. Then press down on the left mouse button and drag the mouse
to define a box containing the desired zoom area. Finally, release the left
mouse button and the viewing area will display the zoomed in schematic.
Also displayed will be a small box in the upper right corner of the viewing
area..This box will contain a picture of the entire schematic, with a rectangle
defming the area that is zoomed in. In addition to showing you where you are
at on the schematic, this zoom box allows you to move around the schematic
without zooming out and then back in. To move the zoomed viewing area,
simply hold down the left mouse button over the rectangle in the zoom box
and move it around the schematic. The zoom box can also be resized.
Resizing the zoom box is just like resizing a window.

Zoom Out: This option zooms out to an area that is twice the size of the
currently zoomed in window. Zooming out is accomplished by selecting
Zoom Out from the View menu on the geometric data window.

Full Plot: This option re-draws the plot to its full original size. The Full Plot
option is accomplished by selecting Full Plot from the View menu on the
geometric data window.

Pan: This option allows the user to move around when in a zoomed in mode.
The pan option is accomplished by selecting Pan from the View menu of the
geometric data window. When this option is selected, the mouse pointer will
turn into a hand. Press the left mouse button and hold it down, then move the
mouse. This will allow the user to move the zoomed in graphic. To turn the
pan mode off, re-select the pan option from the view menu.

Display River Stationing: This option allows you to display river station
identifiers on the schematic. This is accomplished by selecting Display
River Stationing from the View menu on the geometric data window.
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Display Bank Stations: This option allows the user to display the main
channel bank stations on the cross section lines of the schematic. This is
accomplished by selecting Display Bank Stations from the View menu of
the geometric data window.

Display Ineffective Areas: This option allows the user to display the
location of ineffective flow areas on top of the cross section lines of the
schematic. This is accomplished by selecting Display Ineffective Areas
from the View menu of the geometric data window.

Display Levees: This option allows the user to display the location of levees
on the cross section lines of the schematic. This is accomplished by selecting
Display Levees from the View menu of the geometric data window.

Display XS Direction Arrows: This option allows the user to display arrows
along the cross sections in the direction in which they were extracted. This
option is usef't!.J. when you have coordinates defined for the cross section, such
that the software can detect the direction that the cross section was extracted.
Cross-sections are suppose to be entered from left to right while looking
downstream. If a cross section has not been entered in this manner, it should
be reversed. HEC-RAS has an option to reverse the cross section stationing.
This option can be found under the Tools menu bar of the geometric data
editor. To display the cross section direction arrows, select Display XS
Direction Arrows from the View menu of the geometric data window.

Display Background Pictures: This option allows the user to turn on and off
the display of any background pictures that have been loaded.

Set Plot Extents: This option allows the user to. set the extents of the
viewing area for the river system schematic. The user can enter a specific
coordinate system, or utilize the default data system. The default data plot
extents are from 0 to I for both the X and Y axis.

Background Pictures

Another option available to users is the ability to add background images for
displayed behind the river system schematic. One or more pictures can be
added. The user has the option of rectifying the picture by entering
coordinates for the left, right, top, and bottom sides of the picture, with
respect to the coordinates of the river system schematic. If coordinates are
not entered for the extent of the picture, the size of the picture will be based
on its resolution and the resolution of your screen. The following graphi<;al
fonnats are supported for background maps: bitmap (* .bmp); icon (* .ico);
windows metafile (*.wrnf); extended metafile (* .emf); GIF (* .gif); and JPEG
(*.jpg).

6-8



rI. Chapter 6 Entering and Editing Geometric Data

Cross Section Data

After the river system schematic is completed, the next step for the modeler is
to enter the cross section data. Cross section data represent the geometric
boundary of the stream. Cross sections are located at relatively short intervals
along the stream to characterize the flow carrying capacity of the stream and
its adjacent floodplain. Cross sections are required at representative locations
throughout the stream and at locations where changes occur in discharge,
slope, shape, roughness, at locations where levees begin and end, and at
hydraulic structures (bridges, culverts, and weirs).

Entering Cross Section Data

To enter cross section data, the user presses the Cross Section button on the
Geometric Data window (Figure 6.1). Once the cross section button is
pressed, the Cross Section Data Editor will appear as shown in Figure 6.2
(except yours will be blank until you have added some data). To add a cross
section to the model, the user must do the following:

•
1. From the Cross Section Editor, select the river and the reach that you

would like to place the cross section in. This is accomplished by
pressing the down arrow on the River and Reach boxes, and then
selecting the river and reach of choice.

•

2. Go to the Options menu and select Add a new Cross Section from
the list. An input box will appear prompting you to enter a river
station identifier for the new cross section.

3. Enter all of the required data for the new cross section. Required data
is the data that is openly displayed in the cross section editor window.

4. Enter any desired optional information (i.e., ineffective flow areas,
levees, blocked obstructions, etc.). Optional cross section information
is found under the Options menu.

5. Press the Apply Data button in order for the interface to accept the
data. The apply data button does not save the data to the hard disk, it
is used as a mechanism for telling the interface to use the information
that was just entered. If you want the data to be saved to the hard disk'
you must do that from the File menu on the geometric data window.

The required information for a cross section consists of: the river, reach and
river station identifiers; a description; X & Y coordinates (station and
elevation points); downstream reach lengths; Manning's roughness
coefficients; main channel bank stations; and contraction and expansion
coefficients. All of the required information is displayed openly on the Cross
Section Data editor (Figure 6.2). A description of this information follows:
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Figure 6.2 Cross Section Data Editor

River, Reach, and River Station. The River and Reach boxes allow the user
to select a specific hydraulic reach from the available reaches in the
schematic diagram. The river and reach labels define which reach the cross
section will be located in. The River Station tag defines where the cross
section will be located within the specified reach. The river station tag does
not have to be the actual river station of the cross section, but it must be a
numeric value. Cross sections are ordered in the reach from highest river
station upstream to lowest river station downstream. The up and down arrow
buttons next to the river station box can be used to sequentially move through
the river stations.

Description. The description box is used to describe the cross section
location in more detail than just the river, reach, and river station. This box
has a limit of 512 characters. The first line of information is displayed, unless
the button to the right of the box is pressed. Also, the first 40 characters of
the description are used as a label for cross section plots and tables.

Cross Section X & Y Coordinates. This table is used to enter the station
and elevation information of the cross section. Station and elevation
information is entered in feet (meters for metric), The cross section
stationing (x-coordinates) are entered from left to right looking in the
downstream direction. Cross section stationing must be in increasing order.
However, two or more stations can have the same value to represent vertical
walls.
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Downstream Reach Lengths. The downstream cross section reach lengths
describe the distance between the current cross section and the next cross
section downstream. Cross section reach lengths are defined for the left
overbank, main channel, and the right overbank. Cross section reach lengths
are entered in feet (meters for metric).

Manning's n Values. At a minimum, the user must specify Manning's n
values for the left overbank, main channel, and the right overbank.
Alternative roughness options are available from the Options menu.

Main Channel Bank Stations. The main channel bank stations are used to
define what portion of the cross section is considered the main channel and
what is considered left and right overbank area. The bank stations must
correspond to stations entered on the cross section X & Y coordinates table.
If the user enters a value that does not correspond to the station points of the
cross section, the interface will ask the user if they would like the value to be
automatically interpolated and added to the cross section data.

Contraction & Expansion Coefficients. Contraction and expansion
coefficients are use to evaluate the amount of energy loss that occurs because
of a flow contraction or expansion. The coefficients are multiplied by the
change in velocity head from the current cross section to the next downstream
cross section. In other words, the values entered at a particular cross section
are used to compute losses that occur between that cross section and the next
downstream cross section.

Once all of the required data for the cross section are entered, make sure you
press the Apply data button to ensure that the interface accepts the data that
was just entered.

Editing Cross Section Data

The bulk of the cross section data is the station and elevation information.
There are several features available under the Edit menu to assist the user in
modifying this information. These features include the following:

Undo Editing. This editing feature applies to all of the information on the
cross section data editor. Once data has been entered and the Apply Data
button has been pressed, the Undo Editing feature is activated. If any
changes are made from this point, the user can get the original information
back by selecting the Undo Edit option from the Edit menu. Once the Apply
Data button is pressed, the new information is considered good and the Undo
Edit feature is reset to the new data.

Cut, Copy, and Paste. Cut, Copy, and Paste features are available for the
station and elevation information on the cross section editor. These features
allow the user to pass cross section station and elevation data to and from the
Windows Clipboard. To use this feature, first highlight a cell or multiple
cells on the station and elevation table. Cells are higWighted by pressing
down on the left mouse button and moving it over the cells that you would
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like to be highlighted. Next select either the Cut or Copy feature from the
Edit menu. If Cut is selected, the information is placed in the Windows
Clipboard and then it is deleted from the table. If Copy is selected, the
information is placed in the Windows Clipboard, but it also remains in the
table. Once the information is in the Windows Clipboard it can be pasted into
the station and elevation table of any cross section. To paste data into another
cross section, first go to the cross section in which you would like the data to
be placed. Highlight the area of the table in which you want the data to be
placed. Then select the Paste option from the Edit menu. The cut, copy, and
paste features can also be used to pass station and elevation information
between HEC-RAS and other programs.

Delete. This option allows the user to delete a single cell or multiple cells in
the station/elevation table. Once the cells are deleted, everything below those
cells is automatically moved up. To use this option, first highlight the cells
that you would like to delete, then select the Delete option from the Edit
menu. If you would like to clear cells, without moving the data below those
cells, simply highlight the cells and press the delete key.

Insert. This option allows the user to insert one or several rows in the middle
of existing data in the station/elevation table. To use this option, first
highlight the area in the table that you would like to be inserted. Then select
Insert from the Edit menu. The rows will be inserted and all of the data will
be moved down the appropriate number of rows. The user can also insert a
single row by placing the curser in the row just below where you would like
the new row to be inserted. Then select Insert from the Edit menu. The row
will be inserted and all of the data below the current row will be moved down
one row.

Cross Section Options

Information that is not required, but is optional, is available from the Options
menu at the top of the cross section data editor window (Figure 6.2). Options
consist of the following:

Add a new Cross Section. This option initiates the process of adding a cross
section to the data set. The user is prompted to enter a river station tag for the
new cross section. The river station tag locates the cross section within the
selected reach. Once the river station is entered, the cross section data editor
is cleared (except for some default values that get set) and the user can begin
entering the data for the cross section. Whenever a new cross section is
added to the data set, default values will appear for the contraction and
expansion coefficients (0.1 and 0.3 respectively). Also, if the new cross
section is not the first or most upstream cross section of the reach, the
program will set default Manning's n values equal to the n values of the cross
section just upstream of the new cross section. If the user does not want these
default values, they can simply change them to whatever values they would
like.
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Copy Current Cross Section. This option allows the user to make a copy of
the cross section that is currently displayed in the editor. When this option is
selected, the user is prompted to select a river and reach for the new section,
and then enter the a river station. Once the information is entered, the new
cross section is displayed in the editor. At this point it is up to the user to
change the description and any other information about the cross section.
This option is normally used to make interpolated cross sections between two
surveyed cross sections. Once the section is copied, the user can adjust the
elevations and stationing of the cross section to adequately depict the
geometry between the two surveyed sections.

Rename River Station. This option allows the user to change the River
Station of the currently displayed cross section.

Delete Cross Section. This option will delete the currently displayed cross
section. The user is prompted with a message stating specifically which cross
section is going to be deleted, and requesting the user to press the OK button
or the Cancel button. Once the OK button is pressed, the user will be
prompted with a question ofwhether or not they would like the cross section
reach lengths to be automatically adjusted to account for the removal of the
cross section. If the user answers YES then the reach lengths of the current
cross section, that is being deleted, will be added to the reach lengths of the
next upstream cross section. If the user answers NO, then the cross section
will be deleted with out adjusting any reach lengths.

Adjust Elevations. This option allows the user to adjust all of the elevations
of the currently displayed cross section. Positive or negative elevation
changes can be entered. Once the value is entered, the interface automatically
adjusts all the elevations in the table.

Adjust Stations. This option allows the user to adjust the stationing of the
currently displayed cross section. Two options are available. The first
option (Multiply by a Factor) allows the user to separately expand and/or
contract the left overbank, main channel, and the right overbank. When this
option is selected, the user is prompted to enter a multiplier for each of the
three flow elements (left overbank, main channel, and right overbank). If the
multiplier is less than one, the flow element is contracted. If the multiplier is
greater than one, the flow element is expanded. Once the information is
entered, and the user hits the OK button, the interface automatically performs
the contraction and/or expansions. The cross section should be reviewed to
ensure that the desired adjustments were performed. The second option (Add
a Constant) allows the user to add or subtract a constant value from all the
stations in the cross section. This would allow the entire cross section to be
shifted to the right or the left.

Adjust n or k Values.. This option allows the user to either increase or
decrease all the n or k values of the current cross section. The user is
prompted for a single value. This value is then used as the multiplier for all
of the n or k values of the current cross section.
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Skew Cross Section. This option allows the user to adjust the stationing of a
cross section based on a user entered skew angle. Cross sections are suppose
to be taken perpendicular to the flow lines. This may not always be the case,
such as at bridges. in order for the program to use the correct flow area, the
cross section stationing must be adjusted by taking the cosine of the skew
angle times the stationing. When this option is selected, a window will
appear allowing the user to enter a skew angle. Once the angle is entered, the
software will automatically adjust the cross section stationing. The user can
get back to the original stationing by putting a zero skew into the field.

Ineffective Flow Areas. This option allows the user to define areas of the
cross section that will contain water that is not actively being conveyed
(ineffective flow). Ineffective flow areas are often used to describe portions
of a cross section in which water will pond, but the velocity of that water, in
the downstream direction, is close to or equal to zero. This water is included
in the storage calculations and other wetted cross section parameters, but it is
not included as part of the active flow area. When using ineffective flow
areas, no additional wetted perimeter is added to the active flow area. An
example of an ineffective flow area is shown in Figure 6.3. The cross
hatched area on the left of the plot represents the ineffective flow area.

Two alternatives are available for setting ineffective flow areas. The first
option allows the user to define a left station and elevation and a right station
and eievation (normal ineffective areas). When this option is used, and if
the water surface is below the established ineffective elevations, the areas to
the left of the left station and to the right of the right station are considered
ineffective. Once the water surface goes above either of the established
elevations, then that specific area is no longer considered ineffective. In other
words, the program now assumes that the area will be conveying water in the
downstream direction, such that it now uses that area in the conveyance
calculations of the active flow area.

The second option allows for the establishment of blocked ineffective flow
areas. Blocked ineffective flow areas require the user to enter an elevation, a
left station, and a right station for each ineffective block. Up to ten blocked
ineffective flow areas can be entered at each cross section. Once the water
surface goes above the elevation of the blocked ineffective flow area, the
blocked area is no longer considered ineffective.
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Figure 6.3 Cross section with ineffective flow areas

Levees. This option allows the user to establish a left and/or right levee
station and elevation on any cross section. When levees are established, no
water can go to the left of the left levee station or to the right of the right
levee station until either of the levee elevations are exceeded. Levee stations
must be defined explicitly, or the program assumes that water can go
anywhere within the cross section. An example of a cross section with a
levee on the left side is shown in Figure 6.4. In this example the levee station
and elevation is associated with an existing point on the cross section.

The user may want to add levees into a data set in order to see what effect a
levee will have on the water surface. A simple way to do this is to set a levee
station and elevation that is above the existing ground. If a levee elevation is
placed above the existing geometry of the cross section, then a vertical wall is
placed at that station up to the established levee height. Additional wetted
perimeter is included when water comes into contact with the levee wall. An
example of this is shown in Figure 6.5 .

•
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Figure 6.4 Example of the Levee Option
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Figure 6.5 Example Levee Added to a Cross Section
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Blocked Obstructions. This option allows the user to define areas of the
cross section that will be permanently blocke,d out. Blocked obstructions
decrease flow area and add wetted perimeter when the water comes in contact
with the obstruction. A blocked obstruction does not prevent water from
going outside of the obstruction.

Two alternatives are available for entering blocked obstructions. The first
option allows the user to define a left station and elevation and a right station
and elevation (normal blocked obstructions). When this option is used, the
area to the left of the left station and to the right of the right station will be
completely blocked out. An example of this type of blocked obstruction is
shown in Figure 6.6.

Critical Creek - Example 1 Plan: Modified Geometry Conditions
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Figure 6.6 Example of Normal Blocked Obstructions

The second option, for blocked obstructions, allows the user to enter up to 20
individual blocks (multiple blocked obstructions). With this option the user
enters a left station, a right station, and an elevation for each of the blocks.
An example of a cross section with multiple blocked obstructions is shown in
Figure 6.7.

•
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Critical Creek - Example 1 Plan: Modified Geometry Conditions
Geom: Base Geometry Data + Interpolated Flow: 100 Year Profile· Up and Down Sndry.
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Figure 6.7 Example of a Cross Section With Blocked Obstruction

Add a Lid to XS. This option allows the user to add a lid (similar to a bridge
deck/roadway) to any cross section. This is commonly used when trying to
model a long tunnel. The ground geometry can be used to describe the
bottom half of the tunnel, while the lid can describe the top half. A lid can be
added to any number of cross sections in a row. The program treats cross
sections with lids just like any other cross section. The energy equation is
used to balance a water surface, with the assumption of open channel flow.
The only difference is that the program will subtract out area and add wetted
perimeter when the water surface comes into contact with the lid.

Add Ice Cover. This option allows the user to enter ice cover for the
currently opened cross section. For a detailed discussion of ice cover, and ice
modeling, please review the section called Modeling Ice Cover later in this
chapter.

Add a Rating Curve. This option allows the user to add a rating curve to a
cross section as an alternative to the program computing the water surface.
The user is required to enter flow versus elevation information for the rating
curve. When the program is executed in a steady flow mode, the program
will interpolate a water surface elevation from the rating curve for the given
flow of a particular profile.

Horizontal Variation in n Values. This option allows the user to enter more
than three Manning's n values for the current cross section. When this option
is selected, an additional column for n values is added to the cross section
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. coordinates table as shown in Figure 6.8. A Manning's n value must be
placed in the first row of the table. This n value is good for all cross section
stations until a new n value shows up in the table. The user does not have to
enter an n value for every station, only at the locations where the n value is
changing.

212
211.4
210.2
209.4 0.04
208.2
204.4
204.5

• 206.6
209.7 0.06
209.2

Figure 6.8 Cross section with horizontal variation of n values selected

Horizontal Variation in k Values. This option allows the user to enter k
values (roughness heights) instead ofn values. The k.values are entered in
the same manner as the horizontal variation ofn values. To learn more about
k values and how they are used in the program, see Chapter 3 of the
Hydraulic Reference manual.

•

Vertical Variation in n Values. This option allows the user to enter
Manning's n values that vary both horizontally as well as vertically. The user
can vary the n value either by elevation or by flow. When this option is
selected a window will appear as shown in Figure 6.9. The user enters the
stationing for horizontal changes in n values across the top in row 0 (these
stations are entered in the same manner as the horizontal variation of
Manning's n value option). The elevations in which changes occur are
entered in the first column. Then the actual Manning's n values are entered in
rows 1-20 (columns 2-21). The program will interpolate Manning's n values
whenever the actual water surface is between the entered elevations. If the
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water surface is below the first elevatiqn entered, then the values from that
elevation will be used. Likewise, if the water surface is above the last
elevation entered, the program will use the n v~~ues from the last elevation
specified. No extrapolation is done on either side of the user entered values.

Figure 6.9 VerticalVariation of Manning's n Values Window

Plotting Cross Section Data

Once all the data have been entered for a cross section, you should plot the
cross section to inspect it for possible data errors. To plot the current cross
section from the cross section editor, select Plot Cross Section from the Plot
menu.

Stream Junctions

Entering Junction Data

Stream junctions are defmed as locations where two or more streams come
together or split apart. Junction data consist of a description, reach lengths
across the junction, tributary angles, and modeling approach. To enter
junction data the user presses the Junction button on the Geometric Data
window (Figure 6.1). Once the junction button is pressed, the junction editor
will appear as shown in Figure 6.10.
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Figure 6.10 Junction Data Editor

The junction editor will come up with one of the junctions loaded. Fill out the
description and reach lengths for the junction. Reach lengths across the
junction are entered here instead of the cross section data editor. This allows
for the lengths across very complicated confluences (Le., flow splits) to be
accommodated. ill the cross section data, the reach lengths for the
downstream cross section of each reach should be left blank or set to zero.

Selecting A Modeling Approach

ill HEC-RAS a junction can be modeled by either the energy equation or the
momentum equation. The energy equation does not take into account the
angle of a tributary coming in or leaving, while the momentum equation does.
ill most cases the amount of energy loss due to the angle of the tributary flow
is not significant, and using the energy equation to model the junction is more
than adequate. However, there are situations whe're the angle of the tributary
can cause significant energy losses. ill these situations it would be more
appropriate to use the momentum approach. When the momentum approach
is selected, an additional column is added to the table next to the junction
lengths. This column is used to enter an angle for any river reach that is
coming into or exiting the main river. For the reaches that are considered to
be the main river, the angle should be left blank or set to zero. Also, the user
has the option to tum friction and weight forces on or off during the
momentum calculations. The default is to have the weight force turned off.

If there is more than one junction in the river schematic, the other junctions
can be selected from the Junction Name box at the upper left corner of the
window. Enter all the data for each junction in the river system, then close
the window by pressing the OK button in the lower left corner of the window.
When the junction data editor is closed the data are automatically applied.
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Bridges and Culverts

Once all of the necessary cross-section data have been entered, the modeler
can then add any bridges or culverts that are required. HEC-RAS computes
energy losses caused by structures such as bridges and culverts in three parts.
One part consists oflosses that occur in the reach immediately downstream
from the structure where an expansion of flow takes place. The second part is
the losses at the structure itself, which can be modeled with several different
methods. The third part consists oflosses that occur in the reach immediately
upstream of the structure where the flow is contracting to get through the
opening.

The bridge routines in HEC-RAS allow the modeler to analyze a bridge with
several different methods without changing the bridge geometry. The bridge
routines have the ability to model low flow (Class A, B, and C), low flow and
weir flow (with adjustments for submergence), pressure flow (orifice and
sluice gate equations), pressure and weir flow, and high flows with the energy
equation only. The model allows for multiple bridge and/or culvert openings
at a single location.

The culvert hydraulics in HEC-RAS are based on the Federal Highway
Administrations (FHWA) standard equations from the publication Hydraulic
Design of Highway Culverts (FHWA, 1985). The culvert routines include the
ability to model circular, box, elliptical, arch, pipe arch, low profile arch, high
profile arch, and semi circular culverts. The HEC-RAS program has the
ability to model multiple culverts at a single location. The culverts can have
different shapes, sizes, elevations, and loss coefficients. The user can also
specify the number of identical barrels for each culvert type.

Cross Section Locations

The bridge and culvert routines utilize four user defined cross sections in the
computations of energy losses due to the structure. A plan view of the basic
cross section layout is shown in Figure 6.11.

Cross section 1 is located sufficiently downstream from the structure so that
the flow is not affected by the structure (i.e., the flow has fully expanded).
This distance should generally be determined by field investigation during
high flows. Generally, field investigation during high flows is not possible.
The expansion distance will vary depending upon the degree of constriction,
the shape of the constriction, the magnitude of the flow, and the velocity of
the flow. Table 6.1 offers ranges of expansion ratios, which can be used for
different degrees of constriction, different slopes, and different ratios of the
overbank roughness to main channel roughness. Once an expansion ratio is
selected, the distance to the downstream end of the expansion reach (the
distance L. on Figure 6.11) is found by multiplying the expansion ratio by the
average obstruction length (the average of the distances A to B and C to D
from Figure 6.11).
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• Figure 6.11 Cross Section Locations at a Bridge or Culvert

The average obstruction length is half of the total reduction in floodplain
width caused by the two bridge approach embankments. In Table 6.1, biB is
the ratio of the bridge opening width to the total floodplain width, nob is the
Manning n value for the overbank, nc is the n value for the main channel, and
S is the longitudinal slope. The values in the interior of the table are the
ranges of the expansion ratio. For each range, the higher value is typically
associated with a higher discharge.

Table 6.1
Ranges of Expansion Ratios

•

Dob I Ilc = 1 Dob Inc =2 Dob I ne =4

bIB = 0.10 S = 1 ftImile 1.4 - 3.6 1.3 - 3.0 1.2 - 2.1
5 ftImile 1.0 - 2.5 0.8 -2.0 0.8 -2.0

10 ftImile 1.0-2.2 0.8 -2.0 0.8 -2.0
biB = 0.25 S = 1 ftImile 1.6 - 3.0 1.4 - 2.5 1.2 - 2.0

5 ftImile 1.5 - 2.5 1.3 - 2.0 1.3 - 2.0
10 ftImile 1.5 - 2.0 1.3 - 2;0 1.3 - 2.0

biB = 0.50 S = 1 ftImile 1.4 - 2.6 1.3 - 1.9 1.2-1.4
5 ftImile 1.3 - 2.1 1.2 - 1.6 1.0 - 1.4

10 ft/mile 1.3 - 2.0 1.2 -1.5 1.0-1.4
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A detailed study of flow contraction and expansions at bridges was
undertaken by the Hydrologic Engineering Center. The results of this study
have been published as a research document entitled "Flow Transitions in
Bridge Backwater Analysis" (RD-42 HEC, 1995). The purpose of this study
was to provide better guidance to hydraulic engineers performing water
surface profile computations through bridges. Specifically the study focused
on determining the expansion reach length, Le; the contraction reach length,
Lc; the expansion energy loss coefficient, Ce; and the contraction energy loss
coefficient, Ce. A summary of this research, and the final recommendations,
can be found in Appendix B of the HEC-RAS Hydraulic Reference manual.

The user should not allow the distance between cross section 1 and 2 to
become so great that friction losses will not be adequately modeled. If the
modeler feels that the expansion reach will require a long distance, then
intermediate cross sections should be placed within the expansion reach in
order to adequately model friction losses. The user will need to estimate
ineffective flow areas for these intermediate cross sections.

Cross section 2 is located immediately downstream from the bridge (i.e.,
within a few feet). This cross section should represent the natural ground just
outside the bridge. This section is normally located at the toe of the
downstream bridge embankment.

Cross section 3 should be located just upstream from the bridge. The
distance between cross section 3 and the bridge should be relatively short.
This distance should only reflect the length required for the abrupt
acceleration and contraction of the flow that occurs in the immediate area of
the opening. Cross section 3 represents the natural ground just upstream of
the bridge. This section is normally located at the toe of the upstream bridge
embankment.

Both cross sections 2 and 3 will have ineffective flow areas to either side of
the bridge opening during low flow and pressure flow. In order to model only
the effective flow areas at these two sections, the modeler should use the
ineffective flow area option. This option is selected from the cross section
data editor. For a detailed discussion ofhow to set the ineffective flow area
stations and elevations, see Chapter 5 of the Hydraulic Reference manual.

Cross section 4 is an upstream cross section where the flow lines are
approximately parallel and the cross section is fully effective. In general,
flow contractions occur over a shorter distance than flow expansions. The
distance between cross section 3 and 4 (the contraction reach length, Le)

should generally be determined by field investigation during high flows.
Traditionally, the Corps of Engineers recommends locating the upstream
cross section a distance equal to one times the average length of the side
constriction caused by the structure abutments. The contraction distance will
vary depending upon the degree of constriction, the shape of the constriction,
the magnitude of the flow, and the velocity of the flow. As mentioned
previously, the detailed study "Flow Transitions in Bridge Backwater
Analysis" (RD-42, HEC, 1995) was performed to provide better guidance to
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hydraulic engineers performing water surface profile computations through
bridges. A summary of this research, and the final recommendations, can be
found in Appendix B of the HEC-RAS Hydraulic Reference manual.

When the user adds a bridge at a particular river station, the program
automatically formulates two additional cross sections inside of the bridge .
structure. The geometry inside of the bridge is a combination of the bounding
cross sections (2 and 3) and the bridge geometry. The bridge geometry
consists of the bridge deck, abutments if necessary, and any piers that may
exist. The user can specify different bridge geometry for the upstream and
downstream sides of the structure ifnecessary. Cross section 2 and the
structure information on the downstream side are used as the geometry just·
inside the structure at the downstream end. Cross section 3 and the upstream'
structure information are used as the bridge geometry just inside the structure
at the upstream end. The user has the option to edit these internal bridge
cross sections, in order to make adjustments to the geometry.

For a more detailed discussion on laying out cross sections around bridges,
the user is referred to chapter 5 of the Hydraulic Reference Manual.

Contraction and Expansion Losses

Losses due to the contraction and expansion of flow between cross sections
are determined during the standard step profile calculations. Contraction and
Expansion losses are described in terms of coefficient times the absolute
value of the change in velocity head between adjacent cross sections. When
the velocity head increases in the downstream direction a contraction
coefficient is used; and when the velocity head decreases in the downstream
direction, an expansion coefficient is used. For a detailed discussion on
selecting contraction and expansion coefficients at bridges, the user is
referred to chapter 5 of the HEC-RAS Hydraulic Reference Manual.

Bridge Hydraulic Computations

Low Flow Computations. For low flow computations the program first uses
the momentum equation to identify the class of flow. This is accomplished
by first calculating the momentum at critical depth inside the bridge at the
upstream and downstream ends. The end with the higher momentum
(therefore most constricted section) will be the controlling section in the
bridge. The momentum at critical depth in the controlling section is then
compared to the momentum of the flow downstream of the bridge when
performing a subcritical profile (upstream of the bridge for a supercritical
profile). If the momentum downstream is greater than the critical depth
momentum inside the bridge, the class of flow is considered to be completely
subcritical (i.e., class A low flow). lfthe momentum downstream is less than
the momentum at critical depth in the bridge, then it is assumed that the
constriction will cause the flow to pass through critical depth and a hydraulic
jump will occur at some distance downstream (i.e., class B low flow). lfthe
profile is completely supercritical through the bridge then this is class C low
flow. Depending on the class of flow the program will do the following:
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Pressure Flow Computations. Pressure flow occurs when the flow comes
into contact with the low chord of the bridge. Once the flow comes into
contact with the upstream side of the bridge, a backwater occurs and orifice
flow is established. The program will handle two cases of orifice flow: the
first is when only the upstream side of the bridge is in contact with the water;
and the second is when the bridge con~tricti<?n is flowing completely full. For
the first case, a sluice gate type of equation is used, as described in
"Hydraulics ofBridge Waterways" (FHWA, 1978). In the second case, the
standard full flowing orifice equation is used. The program will begin
checking for the possibility ofpressure flow when the energy grade line goes
above the maximum low chord elevation. Once pressl,lfe flow is computed,
the pressure flow answer is compared to the low flow answer and the higher
of the two is used. The user has the option to tell the program to use the
water surface, instead of energy, to trigger the pressure flow calculation.

Weir Flow Computations. Flow over the bridge and the roadway
approaching the bridge will be calculated using the standard weir equation.
For high tailwater elevations the program will automatic~lly reduce the
amount of weir flow to account for submergence on the weir. This is
accomplished by reducing the weir coefficiimt based on the amount of
submergence. When the weir becomes highly submerged, the program will
automatically switch to calculating losses based on the energy equation
(standard step backwater). The criteria for when the program switches to
energy based calculations is user controllable.

Combination Flow. Sometimes combinations oflow flow or pressure flow
occur with weir flow. In these cases an iterative procedure is used to
determine the amount of each type of flow.

Entering and Editing Bridge Data

To enter bridge data the user presses the Bridge/Culvert button on the
geometric data window (Figure 6.1). Once the bridge/culvert button is
pressed, the Bridge/Culvert Data Editor will appear as shown in Figure 6.12
(your bridge/culvert editor will come up with a blank window until you have
entered the bridge data). To add a bridge to the model, do the following:

1. Select the river and reach that you would like to place the bridge in.
Selecting a reach is accomplished by pressing the down arrow on the
river and reach box, then selecting the river and reach of choice.

2. Go to the Options menu and select Add a Bridge and/or Culvert
from the list. An input box will appear prompting you to enter a river
station identifier for the new bridge.

•
3. Enter all of the required data for the new bridge. This includes:

- Bridge Deck
- Sloping Abutments (optional)
- Piers (optional)
- Bridge modeling approach information
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4. Enter any desired optional information. Optional bridge information
is found under the Options menu at the top of the window.

5. Press the Apply Data button for the interface to accept the data.
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Figure 6.12 Bridge/Culvert Data Editor

The required information for a bridge consists of: the river, reach, and river
station identifiers; a short description of the bridge; the bridge deck; bridge
abutments (if they exist); bridge piers (if the bridge has piers); and specifying
the bridge modeling approach. A description of this information follows:

River, Reach and River Station. The River and Reach boxes allow the user
to select a river and reach from the available reaches that are defined in the
schematic diagram. The reach label defines which reach the bridge will be
located in. The River Station tag defines where the bridge will be located
within the specified reach. The river station tag does not have to be the actual
river station of the bridge, but it must be a numeric value. The river station
tag for the bridge should be numerically between the two cross sections that
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bound the bridge. Once the user selects Add a Bridge and/or Culvert from
the options menu, an input box will appear prompting you to enter a river
station tag for the new bridge. After the river station tag is entered, the two
cross sections that bound the bridge will be displayed on the editor.

Description. The description box is used to describe the bridge location in
more detail than just the reach and river station. This box has a limit of 256
characters. Only the first line of information is displayed, unless the button to
the right of the box is pressed. Also, the first 40 characters of the description
are used as a label for bridge plots and tables.

Bridge Deck/Roadway. The bridge deck editor is used to describe the area
that will be blocked out due to the bridge deck, road embankment and vertical
abutments. To enter bridge deck information the user presses the Deck
button on the Bridge/Culvert Data Editor. Once the deck button is pressed,
the Deck Editor will appear as in Figure 6.13 (except yours will be blank).
The information entered in the deck editor consists of the following:

• 0 216.93 200
450 216.93 200
450 216.93 215.7
647 216.93 215.7
647 216.93 200
2000 216.93 200

Figure 6.13 Bridge Deck/Roadway Data Editor

•
Distance - The distance field is used to enter the distance between the
upstream side of the bridge deck and the cross section immediately upstream
of the bridge. This distance is entered in feet (or meters for metric).

Width - The width field is used to enter the width of the bridge deck along the
stream. The distance between the bridge deck and the downstream bounding
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cross section will equal the main channel reach length minus the sum of the
bridge "width" and the "distance" between the bridge and the upstream
section. The width of the bridge deck should be entered in feet (meters for
metric).

Weir Coefficient - Coefficient that will be used for weir flow over the bridge
deck in the standard weir equation.

Upstream Stationing, High Chord, and Low Chord - This table is used to
define the geometry of the bridge deck on the upstream side of the bridge.
The information is entered from left to right in cross section stationing. The
deck is the area between the high and low chord elevation information. The
stationing of the deck does not have to equal the stations in the bounding
cross section, but it must be based on the same origin. The Del Rowand Ins
Row buttons allow the user to delete and insert rows.

Downstream Stationing, High Chord, and Low Chord - This portion of the
table is used to defme the geometry of the bridge deck on the downstream
side of the bridge. If the geometry of the downstream side is the same as the
upstream side, then the user only needs to press the Copy Up to Down
button. When this button is pressed, all of the upstream bridge deck
information is copied to the downstream side. If the bridge deck information
,on .the downstream ~ide is different than the upstream side, then the user must
enter the information into the table.

u.s. Embankment SS - This field is used to enter the slope of the road
embankment on the upstream side of the bridge. The slope should be entered
as the horizontal to vertical distance ratio of the embankment. This variable
is generally not used in the computations, but is used for display purposes in
the profile plot. However, if the user has selected the FHWA WSPRO bridge
method for low flow, this field will be used in the computation of the bridge
discharge coefficient.

D.S. Embankment SS - This field is used to enter the slope of the road
embankment on the downstream side of the bridge. The slope should be
entered as the horizontal to vertical distance ratio of the embankment. This
variable is generally not used in the computations, but is used for display
purposes in the profile plot. However, if the user has selected the FHWA
WSPRO bridge method for low flow, this field will be used in the
computation of the bridge discharge coefficient.

Max Allowable Submergence - The maximum allowable submergence ratio
that can occur during weir flow calculations over the bridge deck. If this ratio
is exceeded, the program automatically switches to energy based calculations
rather than pressure and weir flow.

Submergence Criteria - When submergence occurs there are two choices
available to figure out how much the weir coefficient should be reduced due
to the submergence. The first method is based on work that was done on a
trapezoidal shaped broad crested weir (FHWA, 1978). The second criterion
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was developed for an Ogee spillway shape (COE,1965). The user should
pick the criterion that best matches their problem.

Min Weir Flow El- This field is used to set the mininium elevation for which
weir flow will begin to be evaluated. Once the computed upstream energy
becomes higher than this elevation, the program begins to calculate weir flow.
However, the weir flow calculations are still based on the actual geometry of
the deck/roadway, and are not effected by this elevation. If this field is left
blank, the elevation that triggers weir flow is based on the lowest high chord
elevation on the upstream side of the bridge deck. Also, weir flow is based
on the elevation of the energy grade line and not the water surface.

Once all of the bridge deck information is entered, the user should press the
OK button at the bottom of the window. Pressing the OK button tells the
interface to accept the data and close the window. Once the deck editor
closes, the graphic of the bridge deck will appear on the Bridge/Culvert Data
window. An example of this is shown in Figure 6.14. Note! The data are
not saved to the bard disk at this p~int. Geometric data can only be saved
to the hard disk from the File menu oftbe GeometIic Data window.
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Figure 6.14 Example Bridge Deck Plotted on Bounding Cross Sections
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Sloping Bridge Abutments. The sloping bridge abutments editor is used to
supplement the bridge deck information. Whenever bridge abutments are
protruding towards the main channel (sloping inward abutments), it will be
necessary to block out additional area that cannot be accounted for in the
bridge deck/roadway editor. Ifthe bridge has vertical wall abutments, then it
is not necessary to use this editor. Vertical wall abutments can be included as
part of the bridge deck/roadway data. To add sloping abutments, the user
presses the Sloping Abutment button on the Bridge/Culvert Data editor.
Once this button is pressed the Abutment data editor will appear as in Figure
6.15.

Sloping abutments are entered in a similar manner to the bridge
deck/roadway. When the editor is open, it has already established an
abutment # of 1. Generally a left and right abutment are entered for each
bridge ,Opening. Sloping abutment data are entered from left to right, looking
in the downstream direction. In general it is usually only necessary to enter
two points to describe each abutment.

Figure 6.15 Abutment Data editor

The data for each abutment consist of a skew angle (this is optional) and the
station and elevation information. The station and elevation information
represents the high chord information of the abutment. The low chord
information of the abutment is assumed to be below the ground, and it is
therefore not necessary to enter it. The geometric information for each
abutment can vary from upstream to downstream. If this information is the
same, then the user only needs to enter the upstream geometry and then press
the Copy Up to Down button.

6-32



Chapter 6 Entering and Editing Geometric Data

To add additional sloping abutments, the user can either press the ADD or the
Copy button. To delete an abutment, press the Delete button. Once all of the
abutment data are entered, the user should press the OK button. When the
OK button is pressed, the abutment information is accepted and the editor is
closed. The abutments are then added to the bridge graphic on the
Bridge/Culvert D;1ta editor. An example of a sloping bridge abutment is
shown in Figure 6.16. This graphic is zoomed in on the left abutment of the
bridge.

•
2480

Figure 6.16 Example of a Sloping Abutment
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Bridge Piers. The bridge pier editor is used to describe any piers that exist in
the bridge opening. Note! All piers must be entered through the Pier
Editor, they should not be included as part of the ground or bridge deck.
Several of the low flow bridge computations require that the piers be defmed
separately in order to determine that amount of area under the water surface
that is blocked by the piers. lfthe piers are included with the ground or the
bridge deck, several of the methods will not compute the correct amount of
energy loss for the piers.
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To enter pier infonnation, the user presses the Pier button on the
Bridge/Culvert Data editor. Once the pier button is pressed, the pier data
editor will appear as in Figure 6.17 (except yours will not have any data in it
yet).

Figure 6.17 Per Data Editor

When the pier data editor appears it will have already defmed the first pier as
pier # 1. The user is required to enter a centerline station for both the
upstream and downstream side of the pier. The skew angle is entered in
degrees that the pier is skewed from a line parallel to the flow. The skew
angle is an optional item. The pier geometry is entered as pier widths and
elevations. The elevations must start at the lowest value and go to the highest
value. Generally the elevations should start below the ground level. Any pier
area below the ground, will be clipped off automatically. Pier widths that
change at a single elevation are handled by entering two widths at the same
elevation. The order of the widths in the table is very important. Keep in
mind that the pier is defined from the ground up to the deck. If the pier
geometry on the downstream side is the same as the upstream side, simply
press the Copy Up to Down button after the upstream side data are entered.

6-34



•

•

•

Chapter 6 Entering and Editing Geometric Data

The user also has the option of defining floating pier debris. If the Floating
Debris option is selected, two boxes will appear allowing the user to enter a
width and a height for the debris. The user can set a different height and
width of debris for each pier, or there is a button that will allow the user to
enter a single height and width that will be used for all of the piers.

Addivona~ piers can be added by pressing either the Add or the Copy button.
If the piers are the same shape, it is easier to use the copy button and simply
change the centerline stations of the new pier. To delete a pier, simply press
the Delete button and the currently displayed pier will be deleted. Once all of
the pier data are entered, press the OK button. When the OK button is
pressed, the data will be accepted and the pier editor will be closed. The
graphic of the bridge will then be updated to include the piers. An example
bridge with piers is shown in Figure 6.18. This graphic is only the upstream
side of the bridge with a zoomed in view.

Figure 6.18 Bridge with Piers, zoomed in view
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Bridge Modeling Approach. The Bridge Modeling Approach editor is used
to define how the bridge will be modeled and to enter any coefficients that are
necessary. To bring up the Bridge Modeling Approach editor press the
Bridge Modeling Approach button on the Bridge/Culvert Data editor. Once
this button is pressed, the editor will appear as shown in Figure 6.19 (except
yours will only have the default methods selected).

Figure 6.19 Bridge Modeling Approach Editor

When the Bridge Modeling Approach editor comes up it will be ready to
enter data for the first bridge opening (coefficient set # 1). If there is more
than one bridge opening at the current locat.ion, the user can either use a
single set ofmodeling approaches and coefficients, or establish a different set
for each bridge opening.

Establishing a bridge modeling approach consists of defining which methods
the program will use for low flow computations and high flow (flow at or
above the maximum low chord) computations. The user can instruct the
program to use any or all of the low flow methods during the computations by
clicking the buttons under the Compute column. If either the Momentum or
Yamell method are selected, the user must enter a value for the pier loss
coefficient that corresponds to that method. If the WSPRO method is
selected, the user must press the "WSPRO Variables" button and enter
additional information that is required for the method. Once the WSPRO
Variables button is pressed, a data editor as shown in Figure 6.20 will
appear.
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Figure 6.20 WSPRO Data Editor

As shown in Figure 6.20, there are several variables that must be entered as
well as some options that are available to the user. All of the required
variables shown on the WSPRO data editor are used in the computation of the
discharge coefficient, C, which is used in the WSPRO expansion loss
equation. A detailed discussion of how the discharge coefficient is computed
can be found in appendix D of the HEC-RAS Hydraulic Reference manual.
The following is a description of each of the variables on the WSPRO Data
Editor:

EI ofthe top ofthe Embankment - These fields are used for entering the
elevation of the top of the embankment (top of road) at the edges of the
bridge opening. An elevation must be entered for both the left and right side
of the bridge opening.

EI ofthe toe of the Abutment - These fields are used for entering the elevation
of the abutment toe (elevation at the station in which the abutment toe
intersects with the natural ground inside the bridge opening) on both the left
and right side of the bridge opening.

Abutment Type - This field is used for selecting the type of abutments. There
are four abutment types available from this selection box.
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Slope ofthe Abutments - Thi~ field is used for ent~ring the slope of the
abutments. This slope is taken as the horizontal distance divided by the

. vertical distance. If the abutm~nts are vernc'!.! walls, then this field should be
left blank or set to zero. If the left and ri!iht abutments do not have the same
slope, take an average of the two and enter that into this field.

Top Width ofEmbankment - This field is used for entering the width of the
top of the road embankment, in the area of the bridge opening. If the
topwidth of the embankment varies from one end of the bridge opening to the
other, use an average of the two widths.

Centroid stationing ofthe projected bridge opening at the approach cross
section - For the WSPRO bridge method, it is necessary to calculate the water
surface topwidth inside of the bridge opening, and then project that width
onto the approach cross section. The program calculates the conveyance
within this projected width at the approach cross section. This conveyance is
used in calculating a channel contraction ratio, which is an integral part in the
calculation of the discharge coefficient. If this field is left blank, the program
will automatically center the computed topwidth, such that the center of the
topwidth will be at the center of conveyance at the approach cross-section.
The user can override this by entering their own centroid stationing value for
the approach cross section.

Wing Walls - This field is used for selecting the type of wing walls. There are
three choices available in the selection box: No wing walls present; Angular
wing walls; and Rounded wing walls. If the user selects "Angular wing
walls", then the fields labeled "Angle of Wing Wall" and "Length of Wing
Wall" become active and must be filled out. If the user selects "Rounded
wing walls", then the fields "Length of wing walls" and "Radius of entrance
rounding" become active and must be filled out. If the user selects "No wing
walls present" then no other information on wing walls is necessary. For
more information on wing walls see appendix D of the HEC-RAS Hydraulic
Reference manual.

Guide Banks Type - This field is used for selecting the type of guide banks if
any exist. There are three choices available from the selection box: No guide
bank present; Straight; and Elliptical. If the user selects "Straight" then the
fields labeled "Length of guide banks", "Offset of Guide Banks", and "Skew
of Guide Banks" become active and must be filled out. If the use selects
"Elliptical" then only the fields "Length of Guide Banks" and "Offset of
Guide Banks" become active. If the user selects "No Guide Bank present"
then no other information about guide banks is necessary. For more
information on Guide Banks see appendix D of the HEC-RAS Hydraulic
Reference manual.
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Optional Contraction and Expansion Losses - This box allows the user to turn
on contraction and expansion losses at locations that are traditionally not in
the WSPRO methodology. The basic WSPRO bridge method only computes
expansion losses in the expansion reach (between the exit cross section and
the section just downstream of the bridge). This option allows the user to turn
on contraction and expansion losses individually at the following locations:
downstream inside of the bridge; upstream inside of the bridge; upstream
outside of the bridge; at the end of a guide bank (if guide banks exist); and at
the approach cross section. The default for the WSPRO method is that
contraction and expansion losses will not be calculated at these locations.
Users should not turn these options on unless they feel that the standard
WSPRO bridge approach is not producing enough energy loss through the
bridge.

Two other options that the user has control over are: specifying that the piers
are continuous the whole way through the bridge or not, and using the
Geometric Mean friction slope averaging technique through the bridge
computations (from exit to approach section). The default for the WSPRO
methodology is to assume that the piers are continuous through the bridge,
and to use the Geometric Mean friction slope method.

After all of the variables have been entered, the user must press the OK
button for the WSPRO variables to be accepted. For more information about
the computation of the discharge coefficient, and these data variable, see
appendix D of the HEC-RAS Hydraulic Reference manual.

Once the user has selected which low flow bridge methods will be computed,
they must also specify which of those methods will be used as the final
answer to continue the computations on upstream with. Only one of the
methods can be selected as the answer to "Use" in order to continue the
computations upstream. An alternative to selecting a single method to use is
to instruct the program to use the answer with the highest computed upstream
energy elevation. This is accomplished by pressing the button under the
"Use" column that corresponds to the Highest Energy Answer text field.

For high flows, the modeler can choose between Energy based calculations or
pressure and weir flow calculations. If pressure and weir flow is the selected
high flow method, the user must enter coefficients for the pressure flow
equations. The first coefficient applies to the equation that is used when only
the upstream side (inlet) of the bridge is submerged. If this coefficient is left
blank, the program selects a coefficient based on the amount of submergence.
If the user enters a coefficient, then that value is used for all degrees of
submergence. The second coefficient applies to the equation that is used
when both the upstream and downstream end of the bridge is sub-merged.
Generally this coefficient is around 0.8. For more information on pressure
flow coefficients see Hydraulics of Bridge Waterways (FHWA, 1978).

Max Low Chord - This field is used to set the maximum elevation of the deck
low chord, and therefore the elevation at which pressure flow begins to be
calculated. If this field is left blank, then the elevation that triggers pressure
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flow calculations is based on the highest low chord elevation on the upstream
side of the bridge deck. If the user enters a value in this field, then the value
set will be used to trigger when pressure flow calculations begin. Pressure
flow is triggered when the energy elevation exceeds the maximum low chord.
When pressure flow is calculated, the answer is compared to the low flow
answer and the higher of the two is selected.. Alternatively, the user can tell
the program to use the water surface instead of the energy elevation to trigger
pressure flow calculations. This option can be found under the Bridge and
Culvert Options section of this manual.

Once all of the bridge modeling approach information is entered, the user
should press the OK button. When the OK button is pressed the information
will be accepted and the editor will close. Remember! The data are not
saved to disk at this point, it is only accepted as being valid. To save the
geometric data, use the File menu from the Geometric Data Editor window.

Bridge Design Editor

The bridge design editor allows the user to enter or modify bridge data
quickly and conveniently. With this editor the user can enter the
deck/roadway data, sloping abutments, and pier information. To put together
a bridge with this editor, the user would do the following:

1. From the Geometric Data window, open the Bridge/Culvert data
editor. Select the River and Reach in which you would like to place
the bridge.

2. Go to the Options menu and select Add a Bridge and/or Culvert
from the list. An input box will appear prompting you to enter a river
station identifier for the new bridge.

3. Open the Bridge Design editor by pressing the Bridge Design button
on the lower left side of the Bridge/Culvert Data editor.

4. Enter the required data for the bridge deck/roadway, sloping
abutments (optional), and piers (optional).

When the Bridge Design button is pressed, a window will appear as shown in
Figure 6.21. The user only has to enter a minimal amount of information to
build or edit the bridge. To create the bridge deck/roadway, the user must
enter a high cord elevation (top of road) and a low cord elevation (maximum
elevation inside of the bridge opening).
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Figure 6.21 Bridge Design Editor

The user has the option to limit the width of the bridge opening by selecting
the Add Vertical Walls in Deck option. When this option is selected, the
bridge opening will be limited to either the main channel bank stations (this is
the default) or a user specified width (this is optional). Everything left and
right of the bridge opening will be completely filled in all the way to the
ground elevations. If the user enters a bridge opening width, the opening will
be centered between the main channel bank stations.

The user also has the option to enter sloping abutments. Sloping abutments
should only be entered after selecting to limit the width of the bridge opening
with the vertical walls option. To enter sloping abutments, the user only has
to enter a slope in units of horizontal to vertical. The program will
automatically build a left and right sloping abutment that starts in the upper
left and right corners of the bridge opening.

Once all of the bridge deck/roadway information is entered, the user can have
the program build the deck/roadway by pressing the Make DeckIRoadway
button.

The last option available in the Bridge Design editor is to enter pier
information. The user enters the number of piers, the upstream and
downstream stationing of the left most pier, the spacing between the
centerline of the piers, and the width of the piers. The user then presses the
Make Piers button to have the interface build the piers.
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After all of the bridge data are entered, the user presses the Close button to
get out of the editor. The bridge data can be changed at any time by either
going back into the Bridge Design editor and entering new values, or by
going to the more detailed editors for the bridge deck/roadway, sloping
abutments, and piers.

Culvert Hydraulic Computations

The culvert hydraulic computations in HEC-RAS are similar to the bridge
hydraulic computations, except the Federal Highway Administration's
(FHWA) standard equations for culvert hydraulics under inlet control are
used to compute the losses through the structure. Because of the similarities
between culverts and other types ofbridges, the cross section layout, the use
of ineffective areas, the selection of contraction and expansion coefficients,
and many other aspects ofbridge analysis apply to culverts as well.

The culvert routines in HEC-RAS have the ability to model nine different
types of culvert shapes. These shapes include box (rectangular), circular,
elliptical, arch, pipe arch, semi circular, low profile arch, high profile arch,
and Con Span culverts.

The analysis of flow in culverts is complicated. It is common to use the
concepts of "Inlet" control and "Outlet" control to simplify the analysis. Inlet
control flow occurs when the flow carrying capacity of the culvert entrance is
less than the flow capacity of the culvert barrel. Outlet control flow occurs
when the culvert carrying capacity is limited by downstream conditions or by
the flow capacity of the culvert barrel. The HEC-RAS culvert routines
compute the headwater required to produce a given flow rate through the
culvert for inlet control conditions and for outlet control conditions. In
general, the higher headwater "controls," and an upstream water surface is
computed to correspond to that energy elevation.

Inlet Control Computations. For inlet control, the required headwater is
computed by assuming that the culvert inlet acts as an orifice or a weir.
Therefore, the inlet control capacity depends primarily on the geometry of the
culvert entrance. Extensive laboratory tests by the National Bureau of
Standards, and the Bureau of Public Roads (now, FHWA), and other entities
resulted in a series of equations which describe the inlet control headwater
under various conditions. These equations are used by HEC-RAS in
computing the headwater associated with inlet control.

Outlet Control Computations. For outlet control flow, the required
headwater must be computed considering several conditions within the
culvert and the downstream tailwater. For culverts flowing full, the total
energy loss through the culvert is computed as the sum of friction losses,
entrance losses, and exit losses. Friction losses are based on Manning's
equation. Entrance losses are computed as a coefficient times the velocity
head in the culvert at the upstream end. Exit losses are computed as a
coefficient times the change in velocity head from just inside the culvert (at
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the downstream end) to outside the culvert.

When the culvert is not flowing full, the direct step backwater procedure is
used to calculate the profile through the culvert up to the culvert inlet. An
entrance loss is then computed and added to the energy inside the culvert (at
the upstream end) to obtain the upstream energy (headwater). For more
information on the hydraulics of culverts, the reader is referred to Chapter 6
of the HEC-RAS Hydraulics Reference manual.

Entering and Editing Culvert 'Data

Culvert data are entered in the same manner as bridge data. To enter culvert
data the user presses the Bridge/Culvert button on the Geometric Data
window (Figure 6.1). Once this button is pressed, the Bridge/Culvert Data
Editor will appear (Figure 6.12). To add a culvert group to the model the user
must then do the following:

1. Select the river and reach that you would like to place the culvert in.
This selection is accomplished by pressing the down arrow on the
river and reach boxes, and then selecting the river and reach of
choice.

• 2. Go to the Options menu of the Bridge/Culvert editor and select Add
a Bridge and/or Culvert from the list. An input box will appear
prompting you to enter a river station identifier for the new culvert
group. After entering the river station, pr~ss the OK button and the
cross sections that bound the new culvert group will appear in the
editor.

•

3. Enter all of the required data for the culvert group. This includes the
road embankment information and the culvert specific data. The
roadway information is entered in the same manner as a bridge (using
the deck/roadway editor). To enter culvert specific data, press the
Culvert button on the Bridge/Culvert Data editor.

4. Once all of the culvert data are entered, press the OK button in order
for the interface to accept the information.

River, Reach and River Station. The River and Reach boxes allow the user
to select a river and reach from the available reaches that were put together in
the schematic diagram. The reach label defines which reach the culvert will
be located in. The River Station tag defines where the culvert will be located
within the specified reach. The River Station tag does not have to be the
actual river station of the culvert, but it must be a numeric value. The River
Station tag for the culvert should be numerically between the two cross
sections that bound the culvert. Once the user selects Add a Bridge and/or
Culvert from the options menu, an input box will appear prompting you to
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enter a River Station tag for the new culvert. After the River Station tag is
entered, the two cross sections that bound the culvert will be displayed on the
editor.

Description. The description box is used to describe the culvert location in
more detail than just the river, reach and river station. This box has a limit of
256 characters. Only the first line of information is displayed, unless the
button to the right of the box is pressed. Also, the first 40 characters of the
description are used as a label for culvert plots and tables.

Culvert Road Embankment. The culvert road. embankment is virtually the
same as the bridge deck/roadway information. The road embankment is used
to describe the area blocking the stream and the roadway profile. The only
difference in the information for culverts is that the low chord elevations
should be left blank or set to elevations below the ground data. This will
cause the road embankment to completely fill the channel up to the roadway
elevations (high chord data). Therefore, the only opening below the roadway
will be whatever culvert openings are entered.

To enter the culvert roadway information, press the Deck/Roadway button on
the Bridge/Culvert Data Editor window. For an explanation of the deck
information, please review the section entitled Bridge Deck/Roadway found
earlier in this chapter.

Culvert Data. To enter culvert specific information, press the Culvert
button on the Bridge/Culvert Data Editor window. When this button is
pressed, the Culvert Data Editor will appear as shown in Figure 6.22 (except
yours will be blank). The information entered in the Culvert Data Editor
consists of the following:
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Figure 6.22 Culvert Data Editor

Culvert ID# - The culvert identifier (ID#) is automatically assigned to
"Culvert #1" the first time you open the editor. The user can enter up to ten
culvert types if they are working on a multiple culvert, opening problem. If
all of the culvert barrels are exactly the same, then only one culvert type
(Culvert ID#) should be entered. The number of barrels is an input parameter
in the culvert data. If the user has culverts that are different in shape, size,
elevation, or loss coefficients, then additional culverts types (Culvert ID#'s)
must be added for each culvert type. To add an additional culvert type you
can either use the Add or Copy buttons. The Add button increments the
culvert ID# and clears the culvert editor. The Copy button increments the
culvert ID# and makes a copy of the original culvert data. Once a copy is
made ofa culvert, the user can change any of the existing culvert information.
Culverts can be deleted by pressing the Delete button.

Solution Criteria - This option allows the user to select between taking the
higher of the inlet control and outlet control answers (Highest U.S. EG), or
specifically selecting the Inlet control or Outlet control answer. The default is
to let the program compute both and take the higher of the two. In general
this should be left this way. The only time a user should specifically select
Inlet control or Outlet control, is when they feel the program is in error by
selecting the higher of the two answers.
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Rename - This button allows the user to put in their own identifier for each of
the culvert types. By default the culvert types will be labeled "Culvert #1,"
"Culvert #2," and so on. The user can enter up to twelve characters for each
culvert type.

Shape - The shape selection box allows the user to select from one of the nine
available shapes. This selection is accomplished by pressing the down arrow
on the side of the box, then selecting one of the nine available shapes.

Span - The span field is use'd to define the maximum width inside of the
culvert. The sp<;nis left blank for circular culverts.

Ri~e - The rise field describes the maximum height inside of the culvert.

Chart #. - This field is used to select the Federal Highway Administration
Chart number that corresponds to the type and shape of culvert being
modeled. Once the user has selected a culvert shape, the corresponding
FHWA chart numbers will show up in the chart # selection box. More
information on FHWA chart numbers can be found in the Hydraulics
Reference manual.

Scale. - This field is used to select the Federal Highway Administration Scale
number that corresponds to the type ofculvert entrance. Once the user has
selected a culvert shape and chart #, the corresponding FHWA scale numbers
will show up in the scale selection box. More information on FHWA scale
numbers can be found in the Hydraulics Reference manual.

Distance to Upstream XS - This field is used to locate the culvert in space,
relative to the two cross sections that bound the culvert crossing. The user
should enter the distance between the upstream cross section and the
upstream end of the culvert barrel.

Culvert Length - The culvert length field describes the length of the culvert
along the centerline of the barrel.

Entrance Loss Coefficient - The coefficient entered in this field will be
multiplied by the velocity head inside of the culvert at the upstream end. This
value represents the amount of energy loss that occurs as flow transitions
from the upstream cross section to inside the culvert barrel.

Exit Loss Coefficient - The coefficient entered in this field will be multiplied
by the change in velocity head from inside the culvert to outside the culvert at
the downstream end. This value represents the energy loss that occurs as
water exits the culvert.

Manning's nfor Top - The n-value fields are used for entering the Manning's
n values of the culvert barrel. This version ofHEC-RAS allows the user to
enter a separate n value for the top (which includes top and sides) of the
culvert, as well as for the bottom. If the culvert has the same roughness for
the top and bottom, the user can enter the value for the top. The Manning's n
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value for the bottom will automati9ally be copied from the top field.

Manning's nfor Bottom - This field is used to enter a Manning's n value for
the bottom of the culvert. This n value will be used up to a user specified
depth inside of the culvert. When the water surface gets higher than that
depth, a composite Manning's n value is computed based on the bottom and
top n values and their corresponding wetted perimeters.

Depth to use Bottom n - This field is used to specify tj:J.e depth that the
"Bottom n value" is applied inside of the culvert. The surface of the culvert
below this depth is given the n value for the bottom of the culvert, while the
surface of the culvert above this depth is given the n value for the top of the
culvert.

Depth Blocked - This field is used to block off a portion of the bottom of the
culvert. When a value is entered into this field, the culvert is completely
blocked up to the depth specified. This blocked out area persists the whole
way through the culvert.

Upstream Invert Elevation - This field is used to describe the elevation of the
culvert invert at the upstream end.

Downstream Invert Elevation - This field is used to describe the elevation of
the culvert invert at the downstream end.

# Identical Barrels - This field is used to display the number of identical
barrels. The number of identical barrels is limited to 25. To enter more than
one identical barrel, the user must provide different centerline stationing
information for each barrel. As the centerline stationing information is added,
the number of identical barrels will automatically change to reflect the
number of centerline stations. The user does not enter anything into this field,
it is just used to display the number of identical barrels.

Centerline Stations - This table is used to enter the stationing of each culvert
barrel. Centerline stations must be provided for both the upstream and
downstream side of each culvert barrel.

Once all of the culvert information is entered, the user should press the OK
button at the bottom of the window. Pressing the OK button tells the
interface to accept the data and close the window. Once the culvert editor is
closed, the graphic of the culvert will appear on the Bridge/Culvert Data
editor window. An example culvert with two culvert types and two identical
barrels for each culvert type is shown in Figure 6.23. Note! The data are
not saved to the hard disk at this point. Geometric data can only be saved
from the File menu on the Geometric Data window.
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Figure 6.23 Bridge/Culvert Data Editor with example culvert

Bridge and Culvert Options

Some additional options that are available, but not required, are found under
the Options menu from the Bridge/Culvert Data Editor. These include the
following:

Add a Bridge and/or Culvert. This option initiates the process of adding a
bridge or culvert to the data set. The user is prompted to enter a river station
tag for the new bridge or culvert. The river station tag locates the bridge or
culvert within the selected reach. Once the river station is entered, the
Bridge/Culvert Data editor is cleared and the user can begin entering the data
for that new bridge or culvert.

Copy Bridge and/or Culvert. This option allows the user to make a copy of
the bridge and/or culvert crossing and place it in another reach and/or river
station within the current project.
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Rename River Station. This option allows the user to change the river
station of the currently opened Bridge and/or Culvert crossing.

Delete Bridge and/or Culvert. This option will delete the currently
displayed bridge or culvert. The user is prompted with a message stating
specifically which bridge or culvert is going to be deleted, and requesting
them to press the OK button or the Cancel button.

Internal Bridge Cross-Sections. This option allows the user to edit the two
cross sections inside of a bridge. These two cross sections are a copy of the
cross sections just upstream and downstream of the bridge. If the ground
elevations inside of the bridge are different than just outside of the bridge,
then the internal bridge cross sections should be modified to reflect the
changing elevations. This option allows the user to change the station and
elevation data, roughness coefficients, and main channel bank stations for
each of the two internal bridge cross sections.

Momentum Equation. This option allows the user to change the
components of the momentum equation. The momentum equation is one of
the optional low flow methods in the bridge routines. The default momentum
equation includes terms in the equation to account for friction losses and the
weight of water component. The user can tum either or both of these
components off from this option.

Momentum Class B Defaults. If the program computes that the flow must
pass through critical depth inside the bridge (Class B flow), critical depth will
automatically be located inside the bridge at the most constricted cross
section. Ifboth cross sections are identical, the program will locate critical
depth at the upstream inside cross section. This option allows the user to
control where the program sets critical depth for class B flow. If the user
feels that it would be better to set critical depth inside the bridge at the
downstream end, then this can be selected.

Pressure Flow Criteria. This option allows the user to select either the
energy grade line or the water surface, to be used as the criterion for when the
program begins checking for the possibility of pressure flow. By default the
program uses the energy grade line. This does not change how pre~sure flow
is calculated, only when the program will begin checking for pressure flow.

Ice Option. This option allows the user to select how ice will be handled
inside of the bridge during ice computations. This option is only pertinent if
the user is performing a profile computation with the effects of ice included.
When this option is selected, a window will appear asking the user to select
one of three available options. These options include: no ice inside of the
bridge; a constant amount of ice through the bridge; dynamic ice effects are to
be computed through the bridge.
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Skew Bridge/Culvert. This option allows the user to make adjustments to
bridge/culvert data that is skewed (i.e. not perpendicular to the flow lines
going through the bridge/culvert. When this option is selected, a window will
appear allowing the user to enter a skew angle for the deck/roadway, as well
as the piers. The stationing of the deck/roadway is reduced, by multiplying it
by the cosine of the user entered skew angle. Additionally, the user has the
option to adjust the upstream and downstream cross sections bounding the
bridge by the same skew angle. A separate skew angle is entered for bridge
piers. The piers are assumed to go the whole way through the bridge as a
single continuous pier.

Bridge and Culvert View Features

Several options are available for viewing the bridge/culvert geometric data.
These options include: Zoom In; Zoom Out; Display Upstream XS; Display
Downstream XS; Display Both; Highlight Weir, Opening Lid and Ground;
Highlight Piers; and Grid. These options are available from the View menu
on the bridge/culvert data editor.

Zoom In. This option allows the user to zoom in on a piece of the bridge or
culvert. This is accomplished by selecting Zoom In from the View menu,
then specifying the area to zoom in on with the mouse. Defining the zoom
area is accomplished by placing the mouse pointer in the upper left corner of
the desired area. Then press down on the left mouse button and drag the
mouse to define a box containing the desired zoom area. Finally, release the
left mouse button and the viewing area will display the zoomed in area of the
bridge or culvert.

Zoom Out. This option displays the bridge or culvert back into its original
size before you zoomed in. Zooming out is accomplished by selecting Zoom
Out from the View menu bar on the bridge/culvert data editor.

Full Plot. When this option is selected, the graphic is automatically redrawn
back to its full extent, showing the entire bridge/culvert.

Pan. When this option is selected, the user can move the zoomed in portion
of the graphic. This is accomplished by first selecting the Pan option, then
pressing and holding down the left mouse button while over the graphic.
Next, move the graphic in the desired direction, and then release the left
mouse button. The graphic will be redrawn with a new portion of the graphic
shown in the zoomed in area.

Display Upstream XS. When this option is selected, only the upstream side
of the bridge or culvert will be displayed.

Display Downstream XS. When this option is selected, only the
downstream side of the bridge or culvert will be displayed.

Display Both. When this option is selected, both the downstream and
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upstream sides of the bridge will be displayed in the viewing area.

Highlight Weir, Opening Lid and Ground. When this option is selected,
various portions of the bridge/culvert graphic will be highlighted. The
program will highlight in red the combination of the deck/roadway high cord
and any ground to the left and right of this data. The red color shows what
the program will use for weir flow if the Pressure and Weir option is selected
for high flows.

The program will also highlight any bridge openings. Within the bridge
opening, the ground information will be highlighted in blue and the lid of the
opening (deck/roadway low cord data) will be highlighted in green. If the
any of these three colors show up in an area where they should not be, then
there must be a geometric mistake in the data. This option is very useful for
detecting any data entry errors that may otherwise go unnoticed.

Highlight Piers. When this option is turned on the interface will highlight
what it thinks is the extent of the pier information. This option allows the
user to see exactly what the program thinks piers are, and to see how the pier
information has been clipped. Piers are clipped below the ground and above
the low chord of the bridge.

Grid. This option allows the user to have a grid overlaid on top of the bridge
or culvert graphic.

Multiple Bridge and/or Culvert Openings

HEC-RAS has the ability to model multiple bridge andlor culvert openings at
any individual river crossing. Types of openings can consist of bridges,
culvert groups (a group of culverts is considered to be a single opening), and
conveyance areas (an area where water will flow as op~n channel flow, other
than a bridge or culvert opening). Up to seven openings can be modeled at a
given location, and any combination of bridges and culvert groups can be
used. Conveyance type openings can range from zero to a maximum of two,
and the conveyance areas must be located on the far left and far right of the
river crossing.

An example multiple opening is shown in Figure 6.24. As shown in this
example, there are three types of openings: a conveyance area (left side,
labeled as opening #1), a bridge (labeled as opening #2), and a culvert group
(labeled as opening #3). During low flow conditions, flow will be limited to
the bridge opening. As flow increases, the culverts will begin to take some of
the flow away from the bridge opening. The conveyance area was defined as
ineffective flow (no conveyance) until the water surface goes above the top of
the bridge. This was accomplished by setting blocked ineffective flow areas.
In this example, three blocked ineffective flow areas were established: one to
the left of the bridge (which encompasses the whole conveyance area), one
between the bridge and the culvert group, and one to the right of the culvert
group.
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Figure 6.24 Example Multiple Opening River Crossing

Entering Multiple Opening Data

Multiple opening data are entered in the same manner as any other bridge or
culvert crossing. In general, the user should perform the following steps to
enter multiple opening data:

1. Press the Bridge/Culvert button on the Geometric Data window.

2. Select the river and reach in which you would like to place the
multiple opening river crossing. This is accomplished from the River
and Reach boxes near the top of the window.

3. Select Add a Bridge and/or Culvert from the Options menu of the
bridge and culvert editor. Enter the river station at which you want to
place the multiple opening crossing. Once you have done this, the
two cross sections that bound this river station will appear in the
window. These two cross sections, along with the bridge and culvert
information, .will be used to formulate the two cross sections inside
the multiple opening river crossing.

4. Enter the deck and road embankment data by using the
Deck/Roadway editor.
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5. Enter any piers or sloping abutm.ents that are required.

6. Select the Bridge Modeling Approach button and enter a set of
coefficients and modeling approaches for each bridge opening.

7. Enter Culvert data for any culvert openings.

8. Select the Multiple Opening Analysis button on the bridge and
culvert editor. Enter the types of openings and their station limits.
Start at the left most station of the crossing and work your way to the
right end. This is explamed in greater detail under the section entitled
"Defining the Openings".

Deck/Road Embankment Data. There can only be one deck and road
embankment entered for any bridge and/or culvert crossing. The deck editor
is used to describe the area that will be blocked out due to the bridge deck and
road embankment. As shown by the gray shaded area in Figure 6.23, the
deck and roadway data are usep to block out area around the bridge as well as
around the culverts. In the area of the bridge, high and low chord information
is entered in order to define the top of road as well as the bridge opening. In
the area of the culverts, the high chord information is entered to defme the
rest of the top of the road embankment. However, the low chord information
can be left blank, or set to elevations below the ground, because the culvert
data defme the culvert openings.

Piers and abutments. All piers are entered from the pier editor, which was
described previously under bridge data. The number ofbridge openings has
no impact on how pier data are entered. Piers are treated as separate
information. Once the user establishes that there is more than one bridge
opening, the program is smart enough to figure out which piers go with which
opening. If any sloping abutment data are required for a bridge opening, it
can be entered as described previously under the bridge data section.

Bridge Modeling Approach. A bridge modeling approach and coefficient
set must be established for at least one bridge opening. If there is more than
one bridge opening, and the user has only established a single coefficient set
and bridge modeling approach, those data will be used for all of the bridge
openings. The user can establish a different set of coefficients and modeling
approaches for each bridge opening.
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Figure 6.25 Bridge Modeling Approach Editor

As shown in Figure 6.25, the user must enter information under the Bridge
Modeling Approach editor for at least one bridge Opening. Bridge openings
are referred to as Bridge # I, Bridge # 2, etc., up to the number ofbridge
openings. Bridge # I represents the left most bridge opening while looking in
the downstream direction. Bridge # 2 represents the next bridge opening to
the right of Bridge # I, and so on. The user can enter additional coefficient
sets and modeling approaches by selecting either the Add or Copy button. If
either of these buttons is selected, the Bridge # will automatically be
incremented by one. The user can then enter or change any of the
information on the editor for the second bridge opening. Any bridge opening
that does not have a corresponding coefficient set and modeling approach,
will automatically default to what is set for Bridge # 1.

Culvert Data. Culvert information is added in the same manner as described
in the previous section called "Entering and Editing Culvert Data." Culverts
will automatically be grouped based on their stationing.
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Defining The Openings

Once all of the bridge and/or culvert data are entered for a multiple opening
river crossing, the last step is to define the number and type of openings that
are being modeled. This is accomplished by pressing the Multiple Opening
Analysis button on the Bridge/Culvert Data editor. Once this button is
pressed, an editor will appear as shown in Figure 6.26 (except yours will be
blank the fIrst time you bring it up).

Figure 6.26 Multiple Opening Analysis window

The user selects from the three available opening types: Conveyance; Culvert
Group; and Bridge. Openings must be established in order from left to right,
while looking in the downstream direction. In addition to establishing the
number ,and types of openings, the user must also enter a Station Left and a
Station Right for each opening. These stations are used to establish limits for
each opening as well as stagnation points. Stagnation points are the locations
at which flow separates (on the upstream side) from one opening to the next
adjacent opening. Stagnation points can either be set to fIxed locations or
they can be allowed to migrate within limits.

As shown in Figure 6.26 (numerical representation) and Figure 6.24
(graphical representation), there are three openings established in this
example. The first opening is defined as a conveyance area, and it ranges
from station 98 (the left most station of the section) to station 260. That
means that any water in this area will be treated as normal open channel flow,
and the water surface will be calculated by performing standard step
calculations with the energy equation. The second opening is the bridge
opening. This opening has a left station of260 and a right station of740.
This bridge will be modeled by using the cross section data, bridge deck, and
pier information that lie within these two stations (260 and 740). The bridge
coefficients and modeling approach for this opening will be based on the data
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entered for bridge op~ning #1, ~ince it is the first bridge opening. The third
opening is a culvert group. This opening has a left station of 650 and a right
station of 940. Any culverts that lie within these stations will be considered
as being in the same culvert group.

Notice that the right station of the bridge opening overlaps with the left
station of the culvert group. This is done on purpose. By overlapping these
stations, the user is allowing the program to calculate the location of the
stagnation point between these two openings. This allows the stagnation
point to vary from one profile to the next. In the current version of the HEC
RAS ~oftware, stagnation points are allowed to migrate between any bridge
and culvert group openings. However, stagnation points must be set to a
fixed location for any conveyance opening type. A more detailed explanation
of stagnation points, and how the program uses them, can be found in the
HEC-RAS Hydraulics Reference manual, under the section on Multiple
Openings (Chapter 7).

Once the user has entered all of the information into the Multiple Opening
Analysis window, simply press the OK button to accept the data.

Multiple Opening Calculations .

Multiple opening calculations are computationally intensive. An iterative
solution approach is used, by which the amount of flow through each opening
is adjusted until the computed upstream energies of each opening are
balanced within a predefined tolerance. The general approach of the solution
scheme is as follows:

1. The program makes a first guess at the upstream water surface by
setting 1t to the computed energy of the cross section just downstream
of the bridge.

2. The program sets an initial flow distribution. This is accomplished by
first calculating the amount of active flow area in each opening, based
on the water surface from step one. The program then apportions the
flow by using an area weighting (i.e., if an opening has 40 percent of
the active flow area, then it will receive 40 percent of the flow).

3. Once a flow distribution is established, the program then calculates
the water surface and energy profiles for each opening, using the
estimated flow.

4. Once the program has computed the upstream energy for each
opening, a comparison is made between the energies to see if a
balance has been achieved (Le., all energies are within the predefmed
tolerance). lfthe energies are not within the set tolerance, the
program re-distributes the flow based on the computed energies.
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5. The program cQntinues this proqyss un~il either the computed energies
are within the tolerance or the number of iterations reaches a pre
defined maxinmm. The energy balance tolerance is set as 3 times the
user entered water surface calculation tolerance (The default is 0.03
feet or 0.009 meters). The maximum number of iterations for
mtllupleopening analysis is set to 1.5 times the user entered
maximuni nUrriber of iterations from the normal water surface
calculations (the default is 30 for multiple openings).

A more detailed discussion of how the program performs the multiple
opening analyses can be found in Chapter 7 of the HEC-RAS Hydraulic
Reference manual.

Inline Weirs and Gated Spillways

HEC-RAS has the ability to model radial gates (often called tainter gates) or
vertical lift gates (sluice gates). The spillway crest of the gates can be
modeled as either an ogee shape ora broad crested weir shape. In addition to
the gate openings, the user can also define a separate uncontrolled overflow
weir.

This section of the User's manual will describe how to enter the data for
inline weirs and gated spillways. For information on general modeling
guidelines and the hydraulic computations of inline weirs and gated
spillways, please see Chapter 8 of the HEC-RAS Hydraulic Reference
manual. To find out how to view specific results for an inline weir and gated
spillway, see Chapter 9 of this User's manual.

Entering and Editing Inline Weir and Gated Spillway
Data

Inline weir and gated spillway data are entered in a similar manner as bridge
and culvert data. To enter an inline weir and/or gated spillway press the
Inline Weir/Spill button from the Geometric Data window. Once this button
is pressed, the Inline Weir and Gated Spillway Data editor will appear as
shown in Figure 6.27 (except yours will be blank until you have entered some
data).
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Figure 6.27 Inline Weir and Gated Spillway Data Editor

To add an inline weir and/or gated spillway to a model, the user must do the
following:

1. Select the river and reach that you would like to place this inline weir
and/or spillway into. This is accomplished by fIrst selecting a River,
then selecting a specifIc reach within that river. The River and Reach
selection buttons are at the top of the Inline Weir and/or Gated
Spillway Data editor.

2. Go to the Options menu at the top of the window and select Add an
Iuline Weir and/or Gated Spillway from the list. An input box will
appear asking you to enter a river station identifIer for locating this
structure within the reach. After entering the river station, press the
OK button and a copy of the cross section just upstream of this river
station will appear on the screen. This cross section is used in
formulating the inline weir and/or gated spillway crossing.

3. Enter all of the data for the Inline Weir and/or Gated Spillway. This
data will include a Weir/Embankment profIle, and any gated
spillways that you may be modeling. Gated spillways are optional. If
the user does not enter any gated spillways, then the program assumes
that there is only an inline weir.
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Once all of the Inline Weir and/or Gated Spillway data are entered,
press the Apply Data button in order for the interface to accept the
data. The editor can then be closed by selecting Exit from the File
menu at the top of the window.

•

•

River, Reach, and River Station. The River and Reach boxes allow the user
to select a river and reach from the available reaches that were put together in
the schematic diagram. The river and reach labels defme which river and
reach the inline weir and/or gate spillway will be located in. The River
Station tag defines where the structure will be located within the specified
reach. The River Station tag does not have to be the actual river station of the
structure, but it must be a numeric value. The River Station tag for the inline
weir and/or gated spillway should be numerically between the two cross
sections that bound the structure. Once the user selects Add an Inline Weir
and/or Gated Spillway from the options menu, an input box will appear
prompting you to enter a River Station tag for the new structure. After the
River Station tag is entered, the cross section just ups,tream of the Inline Weir
and/or Gated Spillway will be displayed on the editor.

Description. The description box is used to describe the Inline Weir and/or
Gated Spillway location in more detail than just the river, reach and river
station. This box has a limit of 256 characters. Only the first line of .
information is displayed, unless the button to the right of the box is pressed.
Also, the first 40 characters of the description are used as a label for the Inline
Weir and/or Gated Spillway plots and tables.

Pilot Flow. This option allows the user to put in a flow rate that will be used
as a minimum flow release from the structure. If you have an inline weir
structure in HEC-RAS, there must be flow coming out of the structure at all
times. The pilot flow option is a simple way to ensure that there is always
some flow going through the structure.

Weir/Embankment. The Embankment and Weir data are entered together,
and are used to describe the embankment blocking the stream as well as any
uncontrolled weirs. To enter the weir and embankment data, press the
WeirlEmbankment button and the editor will appear as shown in Figure 6
28.

The Weir/Embankment Data editor is similar to the Deck/Roadway editor for
bridges and culverts. The data on the WeirlEmbankment editor is the
following:

Distance - The distance field is used to enter the distance between the
upstream side of the Weir/Embankment (the top of the embankment) and the
cross section immediately upstream of the structure. This distance is entered
in feet (or meters for metric).
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Figure 6.28 Weir and Embankment Data Editor

Width - The width field is used to enter the width of the top of the
embankment along the stream. The distance between the top of the
embankment and the downstream bounding cross section will equal the main
channel reach length of the upstream cross section minus the sum of the
weir/embankment "width" and the "distance" between the embankment and
the upstream section. The width of the embankment should be entered in feet
(meters for metric).

Weir Coefficient - Coefficient that will be used for weir flow over the
embankment in the standard weir equation.

Station and Elevation Coordinates - This table is used to define the geometry
of the Weir and the Embankment. The information is entered from left to
right in cross section stationing. The user enters stations and elevations of the
top of the embankment and weir. The stationing does not have to equal the
stations in the bounding cross section, but it must be based on the same
origin. Everything below these elevations will be filled in down to the
ground. The Del Rowand Ins Row buttons allow the user to delete and
insert rows.

u.s. Embankment SS - This field is used to enter the slope of the road
embankment on the upstream side of the structure. The slope should be
entered as the horizontal to vertical distance ratio of the embankment.
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D.S. Embankment SS - This field is used to enter the slope of the road
eIIlbankment on the.downstream side of the structure. The slope should be
entered as the horizontal to vertical distance ratio of the embankment.

Weir Crest Shape - When submergence occurs over the weir there are two
choices availabl~ to figure out how much the weir coefficient should be
reduced due to the submergence. These two criteria are based on the shape of
the weir. The .first method is basec:i on work that was done on a trapezoidal
shaped broad crested weir (FHWA, 1978). The second criterion was
developed for an Ogee spillway shape (COE,1965). The user should pick the
criterion that best matches their problem. If the user selects the Ogee
Spillway shape, then some ad4itional information is require. For an Ogee
shaped weir the user must enter the "Spillway Approach Height" and the
"Design Energy Head", The spillway approach height is equal to the
elevation of the spillway crest minus the mean elevation of the ground just
upstream of the spillway. The design energy head is equal to the energy
grade line elevation (at the design discharge) minus the elevation of the
spillway crest. In addition to these two parameters, the user has the option to
have the program calculate the weir coefficient at the design discharge. This
is accomplished by pressing the Cd button. Once this button is pressed, the
program will compute a weir coefficient for the Ogee spillway based on the
design head. During the weir calculations, this coefficient will fluctuate
based on the actual head going over the spillway. The curves used for
calculating the Ogee spillway coefficient at design head, and discharges other
than design head, were taken from the Bureau of Reclamation publication
"Design of Small Dams", Figures 249 and 250 on page 378 (Bureau of
Reclamation, 1977).

Gated Spillway Data. In addition to uncontrC!lled overflow weirs, the user
can add gated spillways (this is optional). To add gated spillways to the
structure, press the Gate button on the Inline Weir and Gated Spillway data
editor. Once this button is pressed, the gated editor will appear as shown in
Figure 6.29 (except yours will be blank until you have entered some data) .

6-61



Chapter 6 Entering and Edifing Geometric Data

Figure 6.29 Gated Spillway Editor

The Gated Spillway editor is similar to the Culvert editor in concept. The
user enters the physical description of the gates, as well as the required
coefficients, in the Gated Spillway editor. The functionality of the gates is
defmed as part of the Steady Flow data, on a per profile basis. The following
is a list of the data contained on this editor:

Gate Group - The Gate Group is automatically assigned to "Gate #1" the fIrst
time you open the editor. The user can enter up to 10 different Gate Groups
at each particular river crossing, and each gate group can have up to 25
identical gate openings. If all of the gate openings are exactly the same, then
only one gate group needs to be entered. If the user has gate openings that are
different in shape, size, elevation, or have different coefficients, then
additional Gate Groups must be added for each Gate type. To add an
additional gate group you can either use the Add or Copy buttons. The Add
button increments the Gate # and clears the culvert editor. The Copy button
increments the Gate # and makes a copy of the original Gate group data.
Once a copy is made of a gate data, the user can change any of the existing
gate information. Gate groups can be deleted by pressing the Delete button.
Also, if the gates are identical, but the user wants to be able to open the gates
to different elevations, then the user must have a separate gate group for each
set of gates that will be opened to different elevations.
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Height - This field is used to enter the maximum possible height that the gate
can be opened in feet (meters for metric).

Width - This field is used for entering the width of the gate in feet (meters).

Invert - This field is used for entering the elevation of the gate invert (sill
elevation of the spillway inside of the gate) in feet (meters for metric).

Discharge Coefficient - This field is used for entering the coefficient of
discharge for the gate opening. This coefficient ranges from 0.6 to 0.8 for
Radial gates and 0.5 to 0.7 for sluice gates.

Gate Type - This field is used for selecting the type of gate. Two gate types
are available, radial (tainter gate) or sluice (vertical lift gate).

Trunnion Exponent - This field is used to enter the trunnion height exponent,
which is used in the radial gate equation. The default value for this field is
0.0.

Opening Exponent - This field is used to enter the gate opening exponent,
which is used in the radial gate equation. A default value of 1.0 is
automatically set for this field.

Head Exponent - This field is used to enter the upstream energy head
exponent, which is used in the radial gate equation. A default value of 0.5 is
automatically set for this field.

Trunnion Height - This field is used for entering the height from the spillway
crest to the trunnion pivot point. See Chapter 8 of the Hydraulic Reference
manual for more details on this variable.

Orifice Coefficient - This field is used to enter an orifice coefficient, which
will be used for the gate opening when the gate becomes more than 80
percent submerged. Between 67 percent and 80 percent submerged, the
program uses a transition between the fully submerged orifice equation and
the free flow equations. When the flow is less than 67 percent submerged,
the program uses the free flow gate equations.

Centerline Stations - This table is used for entering the centerline stationing
of the identical gate openings. The user should enter a different centerline
stationing for each gate opening that is part of the current gate group. All
gate openings within the same gate group are exactly identical in every way,
except their centerline stationing. As a user adds new centerline stationing
values, the number of identical gates in the group is automatically
incremented and displayed in the field labeled "# Openings".

Weir Coefficient - This field is used for entering a weir coefficient that will be
used for the gate opening. This coefficient will only be used when the gate is
opened to an elevation higher than the upstream water surface elevation.
When this occurs, the flow through the gate is calculated as weir flow.
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s~i1~W~Y·,Jk~S\l:,~esN,~eq~9r8~}f~attng~h~pgee spillway coefficient at
d~Slgn~~~d~ a.p.<;i ~~ch~!~e§ ,()tJi~r tp.:~l1geslgn head, work taken from the
Bureau ofReclamation publication "Design ofSmall Dams", Figures 249 and
250 on pa,gy 378 (Burea)l,ofR~clam~tiop., 1977).

~ ,: - . ..' ~

Spillway Approach Heighi - the spillway approach height is equal to the
elevation of the spillway crest minus the mean elevation of the ground just
up~treamof the spill?,ay.

, '.

Design Energy Head - T~~ ?es.i%p¢I;l~~.gyheadi~,~9u~1 to the energy grade
line elevation (at the desigri discharge) minus the'elevation of the spillway.

:,' " Onc:ea1r qf U}~'dat~ for tile ~~tes:ha~ bS~ii .. ep.t~red, the user needs to press the
", OKbuttori for the (ratito 1?,rJ,a.c'~~p.te,c.t.'tt~e,userdoes not want to use the

new data, and would like to go oack to' the' ariginaJ data they had before
entering tl1~ Gate, Editor, press th€; Cancel button. If the user presses the OK
button;)i1i~c:ibes n9t in~~ that #Ie ~~is sav~d to the hard disk, it is only
stored in mem~ry andacc~pt~d its beihg~ood data: T!lls data is part of the
geometry data, and is stored in'the geometric data file. The data can be stored
to ~e um;d?isk by s~lecti,n~ ~ne ofthe8~veoptio~s trom the File menu of the
Georn'elric Datil window.' ,,'

,., -; ,.,. .. ,-:

",

. ·1,.;..

< ,
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Lateral Weirs and Gated Spillways

HEC-RAS has the ability to model lateral weirs and/or gated spillways. The
user can s.et up a single lateral weir, a separ~te set of gates, or a combination
of the two. The gated spillways can have either radial gates (often called
tainter gates) or vertical lift gates (sluice gates). The spillway crest of the
gates can be modeled as either an ogee shape or a broad crested weir shape.

This section of the User's manual will describe how to enter the data for
lateral weirs and gated spillways. For infonnation on general modeling
guidelines and the hydraulic computations of lateral weirs and gated
spillways, please see Chapter 8 of the HEC-RAS Hydraulic Reference
manual. To fmd out how to view specific results for a lateral weir and gated
spillway, see Chapter 9 ofthi.s User's manual.

Entering and Editing Lateral Weir and Gated Spillway
Data

Lateral weir and gated spillway data are entered in a similar manner as bridge
and culvert data. To enter an lateral weir and/or gated spillway press the
Lateral Weir/Spill button from the Geometric Data window. Once this
button is pressed, the La~eral Wei! apd Gated Spillway Data editor will
appear as shown in Figure 6.30 (except yours will be blank until you have
entered some data).

To add a lateral weir and/or gated spillway to a model, the user must do the
following:

1. Select the river and reach that you would like to place this lateral weir
and/or spillway into. This is accomplished by first selecting a River,
then selecting a specific reach within that river. The River and Reach
selection buttons are at the top of the Lateral Weir and/or Gated
Spillway Data editor.

2. Go to the Options menu at the top of the window and select Add an
Lateral Weir and/or Gated Spillway from the list. An input box
will appear asking you to enter a river station identifier for locating
this structure within the reach. The river station you enter will
represent the location of the upstream end of the lateral weir/spillway.
The river station must be unique, and should be numerical between
the river station values of the upstream cross section and the next
section downstream. After entering the river station, press the OK
button and a proftle plot of the channel invert and cross sections in the
vicinity of the lateral weir/spillway will be displayed.
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Figure 6.30 Lateral Weir and Gated Spillway Editor

3. Enter all of the data for the Lateral Weir and/or Gated Spillway. This
data will include a Weir/Embankment profile, and any gated
spillways that you may be modeling. Gated spillways are optional. If
the user does not enter any gated spillways, then the program assumes
that there is only a lateral weir. If the user wants to enter only gated
spillways, and no lateral weir, they must still enter a weir
embankment.

4. Once all of the Lateral Weir and/or Gated Spillway data are entered,
press the Apply Data button in order for the interface to accept the
data. The editor can then be closed by selecting Exit from the File
menu at the top ofthe window.

5. If any gated spillways were entered, the user must go to the Steady
Flow Data Editor to control the gate settings for each individual
profile.

The user can have up to two lateral weirs/spillways defined between any two
given cross sections. However, the lateral weirs must be placed on opposite
sides of the channel (i.e. one on the left and one on the right), and the river
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stations of each later weir must be different (though still contained within the
two cross section river station values). Also, any lateral weir/spillway can be
longer than the distance between cross sections. The user can have a lateral
weir/spillway "that extends d9wnst.re~, ehcOl;npassing up to eight cross
se,etions. Ifyou pave a lateral weir/spi1!way that is longer than that, you must
breaJe it up into separate lateral we4"s/spillways.

River, Reach, and River Station. The River and Reach boxes allow the user
to select a river and reach from the available r.eaches that were defIned in the
schematic diagram. The river and re"ach lab~ls ~efIne which river and reach
the lateral weir and/or gate spillway will pe located in. The River Station tag
defmes where the structure will be located within the specifIed reach. The
River Station tag does not have to be the actual river station of the structure,
but it must be a numeric vlllue. The River Station tag for the lateral weir
and/or gated spillway should be numerically between the two cross sections
that bound the upstream end of the structure. Once the user selects Add an
Lateral Weir and/or Gated Spillway from the options menu, an input box
will appear prompting you to enter a River Station tag for the new structure.
After the River Station tag is entered, a profIle plot of the reach thalweg will
be displayed for the bounding cross sections in the graphic window.

Description. The description box is used to describe the Lateral Weir and/or
Gated Spillway location in more detail than just the river, reach and river
station. This box has a limit of 256 characters. Only the fIrst line of
information is displayed, unless the button to the right of the box is pressed.
Also, the fIrst 40 characters of the description are used as a label for the
Lateral Weir and/or Gated Spillway plots and tables.

Position. The position box is used to defIne where the lateral weir is located
spatially within the cross section. The user can select one of the following:
Left overbank; Next to left bank station; Next to right bank station; and Right
overbank. When the user selects "Left overbank", the weir is assumed to be
located at the left end (beginning cross section station) of the cross section
data, looking in the downstream direction. When the user selects "Next to
left bank station", the weir is assumed to be located on the left edge of the
main channel. When the user selects "Next to right bank station", the weir is
assumed to be located on the right edge of the main channel. When the user
selects "Right overbank", the weir is assumed to be located at the right end of
the cross section data.

Connected To. This fIeld will display what the lateral weir is connected to
(i.e. where the water leaving from the main river will be going). If the weir is
not connected to anything, this fIeld will be blank. A lateral weir can be
connected to a storage area, another river reach, or nothing at all. The buttons
below this fIeld are used to connect the lateral weir, as well as remove a
connection.

WeirlEmbankment. The Embankment and Weir data are entered together,
and are used to describe the embankment in which the gates will be placed, as
well as any uncontrolled weirs. To enter the weir and embankment data,
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press the WeirlEmb~nkment button and the editor will appear as shown in
Figure 6-31.

Figure 6.31 .Lateral WeirlEmbankment editor

The Lateral WeirlEmbankment Data editor is similar to the Deck/Roadway
editor for bridges and culverts. The data on the Weir/Embankment editor is
the following:

Distance - The distance field is used to enter the distance between the
upstream end of the Weir/Embankment (based on where the user will start to
enter the embankment data) and the cross section immediately upstream of
the structure. This distance is entered in feet (or meters for metric).

Weir Width - The width field is used to enter the width of the top of the
embankment. This value will only be used for graphical plotting, and does
not have any effect on the computations. The width of the embankment
should be entered in feet (meters for metric).

Weir flow reference - This value is used to select whether weir flow is
computed by using the energy gradeline or the water surface from the cross
sections. The default is to use the energy gradeline.

Weir Coefficient - Coefficient that will be used for weir flow over the
embankment in the standard weir equation.

Weir Crest Shape - When submergence occurs over the weir there are two
choices available to figure out how much the weir coefficient should be
reduced due to the submergence. These two criteria are based on the shape of
the weir. The first method is based on work that was done on a trapezoidal
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shaped broad crested weir (FHWA, 1978). The &econd criterion was
developed for an Ogeespillway shape (COE, 1965). The user should pick the
criterion that best matches their problem. If the user selects the Ogee
Spillway shape, then some additional informatio!1 is required. For an Ogee
shaped weir the user must enter the "Spillway Approach Height" and the
"pesign Energy :Sead". The spillway approachh~ight is equal to the
elevation of the spillway crestminus the ~~an ei~vation of the ground just
upstream of the spillway. The 4~sign energy head is equal to the energy
grade line elevation ~at the desighdischarge) minus the elevation of the
spillway crest. In addition to these two paraIIleters, the user has the option to
have the program calculate the weir coefficient at the design discharge. This
is accomplished by pressing the Cd button. Once this button is pressed, the
program will compute a weir coefficient for the Og~e spillway based on the
design head. During the weir calculations, this coefficient will fluctuate
based on the actual head going over the spillway. The curves used for
calculating the Ogee spillway coefficient at design head, and discharges other
than design head, were taken from the Bureau of Reclamation publication
"Design ofStnah Dams", Figures 249 and 250 on page 378 (Bureau of
Reclamation, 1977).

Station and Elevation Coordinates - This table is used to define the geometry
of the Weir and the Embankment. The information is entered from upstream
to downstream in stationing. The user enters stations and elevations of the
top of the embankment and weir. The stationing does not have to equal the
stations in the river reach. Everything below these elevations will be filled in
to the ground. The Del Rowand Ins Row buttons allow the user to delete
and insert rows.

Gated Spillway Data. In addition to uncontrolled overflow weirs, the user
can add gated spillways (this is optional). To add gated spillways to the
structure, press the Gate button on the Lateral Weir and Gated Spillway data
editor. Once this button is pressed, the lateral gated editor will appear as
shown in Figure 6.32 (except yours will be blank until you have entered some
data).
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Figure 6.32 Lateral Gated Spillway Editor.

The Gated Spillway editor is similar to the Culvert editor in concept. The
user enters the physical description of the gates, as well as the required
coefficients, in the Gated Spillway editor. The functionality of the gates is
defined as part of the Steady Flow data, on a per profIle basis. The following
is a list of the data contained on this editor:

Gate Group - The Gate Group is automatically assigned to "Gate #1" the fIrst
time you open the editor. The user can enter up to 10 different Gate Groups
at each particular structure, and each gate group can have up to 25 identical
gate openings. If all of the gate openings are exactly the same, then only one
gate group needs to be entered. If the user has gate openings that are different
in shape, size, elevation, or have different coeffIcients, then additional Gate
Groups must be added for each Gate type. To add an additional gate group,
you can either use the Add or Copy buttons. The Add button increments the
Gate # and clears the gate editor. The Copy button increments the Gate # and
makes a copy of the original Gate group data. Once a copy is made of the
gate data, the user can change any of the existing gate information. Gate
groups can be deleted by pressing the Delete button. Also, if the gates are
identical, but the user wants to be able to open the gates to different
elevations, then the user must have a separate gate group for each set of gates
that will be opened to different elevations.
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Height - This field is used to enter the maximum possible height that the gate
can be opened in feet (meters for metric).

Width - This field is used for entering the width of the gate in feet (meters).

Invert - This field is used for entering the elevation of the gate invert (sill
elevation of the spillway inside of the gate) in feet (meters for metric).

Discharge Coefficient - This field is used for entering the coefficient of
discharge for the gate opening. This coefficient ranges from 0.6 to 0.8 for
Radial gates ".Ild 0.5 to 0.7 for sluice gates.

Gate Type - This field is used for selecting the type of gate. Two gate types
are available, radial (tainter gate) or sluice (vertical lift gate).

Trunnion Exponent - This field is used to enter the trunnion height exponent,
which is used in the radial gate equation. The default value for this field is
0.0.

Opening Exponent - This field is used to enter the gate opening exponent,
which is used in the radial gate equation. A default value of 1.0 is
automatically set for this field.

Head Exponent - This field is used to enter the upstream energy head
exponent, which is used in the radial gate equation. A default value of 0.5 is
automatically set for this field.

Trunnion Height - This field is used for entering the height from the spillway
crest to the trunnion pivot point. See Chapter 8 of the Hydraulic Reference
manual for more details on this variable.

Orifice Coefficient - This field is used to enter an orifice coefficient, which
will be used for the gate opening when the gate becomes more than 80
percent submerged. Between 67 percent and 80 percent submerged, the
program uses a transition between the fully submerged orifice equation and
the free flow equations. When the flow is less than 67 percent submerged,
the program uses the free flow gate equations.

Centerline Stations - This table is used for entering the centerline stationing
of the identical gate openings. The user should enter a different centerline
stationing for each gate opening that is part of the current gate group. All
gate openings within the same gate group are exactly identical in every way,
except their centerline stationing. As a user adds new centerline stationing
values, the number of identical gates in the group is automatically
incremented and displayed in the field labeled "# Openings".

Weir Coefficient - This field is used for entering a weir coefficient that will be
used for the gate opening. This coefficient will only be used when the gate is
opened to an elevation higher than the upstream water surface elevation.
When this occurs, the flow through the gate is calculated as weir flow.
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Weir Crest Shape - This parameter allows the user to select between a Broad
Crested shape weir and an Ogee shaped weir. Depending on which shape is
selected, the program will use a different submergence criteria during the
calculation. In addition to the submergence criteria, if the user selects the
Ogee shape, the program will bring up two additional data entry fields that
must be entered by the user. These fields are used for the Spillway Approach
Height and the Design Energy Head, which are explained below. Once these
fields are entered, the user should press the button labeled Cd. When this
button is pressed, the program will compute a weir coefficient for the Ogee
spillway based on the design head. During the weir calculations, this
coefficient will fluctuate based on the actual head over the gated spillway.
The curves used for calculating the Ogee spillway coefficient at design head,
and discharges other than design head, were taken from the Bureau of
Reclamation publication "Design of Small Dams", Figures 249 and 250 on
page 378 (Bureau of Reclamation, 1977).

Spillway Approach Height - The spillway approach height is equal to the
elevation of the spillway crest minus the mean elevation of the ground just
upstream of the spillway.

Design Energy Head - The design energy head is equal to the energy grade
line elevation (at the design discharge) minus the elevation of the spillway.

Once all of the data for the gates have been entered, the user needs to press
the OK button for the data to be accepted. If the user does not want to use the
new data, and would like to go back to the original data they had before
entering the Gate Editor, press the Cancel button. If the user presses the OK
button, this does not mean that the data is saved to the hard disk, it is only
stored in memory and accepted as being good data. This data is part of the
geometry data, and is stored in the geometric data file. The data can be stored
to the hard disk by selecting one of the save options from the File menu of the
Geometric Data window.
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Cross Section Interpolation

Occasionally it is necessary to supplement surveyed cross section data by
interpolating cross sections in between two surveyed sections. Interpolated
cross sections are often required when the change in velocity head is too large
to accurately determine the energy gradient. An adequate depiction of the
change in energy gradient is necessary to accurately model friction losses as
well as contraction and expansion losses.

Cross section interpolation can be accomplished in three ways from within
the HEC-RAS interface. The first method is to simply copy one of the
bounding cross sections and then adjust the station and elevation data. The
cross section editor allows the user to raise or lower elevations and to shrink
or expand various portions of any cross section.

The second and third options allow for automatic interpolation of cross
section data. From the Geometric Data editor, automatic interpolation
options are found under the Tools menu bar as shown in Figure 6.33 .

Figure 6.33 Automatic Cross Section Interpolation Options
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The first cross section interpolation option l Within a Reach, allows for
automatic interpolation over a specified range of cross sections within a
single reach. When this option is selected, a window will pop up as shown in
Figure 6.34. The user must first select the River and Reach that they would
like to perform the interpolation in. Next the user must select a starting River
Station and an ending River Station for which interpolation will be
performed. The user must also provide the maximum allowable distance
between cross sections. If the main channel distance between two sections is
greater than the user defined maximum allowable, then the program will
interpolate cross sections between these two sections. The program will
interpolate as many cross sections as necessary in order to get the distance
between cross sections below the maximum allowable.

Figure 6.34 Automatic Cross Section Interpolating Within a Reach

Once the user has selected the cross section range and entered the maximum
allowable distance, cross section interpolation is performed by pressing the
Interpolate XS's button. When the program has fmished interpolating the
cross sections, the user can close the window by pressing the Close button.
Once this window is closed, the interpolated cross sections will show up on
the river schematic as light green tic marks. The lighter color is used to
distinguish interpolated cross sections from user-entered data. Interpolated
cross sections can be plotted and edited like any other cross section. The only
difference between interpolated sections and user-defined sections is that
interpolated sections will have an asterisk (*) attached to the ynd of their river
station identifier. This asterisk will show up on all input and output forms,
enabling the user to easily recognize which cross sections are interpolated and
which are user defmed.
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The second type of automatic cross section interpolation, Between 2 XS's,
allows the user to have much greater control over how the interpolation is
performed. When this option is selected, a Cross Section Interpolation
window will appear as shown in Figure 6.35.
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Figure 6.35 Detailed Cross Section Interpolation Window

•

This cross section interpolation window displays only two cross sections at a
time. The user can get to any two cross sections from the River, Reach and
River Station boxes at the top of the window. Interpolated cross section
geometry is based on a string model as graphically depicted in Figure 6.31.
The string model consists of chords that connect the coordinates of the
upstream and downstream cross sections. The cords are classified as master
and minor cords. As shown in Figure 6.35, five master cords are
automatically attached between the two cross sections. These master cords
are attached at the ends of the cross sections, the main channel bank stations,
and the main channel inverts. Minor cords are generated automatically by the
interpolation routines. A minor cord is generated by taking an existing
coordinate in either the upstream or downstream section and establishing a
corresponding coordinate at the opposite cross section by either matching an
existing coordinate or interpolating one. The station value at the opposite
cross section is determined by computing the decimal percent that the known
coordinate represents of the distance between master cords and then applying
that percentage to the opposite cross section master cords. The number of
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minor cords will be equal to the sum of all the coordinates of the upstream
and downstream sections minus the number of master cords. Interpolation at
any point in between the two sections is then based on linear interpolation of
the elevations at the ends of the master and minor cords. Interpolated cross
sections will have station and elevation points equal to the number of major
and minor cords.

This interpolation scheme is used in both of the automated interpolation
options ("Within a Reach" and "Between 2 XS's"). The difference is that the
Between 2 XS's option allows the user to defme additional master cords.
This can provide for a better interpolation, especially when the default of five
major cords produces an inadequate interpolation. An example of an
inadequate interpolation when using the default cords is shown below.

Figure 6.36 Cross Section Interpolation Based on Default Master Cords

As shown in Figure 6.36, the interpolation was adequate for the main channel
and the left overbank area. The interpolation in the right overbank area failed
to connect two geometric features that could be representing a levee or some
other type of high ground. If it is known that these two areas of high ground
should be connected, then the interpolation between these two sections should
be deleted, and additional master cords can be added to connect the two
features. To delete the interpolated sections, press the Del Interp button.
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Master cords are added by pressing the Master Cord button that is located to
the right of the Maximum Di~tance f1.~ld aboy~ the graphic. Once this button
is pressed, any nUlllber ofmaster cords can be drawn in. Master cords are
drawn by placing the mouse pointer over the desired location (on the upper
cross section), then while holding the left mouse button down, drag the mouse
pointer to the desired location of the lower cross section. When the left
mouse button is released, a cord is ~utomatically attached to the closest point
near the pointer. An example ofhow to connect master cords is shown in
Figure 6.37.

/
,I

/

Figure 6.37 Adding Additional Master Cords for Interpolation

User defined master cords can also be deleted. To delete user defined master
cords, press the scissors button to the right of the master cords button. When
this button is pressed, simply move the mouse pointer over a user defined
cord and click the left mouse button to delete the cord.

Once you have drawn in all the master cords that you feel are required, and
entered the maximum distance desired between sections, press the
interpolate button. When the interpolation has finished, the interpolated
cross sections will automatically be drawn onto the graphic for visual
inspection. An example of this is shown in Figure 6.38.
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Figure 6.38 Final Interpolation With Additional Master Cords

As shown in Figure 6.38, the interpolation with the addition ofuser defined
master cords is very reasonable.

In general, the best approach for cross section interpolation is to first
interpolate sections using the "Within a Reach" method. This provides for
fast interpolation at all locations within a reach. The "Within a Reach"
method uses the five default master cords, and is usually very reasonable for
most cross sections. Once this is accomplished, all of the interpolated
sections should be viewed to ensure that a reasonable interpolation was
accomplished in between each of the cross sections. This can be done from
the "Between 2 XS's" window. Whenever the user finds interpolated cross
sections that are not adequate, they should be deleted. A new set of
interpolated cross sections can be developed by adding additional master
cords. This will improve the interpolation.

CAUTION: Automatic geometric cross section interpolation should not be
used as a replacement for required cross section data. If water surface profile
information is required at a specific location, surveyed cross section data
should be provided at that location. It is very easy to use the automatic cross
section interpolation to generate cross sections. But if these cross sections are
not an adequate depiction of the actual geometry, you may be introducing
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error into the calculati()n oftl,le wat~W~UTface profile.' Whenever possible, use
t(}pogr~p~c ,maps to a.:s~'lst you iJ:l((,v~lu~tingwli.e¢~r or not the interpolated
cio~s sdc.#ons '<ire' ad~quate. Also, ot:iCe tbectoss'sections are interpolated,
they can be modified just like any other cross section.

If the geowetry between two surveye~ cross ,sections does not change
linearly, !pen the interpolated cross sections will not adequately depict what is
in the field. When this occurs, the modeler should either get additional
surveyed cross sections, or adjust the interpolated sections to better depict the
information from the topographic map. '

The current version ofHEC-RAS allows the user to model ice-covered
channels. This section of the users manual will describe how to enter the data
describing the ice cover and the ice cover properties. If the ice cover
geometry is known, that is, if the ice cover thickness and roughness are
known throughout the reaches of interest, the user can supply these data and
describe the ice cover directly. If the ice cover results from a wide-river type
jam, HEC-RAS will estimate the jam thickness in reaches where the ice jam
occurs. In this case, the user can supply the material properties of the jam or
use the default values. To find out how to view specific results for a channel
with an ice cover, see Chapter 9 of this User's manual.

Entering and Editing Ice Data

River ice data can be entered in two ways: by using the Add Ice Cover
option under the Options Menu found at the top of the Cross Section Data
,Editor (Figure 6.2), or by using Tables Menu found at the top of the
Geometric Data window (Figure 6.1). Both ways of entering data will be
described below. It is important to remember that at least two cross sections
are required to define the ice cover. A cross section should be placed at the
upstream and downstream ends of each ice-covered reach.

Entering Ice Data at a Cross Section

To enter river ice data the user presses the Cross Section button on the
Geometric Data window (Figure 6.1). Once the cross section button is pressed
the Cross Section Data Editor will appear as shown in Figure 6.2. See the
CROSS SECTION DATA section of the User's Manual, for information on
selecting the appropriate river, reach, and cross section in the Cross Section
Data Editor. Once a cross section with an ice cover has been selected, choose
the "Add ice cover..." option under the Options Menu found at the top of the
Cross Section Data Editor (Figure 6.2). This will open the Ice Cover Editor
(Figure 6.39). All ice data for this cross section can be entered with this
editor.
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Figure 6.39 Ice Cover Editor

Ice Cover Thickness. The ice cover thickness in the left overbank (LOB),
main channel (Channel), and right overbank (ROB), are entered here. If there
is no ice in any of these areas, a thickness of zero should be entered.

Ice Cover Manning's n Values. The Manning's n value of the ice cover in
the left overbank (LOB), main channel (Channel), and right overbank (ROB),
are entered here. If any part of a cross section has a non-zero ice thickness, a
Manning's n value must be supplied.

Ice Cover Specific Gravity. The default value is 0.916. The user can supply
an alternative value here.

Wide River Ice Jam. The boxes under this option are checked if this section
is to be treated as a wide river ice jam. In this case, HEC-RAS will estimate
the jam thickness using the complete ice jam force balance as described in the
Hydraulic Reference Manual. The user can confine the jam to the main
channel or allow the jam to be in the channel and overbank areas by checking
the proper boxes. If the ice cover is confmed to the channel, the overbanks
can have a known ice thickness (including an ice thickness of zero) assigned
to them in the Ice Cover Thickness option. If the Wide River Ice Jam option
is selected, an ice cover thickness must be supplied for the main channel
using the Ice Cover Thickness Option or through the Ice Tables (see below).
This ice cover thickness will be used as the initial estimate of the ice jam
thickness and will also serve as the minimum thickness allowed for the ice
jam at that section. If the jam is allowed in the overbank areas, the channel
and overbanks hydraulic properties will be combined to calculate a single jam
thickness for the channel and overbanks. NOTE: A wide river jam cannot be
selected for an entire river channel. A cross section with fixed ice cover
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geometry must be included at the upstream end and the downstream end of
the wide river ice jam to serve as the boundary conditions for the jam. There
is no limit to the number of separate wide river jams that can exist in a river
network. However, every ice jam must have a cross section with fixed ice
geometry at its upstream and downstream limit. Ice jams can extend through
any number ofjunctions. However, the jam will only be extended between
reaches that have identical reach names.

Internal Friction Angle of the Jam (degrees). This describes the "strength"
of the ice jam as a granular material. The default value is 45_degrees.

Ice Jam Porosity (fraction water filled). This describes the fraction of the
ice jam that is filled with liquid water. The default value is 0.4.

Coefficient Kl (longitudinal to lateral stress in jam). This describes the
ratio of the lateral stress '!lid the longitudinal stress in the jam. It is the
efficiency of the jam in transferring longitudinal stress into lateral stress
against the channel banks. The default value is 0.33

Maximum mean velocity under ice cover. This option limits the maximum
mean velocity under a wide river ice jam. The default value is 5 fps. If the
maximum mean velocity is greater than this, the ice cover will be thinned
until the maximum velocity is attained, or the minimum ice thickness
supplied by the user is reached. In any case, the jam thickness will not be
allowed to be thinner than the user supplied thickness. This option prevents
the jam from thickening to such an extent that the entire cross sectional area
of the channel would bec.ome blocked.

Ice Cohesion. At present, the ice jam cohesion is set to the default value of
zero. This cannot be changed by the user. A value of zero is appropriate for
breakup ice jams.

Fixed Mam;ting's n Value (or Nezhikovsky's data will be used). The
Manning's n value of the ice jam can be specified by the user or estimated
using the empirical relationships developed from Nezhikovsky's data (1964).
The empirical relationships estimate the Manning's n value on the basis of the
jam thickness and the total water depth. The default is the user supplied
Manning's n value.

Once all the ice data have been entered and edited, click the OK button. At
the bottom ofthe Cross Section Data Editor, in the space entitled "List of
special notes for cross section," the words "Ice cover" will now appear. The
user can now click on the words "Ice cover" to return to the ice cover editor
for that cross section.
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Entering Ice Data Through a Table

Ice cover information can also be entered using the Tables Menu found at the
top of the Geometric Data Window (Figure 6.1). To enter data the user selects
the Ice Cover Option under the Tables Menu. All the information that can be
entered under the Ice Cover Editor can also be entered using the Ice Cover
table. It is often very convenient to enter and view data for more than one
cross section at a time (Figure 6.40).

Figure 6.40 Entering ice information using a Table

The user has the option of entering the ice thickness in the left overbank
(LOB ice Thickness), the main channel (Chan ice Thickness), and the right
overbank (ROB ice Thickness); the Manning's n value of the left overbank
ice cover (LOB ice Mann n), the main channel ice cover (Chan ice Mann n),
and the right overbank ice cover (ROB ice Mann n); and the specific gravity
of the ice cover (Ice gravity). The user can also choose if the ice cover in the
main channel is the result of a wide river ice jam (Ice Jam Chan. Note: only y
or n can be entered here), and choose if the overbanks are also included in
the wide river ice jam (Ice Jam OB. Note: only y or n can be entered here).
The user can further select the internal friction angle of the ice jam (Friction
Angle); the porosity of the ice jam (Porosity); the longitudinal to lateral stress
ratio of the ice jam (Stress KI ratio); the maximum allowable under ice flow
velocity (Max Velocity); and if the Manning's n value of the ice jam is fixed,
that is selected by the user, or if the Manning's n value will be determined by
HEC-RAS (Note: only y or n can be entered here).

As in all instances where a Table is used to enter data, in each column the
user has the option of entering one or more values, adding a constant to one
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or more. of the values, multiplying a group ofvalues by a factor, or changing a
group of values to a specific value. Additionally, cut, copy, and paste buttons
are provided to pass data to and from the Windows Clipboard.

Entering Ice Data at Bridges

The influence of ice on the hydraulics of bridges is a relatively unstudied
area. Little is known about the ways in which a wide river ice jam interacts
with the various components of a bridge. The important components of a
bridge that may interact with an ice jam include the piers, low chord,
approaches, and deck. Previous investigations of ice jams in rivers with
bridges have largely ignored their presence, arguing that observed ice jams
did not contact the low steel significantly. Removing the bridge information
for an ice jam study still remains an option. However to allow a user to
efficiently use HEC-RAS with ice and with bridges, three separate options
are provided. These options allow the user to selectively decide at each bridge
whether or not the ice cover can interact with the structure. When modeling
ice at bridges, users should carefully evaluate the results for consistency and
accuracy.

Ice information at bridges is entered using the Bridge/Culvert editor found
under the Geometry editor. Use the options menu in the Bridge/Culvert editor
to select the ice option. This will open a window as shown in Figure 6.41.

Figure 6.41 Entering ice information at bridges

No ice computed in the bridge. In this case no ice calculations will be
preformed at the bridge itself and the ice thickness at the bridge will be
assumed to be zero.

Ice remains constant through the bridge. In this case, the ice thickness at
the cross section immediately upstream of the bridge will be used. If the ice
thickness is calculated as a wide river jam, this thickness will be used.

Dynamic ice jam computed through the bridge. In this case, the wide river
ice jam calculations will be preformed at the bridge cross section. The user
must check for inconsistent results, especially if any part of the ice jam is
above the low chord of the bridge.
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Setting Tolerances for the Ice Jam Calculations

The user can override the default settings for the ice jam calculation
tolerances which are used in the solution of the ice jam force balance
equation. The tolerances are set as multiples of the water surface calculation
tolerance used in the solution of the energy equation, described in the
Simulation Options section of Chapter 7. The user can change the values of
these tolerances by changing the water surface calculation tolerance. The
tolerances are as follows:

Ice thickness calculation tolerance. This tolerance is compared with the
difference between the computed and assumed ice thickness at a cross
section. It is set to ten times the water surface calculation tolerance. Its
default value is b.l ft.

Global ice thickness calculation tolerance. This tolerance is compared with
the difference between the computed ice thickness at each cross section
between successive solutions of the ice jam force balance equation and the
energy equation. It is set to ten times the water surface calculation tolerance.
Its default value is 0.1 ft.

Global water level calculation tolerance. This tolerance is compared with
the difference between the computed water surface elevations at each cross
section between successive solutions of the ice jam force balance equation
and the energy equation. It is set to six times the water surface calculation
tolerance. Its default value is 0.06 ft.

Maximum number of ice jam iterations. This variable defmes the
maximum number of times for successive solutions of the ice jam force
balance equation and the energy equation. It is set to 2.5 times the maximum
number ofiterations. Its default value is 50.
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Viewing and Editing Data Through Tables

Once cross-section data are entered, the user can view and edit certain types
of data in a tabular format. The current version of HEC-RAS allows the user
to view and edit Manning's n or k valqes, cross-section reach lengths,
contract and expansion coefficients, ice cover, cross-section river stationing,
and node names. These options are available from the Tables menu option
on the Geometric Data editor. The following is a description of each option.

Manning's n or k values

It is often desirable to view and edit the Manning's n values or roughness
heights (k values) for several cross sections all at the same time. From the
Geometric Data editor, the user can select Manning's n or k values from
the Tables menu item. Once this option is selected, a window will appear as
shown in Figure 6.42.

As shown in Figure 6.42, the user has the options of selecting either n or k
values to be used as the roughness coefficient, add a constant to one or more
of the n or k values, multiply a group ofn or k values by a factor, or change a
group ofn or k values to a specific value. Additionally, cut, copy, and paste
buttons are provided to pass data to and from the Windows Clipboard.

To add a constant to a group ofn or k values, the user must first highlight the
values that they would like to change. Highlighting is accomplished by
placing the mouse in the upper left cell of the desired cells to highlight, then
press the left mouse button and drag the cursor to the lower left corner of the
desired cells to highlight. When the left mouse button is released, the cells
that are selected will be highlighted (except the first cell). Once the user has
highlighted the desired cells to be modified, press the Add Constant button.
This will bring up a pop up window, which will allow the user to enter a
constant value that will be added to all cells that are highlighted.
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Figure 6.42 Manning's n Data View and Editing Table

To multiply a group of n or k values by a factor, the user fIrst highlights the
desired cells. Once the cells are highlighted, pressing the Multiply by a
Factor button will bring up a pop up window. This window allows the user
to enter a value that will be multiplied by each of the highlighted cells.

To set a group ofn or k values to the same number, the user must first
highlight the values that they would like to change. Once the cells are
highlighted, pressing the Set Values button will bring up a pop up window.
This window will allow the user to enter a specifIc n or k value, which will
replace all of the highlighted values.

The user can also go directly into the table and change any individual values.
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Reach Lengths

The user has the ability to view and edit cross section reach lengths in a
tabular format. This is accomplished by selecting Reach Lengths from the
Tables menu of the Geometric Data editor. OI!ce this option is selected, a
window will appear ~ shown in Figure 6.43. The user has the same editing
features a,s described previously fot the n values table. See the discussion
under Manning's nor k values, in the previous section, for details on how to
edit the data.

440
440
225
225
240

• 240
270
100
Bridge
320 500 580
410 416.5 410
410 416.5 410
310 355 340
310 355 340
0 0 0

Figure 6.43 Reach Lengths View and Editing Table

Contraction and Expansion Coefficients

•

The user has the ability to view and edit contraction and expansion
coefficients in a tabular format. This is accomplished by selecting
Coefficients from the Tables menu of the Geometric Data editor. Once this
option is selected, a window will appear as shown in Figure 6.44. The user
has the same editing features as described previously for the n values table.
See the discussion under Manning's n values, in the previous section, for
details on how to edit the data.
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Figure 6.44 Contraction and Expansion Coefficients Table

River Stationing

This option allows the user to view and edit the cross section river stationing
in a tabular form. This is accomplished by selecting River Stations from the
Tables menu of the Geometric Data editor. Once this option is selected, a
window will appear as shown in Figure 6.45. This table allows the user to
change the river stationing of individual cross sections, add a constant value
to the river stationing of selected cross sections (those cross sections
highlighted by the user), multiply the selected cross sections river stationing
by a factor, or to renumber the cross section river stationing based on the
main channel reach lengths.

Ice Cover

This option allows the user to enter ice cover data in a tabular form. A
detailed discussion of ice cover information was presented earlier in this
chapter.
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Figure 6.45 Cross Section River Stationing View and Editing Table

Node Names

This option allows the user to add an additional name to a node (a node is a
cross section, bridge, culvert, weir/spillway, etc ... ). The name can be up to
16 characters long. The user can request that the name be displayed on a
profile plot or on a cross-section plot. To use this feature, select Node
Names from the Tables menu. When this option is selected a window will
appear as shown in Figure 6-46. Enter any text name that you want at a
desired location within the model.
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Figure 6.46 Node Name Table Editor

Bridge Width Table

This option allows the user to view andlor modify bridge width and distance
data. Previous versions ofHEC-RAS (versions 2.21 and earlier) allowed the
user to enter a zero length between the cross sections inside of a bridge and
the cross sections just outside of the bridge. This creates and unrealistic
water surface profile in the vicinity of the bridge. Current versions require
the user to maintain some distance between the outside cross sections and the
bridg~ structure. This table was added to make the process of modifying old
data sets less painful. When this option is selected, a window will appear as
shown in Figure 6-47. As shown in Figure 6-47, the user is given the length
between the cross sections that bound the bridge, the distance between the
upstream cross section and the bridge, the bridge width, and the distance
between the downstream cross section and the bridge. The user must ensure
that the upstream and downstream distances are greater than zero. This will
require entering an upstream distance, and then changing the bridge width to
allow for a positive downstream distance.
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Figure 6.47 Bridge Width and Distance Table

Importing Geometric Data

HEC-RAS has the ability to import geometric data in several different
formats. These formats include: a GIS format (developed at HEC); the
USACE Standard Surveyor format; HEC-2 data format; HEC-RAS data
format; UNET geometric data format; and the MIKE11 cross section data
format. Data can be imported into an existing HEC-RAS geometry file or for
a completely new geometry file. Multiple data files can be imported into the
same geometric data file on a reach-by-reach basis.

To import data into an HEC-RAS geometric data file, the user selects the
Import Geometric Data option from the File menu of the Geometric Data
window. Once this option is select~d, the user then selects one of the three
available formats from the list. After a format is selected, the user will be
asked if they want to add the data to the current geometry file, or if they want
to clear the current geometry file before importing the data. Once this choice
i·s made, the user will be prompted to enter the name of the file containing the
data. The following is a discussion of each of the three file formats.

GIS Format

A file format for interfacing HEC-RAS with GIS/CADD systems has been
developed at HEC. A detailed description of the file format is contained in
Appendix B of this manual. Chapter 13 of this manual provides detailed
discussions on how to import GIS/CADD data into HEC-RAS, as well as
how to export computed water surface profiles back to GIS/CADD systems.
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USACE Survey Data Format

The U.S. Army Corps of Engineers (USACE) has developed a standard file
format for survey data. This format is documented in Chapter 6 of
Engineering Manual (EM) 1110-1-1005. The USACE survey format
encompasses a wide range of data types. The current version of HEC-RAS
has the capability to read this file format, but only cross section data are

.extracted from the file. At this time all other data are ignored.

HEC-2 Data Format

The HEC-2 program was the predecessor to the HEC-RAS software package.
The HEC-2 program was used for many years to compute steady flow water
surface profiles. Consequently, thousands of data sets exist in the HEC-2
data format. HEC-RAS has two ways of importing ,HEC-2 data. The fust
way is accomplished through the use of the Import HEC-2 Data option from
the File menu on the main HEC-RAS window. When this method is used, it
is assumed that the user has started a new project; and therefore all of the
HEC-2 data is imported (geometric data, flow data, and plan information). A
second way of importing HEC-2 data is provided from the geometric data
editor. This way of importing HEC-2 data allows the user to bring the data
into existing HEC-RAS geometric data files. This method also allows the
user to import multiple HEC-2 data files into the same HEC-RAS geometric
data file. However, when importing HEC-2 data from the geometric data
window, only the geometric data contained in the HEC-2 files will be
imported. All of the other data (flow data and plan information) will be
ignored.

HEC-RAS Data Format

This option allows the user to combine several HEC-RAS geometry files into
a single geometry file. For example, if several pieces of a river system were
developed as separate HEC-RAS models, this option could be used to put
them together into one model.

UNET Geometric Data Format

This option allows the user to import a UNET geometric data file (CSECT
geometry file). UNET is an unsteady flow program developed by Dr. Robert
Barkau. The Corps, as well as many other agencies, has used this software
for many years. UNET models are often very complex, consisting of many
river reaches that can be connected in numerous ways. The HEC-RAS UNET
importer does not have enough information tO,draw the schematic in the
proper manner. The river reaches and storage areas will be connected
correctly, but the user will need to edit the schematic to make it look like the
actual river system.
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MIKE11 Cross-5ection Data

This option allows the user to import cross section data from the MIKEll
program. MIKEll is a ~)lle-dimensional river hydraulics model developed by
the Danish Hydraulic Institute. Users must first export the MIKEll data to a
raw text file. This is an available option from MIKE11. Once the data is in
the text file format, it can be imported into HEC-RAS.

Geometric Data Tools

Several tools are available from the Geometric Data editor to assist you in the
development and editing of data. These tolls consist of: cross section
interpolation; channel modification; graphical cross section editor; reverse
stationing data; set ineffective flow areas to permanent mode; cross section
points filter; fixed sediment elevation; pilot channels; and GIS cut line check.
The cross section interpolation tool has been described previously in this
chapter. Channel modification is described separately in Chapter 13 of this
manual. The following is a short description of each of the tools.

Graphical Cross Section Editor

A graphical cross section editor is available from the Tools menu of the
Geometric Data Editor window. When this option is selected, a window will
appear as shown in Figure 6.48.

The user has the option to move objects (objects are ground points, main
channel bank stations, ineffective flow areas, levees, and blocked
obstructions), delete objects, or add new objects. To move an object, the user
first selects Move Objects from the Options menu. Then move the mouse
pointer over the object that you want to move, press down the left mouse
button, and then move the object. When you are finished moving the object,
simply release the left mouse button and the object will be moved. To delete
an object, first select Delete Objects from the Options menu. Next, move
the mouse pointer over the object that you would like to delete and click the
left mouse button. Whatever object is closest to the mouse pointer will be
deleted. To add an object to the cross section, first select the type of object
you want to add from the available list under the Options menu. Once you
have selected an object type to add, move the mouse pointer to the location
where you would like to add it and click the left mouse button. lfthe object
that you are adding requires more than one point, such as blocked ineffective
flow areas and blocked obstructions, then continue to move the mouse pointer
and click the left mouse button to add the additional points.
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Figure 6.48 Graphical Cross Section Editor

Other available options from the Graphical Cross Section editor are the ability
to zoom in and zoom out, full plot, pan, overlay a grid onto the cross section
plot, and to undo all of the graphical editing. When the Undo Edits option is
selected, the cross section is automatically returned to its original state before
this particular editing session began. However, once this editor is closed, or
if the user selects a different cross section from the editor, it is assumed that
the user is happy with the changes that were made and they are saved in
memory. The data is not saved to the hard disk, so it is still possible to get
the original data back ifneeded.

Reverse Stationing Data

Cross section data should be entered into HEC-RAS from left to right when
looking downstream. This is the assumed direction for all of the cross
sections and other structure data. If you have data that has not been entered
from left to right while looking downstream, this editor will allow you to
reverse the data to the assumed direction. To bring up this editor, select
Reverse Station Data from the Tools menu of the geometric data editor.
When this option is selected a window will appear as shown in Figure 6.49.

6-94



•

•

Chapter 6 Entering and Editing Geometric Data

Figure 6.49 Reverse Cross Section Stationing Editor

As shown in Figure 6.49, you first select the river and reach which contains
the data to be reversed. Then select the particular river stations of the data
that is not in the correct format (left to right looking downstream). Add those
locations to the box on the right side of the editor, by pressing the arrow
button in the middle of the editor. Continue to do this until you have all of
the cross section that you want to reverse the stationing for. Finally, press the
OK button and the data will be reversed.

Set Ineffective Areas to Permanent Mode

The default method for ineffective flows is that the area defined as ineffective
will contain water but have no conveyance (the velocity is assumed to be
zero). This remains true until the water surface reaches a trigger elevation (an
elevation set by the user, as to when the ineffective flow area should become
effective again). Once the water surface is higher than the trigger elevation,
the entire ineffective flow area becomes effective. Water is assumed to be
able to move freely in that area based on the roughness, wetted perimeter and
area of each subsection.

Occasionally you may have a need to have these ineffective flow areas
remain ineffective permanently. The ineffective flow areas can be set to the
permanent mode individually from the cross section editor, or through a table
from the geometric data editor. To bring up the table, select Set Ineffective
Areas to Permanent Mode from the Tools menu of the geometric data
editor. When this option is selected a window will appear as shown in Figure
6.50.
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Figure 6.50 Editor to Set Ineffective Flow Areas to Permanent

The editor for this option allows the user to select the river, reach, and river
stations, of the cross sections in which you want to set the ineffective flow
areas to the permanent mode. Add those locations to the box on the right side
of the editor, by pressing the arrow button in the middle of the editor.
Continue to do this until you have all of the cross section that you want.
Finally, press the OK button and the data will be reversed.

Cross Section Points Filter

This tool allows a user to filter out unnecessary points in cross sections. With
the use of GIS data, cross sections can contain many more points than
actually necessary to describe the terrain. HEC-RAS has a limit of 500 points
in any cross section. Because of this limit, it is occasionally necessary to
filter out points that are not needed. To bring up this editor, select Cross
Section Points Filter from the Tools menu of the geometric data editor.
When this option is selected a window will appear as shown in Figure 6.51.

As shown in Figure 6.51, the editor allows the user to filter points on a cross
section by cross section basis, or for a range of cross sections at one time
(Multiple Locations option tab). To filter a single cross section, the user
selects the river; reach, and river station they want to work on. Then press the
button labeled Filter Points on Selected XS to filter the points.
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Figure 6.51 Cross Section Points Filter Editor

The cross section points filter performs two different types of filtering on
each cross section. The first type is called a Near Points Filter, this method
simple searches for points that are close together. If two points are found to
be within the horizontal and vertical distance tolerance, then the second point
is removed. The second type of filter is a Collinear Points Filter. This filter
searches for points that are in a straight line, or nearly in a straight line. This
filter searches to find three consecutive points that may be in a straight line.
If a line is connected between points one and three, and point two is less than
a predefined tolerance from that line (vertical filter tolerance based on a
distance perpendicular to the line), then the second point is a candidate to be
removed. A second check is done to ensure the slope of the line that connects
point one and two together, is not changing significantly when point one and
three are connected (minimum change in slope tolerance).

Options are available to only filter cross sections that have more than 500
points, as well as to restore a cross section back to the original points before
filtering occurred. .
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Additionally, this editor allows the user to select multiple cross sections and
perform the filter operation on all of them at one. This is done by first
selecting the Multiple Locations tab. Then select the cross sections that you
would like to fIlter. Set the fIlter tolerances to any desired values, and then
press the Filter Points on Selected XS button.

Fixed Sediment Elevations

This option allows the user to fill in portions of cross sections with sediment.
The sediment is assumed to be at a constant elevation in any particular cross
section. To use this option select Fixed Sediment Elevations from the Tools
menu of the'geometric data editor. When this option is selected, a window
will appear as sho~n in Figure 6.52.
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Figure 6.52 Fixed Sediment Elevation Editor

As shown in Figure 6.52, the user selects a particular river and reach to work
on, then a range of cross sections to apply the sediment fill to. There are
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three options for having a sediment fill over a range of cross sections. The
first option is to enter a sediment elevation at an upstream or downstream
cross section then project the sediment fill on a slope over the range of
selected cross sections. The second option is to set the upstream and
downstream elevations, then allow the program to use linear interpolation for
the cross sections in between. The fmal option is to set the sediment
elevation indivi~~ally on a ~ross-~~G(ion by cross-se9tjon ba~is.

The lower left hand portion of the editor is used to set the sediment values
over a range of sections .. The table on the lower right hand side of the editor
shows the actual values that are applied to each cross section. The user can
change any value in the table directly, or they can highlight a section of
values and use the three buttons above the table to modify the values. These
three buttons allow for adding a constant; multiplying the values by a factor;

or setting all of them to a specific value.

Pilot Channels

Pilot channels are an option that was added for unsteady flow modeling.
Occasionally, when modeling low flows (such as at the beginning or end of a
storm event), the program will go unstable. This instability can occur for
many reasons. The following is a list of some of the main causes for
instabilities at low flows:

1. At low flows the depths are very small. As the floodwave begins to
come into the reach, the depths change dramatically percentage wise.
Unsteady flow models us derivatives that are based on the change in
depth with respect to time and distance. lfthe depth changes
significantlyd~g any time step, the derivatives can become very
large, and oscillations will occur. These oscillations can grow to the
point at which the solution becomes unstable.

2. Also during low flows, it is mucp more likely that your river may be
flowing in a pool and riffle sequence. At the riflles, th~ flow may be
passing through critical depth and going supercritical. The current
version of the unsteady flow solver in HEC-RAS carmot handle
supercritical flow, or even flows going down to critical depth. This
again causes instabilities in the solution, and may eventually cause the
solution to go unstable.

Pilot channels are one of the available options to help prevent the model from
going unstable. A pilot channel cuts a rectangular notch into the bottom of
the cross section. Generally this notch is not very wide (often 1 ft is used),
but it provides depth to the cross section at low flows (typically make it 5 to
10 feet deep). Additionally, the use of a pilot charinelcan smooth-out
irregularities in the channel bottom. This also helps the stability of the model
solution. The pilot channel area and conveyance are barrowed from the lower
portion of the main channel, such that the total area and conveyance
properties of the cross section relate to the original cross section at higher
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flows. In other words, one the depth of flow gets higher, the area and
conveyance of the pilot channel are ignored. To use the pilot channel option,
select Pilot Channel from the Tools menu of the geometric data editor.
When the pilot channel option is selected a window will appear as shown in
Figure 6.53.
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Figure 6.53 Pilot Channel Editor

As shown in Figure 6.53, the user selects a river, reach, and range of river
stations to apply the pilot channel too. On the lower left hand side of the
form are some utilities to enter the pilot channel information. The user enters
the pilot channel width (typically the width should be narrow), and the
Manning's n value (should be equal to or higher than the main channel n
value). The user can either enter an elevation for the invert of the pilot
channel and project it on a slope over the range of cross sections, or they can
enter an upstream and a downstream invert elevation and have the program
use linear interpolation for the cross sections in between. A list of the fmal
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pilot channel values for each of the cross sections is shown in the table on the
lower right hand side of the editor. The user can modify the table directly and
change any value on a cross section-by-cross section basis. The profile plot
on the editor will display the invert elevation of the pilot so you can compare
it to the actual channel invert. Once you have finished adding the pilot
channel information, press the OK button, and then save the geometric data.

GIS Cut Line Check

This tool is used when working with cross section data that has been geo
referenced. Geo-referencing a cross section consists of entering coordinates
for the end points and internal vertices of the cross section (If a cross section
that is drawn as a straight line it will only have two points to reference. A
cross section that is drawn as a series of straight lines will have two end
points plus some internal vertices.). To use this tool, select GIS Cut Line
Check from the Tools menu of the geometric data editor. When this option is
selected, a window will appear as shown in Figure 6.54.

Figure 6.54 GIS Cut Line Check Editor

This tool checks to see if the actual length of the cross section and the length
along the cross-section cut line match. If the two lengths are different, you
will need to adjust the coordinates of the cross-section cut line. The editor
shows the length of the cross section cut line, the length of the actual cross
section, and the ratio of those two lengths. The cross-section cut line can be
adjusted automatically from this editor. The cross-section cut line can be
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made longer or shorter, and you can adjust it at either end or both ends. The
adjustment is made using a linear projection from the ends of the cross
section cut line..

Attaching and Viewing Pictures

The user can attach a picture to any cross section or hydraulic structure
(bridge, culvert, etc.). Once pictures are attached, they can be viewed from a
picture viewer within the HEC-RAS geometric data editor. The picture
viewer supports the following graphics formats: bit map (*.bmp); icon
(*.ico); windows metafile (*.wmf); GIF (*.gif); and JPEG (*.jpg).

Pictures are attached to cross sections or hydraulic structures from within the
picture viewer. To bring up the picture viewer, go to the geometric data
editor and click on the View Picture button with the left mouse button. An
editor will appear as shown in Figure 6.55. To attach a picture to a particular
river station, first select the River, Reach, and River Station in which you
would like to attach the picture. Next select the Add Picture button, and a
file selection box will appear allowing you to select a graphics file to attach to
the selected location. If the picture file is not in the same location as your
data files, you can select the drive and path of the picture from within the file
selection box. Once a graphic file is located and selected, press the Open
button to atta<;:h it to the selected location. The picture should automatically
show up inside of the picture viewer. An example picture is shown in Figure
6.56. Additional pIctures can be added by selecting a different location, then
select the Add Picture button to attach the picture. Only one picture can be
attached to a model object.
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Figllre 6.~55 HEC-RAS Picture Viewer

Once pictures are attached to the viewer, the user can move to different
pictures by using the up and down arrow buttons, or selecting a specific river
stationing that has a picture attached to it. Options are available to zoom in,
zoom out, remove pictures, and to resize the picture to fit within the size of
the picture viewer window. The user can resize the picture viewer to
whatever size they want. However, if you are viewing a bitmap picture, and
you make the window larger than the actual picture resolution, the photo will
begin to distort.

Once pictures are attached to the geometry file, a small red square will be
displayed on the river system schematic at each location where a picture
exists. When the user clicks the left mouse button over a cross section, a pop
up menu will appear. If that particular cross section has a picture attached to
it, one of the menu options will be to view the picture. Selecting the View
Picture option from the pop up menu will bring up the picture viewer and
automatically load that particular picture.

The pictures are stored as part of the geometry data (not the actual picture, but
its location on the hard disk). In general, it is a good idea to keep the picture
files in the same directory as your project data files. This will make it easier
to keep track of all the files associated with a particular project.
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Figure 6.56 Picture Viewer with Example Bit Map Photo

Saving the Geometric Data

To save the geometric data, use the Save Geometry Data As option from the
File menu of the Geometric Data window. When this option is selected, the
user is prompted to enter a title for the geometric data. Once you have
entered the title, press the OK button and the data will be saved to the hard
disk. If the geometric data have been saved before (and therefore a title has
already been entered), then it is only necessary to select the Save Geometry
Data option. When this option is selected, the geometry data are saved with
the previously defined title.

In general, it is a good idea to periodically save your data as you are entering
them. This will prevent the loss of large amounts of information in the event
of a power failure, or if a program error occurs in the HEC-RAS user
interface.
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State Standard Workgroup
Training Course

Floodplain Issues in Transportation Design

Draft Scope of Work

Background/Purpose

The objective of this project is to develop a training manual and materials, and instructor

presentation materials, that will be used to provide guidance to the transportation

engineer for the proper application of existing rules, regulations, and engineering

practices for the design of transportation facilities that encroach in floodplains. It is not

intended to cover transportation drainage topics not associated with floodplains.

1. General Requirements

1.1 The contractor shall provide qualified individuals to provide research,

evaluation and consulting services to the State Agency.

1.2 The contractor agrees and understands that the contract shall be construed as an

exclusive arrangement and further agrees that the State Agency may secure

identical and/or similar services from other sources at any time in conjunction

with, or in replacement of the contractor's services.

2. Specific Requirements:

2.1.1 The contractor shall have a thorough understanding of applicable federal and

state laws and regulations governing the design and construction of

transportation facilities as they relate to floodplains. The contractor shall have

knowledge and expertise in the application of existing transportation drainage

standards from ADOT, FHWA and FEMA, including the publication

"Highways in the River Environment". The contractor shall collect and

review transportation drainage standards from other agencies, locally and

nationally.



2.1.2 The contractor shall attend a kick-off meeting with the SSWG, within 30 days

ofNTP.

2.1.3 The contractor is expected to attend monthly meetings with the SSWG

throughout the project to deliver and discuss submittals, and to receive review

comments and input from the SSWG.

2.1.4 The contractor shall prepare an outline of the topics to be covered in the

training manual. The topics shall include:

1. Floodplain terms and definitions.

2. Overview of existing federal and state regulations governing

transportation facilities in floodplains.

3. Information on the National Flood Insurance Act.

4. Information on NFIP technical and program rules.

5. Environmental permitting considerations and references.

6. Design Standards to be used, including references to

appropriate State Standards.

7. Acceptable computer models.

8. Location hydraulic studies (A term from 23 CFR, risks and

impacts).

9. Content of Design Studies, including checklists for the

designer.

10. Typical problems associated with transportation encroachments

in floodplains.

11. Guidance for good design practices in placing transportation

facilities in floodplains.

12. Levee systems.

13. Effects of scour and sediment transport on bridge safety and

capacity.

14. Coordination with local floodplain jurisdictions.

15. Coordination with FEMA.

16. Map revision process, including required documentation and

problems in processing.
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17. Three unique illustrated examples of well-designed

transportation encroachment projects with discussion,

including longitudinal as well as transverse encroachments.

The above list can be added to and rearranged by the contractor, subject to State

Standards Work Group approval.

2.15 Deliverable: The contractor shall provide six copies of the draft outline of the

training manual and materials to the State Standards Work Group for their review

and approval. The draft outline shall be delivered within 30 days of the kickoff

meeting.

2.16 The contractor will finalize the outline after incorporating comments received from

the SSWG into the draft.

2.17 Deliverable: Six copies of the final outline shall be submitted, along with a

schedule that shows the submittal dates for each of the sections. The overall

schedule for completion of all sections shall not exceed 270 days, including 90 days

for review by the SSWG. /'

2.18 The contractor shall deliver per the schedule established in 2.17, the text and

graphics for the training manual and materials. The contractor shall also develop

and submit a Powerpoint presentation suitable for use by a course instructor.

2.19 SSWG review and approval.

2.20 Public review process, including transportation agencies.

2.21 AFMA review.

2.22 Final training manual and materials in WP format, and in Adobe Acrobat format. A

copy of presentation materials to be used by a course instructor shall be provided in

Powerpoint format.
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Performing a Steady Flow Analysis

This chapter discusses how to calculate stea~y flow water surface profiles.
The chapter is divided into two paIis. The first partdisc~sses how to enter
steady flow data and bound;uy conditions. The second part discusses how to
develop a plan and perform the calculations.

Contents

• Entering and Editing Steady Flow Data

• Perfonning Steady Flow Calculations

Entering and Editing Steady Flow Data

Once all of the geometric data are entered, the modeler can then enter any
steady flow data that are required. To bring up the steady flow data editor,
select Steady Flow Data from the Edit menu on the HEC-RAS main
window. The steady flow data editor should appear as shown in Figure 7.1

Steady Flow Data

The user is required to enter the following infonnation: the number of profiles
to be calculated; the peak flow data (at least one flow for every river reach
and every profile); and any required boundary conditions. The user should
enter the number ofprofiles first. The next step is to enter the flow data.
Flow data are entered directly into the table. Use the mouse pointer to select
the box in which to enter the flow then type in the desired value.

Flow data are entered from upstream to downstream for each reach. At least
one flow value must be entered for each reach in the river system. Once a
flow value is entered at the upstream end of a reach, it is assumed that the
flow remains constant until another flow value is encountered within the
reach. The flow data can be changed at any cross section within a reach. To
add a flow change location to the table, first select the reach in which you
would like to change the flow (from the river and reach boxes above the
table). Next, select the River Station location for which you want to enter a
flow change. Then press the Add Flow Change Location button. The new
flow change location will appear in the table.
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Figure 7.1 Steady Flow Data Editor

Each profile is automatically assigned a title based on the profile number,
such as profile #1 is assigned a title of "Prof # l," profile #2 is assigned a title
of "Prof #2," etc. The user can rename the title for each profile by simply
going into the options menu and selecting Edit ProfIle Names. Once this
option is selected, a dialog will appear allowing you to rename each of the
profile titles.

Boundary Conditions

After all of the flow data have been entered into the table, the next step is to
enter any boundary conditions that may be required. to enter boundary
conditions data, press the Boundary Conditions button at the top right of the
steady flow data editor. The boundary conditions editor should appear as
shown in Figure 7.2.

Boundary conditions are necessary to establish the starting water surface at
the ends of the river system (upstream and downstream). A starting water
surface is necessary in order for the program to begin the calculations. In a
subcritical flow regime, boundary conditions are only necessary at the
downstream ends of the river system. If a supercritical flow regime is going
to be calculated, boundary conditions are only necessary at the upstream ends
of the river system. If a mixed flow regime calculation is going to be made,
then boundary conditions must be entered at all ends of the river system.
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Figure 7.2 Steady Flow Boundary Conditions Editor

The boundary conditions editor contains a table listing every reach. Each
reach has an upstream and a downstream boundary condition. Connections to
junctions are considered internal boundary conditions. Internal boundary
conditions are automatically listed in the table, based on how the river system
was defined in the geometric data editor. The user is only required to enter
the necessary external boundary conditions.

To enter a boundary condition, first use the mouse pointer to select the cell
location in which you would like to enter a boundary condition. Then select
the type ofboundary condition from the four available types listed above the
table. The four types ofboundary conditions consist of:

Known Water Surface Elevations - For this boundary condition the user
must enter a known water surface for each of the profiles to be computed.

Critical Depth - When this type ofboundary condition is selected, the user is
not required to enter any further information. The program will calculate
critical depth for each of the profiles and use that as the boundary condition.

Normal Depth - For this type ofboundary condition, the user is required to
enter an energy slope that will be used in calculating normal depth
(Manning's equation) at that location. A normal depth will be calculated for
each profile based on the user-entered slope. If the energy slope is unknown,
the user could approximate it by entering either the slope of the water surface
of the slope of the channel bottom.

fj(-

Rating Curve - When this type ofboundary condition is selected, a pop up
window appears allowing the user to enter an elevation versus flow rating
curve. For each profile, the elevation is interpolated from the rating curve
given the flow.
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An additioll~l feature of the boundary condition editor is that the user can
specify a different type of boundary condition for each profile at the same
location. This is accomplished by first selectingthe option 'that says "Set
boundary for one profile at a time>" aHhe top of the window. When this
option is selected, the table will expand out ~o provide a row for each profile,
at every location. The user can then select the location and profile for which
they would like to change the boundary condition type.

Once all the boundary conditions data are entered, press the OK button to
return to the steady flow data editor. Press the Apply Data button to have the
data accepted.

Steady Flow Data Options

Several options are available from the steady flow data editor to assist users
in entering the data. These features can be found under the Options menu at
the top of the window. The following options are available:

Undo Editing. This option allows the user to retrieve the data back to the
form that it was in the last time the Apply Data button was pressed, Each
time the Apply Data button is pressed, the Undo Editing feature is reset to the
current information.

Delete Row From Table. This option allows the user to delete a row from
the flow data table. To use this option, first select the row to be deleted with
the mouse pointer. Then select Delete Row From Table from the options
menu. The row will be deleted and all rows below it will move up one.

Delete Column (Profile) From Table. This option allows the user to delete
a specific column (profile) of data from the table. To use this option, first
select the column that you want to delete by placing the mouse over any cell
of that column and clicking the left mouse button. Then select Delete
Column (Profile) From Table from the Options menus. The desired
column will then be deleted.

Ratio Selected Flows. This option allows the user to multiply selected
values in the table by a factor. Using the mouse pointer, hold down the left
mouse button and highlight the cells that you would like to change by a
factor. Next, select Ratio Selected Flows from the options menu. A pop up
window will appear allowing you to enter a factor to multiply the flows by.
Once you press the OK button, the highlighted cells will be updated with the
new values.

Edit Profile Names. This option allows the user to change the profile names
from the defaults ofPF#l, PF#2, etc.

Set Changes in WS and EG. This option allows the user to set specific
changes in the water surface and energy between any two cross sections in the
model. The changes in water surface and energy can be set for a specific
profile in a multiple profile model. When this option is selected, a window
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will appear as shown in Figure 7.3. As shown, there are four options that the
user can select from: Additional EG, Change in EG, Known WS, and
Change in WS. The Additional EG option allows the user to add an
additional energy loss between two cross sections. This energy loss will be
used in the energy balance equation in addition to the normal friction and
contraction and expansion losses. The Change in EG option allows the user
to set a specific amount of energy loss between two cross sections. When this
option is selected, the program does not perform an energy balance, it simply
adds the specified energy loss to the energy of the downstream section and
computes a corresponding water surface. The Known WS option allows the
user to set a water surface'at a specitic cross I)ection for a specific profile.
During the computations, the program will not compute a water surface
elevation for any cross section where a known water surface elevation has
been entered. The program will use the known water surface elevation and
then move to the next s'ection. The Change in WS option allows the user to
force ~~pecific change in th~ wat~r surfa~e elevation between two cross
sections. When this option is selected, the progra~ Jidds the user specified
change in water surface to the downstream cross section, and then calculates a
corresponding energy to match the new water surface.

Figure 7.3 Setting Changes in Water Surface and Energy

As shown in Figure 7.3, to use the "Set Internal Changes in WS and EG"
option, the user first selects the river, reach, river station, and profile that they
would like to add an internal change too. Once the user has established a
location and profile, the next step is to select one of the four available options
by pressing the appropriate button. Once one of the four buttons are pressed,
a row will be added to the table at the bottom, and the user can then enter a
number in the value column, which represents the magnitude of the internal
change.
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Observed WS. This option allows the user to enter observed water surfaces
at any cross section for any ofthe computed profiles. The observed water
surfaces can be displayed on the profile plots and in the summary output
tables.

Inline Spillway Gate Openings. This option allows the user to control gate
openings for any inline gated spillways that have been added to the geometric
data. When this option is selected, a window will appear as shown in
Figure 7.4.

Figure 7.4 Inline Spillway Gated Openings Editor

As shown in Figure 7.4, for each profile the user can specify how many gates
are opened, per gate group, and at what elevation they are opened too. For the
example shown in Figure 7.4,there are 'three gate groups'labeled "Left
Group," "Center Group," and "Right Group." Each gate group has five
identtcal gate openings. All of the gate.ope,nings have a maximum opening
height often fc:;et. For profile n~mber 1, only the middle gate group is
opened, with all five gates opened to a height of five feet. For the second
profile, all three gate groups are opened. The Left gate group has two gates
opened to seven feet, the Center gate group has five gates opened to four feet,
and the Right gate group has two gates opened for seven feet. This type of
information must be entered for all of the profiles being computed.

Initial Lateral Split Flow Values. This option allows the user to enter initial
estimates of the flow that is leaving the main river through a lateral
weir/spillway. Flow values can be entered for each profile. When a value is
entered for this option, that amount of flow is subtracted from the main river
before the first profile is computed. This option can be useful in reducing the
required computation time, or allowing the program to reach a solution that
may not otherwise been obtainable.
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Storage Area Elevations. This option allows the user to enter water surface
elevations for storage areas that have been entered into the geometric data.
Storage areas are most often used in unsteady flow modeling, but they may
also be part of a steady flow model When using storage areas within a
steady flow analysis, the user is requires to enter a water surface elevation for
each profile.

Saving The Steady Flow Data

The last step in developing the steady flow data is to save the information to a
file. To save the data, select the Save Flow Data As from the File menu on
the steady f!.ow data editor. A pop up window will appear prompting you to
enter a title for the data.

Importing Data From The HEC Data Storage System
(H,EC-DSS)

HEC-DSS is a data base system that was specifically designeq to store data
for applications in water resources. 1'he HEC-DSS system can store almost
any type of data, but it is most efficient at storing large blocks of data (e.g.,
time-series data). These blocks of data are stored as records in HEC-DSS,'
and each record is given a unique name called a "pathname." A pathname
can be up to 391 c4(lra~ters long and, by convention, is separated into six
parts. The parts are, referenced by the letters A, B, C, D, E, andF', and are
delimited by a slash "I" as follows:

IA/B/C/D/E/FI

The pathname is used to describe the data in enough detail that various
application programs can write to and read data from HEC~D,~"§ by sU:qply
knowing the pathname. For more information about HEC-IYSS; the user is
referred to the "HEC-DSS, User's Guide and Utility Manuals" (HEC, 1995).

Many of the HEC application programs have the ability to read from and
write to the HEC-DSS. This capability facilitates the use of observed data as
well as passing information between software programs. The ability to read
data from HEC-DSS has been added to HEC-RAS in order to extract flow
and stage data for use in water surface profile calculations. It is a common
practice to use a hydrologic model (Le., HEC-HMS) to compute the runoff
from a watershed and then use HEC-RAS to compute the resulting water
surface profiles.

Reading data from HEC-DSS into HEC-RAS is a two-step process. First, the
user must establish connections between HEC-RAS cross-section locations
and pathnames contained in the HEC-DSS file. These connections are
established by selecting the "Set Locations for DSS Connections" option
from the File menu of the Steady Flow Data editor. When this option is
selected, a wind9w will appear as shown in Figure 7.5. The user selects
cross-section locationsfor DSS connections by selecting a River, Reach, and

7-7



Chaoter 7 Performing a Steady Row Analysis

River Station, then pressing the "Add selected location to table" button.
When this button is pressed, a new row will be added to the table at the top of
the window. The user should do this for all the locations where they want to
establish connections to HEC-DSS data.

The next step is to open a particular HEC-DSS file. The user has the option
of either typing the filename in directly, or using the open button, which is
right next to the filename field. Once a DSS file is selected, a listing of the
pathnames for all of the data contained in that file Will appear in the table at
the bottom of the window. The user can establish connections to more than
one DSS file if desired.

Figure 7.5 Editor for setting connections to HEC-DSS pathnames.

To establish the connection between an HEC-RAS cross section and a
particular pathname in the DSS file, the user selects the row in the upper table
that contains the river station that they want to connect data to. Next, they
select the pathname that they want to connect to that river station from the
lower table. Finally, they press the button labeled "Select DSS Pathname,"
and the pathname is added to the table at the top of the window.

To make it easier to find the desired pathnames, a set ofpathname part filters
were added to the top row of the lower table. These filters contain a list of all
the DSS pathname parts contained within the currently opened DSS file. If
the user selects a particular item within the list of one of the pathname parts,
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then only the pathnames that contain that particular pathname part will be
displayed. These filters can be used in combination to further reduce the list
of pathnames displayed in the table. When a particular filter is left blank, that
means that pathname part is not being filtered.

Another feature on the editor to assist in selecting the appropriate pathnames
is the "Plot Selected Pathname" button. This button allows the user to get a
plot or a table of the data contained within any record in the DSS file. The
user simply selects a DSS pathname, and then presses the Plot Selected
Pathname button, and a new window will appear with a graphic of the data
contained within that record.

Once all of the pathname connections are set, the user presses the OK button
to close the editor. The next step is to import the data. This is accomplished
by selecting "DSS Import" from the File menu of the Steady Flow Data
editor. When this option is selected, a window will appear as shown in
Figure 7.6

Figure 7.6 DSS Data Import Window

First the user sets a time window, which consists of a starting date and time
and an ending date and time. When data are extracted from DSS, the
program will only look at the data that is contained within the user specified
time window.

Below the time window there are two options for selecting flow data to be
extracted from the DSS file. The first option allows the user to pick off flow
data at a specified time interval, starting with the beginning of the time
window for the first profile. The second and subsequent profiles would be
based on adding the user specified time interval to the start time of the time
window. Flow data is extracted from the hydrographs at each of the locations
being read from DSS. The second option listed on the window allows the
user to get an overall peak flow for a profile computation. When this option
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is selected, the peak flow will be extracted from each hydrograph, within the
time wipdow specified. These peak flows will be made into the final profile
in the flow data editor.

The bottom portion of the window contains options for interpolating flow
data at locations that do not have hydrographs in the DSS file. After the flow
data are read in, it will be necessary to interpolate flow data at all of the
locations listed in the flow data editor that do not have values in the DSS file.
Three options are available: no interpolation, linear interpolation, or using the
flow data from an existing profile to calculated ratios for interpolating
between points that have data. Once all the options are set, the user presses
the "Import Data" button, to have the data imported and fill out the flow data
editor.

Performing Steady Flow Calculations

Once all of the geometry and steady flow data have been entered, the user can
begin calculating tile steady :Oowwater surface profiles. To perform the
simulations, go to the HEC-RAS main window and select Steady Flow
Analysis from the Run menu. The Steady Flow Analysis window will
appear as in Figure 7.7 (except yours may not have a Plan title and short ill).

Figure 7.7 Steady Flow Analysis window

Defining A Plan

The first step in performing a simulation is to put together a Plan. The Plan
defmes which geometry and flow data are to be used, as well as provide a
description and short identifier for the run. Also included in the plan
information are the selected flow regime and the simulation options.
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Before a Plan is defined, the user should select which geometry and flow data
will be used in the plan. To select a geometry or flow file, press the down
arrow button next to the desired data type. When this button is pressed, a list
will appear displaying all of the available files of that type that are currently
available for the project. Select the geometry and flow files that you want to
use for the current plan.

To establish a Plan, select New Plan from the File menu on the steady flow
analysis window. When New Plan is selected, a window will appear
prompting you to enter a title for the plan. After you enter the title, press the
OK button to close the window and accept the title. The user will also be
prompted to enter a short identifier for the plan. The short identifier is limited
to 12 characters. It is very important to enter a short identifier that is
descriptive of the plan. When viewing multiple plan output from the graphics
and tables, the Short ID will be used to identify each plan.

The last step is to select the desired flow regime for which the model will
perform calculations. The user can select between subcritical, supercritical,
or mixed flow regime calculations.

Saving The Plan Information

To save the Plan information to the hard disk, select Save Plan from the File
menu of the simulation window. Whenever any option is changed or
modified on the Steady Flow Analysis window, the user should Save the
Plan.

Simulation Options

The following is a list of the available simulation options under the Options
menu of the Steady Flow Analysis window:

Encroachments. This option allows the user to perform a floodway
encroachment analysis. For a detailed description of how to use the floodway
encroachment capabilities ofHEC-RAS, see Chapter 9 of the User's Manual
(this manual). For a description of how the encroachment calculations are
performed for the various encroachment methods, see Chapter 9 of the
Hydraulic Reference Manual.

Flow Distribution Locations. This option allows the user to specify
locations in which they would like the program to calculate flow distribution
output. The flow distribution option allows the user to subdivide the left
overbank, main channel, and right overbank, for the purpose of computing
additional hydraulic information.
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As shown in Figure 7.8, the user can specify to compute flow distribution
information for all the cross sections (this is done by using the Global option)
or at specific locations in the model. The number of slices for the flow
distribution computations must be .defined for the left overbank, main
channel, and the right overbank. The user can define up to 45 total slices.
Each flow element (left overbank, main channel, and right overbank) must
have at least one slice. The flow distribution output will be calculated for all
profiles in the plan during the computations.

Figure 7.8 Window for Specifying the Locations of Flow Distribution

To set the flow distribution option for all the cross sections, simply select the
number of slices for the left overbank, main channel, and right overbank from
the Set Global Subsections portion of the window. To set flow distribution
output at specific locations, use the Set Specific Location Subsection
Distribution option.

During the normal profile computations, at each cross section where flow
distribution is requested, the program will calculate the flow, area, wetted
perimeter, percentage of conveyance, and average velocity for each of the
user defined slices. For details on how the flow distribution output is
actually calculated, see Chapter 4 of the HEC-RAS Hydraulic Reference
Manual. For information on viewing the flow distribution output, see Chapter
9 of the User's Manual (this manual).
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Conveyance Calculations. This option allows the user to tell the program
how to calculate conveyance in the overbanks. Two options are available.
The first option, At breaks in n values only, instructs the program to sum
wetted perimeter and area between breaks in n values, and then to calculate
conveyance at these locations. Ifn varies in the overbank the conveyance
values are then summed to get the total overbank conveyance. The second
option, Between every coordinate point (HEC-2 style), calculates wetted
perimeter, area, and conveyance between every coordinate point in the
overbanks. The conveyance values are then summed to get the total left
overbank and right overbank conveyance. These two methods can provide
different answers for conveyance, and therefore different computed water
surfaces. The At breaks in n values only method is the default.

Friction Slope Methods. This option allows the user to select one of four
available friction slope equations, or to allow the program to select the
method based on the flow regime and profile type. The four equations are:

- Average Conveyance (Default)

- Average Friction Slope

- Geometric Mean Friction Slope

- Harmonic Mean Friction Slope

Set Calculation Tolerances. This option allows the user to override the
default settings for the calculation tolerances. These tolerances are used in
the solution of the energy equation. Warning III - Increasing the default
calculation tolerances could result in computational errors in the water
surface profile.. The tolerances are as follows:

Water surface calculation tolerance: This tolerance is used to compare
against the difference between the computed and assumed water surface
elevations. When the difference is less than the tolerance, the program
assumes that it has a valid numerical solution.

Critical depth calculation tolerance: This tolerance is used during the critical
depth solution algorithm.

Maximum number ofiterations: This variable defines the maximum number
of iterations that the program will make when attempting to balance a water
surface.

Maximum difference tolerance: This tolerance is used during the balance of
the energy equation. As the program attempts to balance the energy equation,
the solution with the minimum error (assumed minus computed water
surface) is saved. If the program goes to the maximum number of iterations
without meeting the specified calculation tolerance, the minimum error
solution is checked against the maximum difference tolerance. If the solution
at minimum error is less than this value, then the program uses the minimum
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error solution as the answer, issues a warning statement, and then proceeds
with the calculations. If the solution at minimum error is greater than the
maximum difference tolerance, then the program issues a warning and
defaults the solution to critica.l depth. The computations then proceed from
there.

Flow Tolerance Factor: This factor is only used in the bridge and culvert
routines. The factor is used when the program is attempting to balance
between weir flow and flow through the structure. The factor is multiplied by
the total flow. The resultant is then used as a flow tolerance for the balance
of weir flow and flow through the structure.

Maximum Iteration in Split Flow: This variable defmes the maximum
number of iterations that the program will use during the split flow
optimization calculations.

Flow Tolerance Factor in Weir Split Flow: This tolerance is used when
running a split flow optimization with a lateral weir/gated spillway. The split
flow optimization continues to run until the guess of the lateral flow and the
computed value are within a percentage of the total flow. The default value
for this is 2 percent (.02).

Maximum Difference in Junction Split Flow: This tolerance is used during a
split flow optimization at a stream junction. The program continues to
attempt to balance flow splitting from one reach into two until the energy
gradelines of the receiving streams are within the specified tolerance.

Each of these variables has an allowable range and a defau.lt value. The user
is not allowed to enter a value outside of the allowable range.

Critical Depth Output Option. This option allows the user to instruct the
computational program to calculate critical depth at all locations.

Critical Depth Computation Method. This option allows the user to select
between two methods for calculating critical depth. The default method is the
Parabolic Method. This method utilizes a parabolic searching technique to
find the minimum specific energy. This method is very fast, but it is only
capable of finding a single minimum on the energy curve. A second method,
Multiple Critical Depth Search, is capable of finding up to three minimums
on the energy curve. If more than one minimum is found the program selects
the answer with the lowest energy. Very often the program will find
minimum energies at levee breaks and breaks due to ineffective flow settings.
When this occurs, the program will not select these answers as valid critical
depth solutions, unless there is no other answer available. The Multiple
Critical Depth Search routine takes a lot of computation time. Since critical
depth is calcu.lated often, using this method will slow down the computations.
This method should only be used when you feel the program is finding an
incorrect answer for critical depth.
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Split Flow Optimizations. This option allows the user to have the program
optimize the split of flow at lateral weirs/spillways, lateral rating curves, and
stream junctions. When this option is selected, a window will appear as
shown in Figure 7.9. As shown in Figure 7.9, there are two tabs to choose
from. One tab is for Lateral Weirs/Rating Curves, and the other is for
Junctions (stream junctions).

When the Lateral Weir/Rating Curve tab is selected, a table with all of the
lateral weirs/spillways and rating curves defined in the model will be
displayed. To have the program optimize the split of flow between the main
stream and a lateral weir/spillway (or rating curve), the user simply puts a "y'
under the column labeled "Optimize (y/n)." If you do not want a particular
lateral weir/spillway to be optimized, the user would enter "n". For the first
iteration of the flow split optimization, the program assumes that zero flow is
going out of the lateral weir. Once a profile is computed, the program will
then compute flow over the weir/spillway. The program then iteratively
reduces the flow in the main channel, until a balance is reached between the
main river and the lateral weir/spillway. The user has the option to enter an
initial estimate of the flow going out the lateral weir/spillway. This can speed
up the computations, and may allow the program to get to a solution that may
not have otherwise been possible. This option is available by selecting
"Initial Split Flow Values" from the "Options" menu of the Steady Flow
Data editor.

Figure 7.9 Split Flow Optimization Window

When the junction tab is selected, the table will show all of the junctions in
the model that have flow splits. To have the program optimize the split of
flow at a junction, enter a "y" in the optimize column, otherwise enter "n".
Flow optimizations at junctions are performed by computing the water
surface profiles for all of the reaches, then comparing the computed energy
grade lines for the cross sections just downstream of the junction. If the
energy in all the reaches below a junction is not within a specified tolerance
(0.02 feet), then the flow going to each reach is redistributed and the profiles
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View Log File. This option allows the user to view the contents of the log
file. ThdnteFface uses the Winclo,wsWrite-program to accomplish this. It is
up to the user to set an appropriate font in the Write program. If the user sets
a font that uses proportional spacing, the information in the log file will not
lineup'c::orrectly.. Some fontsthatworlcwell are: Line Printer; Courier (8 pt.);
andHelvetica~g-,pt..). Consulty,our Windows,user's manual for information
on how to use the Write program.
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Figure 7.10 Log File Output Level Window

Starting the Computations

Once all of the data have been entered, and a Plan has been defmed, the
steady flow computations can be performed by pressing the Compute button
at the bottom of the steady flow simulation window. Once the compute
button is pressed, a separate window will appear showing you the progress of
the computations. The information that appears in the window is only there
as an indicator of the programs progress during the computations. This
window is not intended to be used for viewing any output. When the
computations have been completed, the user can close the computations
window by clicking the close button at the bottom of the window. If the
computations ended with a message stating "SNET FINISHED
NORMALLY," the user can then begin to review the output.
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CHAPTER 8'

Performing an Unsteady Flow An.ill,y.$is

This chapter shows how to calculate unsteady flow water surface profiles.
The chapter IS divided into two parts~ 'The fITst part explains how to enter
unsteady flow data and boundary conditions. The second part describes how
to develop a plan and perform the calculations.

Contents

• Entepng and Editjng Unsteady Flow Data

• Performing Unsteady Flow Calculations

Entering and Editing Unsteady Flow Data

Once all of the geometric data are entered, the modeler can then enter any
unsteady flow data that are required. To bring up the unsteady flow data
editor, sele.ct Unsteady Flow Data from the Edit menu on the HEC-RAS
main window. The Unsteady flow data editor !)hould appear as shown in
Figure 8.1.

Unsteady Flow Data

The user is required to enter boundary conditions at all of the external
boundaries of the system, as well as any desired internal locations, and set the
initial flow and storage area conditions in the system at the beginning of the
simulation period.

Boundary conditions are entered by fITst selecting the Boundary Conditions
tab from the Unsteady Flow Data Editor. River, Reach, and River Station
locations of the external bounds of the system will automatically be entered
into the table. Boundary conditions are entered by first selecting a cell in the '
table for a particular location, then selecting the boundary condition type that
is desired at that location. Not all boundary condition types are available for
use at all locations. The program will automatically gray-out the boundary
condition types that are not relevant when the user highlights a particular
location in the table. Users can also add locations for entering internal
boundary conditions. To add an additional boundary condition location, select
the desired River, Reach, and River Station, then press the Add a Boundary
Condition Location button.

8-1



·~.l < ",;{,.~., <..:·.~iiULp",i·,,' ;:: ',1> .

Boundary Conditions
I., \ • • . ~_. .~ ;i.i; ;' I '~ .,.

There~[e's~v.el'aldifferent·typesof'houndary\conditions available to the user.
The following is' a short discussioni6f, each, type:

! . '.'

Flow Hydrograph: '
~ .:

8-2

. A flow hydrograph can be used as eithenan;upstream boundary or
!;d.9Wtistream;bpundary'G0ndition,\but·.is:niQsdG~tmllonlyused as an upstream

·,;",.bofutdar;y c;JlIqlti0n:"Wlieo:,the flow liydJro'grapl,i:button is pressed, the
cwiridow'shown:in Eigtme,;8.2 will app~ar-;.,'iAs sho~n,.the user can either read

'\,' the"qata>,froin,ai-IEG-DSS- (HEC D~tar$to1iage:System)fIle, or they can enter
the b,ydrograph:ordinates into a table. Jif. the us~r selects the option to read the
data from DSS, they must press,-the SelectDSS'FPe and Path button. When
this button is pressed a DSS file and pathname selection screen will appear as
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browser button at the top. Once a DSS fIle is selected, a list of all of the DSS
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pathnames within that file will show up in the table. The user can use the
pa,thname}ilte~s to reduce the number qf pathnames shown in the table. The
last step is to select the desired DSS Pat@ameand to clQse the winqQw.

. "; •• :4

Figure 8.2 Example Flow Hydrograph Boundary Condition

The user also has the option of entering a flow hydrograph directly into a
table, as shown in Figure 8.2. The first step is to enter a "Data Time
Interval." Currently the program only supports regular interval time series
data. A list of allowable time intervals is shown in the drop down window of
the data interval list box. To enter data into the table, the user is required to
select either "Use Simulation Time" or "Fixed Start Time." If the user
selects "Use Simulation Time", then the hydrograph that they enter will
always start at the beginning of the simulation time window. The simulation
starting date and time is shown next to this box, but is grayed out. If the user
selects "Fixed Start Time" then the hydrograph is entered starting at a user
specified time and date. Once a starting date and time is selected, the user can
then begin entering the data.
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Figure 8.3 HEC-DSS File and Pathname Selection Screen

An additional option listed on the flow hydrograph boundary condition is to
make this boundary a "Critical Boundary Condition." When you select this
option, the program will monitor the inflow hydrograph to see if a change in
flow rate from one time step to the next is exceeded. If the change in flow
rate does exceed the user entered maximum, the program will automatically
cut the time step in half until the change in flow rate does not exceed the user
specified max.. Large changes in flow can cause instabilities. The use of this
feature can help to keep the solution of the program stable.

Stage Hydrograph:

A stage hydrograph can be used as either an upstream or downstream
boundary condition. The editor for a stage hydrograph is similar to the flow
hydrograph editor (Figure 8.2). The user has the choice of either attaching a
HEC-DSS fIle and pathname or entering the data directly into a table.

Stage and Flow Hydrograph:

The stage and flow hydrograph option can be used together as either an
upstream or downstream boundary condition. The upstream stage and flow
hydrograph is a mixed boundary condition where the stage hydrograph is
inserted as the upstream boundary until the stage hydrograph runs out of data;
at this point the program automatically switches to using the flow hydrograph
as the boundary condition. The end of the stage data is identified by the HEC
DSS missing data code of "-901.0". This type of boundary condition is
primarily used for forecast models where the stage is observed data up to the
time of forecast, and the flow data is a forecasted hydrograph.
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Rating Curve:

The rating curve option can be used as a downstream boundary condition.
The user can either read the rating curve from HEC-DSS or enter it by hand
into the editor. Shown in Figure 8.4 is the editor with data entered into the
table. The downstream rating curve is a single valued relationship, and does
not reflect a loop in the rating, which may occur during an event. This
assumption may cause errors in the vicinity of the rating curve. The errors
become a problem for streams with mild gradients where the slope of the
water surface is not steep enough to dampen the errors over a relatively short
distance. When using a rating curve, make sure that the rating curve is a
sufficient distance downstream of the study area, such that any errors
introduced by the rating curve do not affect the study reach.

Figure 8.4 Example Rating Curve Boundary Condition Editor

Normal Depth:

The Normal Depth option can only be used as a downstream boundary
condition for an open-ended reach. This option uses Manning's equation to
estimate a stage for each computed flow. To use this method the user is
required to enter a friction slope for the reach in the vicinity of the boundary
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condition. The slope of the water surface is often a good estimate of the
friction slope.

As recommended with the rating curve option, when applying this type of
boundary condition you should place it far enough downstream of the study
reach, such that any errors it produces will not affect the results at the study
reach.

Lateral Inflow Hydrograph:

The Lateral Inflow Hydrograph is used as an internal boundary condition.
This option allows the user to bring in flow at a specific point along the
stream. The user attaches this boundary condition to the river station of the
cross section just upstream of where the lateral inflow will come in. The
actual change in flow will not show up until the next cross section
downstream from this inflow hydrograph. The user can either read the
hydrograph from DSS or enter it by hand.

Uniform Lateral Inflow Hydrograph:

The Uniform Lateral Inflow Hydrograph is used as an internal boundary
condition. This option allows the user to bring in a flow hydrograph and
distribute it uniformly along the river reach between two specified cross
sections. The hydrograph for this boundary condition type can be either read
in from DSS, or entered by hand into a table.

Groundwater Interflow:

The Groundwater Interflow option allows the user to identify a reach of river
that will exchange water with a groundwater reservoir. The stage of the
groundwater reservoir is assumed to be independent of the interflow from the
river, and must be entered manually or read from DSS. The groundwater
interflow is similar to a uniform lateral inflow in that the user enters an
upstream and a downstream river station, in which the flow passes back and
forth. The computed flow is proportional to the head between the river and
the groundwater reservoir. The computation of the interflow is based on
Darcy's equation. The user is required to enter Darcy's groundwater loss
coefficient (hydraulic conductivity), as well as a time series of stages for the
groundwater aquifer.

Time Series of Gate Openings:

This option allows the user to enter a time series of gate openings for an inline
gated spillway, lateral gated spillway, or a spillway connecting two storage
areas. The user has the option of reading the data from a DSS me or entering
the data into a table from within the editor. Figure 8.5 shows an example of
the Times Series of Gate Openings editor.

8-6



•

•

•

Chapter 8 Performing a Unsteady Flow Analysis

As shown in Figure 8.5, the user first selects.a gate group, then either attaches
a DSS pathname to that group or enters the data into the table. This is done
for ~ach of the gate groups contained within the partj,cular hydraulic structure.

Figure 8.5 Example Time Series of Gate Openings Editor

Warning: Opening and closing gates to quickly can cause instabilities in
the solution of the unsteady flow equations. If instabilities occur near
gated locations, the user should either reduce the computational time step
and/or reduce the rate at which gates are opened or closed.

Elevation Controlled Gate:

This option allows the user to control the opening and closing of gates based
on the elevation of the water surface upstream of the structure. A gate begins
to open when a user specified elevation is exceeded. The gate opens at a rate
specified by the user. As the water surface goes down, the gate will begin to
close at a user specified elevation. The closing of the gate is at a user
specified rate (feet/min.). The user must also enter a maximum and minimum
gate opening, as well as the initial gate opening. Figure 8.6 shows and
example of this editor.
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Figure 8.6 Elevation Controlled Gate Editor

Internal Observed Stage Hydrograph:

This option allows the user to enter an observed stage hydrograph to be used
as an internal boundary condition just upstream of an inline structure with
gated spillways. The observed stage hydrograph can either be entered into the
editor directly or it can be read from HEC-DSS.

Internal Observed Stage and Flow Hydrograph:

This is a mixed boundary condition where a stage hydrograph is inserted as
the observed boundary until the stage hydrograph runs out of data; afterward
the flow hydrograph is used. The end of data in the stage hydrograph is
identified by the HEC-DSS missing data code, -901.0. The stage and flow
hydrographs can either be entered into a table or can be entered from HEC
DSS. The mixed boundary condition is primarily used for forecast models
where the stage data is observed up to the forecast time and the flow
hydrograph is the flow forecast. This option can only be used at the upstream
cross section of an inline gated spillway structure.

Initial Conditions

In addition to the boundary conditions, the user must establish the initial
conditions of the system at the beginning of the unsteady flow simulation.
Initial conditions consist of flow and stage information at each of the cross
sections, as well as elevations for any storage areas defmed in the system.
Initial conditions are established from within the Unsteady Flow Data editor
by selecting the Initial Conditions tab. After the Initial Conditions tab is
selected, the unsteady flow data editor will appear as shown in Figure 8.7.
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As shown in Figure 8.7, the user has two options for establishing the initial
conditions of the system. The fIrst option is to enter flow data for each reach
and have the program perform a steady flow backwater run to compute the
corresponding stages at each cross section. This option also requires the user
to enter a starting elevation for any storage areas that are part of the system.
This is the most common method for establishing,initial conditions. In the
current version ofHEC-RAS, the user is limited to entering only one flow per
reach, for establishing the initial conditions (i.e. performing the steady flow
backwater).

Figure 8.7 Initial Conditions Editor

A second method is to read in a fIle of stages and flows that was written from
a previous run, which is called a "Restart File". This option is often used
when running a long simulation time that must be divided into shorter periods.
The output from the fIrst period is used as the initial conditions for the next
period, and so on. Additionally, this option may be used when the software is
having stability problems at the very beginning of a run. Occasionally the
model may go unstable at the beginning of a simulation because of bad initial
conditions. When this happens, one way to fIx the problem is to run the
model with all the inflow hydrographs set to a constant flow, and set the
downstream boundaries to a high tailwater condition. Then run the model and
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decrease the tailwater down to a nonnal stage over time (use a stage
hydrograph downstream boundary to do this). Once the tailwater is decreased
to a reasonable value for the constant flow, those conditions can be written out
to a file, and then used as the starting conditions for the unsteady flow run.

Unsteady Flow Data Options

Several options are available from the unsteady flow data editor to assist users
in entering and viewing the data. These features can be found under the
Options menu at the top of the window. The following options are available:

Undo Editing. This option allows the user to retrieve the data back to the
fonn that it was in the last time the Apply Data button was pressed. Each time
the Apply Data button is pressed, the Undo Editing feature is reset to the
current infonnation.

Delete Boundary Condition. This option allows the user to delete a
boundary condition from the table. To use this option, fIrst select the row to
be deleted with the mouse pointer. Then select Delete Boundary Condition
from the options menu. The row will be deleted and all rows below it will
move up one. Only user inserted boundary conditions can be deleted from the
table. If the boundary condition is an open end of the system, the system will
not allow that boundary to be deleted. There must always be some type of
boundary condition at all the open ends of the system.

Observed Data In DSS. This option allows the user to attached observed
data pathnames from a HEC-DSS file to specifIc river stations within the
model. When an observed data pathname is attached to a specifIc river station
location, the user can get a plotof the observed flow or stage hydrograph on
the same plot as the computed flow and stage hydrographs. Additionally the
observed data will show up on profile and cross section plots.

To use this option, the user selects Observed Data In DSS from the Options
menu of the Unsteady Flow Data editor. When this option is selected a
window will appear as shown in Figure 8.8. As shown in the fIgure below,
the user fIrst selects a river, reach, and river station, and then presses the Add
selected location to table button, in order to select a location to attach
observed data to. This should be done for all the locations in which you have
observed data. The next step is to open up the DSS fIle that contains the
observed data. This is accomplished by pressing the open file button, which is
next to the DSS filename fIeld. When a DSS file is selected, a list of the
available pathnames contained in that DSS file will show up in the lower
table. To attach a DSS pathname to a particular river station, fIrst select the
river station row from the upper table. Then select the DSS pathname row
from the lower table. Finally, press the button labeled Select DSS Pathname.
Repeat this process for every location in which you wish to attach observed

data. If you are going to have more than one data type (such as stage and
flow) at a particular river station, you must have to entries in the upper table
for that river station.
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Figure 8.8 Editor for Establishing Locations of Observed Data

Saving The Unsteady Flow Data

The last step in developing the unsteady flow data is to save the information to
a file. To save the data, select the Save Unsteady Flow Data As from the
File menu on the steady flow data editor. A pop-up window will appear
prompting you to enter a title for the data.

Performing Unsteady Flow Calculations

Once all of the geometry and unsteady flow data have been entered, the user
can begin performing the unsteady flow calculations. To run the simulation,
go to the HEC-RAS main window and select Unsteady Flow Analysis from
the Run menu. The Unsteady Flow Analysis window will appear as in Figure
8.9 (except yours may not have a Plan title and short ill).
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Figure 8.9 Unsteady Flow Analysis Window

Defining A Plan

The first step in performing a simulation is to put together a Plan. The Plan
defmes which geometry and unsteady flow data are to be used, as well as
provide a description and short identifier for the run. Also included in the
plan information are the selected programs to be run; simulation time window;
computation settings; and the simulation options.

Before a Plan is defmed, the user should select which geometry and unsteady
flow data will be used in the plan. To select a geometry or unsteady flow file,
press the down arrow button next to the desired data type. When this button is
pressed, a list will appear displaying all of the available files of that type that
are currently available for the project. Select the geometry and unsteady flow
file that you want to use for the current plan.

To establish a Plan, select Save Plan As from the File menu on the Unsteady
Flow Analysis window. When Save Plan As is selected, a window will
appear prompting you to enter a title for the plan. After you enter the title,
press the OK button to close the window and accept the title. The user will
also be prompted to enter a short identifier for the plan. The short identifier is
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limited to 12 characters. It is Vf?ry iwportant to enter a short ,identifier that is
descriptive of the plan. When viewing multiple p1~ outp~t from the graphics
and tables, the Short ill will be used to identify each plan.

Selecting Programs to Run

There are three components used in performing an unsteady flow analysis
within HEC-RAS. These components are: a geometric data pre-processor
(RTAB); the unsteady flow simulator (UNET); and an output post-processor.

Geometric Pre-Processor (HTAB)

The pre-processor is used to process the geometric data into a series of
hydraulic properties tables and rating curves. This is done in order to speed
up the unsteady flow calculations. Instead of calculating hydraulic variables
for each cross-section during each iteration, the progrwn interpolates the
hydraulic variables from the tables. The preprocessor must be executed at
least once, but then only needs to be re-executed if something in the
geometric data has changed.

Cross sections are processed into tables of elevation versus hydraulic
properties of areas, conveyances, and storage. Each table contains a minimum
of 21 points (a zero point at the invert and 20 computed values). The user is
required to set an interval to be used for spacing the points in the cross section
tables. The interval can be the same for all cross sections or it can vary from
cross section to cross section. This interval is very important, in that it will
defme the limits of the table that is built for each cross section. On one hand,
the interval must be large enough to encompass the full range of stages that
may be incurred during the unsteady flow simulations. On the other hand, if
the interval is to large, the tables will not have enough detail to accurately
depict changes in area, conveyance, and storage with respect to elevation.

The interval for the cross section tables is defmed as part of the geometric
data. To set this interval, the u~er selects the HTab Parameters button from
the Geometric Data editor. When this option is selected, a window will
appear as shown in Figure 8.10.
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Figure 8.10 Hydraulic Table Parameters for Cross Sections

As shown in Figure 8.10, the table contains three columns in which the user
can enter information: starting elevation; increment; and Number ofPoints.
The ftrst t~e the user opens this editor all of the columns are automatically
ftlled. The starting elevation columns are automatically ftlled to an elevation
one foot higher than the invert, however, the user can change these values to
whatever they want. The second and third columns are used for the table
increment and the number of points. These two variable will describe the
extent to which the table encompasses the cross section data. A default value
will be set for the increment and the number of points. Normally the
increment will be set to on foot, and the number ofpoints will be set to a value
that will allow the table to extend to the top of the cross section. If this
combination would end up with less than 20 points, then the number of points
is set to 20 and the increment is reduced to get the table to the top of the cross
section. The user can set these values individually for each cross section, or
they can highlight a series of cross sections and use the Set Values button to
enter the value for all of the highlighted sections. Other options are available
to multiply highlighted ftelds by a factor or add a constant to all of them.
Additionally, cut, copy, and paste buttons are available for manipulating the
data.

Hydraulic structures, such as bridges and culverts, are converted into families
of rating curves that describe the structure as a function of tailwater, flow and
headwater. The user can set several parameters that can be used in defming
the curves. To set the parameters for the family of rating curves, the user can
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select the "Htab Parameters" button from the Bridge and Culvert editor or
from the Hydraulic connection editor. .When this button is pressed the
following window will appear:

Figure 8.11 Hydraulic Properties Table for Bridges/Culverts

As shown in Figure 8.11, the user can set the number of points to be computed
on the free-flow rating curve (pmximum of 50 points); the number of
submerged curves to be c0tnputed (maximum of 50); and the number ofpoints
on the submerged curves (maXimum of 20). The default values for these
parameters are 40, 40, and 10 respectively. Additionally, the user can refme
the curves by putting limits on the extents of the curves. This can be
accomplished by entering the head water maximum elevation; tail water
maximum elevation; maximum swell head (difference between the head water
and tailwater); and the maximum possible flow.

Structures that are gated, such as gated spillways, are not converted into
curves because it would require a new family of curves for each possible gate
setting. The hydraulics through gated structures is calculated on the fly during
the unsteady flow calculations. No hydraulic table parameters are required for
gated structures.
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Unsteady Flow Simulation (UNET)

The unsteady flow computations within HEC-RAS are performed by a
modified version of the UNET (Unste~dyNETwork model) program,
developed by Dr. Robert aarkau (Barkau, 1992). The unsteady flow
simulation is actually a three step process. First a program called RDSS (Read
DSS data) runs. This software reads data from a HEC-DSS file and converts
it into the user specif1ed computation interval. Next, the UNET program runs.
This software reads the hydraulic properties tables computed by the

preprocessor, as well as the boundary conditions and flow data from the
interface and the RDSS progratp.. The progr~ then performs the unsteady
flow calculations. The fmal step is a program called TABLE. This software
takes the results from the UNET unsteady flow run and writes them to a HEC
DSS file.

Post-Processor

The Post Processor is used to compute detailed hydraulic information for a set
of user specified time lines during the unsteady flow simulation period. In
general, the UNET program only computes stage and flow hydrographs at
user specified locations. If the Post Processor is not run, then the user will
only be able to view the stage and flow hydrographs and no other output
from HEC-RAS. By running the Post Processor, the user will have all of the
available plots and tables for unsteady flow that HEC-RAS normally produces
for steady flow.

By default, the Post-Processor will compute detailed output for a maximum
stage water surface profile. This profile does not represent any specific
instance in time, but rather represents a profile of the maximum stage that
occurred at each cross section during the entire simulation. This profile is
often useful for getting a quick view of the maximum extent of flooding
during a specific event.

In addition to the maximum water surface profile, the user can request the
software to write out a series of instantaneous profiles at a specific time
interval. This is accomplished from the Computation Settings section of the
Unsteady Flow Analysis window. The user turns on this option by selecting
an interval from the box labeled Detailed Output Interval. The post
processor will then compute detailed output for each of the instantaneous
profiles requested (Note: the post-processor is limited to 500 profiles). When
the unsteady flow program runs, flow and stage water surface profiles are
written to DSS for the entire system, starting with the beginning of the
simulation and then at the user specified time interval for the entire simulation.

When the Post-Processor runs, the program reads from HEC-DSS the
maximum water surface profile (stages and flows) and the instantaneous
profiles. These computed stages and flow are sent to the HEC-RAS steady
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flow computation program SNET. Because the stages are already computed,
the SNET program does not need to calculate a stage, but it does calculate all
of the hydraulic variables that are normally computed. This consists of over
two hundred hydraulic variables that are computed at each cross section for
each flow and stage.

At hydraulic structures such as bridges and culverts, the unsteady flow
program only reports the stage just upstream and downstream of the structure.
During the Post-Processing of the results, the SNET program calculates the

hydraulics of the structures by using the computed tailwater and flow, and
then performing detailed hydraulic structure calculations. This is done so that
the user can see detailed hydraulic information inside of the hydraulic
structures for each of the profiles that are being post processed. However, this
process can produce slightly different results for the upstream headwater
elevation. Occasionally, you may notice a headwater elevation computed
from the post-processor that is higher than the next upstream sections water
surface. This difference is due to the fact that the unsteady flow simulation
uses a pre-computed family of rating curves for the structure during the
unsteady flow calculations. The program uses linear interpolation between the
points of the rating curVes to get the upstream headwater for a given flow and
tailwater. The post-process performs the calculations through the structure
and does not use rating curves (it solves the actual structure equations).

Once the Post-Processor is finished running, the user can view output from all
of the HEC-RAS plots and tables. The maximum water surface profile and
user specified instantaneous profiles can be viewed by selecting Profiles from
the Options menu on each ofthe output windows (tables or plots). The
overall maximum water surface profile will be labeled "Max W.S.", while the
instantaneous profiles are labeled by the date and time. For example, a profile
from January 5, 1999 at 1:00 p.m. would be labeled "05Jan1999 1300".

Simulation Time Window

The user is required to enter a time window that defines the start and end of
the simulation period. The time window requires a starting date and time and
an ending date and time. The date must have a four digit year and can be
entered in either of the two following formats: 05Jan2000 or 01/05/2000.
The time field is entered in military style format (i.e. 1 p.m. is entered as
1300).

8-17



Chapter 8 Performing a Unsteady Flow Analysis

Computation Settings

The Computation Settings area of the Unsteady Flow Analysis window
contains: the computational interval; hydrograph output interval; detailed
output interval; and the name and path of the output DSS file.

The computation interval is used in the unsteady flow calculations. This is
probably one of the most important parameters entered into the model.
Choosing this value should be done with care and consideration as to how it
will affect the simulation. The computation interval should be based on
several factors. First, the interval should be small enough to accurately
describe the rise and fall of the floodwave. A general rule of thumb is to use a
computation interval that is equal to or less than the time of rise of the
floodwave divided by 24. In other words, if the flood wave goes from its base
flow to its peak flow in 24 hours, then the computation interval should be
equal to or less than I hour.

Additional considerations must be made for hydraulic structures, such as
bridges, culverts, weirs, and gated spillways. Within bridges and culverts,
when the flow transitions from unsubmerged to submerged flow, the water
surface can rise abruptly. This quick change in water surface elevation can
cause the solution of the unsteady flow equations to go unstable. One solution
to this problem is to use a very small time step, on the order of I to 5 minutes.
This allows the module to handle the changes in stage in a more gradual

manner. Additionally, when gates are opened or when flow just begins to go
over a weir, the change in stage and flow can be dramatic. Again, these types
of quick changes in stage and flow can cause the solution of the unsteady flow
equations to go unstable. The only solution to this problem is to shorten the
computational time step to a very short interval. This may require the user to
set the value as low as 1 to 5 minutes. The time step should be adjusted to
find the largest value that will still solve the equations accurately. Additional
variables that affect stability are the number of iterations and the Theta
weighting factor. These two variables are discussed under the calculation
tolerances section below.

The Hydrograph Output Interval is used to defme at what interval the
computed stage and flow hydrographs will be written to HEC-DSS. This
interval should be selected to give an adequate number of points to define the
shape of the computed hydrographs without losing information about the peak
or volume of the hydrographs. This interval must be equal to or larger than
the selected computation interval.

The Detailed Output Interval field allows the user to write out profiles of .
water surface elevation and flow at a user specified interval during the
simulation. Profiles are not written for every computational time step because
it would require too much space to store all of the information for most jobs.
Also, when the post-processor is run, the program will compute detailed
hydraulic information for each one of the instantaneous proftles that are
written. This option is turned on by selecting an interval from the drop-down
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box next to the detailed hydrograph output label. The selected interval must
be equal to or greater than the co:wpu4lH.on int~rval. However, it is suggested
that you make this interval fairly large as to reduce the amount of post
processing and storage required for detailed hydraulic output. One example
for selecting this variable would oe, if the time window of the simulation was
set at 72 hours, then one might \\fannO set the instamaneous profiles to an
interval of every 6 hours. This w9u,ld eq).late to 13 profiles being written out
and having detailed hydraulic information computed for them.

The field labeled DSS Output Filename is required before an execution can
be made. The program will always write some results to a HEC-DSS file, so
the user is required to select a path and filename to be used for this
information.

Simulation Options

From the Options menu of the Unsteady Flow Analysis window, the
following options are available: stage and flow output locations; flow
distribution locations; flow roughness factors; seasonal roughness factors;
calculation options and tolerances; output options; checking data before
execution, and viewing the computation log.

Stage and Flow Output Locations. This option allows the user to specify
locations where they want to have hydrographs computed and available for
display. By default, the program sets locations of the first and last cross
section of every reach. To set the locations, the user selects Stage and Flow
Output Locations from the Options menu of the Unsteady Flow Analysis
window. When this option is selected a window will appear as shown in
Figure 8.12.

As shown in Figure 8.12, the user can select individual locations, groups of
cross sections, or entire reaches. Setting these locations is important, in that,
after a simulation is performed the user will only be able to view stage and
flow hydrographs at the selected locations.

Flow Distribution Locations. This option allows the user to specify
locations in which they would like the program to calculate flow distribution
output. The flow distribution option allows the user to subdivide the left
overbank, main channel, and right overbank, for the purpose of computing
additional hydraulic information.
The user can specify to compute flow distribution information for all the cross
sections (this is done by using the Global option) or at specific locations in the
model. The number of slices for the flow distribution computations must be
defined for the left overbank, main channel, and the right overbank. The user
can defme up to 45 total slices. Each flow element (left overbank, main
charmel, and right overbank) must have at least one slice. The flow
distribution output will be calculated for all profiles in the plan during the
computations.
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Figure 8.12 Stage and Flow Hydrograph Output Window

Flow Roughness Factors. This option allows the user to adjust roughness
coefficients with changes in flow. This feature is very useful for calibrating
an unsteady flow model for flows that range from low to high. Roughness
generally decreases with increases flow and depth. This is especially true on
larger river systems. This feature allows the user to adjust the roughness
coefficients up or down in order to get a better match of observed data. To
use this option, select Flow Roughness Factors from the Options menu of
the Unsteady Flow Simulation manager. When this option is selected, a
window will appear as shown in Figure 8.13 .

. As shown in Figure 8.13, the user fIrst selects a river, reach, and a range of
cross sections to apply the factors to. Next a starting flow, flow increment,
and a number of increments is entered. Finally, a roughness factor is entered
into the table for each of the flows. The user can create several sets of these
factors to cover a range of locations within the model. However, one set of
factors cannot overlap with another set of factors. Hence, you can only apply
one set of roughness change factors to any given cross section.
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Figure 8.13 Flow versus Roughness Change Factors Editor

Seasonal Roughness Change Factors. This option allows the user to change
roughness with time of year. This feature is most commonly used on larger
river systems, in which temperature changes can cause changes in bed forms,
which in tum causes changes in roughness. This factor can be applied in
conjunction with the flow roughness change factors. When applying both, the
seasonal roughness factor gets applied last.

To use this option, select Seasonal Roughness Factors from the Options
menu of the Unsteady Flow Simulation manager. When this option is selected
a window will appear as shown in Figure 8.14.

As shown in Figure 8.14, the user ftrst selects a river, reach, and range of river
station to apply the factors to. Next the user enters the day and month in the
Day column, for each time that a new roughness factor will be entered. By
default the program will automatically list the ftrst of each month in this
column. However, the user can change the day to whatever they would like.
The fmal step is to then enter the roughness change factors .
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Figure 8.14 Seasonal Roughness Factors Editor

Calculation Options and Tolerances. This option allows the user to set
some computation options and to override the default settings for the
calculation tolerances. These tolerances are used in the solution of the
momentum equation. Warning III - Increasing the default calculation
tolerances could result in computational errors in the water surface profile.
The tolerances are as follows:

Theta implicit weighting factor: This factor is used in the fInite difference
solution of the unsteady flow equations. The factor ranges between 0.6 and
1.0. A value of 0.6 will give the most accurate solution of the equations, but
is more susceptible to instabilities. A value of 1.0 provides the most stability
in the solution, but may not be as accurate for some data sets. The default
value is set to 1.0. Once the user has the model up and running the way they
want it, they should then experiment with changing theta towards a value of
0.6. If the model remains stable, then a value of 0.6 should be used. In many
cases, you may not see an appreciable difference in the results when changing
theta from 1.0 to 0.6. However, every simulation is different, so you must
experiment with your model to fmd the most appropriate value.
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Water surface calculation tolerance: This tolerance is used to compare
against the difference between the computed and assumed water surface
elevations at cross sections. If the difference is greater than the tolerance, the
program continues to iterate for the current time step. When the difference is
less than the tolerance, the program assumes that it has a valid numerical
solution. The default value is set to 0.02 feet.

Storage area elevation tolerance: This tolerance is used to compare against
the difference between computed and assumed water surface elevations at
storage areas. If the difference is greater than the tolerance, the program
continues to iterate for the current time step. When the difference is less that
the tolerance, the program can go on to the next time step. The default
tolerance for storage areas is set to 0.1 feet.

Maximum number ofiterations: This variable defmes the maximum number
of iterations that the program will make when attempting to solve the unsteady
flow equations to the specified tolerances. The default value is set to 20, and
the allowable range is from 0 to 40.

Maximum number ofwarm-up time steps: Before the dynamic simulation, the
program runs a series of time steps with constant inflows. This is called a
warm-up period. This is done in order to smooth the profJ.1e before allowing
the inflow hydrographs to progress. This helps to make a more stable solution
at the beginning of the simulation. The default number of warm-up time steps
is set to 20. This value ranges from 0 to 40.

Time step during warm-up period: During the warm-up period described in
the previous paragraph, it is sometimes necessary to use a smaller time step
than what will be used during the unsteady flow calculations. The initial
conditions from the backwater analysis uses a flow distribution in the reaches
which is often different than that computed by unsteady flow. This can cause
some instabilities at the beginning of the simulation. The use of a smaller time
step during the warm-up period helps to get through these instabilities. The
default is to leave this field blank, which means to use a time step that is the
same as for the unsteady flow simulation period.

Minimum time step for interpolation: The program has an option to interpolate
between time steps when it fmds a very steep rise in an inflow hydrograph, or
a rapid change in stage at any cross section. This option allows the user to set
a minimum time step to use during interpolation. This prevents the program
from using to small of a time step during time slicing.

Maximum number ofinterpolated time steps: This option defmes the
maximum number of interpolated time steps that the program can use during
time slicing, as described in the previous paragraph.

'Weir flow stability factor: This factor is used to increase the stability of the
numerical solution in and around a weir. This factor varies from 1.0 to 3.0.
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As the value is increased, the solution is more stable but less accurate. A
value of 1.0 is the most accurate, but is susceptible to oscillations in the
computed weir flow. The default value is 1.0. If you observe oscillations in
the computed flow over the weir, you should first check to see if you are using
a small enough computation interval. If the computation interval is
sufficiently small, you should then try increasing this coefficient to see if it
solves the problem.

Spillway flow stability factor: This factor is used to increase the stability of the
numerical solution in and around a gated spillway. This factor varies from 1.0
to 3.0. As the value is increased, the solution is more stable but less accurate.
A value of 1.0 is the most accurate, but is susceptible to oscillations in the
computed spillway flow. The default value is 1.0. Ifyou observe oscillations
in the computed flow over the spillway, you should first check to see if you
are using a small enough computation interval. If the computation interval is
sufficiently small, you should then try increasing this coefficient to see if it
solves the problem.

Weir flow submergence decay exponent: This coefficient is used to stabilize
the solution of flow over a weir for highly submerged weirs. This factor
varies from 0.0 to 2.0. As the headwater and tailwater stages become closer
together, occasionally oscillations in the solution can occur. This exponent
will prevent this from happening. The default value of zero has no effect. As
you increase the coefficient, dampening of the oscillations will occur.

Spillway flow submergence decay exponent: This coefficient is used to
stabilize the solution of flow over a gated spillway for highly submerged
flows. This factor varies from 0.0 to 2.0. As the headwater and tailwater
stages become closer together, occasionally oscillations in the solution can
occur. This exponent will prevent this from happening. The default value of
zero has no effect. As you increase the coefficient, dampening of the
oscillations will occur.

Convert energy method bridges to cross-sections with lids: This option is used
to convert bridges to normal cross sections, instead of being processed as a
family of rating curves. If you have a bridge in which you are using the
energy solution method for high and low flow solutions, there is no need to
process this as a family of rating curves. Instead, you can have the program
treat the two internal bridge cross sections as any other normal cross section.
If you turn this option on, the program will create a separate table of elevation
versus area and conveyance for each of the tWo bridge sections.

Output Options. This option allows the user to set some additional output
flags. The following is a list of the available options:

Write velocity profiles to DSS: When this option is turned on, the program will
write velocity profiles to the HEC-DSS file. One velocity profile will be
written for each corresponding water surface profile that is written.
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Write Initial Conditions file: This option allows the user to write out a "Hot
Start" file. A hot start file can be used to set the initial conditions of the
system for a subsequent run. This is commonly done in real time forecasting,
where you want to use the results at a specific time from a previous run to be
the initial conditions of the next run. The user is require to put a time in hours
from the beginning of the current simulation, which represents the time at
which the conditions of the system will be written to the hot start me.

Write Detailed Output for Debugging: This option allows the user to turn on
detailed output that is written to alog me. This option is used when there is a
problem with the unsteady flow solution, in that it may be oscillating or going
completely unstable. When this occurs, the user should turn this option on
and re-run the program. After the run has either fmished or blown up, you
can view the log file output by selecting View Computation Log File from
the Options menu of the Unsteady Flow Simulation window. This log file
will show what is happening on a time step by time step basis. It will also
show which cross section locations the program is having trouble balancing
the unsteady flow equations, as well as the magnitude of the errors.

Check Data Before Execution. This option provides for comprehensive
input data checking. When this option is turned on, data checking will be
performed when the user presses the compute button. If all of the data are
complete, then the program allows the unsteady flow computations to
proceed. If the data are not complete, or some other problem is detected, the
program will not perform the unsteady flow analysis, and a list of all the
problems in the data will be displayed on the screen. If this option is turned
off, data checking is not performed before the unsteady flow execution. The
default is that the data checking is turned on.

View Computation Log File. This option allows the user to view the
contents of the unsteady flow computation log file. The interface uses the
Windows Notepad program to accomplish this. The log file contains detailed
information of what the unsteady flow computations are doing on a time step
by time step basis. This file is very useful for debugging problems with your
unsteady flow model.

Saving The Plan Information

To save the Plan information to the hard disk, select Save Plan from the File
menu of the simulation window. Whenever any option is changed or modified
on the Unsteady Flow Analysis window, the user should Save the Plan.

Starting the Computations

Once all of the data have been entered, and a Plan has been defmed, the
unsteady flow computations can be performed by pressing the Compute
button at the bottom of the unsteady flow simulation window. Once the
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compute button is pressed, a separate window will appear showing you the
progress of the computations. The information that appears in the window is
only there as an indicator of the programs progress during the computations.
This window is not intended for viewing any output. When the computations
have been completed, the user can close the computations window by clicking
the upper right comer of the window. If the computations ended with a
message stating "Program Finished Normally," the user can then begin to
review the output. If the program does not fmish normally, then the user
should turn on the log file option and re-run the program. Then view the log
file output to begin debugging the problem.
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Viewing Results

After the model has finished the steady flow profile computations or the
unsteady flow post-processor, you can begin to view the output. Output is
available in a graphical and tabular format. The current version of the
program allows the user to view cross sections, profiles, rating curves,
hydrographs, X-Y-Z perspective plots, detailed tabular output at a single
cross section, and limited tabular output at many cross sections. Users also
have the ability to develop their own output tables.

Contents

• Cross Sections, Profiles, and Rating Curves

• Stage and Flow Hydrographs

• X-Y-Z Perspective Plots

• Tabular Output

• Viewing Results From The River System Schematic

• Viewing Ice Information

• Viewing Data Contained in an HEC-DSS File

• Exporting Results to HEC-DSS

Cross Sections, Profiles, and Rating Curves

Graphical displays are often the most effective method of presenting input
data and computed results. Graphics allow the user to easily spot errors in the
input data, as well as providing an overview of the results in a way that tables
of numbers cannot.

Viewing Graphics on the Screen

To view a graphic on the screen, select Cross Sections, Profiles, or Rating
Curves from the View menu on the HEC-RAS main window. Once you
have selected one of these options, a window will appear with the graphic
plotted in the viewing area. An example cross-section plot is shown in Figure
9.1. The user can plot any cross section by simply selecting the appropriate
reach and river station from the list boxes at the top of the plot. The user can
also step through the cross section plots by using the up and down arrows.
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An example profile plot is shown in Figure 9.2. The profile plot displays the
water surface profile for the first reach in the river system. Ifthere is more
than one reach, additional reaches can be selected from the Options menu on
the plot.

An example rating curve plot is shown in Figure 9.3. The rating curve is a
plot of the water surface elevation versus flow rate for the profiles that were
computed. A rating curve can be plotted at any location by selecting the
appropriate reach and river station from the list boxes at the top of the plot.

•
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Graphical Plot Options

Several plotting features are available from the Options menu on all of the
graphical plots. These options include: zoom in; zoom out; selecting which
plans, profiles, reaches and variables to plot; and control over labels, lines,
symbols, scaling, grid options, zoom window location, font sizes, and land
marks. In addition to using the options menu at the top of each graphic
window, if a user presses the right mouse button while the cursor is over a
graphic, the options menu will appear right at the cursor location. In general,
the options are about the same on all of the graphics.

Zoom In. This option allows the user to zoom in on a portion of the graphic.
This is accomplished by selecting Zoom In from the Options menu, then
specifying the area to zoom in on with the mouse. Defining the zoom area is
accomplished by placing the mouse pointer at a comer of the desired zoom
area. Then press down on the left mouse button and drag the mouse to define
a box containing the desired zoom area. Finally, release the left mouse button
and the viewing area will display the zoomed-in graphic. A small window
showing the entire graphic will be placed in one of the comers of the graphic.
This window is called the Zoom Window. The Zoom Window shows the
entire graphic with a box around the zoomed in area. The user can move the
zoom box or resize it in order to change the viewing area.

Zoom Out. This option doubles the size of the currently zoomed in graphic.

Full Plot. This option re-displays the graphic back into its original size
before you zoomed in. Using the Full Plot option is accomplished by
selecting Full Plot from the Options menu.

Pan. This option allows the user to move the graphic around while in a
zoomed in mode. After zooming in, to move the graphic around, select Pan
from the Options menu. Press and hold the left mouse button down over the
graphic, then move the graphic in the desired direction.

Animate. This option was developed for unsteady flow output analysis, but
can also be used for steady flow output. This option works with the cross
section, profile, and X, Y, Z perspective plots. When this option is selected, a
window will appear that allows the user to control the animation of any
currently opened graphics. The user has the option to too "play" a graphic,
which means to step through the time sequence of computed profiles. In a
steady flow analysis, it can be used to switch between the profiles
conveniently.

Plans. This option allows the user to select from the available Plans for
plotting. The default plan is the currently opened plan. The user can select
additional plans to view for comparison of results graphically.

ProfIles. This option allows the user to select which profiles they would like
to have displayed on the graphic. This option does not apply to the rating
curve, it automatically plots all of the profiles.
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Reaches. This option allows the user to select which river reaches they
would like to have displayed. This option only applies to the profile plot.

Variables. This option allows the user to select what ever variables are
available for plotting. The number and type of variables depends on what
type of graphic is being displayed. The following is a list of variables that
can be found on the profile plot: water surface, energy, critical water surface,
observed water surfaces, reach labels, and left and right main channel bank
stations. The cross section plot is limited to the following four variables:
water surface, energy, critical water surface, and Manning's n values.

Labels. This option allows the user to change the labels at the top of the plot.
The user can select any or all ofthe following items to be added to the
caption: project title, plan title, run date, run time, geometry title, flow title,
river and reach names, cross section descriptions, cross section river
stationing, and any user defined additional text.

Lines and Symbols. This option allows the user to change the line types,
line colors, line widths, symbol types, symbol sizes, symbol colors, fill
patterns, and the line labels. When the user selects this'option, a window will
appear as shown in Figure 9.4.

•
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Figure 9.4 Line and Symbol Options Window
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•
When the Line and Symbol Options window comes up, it will list only the
information from the current plot. When this window is in the "Current Pict
Line Styles" mode, the user can only change the information for the current
plot. If the user wants to change the default line and symbol options for all of
the plots, they must select Default Line Styles at the top of the window.
When this option is selected, the user will be able to change the label, line,
and symbol options for every variable that is plotted in the program. To use
this option, the user finds the variable that they want to change from the list
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on the left side of the window. Select that variable by clicking the left mouse
button while over top of the variable. Once a variable is selected, the options
that are set for that variable will be highlighted with a red box around each
option. The user can change whatever option they want, as well as changing
the label for that variable. If a variable does not have a default label, you
cannot enter one for that variable. Once the user has made all of the changes
that they want to all of the desired variables, they should press the OK button.
The changes will be saved permanently, and any plot that is displayed within
HEC-RAS will reflect the user-entered changes.

Scaling. This option allows the user to define the scaling used for the plot.
Users are allowed to set the minimum, maximum, and labeling increment for
the X and Yaxis. Scaling can be set temporarily, or scaling can be set to be
persistent (scaling stays constant for all cross sections). Persistent scaling is
only available for the cross section and rating curve plots.

Grid. This option allows the user to overlay a grid on top of the graphic.
Users have the option to have both major and minor tics displayed, as well as
a border around the plot.

Zoom Window Location. This option allows the user to control which
corner of the plot that the zoom window will be placed, and the size of the
zoom window. The zoom window appears whenever the user has selected the
Zoom In option.

Font Sizes. This option allows the user to control the size of all of the text
displayed on the graphic.

Land Marks. This option is specific to profile plots. With this option the
user can turn on additional labels that will be displayed as land marks below
the invert of the channel. Two types ofland marks can be displayed, cross
section river stations or cross section descriptions. In addition to these two
variables, once one of the two are displayed, the user can select to edit the
land mark labels.

Plotting Velocity Distribution Output

The user has the option ofplotting velocity distribution output from the cross
section viewer. Velocity distributions can only be plotted at locations in
which the user has specified that flow distribution output be calculated during
the computations. To view the velocity distribution plot, first bring up a cross
section plot (select "Cross Sections" from the view menu of the main HEC
RAS window). Next, select the cross section in which you would like to see
the velocity distribution output. Select Velocity Distribution from the
Options menu of the cross section window. This will bring up a pop up
window (Figure 9.5) that will allow you to set the minimum velocity,
maximum velocity, arid velocity increment for plotting. In general, it is better
to let the program use the maximum velocity range for plotting. Next, the
user selects Plot Velocity Distribution, then press the "OK" button and the
velocity distribution plot will appear as shown in Figure 9.6.
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For details on how to select the locations for computing the velocity
distribution, see Chapter 7 and 8 of the User's Manual. For information on
how the velocity distribution is actually calculated, see Chapter 4 of the
Hydraulic Reference Manual.
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Plotting Other Variables in Profile

To plot variables other than the water surface in profile, select General
Profile from the View menu of the main HEC-RAS window. Any variable
that is computed at a cross section can be displayed in profile. An example
would be to plot velocity versus distance. Other variables can be selected
from the Variables option under the Options menu of the plot. The user can
plot several different variable types at one time ( e.g., velocity and area versus
distance), but the scaling may not be appropriate when this is done. An
example ofplotting other variables in profile is shown in Figure 9.7.
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Plotting One Variable Versus Another

The rating curve plotting window has the ability to plot other variables
besides discharge versus water surface elevation. Any variable that is
computed at a cross section can be displayed against another computed
variable (or variables). An example of this capability is shown in Figure 9.8.
In this example, Discharge (x-axis) is being plotted against total flow area and
main channel flow area (y-axis).

,e
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To plot other variables, the user selects the X Axis Variable and Y Axis
Variable from the Options menu of the rating curve plotting window. When
selected variables to plot, keep in mind that all variables selected for a
particular axis should have a similar range in magnitude.
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Figure 9.8 Example of Plotting One Variable Against Other Variables

Sending Graphics to the Printer or Plotter

All of the graphical plots in HEC-RAS can be sent directly to a printer or
plotter. The printer or plotter used depends on what you currently have set as
the default printer or plotter in the Windows Print Manager. To send a
graphic to the printer or plotter, do the following:

1. Display the graphic of interest (cross section, profile, rating curve, X
Y-Z, or river system schematic) onto the screen.

2. Using the available graphics options (scaling, labels, grid, etc.),
modify the plot to be exactly what you would like printed.

•
3. Select Print Current (or just Print on the profile plot) from the File

menu of the displayed graphic. When this option is selected, a pop up
window will appear allowing you to modify the default print options.
Change any desired options and press the Print button. The graphic will
be sent to the Windows Print Manager. The print manager will then send
the plot to the default printer or plotter.
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Note: The user can print multiple cross-sections at one time by using the
Print Multiple option from the File Menu of the cross section and rating
curve plots. This option also allows the user to establish how many cross
sections or rating curves they would like to have printed on each page.

Sending Graphics to the Windows Clipboard

All of the HEC-RAS graphics can be sent to the Windows Clipboard.
Passing a graphic to the clipboard allows that graphic to then be pasted into
another piece of software (i.e., a word processor or another graphics
program). To pass a graphic to the windows clipboard, and then to another
program, do the following:

1. Display the graphic of interest on the screen.

2. Using the options menu, modify the plot to be exactly what you want.

3. Select Copy to Clipboard from the File menu of the displayed
graphic. The plot will automatically be sent to the Windows
Clipboard.

4. Bring up the program that you want to paste the graphic into. Select
Paste from the Edit menu of the receiving program. Once the
graphic is pasted in, it can be re-sized to the desired dimensions.

HEC-RAS sends and displays all graphics in a Window's Meta file format.
Since Meta files are vector based graphics, the graphic can be resized without
causing the image to distort.

Stage and Flow Hydrographs

If the user has performed an unsteady flow analysis, then stage and flow
hydrographs will be available for viewing. To view a stage and/or flow
hydrograph, the user selects Stage and Flow Hydrographs from the View
menu of the main HEC-RAS window. When this option is selected a plot
will appear as shown in Figure 9.9. The user has the option to plot just the
stage hydrograph, just the flow hydrograph, or both as shown in the figure.
Additionally, there are two tabs on the plot. One says Plot and the other says
Table. By default the window comes up in a plotting mode. If the user
selects the Table tab, then a table of the hydrograph results will appear.

The stage and flow hydrograph plot also has a menu option to select the
specific node types to be viewed. By default the plot comes up with a node
type of cross section selected. This allows the user to view hydrographs at
cross sections only. Other available node types include: Bridges/Culverts;
Inline Weirs; Lateral Weirs; Storage Areas; and Hydraulic Connections.

There are several options available for viewing this graphic. These options
are the same as described previously for the cross section, profile, and rating
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curve plots. Additionally, this graphic can be sent to the windows clipboard,
or the printer, as described under the previous plots.
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Figure 9.9 Stage and Flow Hydrograph Plot

X-y-Z Perspective Plots

Another type of graphic available to the user is the x-Y-2 Perspective Plot.
The X-Y-2 plot is a 3-dimensional plot of multiple cross sections within a
reach. An example X-Y-2 Perspective plot is shown in Figure 9.10.

••!
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Critical Creek - Example 1 Plan: Modified Geometry Conditions
Geom: Base Geometry Data + Interpolated Flow: 100 Year Profile - Up and Down Bndry.
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Figure 9.9 Example X-Y-Z Perspective Plot

The user has the ability to select which reaches to be plotted, the range of the
river stations, and which plans and profiles to be displayed. The plot can be
rotated left and right, as well as up and down, in order to get different
perspectives of the river system. Zoom in and zoom out features are
available, as well as the ability to move around with scroll bars. The user can
choose to overlay the water surface or not. The user has the ability to overlay
a grid on the plot, as well as a legend and labels at the top. The graphic can
be sent to the printer/plotter or the clipboard just like any other plot. Sending
the graphic to the printer or clipboard is accomplished by selecting the Print
or Clipboard options from the File menu. The user also has the option to
reverse the order in which the water surface profiles are displayed. This
option allows the user to display the higher water surfaces first, such that the
lower profiles are not covered up.
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Tabular Output

Summary tables of the detailed water surface profile computations are often
necessary to analyze and document simulation results. Tabular output allows
the user to display large amounts of detailed information in a concise format.
HEC-RAS has two basic types of tabular output, detailed output tables and
profile summary tables.

Detailed Output Tables

Detailed output tables show hydraulic information at a single location, for a
single profile. To display a detailed output table on the screen, select
Detailed Output Table from the View menu of the main HEC-RAS window.
An example detailed output table is shown in Figure 9.10.

Figure 9.10 Example Cross Section Detailed Output Table

By default, this table comes up displaying detailed output for cross sections.
Any cross section can be displayed in the table by selecting the appropriate
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river, reach and river station from the list boxes at the top of the table. Also,
any of the computed profiles can be displayed by selecting the desired profile
from the profile list box.

Users can also view detailed hydraulic information for other types of nodes.
Other table types are selected from the Type menu on the detailed output
table window. The following types are available in addition to the normal
cross section table (which is the default):

Culvert. The culvert table type brings up detailed culvert information. This
table can be selected for normal culverts, or for culverts that are part of a
multiple opening river crossing. An example culvert specific table is shown
in Figure 9.12.

100.00
3.62
3.62

70.50
70.25
0.04
0.07
0.10

961.94
118.32
350.68

0.79
1.78
1.62

376.62
80.01

Figure 9.12 Example Culvert Type of Cross Section Table

Bridge. The bridge table type brings up detailed output for the cross sections
inside the bridge as well as just upstream of the bridge. The bridge table type
can be selected for normal bridge crossings, or for bridges that are part of a
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multiple opening river crossing. An example of the bridge specific cross
section table is shown in Figure 9.13.

82.89 82.87
82.76 82.58
76.73 76.73
12.76 12.58

4.12 4.65

121.28 107.48
0.08 0.09

577.68 566.92
1.55 1.42 .

130.85 128.31

78.01 75.54

Figure 9.13 Example Bridge Type of Cross Section Table

Conveyance. The conveyance type of table is the same as a normal cross
section table. The only difference is that a conveyance type of table is used to
view the hydraulic results of a portion of a multiple opening river crossing.
That is, if the user has defined an open channel flow type of opening (i.e.,
conveyance area), at a multiple opening crossing, then this table can be used
to view the hydraulic results for that specific opening.

Inline Weir/Spillway. The Inline Weir/Spillway type of table can be used to
view detailed output for any inline weirs and/or gated spillways that have
been entered by the user.

Lateral Weir/Spillway. The Lateral Weir/Spillway type aftable can be used
for viewing detailed output from a lateral weir/spillway structure.
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Flow Distribution. The Flow Distribution table type can be used to view the
computed flow distribution output at any cross section where this type of
output was requested. An example of the flow distribution table output is
shown in Figure 9.14.

150.01 52.17 3.32 2.90 1.99
333.48 72.08 10.14 4.63 2.74
309.20 72.05 8.94 4.29 2.60
181.00 72.97 3.63 2.51 1.81
257.11 . 73.14 6.51 3.57 2.28
297.79 72.03 8.40 4.14 2.54
260.15 72.01 6.71 3.61 2.32
232.05 72.00 5.54 3.22 2.15
247.99 72.01 6.19 3.44 2.25
204.82 72.10 4.50 2.84 1.98

• 12.43 5.67 0.51 2.76 3.73
28.47 5.89 2.00 6.33 6.31
44.07 5.22 4.48 9.79 9.16

Figure 9.14 Example of the Flow Distribution Type of Table

Hydraulic Connections. The Hydraulic Connections table type can be used
to view detailed output for any user entered hydraulic connections between
storage areas and river reaches.

•
At the bottom of each of the detailed output tables are two text boxes for
displaying messages. The bottom text box is used to display the definition of
the variables listed in the table. When the user presses the left mouse button
over any data field, the description for that field is displayed in the bottom
text box. The other text box is used to display any Errors, Warnings, and
Notes that may have occurred during the computations for the displayed cross
section.
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Detailed Output Table Options

Under the Options menu of the cross section table window, the user has the
following options:

Plans. This option allows the user to select which plan, and therefore output
file, they would like to view.

Include Interpolated XS's. This option allows the user to either view
interpolated cross-section output or not. Turning the "include interpolated
XS's" option on (which is the default), allows interpolated sections to be
selected from the river station box. Turning this option off gets rid of all the
interpolated sections from the river station selection box, and only the user
entered cross-sections are displayed.

Include Errors, Warnings, and Notes in Printout. This option allows the
user to have the errors, warnings, and notes information printed below the
table, when the option to print the table is selected.

Units System For Viewing. This option allows the user to view the output in
either English or Metric units. It does not matter whether the input data is in
English or Metric, the output can be viewed in either system.

Profile Summary Tables

Profile summary tables are used to show a limited number of hydraulic
variables for several cross sections. To display a profile summary table on
the screen, select Profile Summary Table from the View menu of the main
HEC-RAS window. An example profile summary table is shown in Figure
9.15.

Figure 9.15 Example Profile Table

9-17



•

•

•

Chapter 9 Viewing Results

There are several standard table (Std. Tables) types available to the user.
Some of the tables are designed to provide specific information at hydraulic
structures (e.g., bridges and culverts), while others provide generic
information at all cross sections. The standard table types available to the
user are:

Standard Table 1. The is the default profile type of table. This table gives
you a summary of some of the key output variables.

Standard Table 2. This is the second of the standard summary tables. This
table provides information on the distribution of flow between the left
overbank, main channel, and right overbank. This table also shows the
friction losses, as well as contraction and expansion losses that occurred
between each section. Energy losses displayed at a particular cross section
are for the losses that occurred between that section and the next section
downstream.

Four XS Culvert. This standard table provides summary results for the four
cross sections around each of the culverts in the model. The four cross
sections are the two immediately downstream and the two immediately
upstream of the culvert. This table will list all of the culverts in the model for
the selected reaches.

Culvert Only. This standard table provides hydraulic information about the
culvert, as well as the inlet control and outlet control computations that were
performed.

Six XS Bridge. This table provides summary results for the six cross
sections that make up the transition of flow around a bridge. The six cross
sections include the two cross sections just downstream of the bridge; the two
cross sections inside of the bridge; and the two cross sections just upstream of
the bridge. The program will display results for all the bridges in the model
within the selected reaches. When viewing this table, on occasion there will
be no displayed results for the cross sections inside of the bridge. This occurs
only when the user has selected a bridge modeling approach that does not
compute results inside of the bridge. This includes: Yamell' s method; both
pressure flow equations; and pressure and weir flow solutions.

Bridge Only. The bridge only table shows summary information specifically
for bridges.

Bridge Comparison. The bridge comparison table shows the results for all
of the user selected bridge modeling approaches that were computed during
the computations. For example, the program can calculate low flow bridge
hydraulics by four different methods. The resulting upstream energy for the
user selected methods will be displayed in this table.
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Multiple Opening. This table shows a limited number of output variables for
each opening of a multiple opening river crossing.

Four XS Inline Weir. This table displays summary results of the four cross
sections immediately around an inline weir and/or gated spillway. The four
cross sections are the two immediately upstream and the two immediately
downstream of the inline weir and/or gated spillway.

Inline Weir Only. This table shows the final computed water surface and
energy just upstream of each of the inline weir and/or gated spillways. In
addition to these elevations, the table displays the total flow, the flow over the
weir, and the total flow through all of the gates.

Lateral Weir/Spillway. This table shows a limited set of output variables for
all of the lateral weir/spillway structures within the selected reaches.

Encroachment 1, 2, and 3. These three standard tables provide various
types of output for the computations of floodway encroachments.

BEC-FDA. This table provides information that can be exported to the HEC
Flood Damage Analysis (FDA) program. The table displays total flow,
channel invert elevation, and water surface elevation.

BEC-SQ. This table provides information that can be exported to the HEC
5Q (river and reservoir water quality analysis) program. The table displays
only the specific parameters required by the HEC-5Q program.

Ice Cover. This table shows summary output of ice information. This table
was designed for performing a study that includes ice cover.

Junctions. This summary table provides a limited set of output for all of the
cross sections that bound a junction. This table will show this output for all
of the junctions found in the model.

Storage Areas. This table shows a limited amount of output for all of the
storage areas in the model. Output includes: water surface elevation;
minimum storage area elevation; surface area; and volume.

To view one ofthe types of tables, select the desired table type from the Std.
Tables menu on the profile summary table. In addition to the various types
of profile tables, the user can specify which plans, profiles and reaches to
include in the table. The plans, profiles and reaches options are available
from the Options menu on the profile plot.

The user also has the ability to turn the viewing of interpolated cross sections
on or off. The default is to view all cross-sections, including the interpolated
ones. To prevent the interpolated sections from showing up in the table, de
select Include Interpolated XS's from the Options menu.

Another feature available to users is the ability to set the number of decimal
places that will be displayed for any variable of the pre-defined tables. Once
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a pre-defined table is selected from the Tables menu, select Standard Table
# Dec Places from the Options menu. A window will appear displaying the
current number of decimal places for each variable. The user can change the
number of decimal places to what ever they wish.

User's also have the ability to view profile output tables in either English or
metric units. This is available from the Options menu on the profile tables.
It does not matter whether the input data is in English or metric, the output
can be viewed in either system.

User Defined Output Tables

A special feature of the profile summary tables is the ability for users to
define their own output tables. User defined output tables are available by
selecting Define Table from the Options menu of the profile table. When
this option is selected, a window will appear, as shown in Figure 9.16. At the
top of the window is a table for the user selected variable headings (Table
Column Headings), the units, and the number of decimal places to be
displayed for each variable. Below this table is a table containing all of the
available variables that can be included in your user-defmed table. The
variables are listed in alphabetical order. Below the list of variables is a
message box that is used to display the definition of the selected variable.

To get a defmition of a particular variable, simply click the left mouse button
once while the mouse pointer is over the desired variable. The description of
the variable will show up at the bottom of the window. To add variables to
the column headings, simply double click the left mouse button while the
mouse pointer is over the desired variable. The variable will be placed in the
active field of the table column headings. To select a specific column to
place a variable in, click the left mouse button once while the mouse pointer
is over the desired table column field. To delete a variable from the table
headings, double click the left mouse button while the mouse pointer is over
the variable that you want to delete. The number of decimal places for each
variable can be changed by simply typing in a new value.

User defined tables are limited to 15 vari.ables. Once you have selected all of
the variables that you want, press the OK button at the bottom of the window.
The profile table will automatically be updated to display the new table.
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Figure 9.16 User Defined Tables Window

Once you have the table displayed in the profile table window, you can save
the table headings for future use. To save a table heading, select Save Table
from the Options menu on the profile table window. When this option is
selected, a pop up window will appear, prompting you to enter a name for the
table. Once you enter the name, press the OK button at the bottom of the pop
up window. The table name will then be added to a list of tables included
under the User Tables menu on the profile table window. To delete a table
from the list of user defined tables, select Remove Table from the Options
menu of the profile table window. When this option is selected, a pop up
window will appear displaying a list of all the user-defined tables. Click the
left mouse button over the tables that you want to delete, then press the OK
button. The selected tables will then be deleted from the User Tables menu
list.

Sending Tables to the Printer

To send a table to the printer, do the following:

••I •

1.

2.

Bring up the <iesired table from the tabular output (cross section or
profile tables) section of the program.

Select Print from the File menu of the displayed table. When this
option is selected, a pop up window will appear allowing you to
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modify the default print options. Once you have set the printer with
the desired options, press the Print button. The table will be sent to
the Windows Print Manager. The Windows Print Manager will
control the printing of the table.

The profile summary type of tables, allow you to print a specific portion of
the table, rather than the entire table. Ifyou desire to only print a portion of
the table, do the following:

1. Display the desired profile type table on the screen.

2. Using the mouse, press down on the left mouse button and highlight
the area of the table that you would like to print. To get an entire row
or column, press down on the left mouse button while moving the
pointer across the desired row or column headings.

3. Select Printer from the File menu of the displayed table. Only the
highlighted portion of the table and the row and column headings will
be sent to the Windows Print Manager.

Sending Tables to the Windows Clipboard

To pass a table to the Windows Clipboard, and then to another program, do
the following:

1. Display the desired table on the screen.

2. Select Copy to Clipboard from the File menu of the displayed table.

3. Bring up the program that you want to pass the table into. Select
Paste from the Edit menu of the receiving program.

Portions of the profile tables can be sent to the Clipboard in the same manner
as sending them to the printer.

Viewing Results From the River System Schematic

The user has the option of either bringing up graphics and tables from the
View menu on the main HEC-RAS window (as discussed above), or from the
river system schematic (found under geometric data). Once data have been
entered, and a successful simulation has been made, the user can interact with
the river system schematic. When the left mouse button is pressed over the
river system schematic, a pop up menu will appear listing options that are
relevant to the area of the schematic that is located under the mouse pointer.
An example of this is shown in Figure 9.17.

In Figure 9.17, the pop up menu shown comes up whenever the user presses
the left mouse button over a cross section. In this particular example, the
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mouse button was pressed over the cross section located at river station 10.0
of the Upper reach of Fall river. As shown in the menu, the user has the
choice of editing the cross section data; plotting the cross section; plotting the
profile for the reach containing this cross section; bringing up the XYZ plot
for that reach; viewing tabular output; plotting the computed rating curve at
this cross section; or viewing a picture of the location. Other pop up menus
are available for bridges; culverts; junctioJ;ls; and reach data.

Figure 9.17 Geometric Data Window With Pop up Menu
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Viewing Ice Information

River ice information can be viewed both in a graphical and tabular fonnat.

Viewing Graphical Ice Information on the Screen

To view graphical ice infonnation on the screen, select either Cross Sections,
Promes, or X-Y-Z Perspective Plot from the View menu on the HEC-RAS
main window.

Cross Section Plot. Figure 9.18 is an example cross section plot displaying
ice. The ice cover is displayed by selecting Variables under the Options
menu, then selecting the Ice Cover option. The ice thicknesses in the right
overbank, main channel, and left overbank are displayed. The default color
and fill pattern can be changed by the user by selecting Lines and Symbols
under the Options menu. Note that multiple profiles and multiple plans can
be displayed on the same plot.

• Thames River Ice Jam - Example 14 Plan: Thames River Ice Jam Analysis
Geom: Thames River Ice Jam Data Flow: Estimated Thames River Flow
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Figure 9.18 Cross section Plot with ice

•
Promes Plot. An example of a profile plot with ice is shown in Figure 9.19.
In this case, the WS-EG Prome was selected. As with the Cross Section plot,
the ice cover is displayed by selecting Variables under the Options menu,
then selecting the Ice Cover option. The ice thicknesses in the right

9-24



'. Chapter 9 Viewing Results

overbank, main channel, and left overbank are displayed. The default color
and fill pattern can be changed by the user by selecting Lines and Symbols
under the Options menu. Note that multiple profiles and multiple plans can be
displayed on the same plot.

Thames River Ice Jam - Example 14 Plan: Thames River Ice Jam Analysis
Geom: Thames River Ice Jam Data Flow: Estimated Thames River Flow
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• Figure 9.19 ProfIle plot with ice cover

Ice information can also be displayed in profile plots by selecting the
General ProfIle option and then selecting Variables under the Options
menu. This provides a number of ice variables, including ice volume in the
channel, left, and right overbanks; ice thickness in the channel, left, and right
overbanks; top of ice elevation in the channel, left, and right overbanks; and
bottom of ice elevations in the channel, left, and right overbanks. These plots
can all be viewed in different widow sizes and printed.

x-Y-Z Perspective Plot. As with the Cross Section plot, the ice cover is
displayed by selecting Variables under the Options menu, then selecting the
Ice Cover option. The ice thicknesses in the right overbank, main channel,
and left overbank are displayed. The default color and fill pattern can be
changed by the user by selecting Lines and Symbols under the Options
menu.

•
9-25



•

•

Chapter 9 Viewing Results

Viewing Tabular Ice Information

Tabular information describing the results of the ice calculations can be
displayed by selecting Profile Summary Table under the View menu on the
HEC-RAS main window. Ice information is available directly by selecting the
Ice Cover option under the Std. Tables menu of the Profile Table window. The
Ice Cover option provides a table that includes the ice volume, ice thickness, and
composite Manning's n value for the main channel, left overbank, and right
overbank.. In addition, the Ice Cover Table includes the water surface elevation
and the cumulative ice volume starting from the downstream end of the channel.
An example table of ice information is shown in Figure 9.20. Tables of ice
information can also be created using the Define Table option under the Options
menu of the Profile Table window.

Figure 9.20 Ice Cover Table

Viewing Data Contained in an HEC-DSS File

The HEC-RAS software can write and read data to and from the HEC-DSS
(Data Storage System) database. The steady flow portion ofHEC-RAS can
read flow data to be used as profile information, and can write water surface
profiles, storage-outflow information, and rating curves. The unsteady flow
portion ofHEC-RAS can read complete hydrographs (stage and flow), as
well as gate settings to be used during a simulation. Observed data contained
in a DSS file can be attached to specific cross sections for comparison with
computed results at those locations, and computed profiles and hydrographs
are written to the DSS file during an unsteady flow simulation.

Because a DSS file can be used to share information between different HEC
programs (such as HEC-HMS and HEC-RAS), it is often necessary to be able
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to view data contained within a DSS file. A DSS viewer is available from
within the HEC-RAS software. To bring up the DSS viewer select DSS Data
from the View menu ofthe main HEC-RAS window (Or press the button
labeled DSS on the main window). When this option is selected a window
will appear as shown in Figure 9.21.

Figure 9.21 HEC-DSS Viewer Window

As shown in Figure 9.21, the user selects a DSS file by pressing the open file
button located next to the DSS Filename field. When a DSS file is selected, a
list of the available pathnames within that file will show up in the table. Each
DSS pathname represents a record of data stored within the DSS file. The
user can select one or more DSS pathnames to be plotted and/or tabulated. A
pathname is selected by using the left mouse button to select a row(s) in the
table, then the button labeled Select highlighted DSS Pathnames is pressed
and the pathname shows up in the lower box. The final step is to hit the
PlotlTabulate Selected Pathnames button, and the data will be plotted. An
example plot is shown in Figure 9.22.

As shown in Figure 9.22 there are two tabs on the window, one says Plot and
the other says Table. By default the window comes up plotting the data. To
view the data as a table, simply press the table tab.
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Figure 9.22 Example Plot From The HEC-RAS DSS Viewer

Data can be viewed from one or more DSS files simultaneously. The user
simple opens one DSS file and picks the desired pathnames, then opens
another DSS file and selects additional pathnames. When the Plotrrabulate
button is pressed, the data from both DSS files will be plotted and/or
tabulated.

A few utilities are also available from the DSS viewer. These utilities
include: Time Series Importer; Delete Selected Pathnames; and Squeeze the
DSS file. The time series importer allows the user to enter regular interval
time series data into a table, which can then be imported into a DSS file. To
use this option select Time Series Import from the Utilities menu of the DSS
Data Viewer. When this option is selected a window will appear as shown in
Figure 9.23.
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Figure 9.23 DSS Time Series Data Import Utility

As shown in Figure 9.23, the user first selects a DSS file to import data into.
Next a DSS Pathname must be entered for the data to be written to the DSS
file. The pathname parts are separated with a "I" between each pathname
part. Some parts can be left blank, but the Band C part must be entered at a
minimum. Next the user enters the date and time of the first data point, as
well as the interval of the data (the interval is selected from the available DSS
intervals). Next the data units and data type are selected from the drop down
lists. If the lists do not contain the units of your data you can enter them
directly into the field. The data is then entered into the table at the bottom.
You can cut and paste information into this table, using the standard windows
keys of Ctrl-C for cut, and Ctrl-V for paste. There are buttons available to
perform the following tasks: set the number of rows in the table (the default is
99); linearly interpolate missing values; delete a row; insert a row; add a
constant to a highlighted section of the table; multiply the highlighted section
by a factor; and set a highlighted section to a specific value.

The utility labeled Delete Selected Paths is used to delete data from the DSS
file. The user simply selects the pathnames they want to delete, then selects
this option from the Utilities menu. A window will appear to asking if you
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are sure you want to delete the selected pathnames. If you answer OK, then
the data will be deleted from the DSS file.

The utility labeled Squeeze DSS File is used to compress the DSS file, such
that it takes significantly less hard disk space. This is a convenient function if
you are working with very large DSS files. To use this option just select
Squeeze DSS File from the Utilities menu. A window will come up asking
you if you want to squeeze the currently opened DSS file. If you answer OK
then the file will be compressed.

Exporting Results To HEC-DSS

The HEC-RAS software has the ability to export a limited set of results to a

HEC-DSS file for both steady and unsteady flow simulations. When
performing an Unsteady flow simulation, the program automatically writes
stage and flow hydrographs to the DSS file, but only for the user-selected
hydrograph output locations. Water surface profiles are also automatically
written to the DSS file. The profiles are written for the user selected detailed
output interval, as well as the overall maximum water surface profile (profile
of the maximum stage at every cross section).

Once a steady flow or unsteady flow simulation is performed, the user can
write the following information to a DSS file: water surface profiles;
computed rating curves; and storage-outflow information. To export
computed results to a DSS file the user selects Export To HEC-DSS from
the File menu of the main HEC-RAS window. When this option is selected a
window will appear as shown in Figure 9.24.

Figure 9.24 Export Computed Results to DSS Window
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As shown in Figure 9.24, there are three tabs on the window; one for profiles,
rating curves, and storage outflow. To export computed water surface
profiles, select the Profiles tab from the window. Select the type ofprof:tles
that you want to export (water surface elevations or flow). Next select the
specific profiles to be exported, as well as the reaches that you want to have
profiles for. Select how you want the stationing to be labeled. This is
accomplished by selecting one of the options under the field labeled Reach
Starting Station. The user can have the river stationing labeled in feet or
miles, and have it start at zero or whatever the magnitude is of the most
downstream cross section. The final option is to press the Export ProfIle
Data button, and the data will then be written to the DSS file.

To write computed rating curves to the DSS file select the Rating Curve tab.
When the rating curve tab is selected, the window will change to what is
shown in Figure 9.25.

Figure 9.25 Exporting Computed Rating Curves to HEC-DSS

As shown in Figure 9.25, to export a computed rating curve to DSS, select the
river, reach, and river stations that you want to have exported to the DSS file.
Then simply press the Export Rating Curves button to have the program
write the data to the DSS file. If your profiles are not in the order from
lowest flow to highest flow, turn on the option that says Sort flows in rating
curve. This option will ensure that the curve is written in the order of
increasing flow rate.

The HEC-RAS program computes cumulative storage volumes for each of
the water surface profiles. This information can be used for hydrologic
routing in a hydrology model such as HEC-HMS or HEC-l. The HEC-RAS
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program allows the user to write out storage versus volume information to a
DSS file. To use this option select the Storage Outflow tab from the Export
to DSS window. When this option is selected a window will appear as shown
in Figure 9.26.

Figure 9.26 Exporting Storage-Outflow Information to HEC-DSS

As shown in Figure 9.26, the user selects the River, upstream reach, upstream
river station, downstream reach, and downstream river station to completely
define a routing reach in which they want to have storage-outflow
information written to the DSS file. This can be done for as many reaches as
you want within the model. After all of the reaches are defined, simply press
the button labeled Export Volume Outflow Data to write the information to
the DSS file .
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CHAPTER 10

Performing a Floodplain Encroachment
Analysis

The evaluation of the impact of floodplain encroachments on water surface
profiles can be of substantial interest to planners, land developers, and
engineers. Floodplain and floodway evaluations are the basis for floodplain
management programs. Most of the studies are conducted under the National
Flood Insurance Program and follow the procedures in the "Flood Insurance
Study Guidelines and Specifications for Study Contractors," FEMA 37
(Federal Emergency Management Agency, 11085).

FEMA 37 defmes a floodway "...as the channel ofa river or other
watercourse and the adjacent land areas that must be reserved in order to
discharge the base flood without cumulatively increasing the water-surface
elevation by more than a designated height." Normally, the base flood is the
one-percent chance event (lOO-year recurrence interval), and the designated
height is one foot, unless the state has established a more stringent regulation
for maxjmum rise. The floodway is usually determined by an encroachment
analysis, using an equal loss of conveyance on opposite sides of the stream.
For purposes offloodway analysis, the floodplain fringe removed by the
encroachments is assumed to be completely blocked.

HEC-RAS contains five optional methods for specifying floodplain
encroachments. For information on the computational details of each of the
five encroachment methods, as well as special considerations for
encroachments at bridges, culverts, and multiple openings, see Chapter 10 of
the HEC-RAS hydraulics reference manual. This chapter describes how to
enter floodplain encroachment data, how to perform the encroachment
calculations, and viewing the floodplain encroachment results.

Contents

• General

• Entering Floodplain Encroachment Data

• Performing the Floodplain Encroachment Analysis

• Viewing the Floodplain Encroachment Results
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General

The HEC-RAS floodplain encroachment procedure is based on calculating a
natural profile (existing conditions geometry) as the first profile in a multiple
profile run. Other profiles, in a run, are calculated using various
encroachment options, as desired. Before performing an encroachment
analysis, the user should have developed a model of the existing river system.
This model should be calibrated to the fullest extent that is possible.
Verification that the model is adequately modeling the river system is an
extremely important step before attempting to perform an encroachment
analysis.

Currently, the HEC-RAS program has 5 methods to determine floodplain
encroachments. These methods are:

Method 1 
Method 2
Method 3 
Method 4
Method 5 -

User enters right and left encroachment stations
User enters fixed top width
User specifies the percent reduction in conveyance
User specifies a target water surface increase
User specifies a target water surface increase and
maximum change in energy

For a detailed discussion on each of these methods, the user is referred to
Chapter 10 of the Hydraulic Reference Manual.

The goal ofperforming a floodplain encroachment analysis is to determine
the limits of encroachment that will cause a specified change in water surface
elevation. To determine the change in water surface elevation, the program
must first determine a natural profile with no encroachments. This base
profile is typically computed using the one percent chance discharge. The
computed profile will define the floodplain, as shown in Figure 10.1. Then,
by using one of the 5 encroachment methods, the floodplain will be divided
into two zones: the floodway fringe and the floodway. The floodway fringe
is the area blocked by the encroachment. The floodway is the remaining
portion of the floodplain in which the one-percent chance event must flow
without raising the water surface more than the target amount.
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Figure 10.1 Floodway Definition Sketch

Entering Floodplain Encroachment Data

Within HEC-RAS, the data for performing a floodplain encroachment
analysis are entered from the Steady Flow Analysis window. Encroachment
information is not considered as permanent geometry or flow data, and is
therefore not entered as such. The encroachment information is saved as part
of the existing Plan data.

To bring up the floodplain encroachment data window, select the
Encroachments option from the Options menu of the Steady Flow Analysis
window. When this option is selected an Encroachment window will appear
as shown in Figure 10.2 (except yours will be blank when you first open it).

••

As shown in Figure 10.2, There are several pieces of data that the user must
supply for an encroachment analysis. The encroachment analysis can only be
performed for profiles 2 through 15 (or what ever number has been set by the
user in the flow data editor). Encroachments are not performed on profile one
because most of the encroachment methods rely on having a base profile for
comparison.
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Figure 10.2 Floodplain Encroachment Data Editor

The data for an encroachment analysis should be entered in the following
manner:

Global Information. Global information are data that will be applied at
every cross section for every profile computed. The first piece of global
information is the Equal Conveyance Reduction selection box at the top of
the Encroachment data editor window. Equal conveyance reduction applies
to encroachment methods 3, 4, and 5. When this is turned on, the program
will attempt to encroach, such that an yqualloss of conveyance is provided on
both sides of the stream. If this option is turned off, the program will
encroach by trying to maintain a loss in conveyance in proportion to the
distribution of natural overbank conveyance. The default is to have equal
conveyance reduction turned on.

The second item under global information is the Left bank offset and the
Right bank offset. The left and right offsets are used to establish a buffer
zone around the main channel for further limiting the amount of the
encroachments. For example, if a user established a right offset of 5 feet and
a left offset of 10 feet, the model will limit all encroachments to 5 feet from
the right bank station and 10 feet from the left bank station. The default is to
have no right or left offset, this will allow the encroachments to go up to the
main channel bank stations, if necessary.
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River, Reach and River Station Selection Boxes. The next piece of data for
the user to select is the river and reach in which to enter encroachment data.
The user is limited to seeing one reach at a time on the encroachment data
editor. Once a reach is selected, the user can then enter a Starting and
Ending River Station to work on. By default, the program selects all the
sections in the reach. The user can change this to any range of cross sections
within the reach.

ProfIle. Next, the user should select a profIle number to work on. Profiles
are limited to 2 through the rriaximum number set in the currently opened
flow data (e.g., 2 through 4, if the user has set 4 profIles in the flow data
editor). The user can not set encroachments for profIle 1.

Method and Target Vahles. The next step is to enter the desired
encroachment method to be used for the currently selected profile. Once a
method is selected, the data entry boxes that corresponds to that method will
show up below the method selection box. Some of the methods require only
one piece of data, while others require two. The user should then enter the
required information that corresponds to the method that they have selected.
For example, if the user selects encroachment method 4, only one piece of
information is required~ the target change in water surface elevation. The
available encroachment methods in HEC-RAS are:

• Method 1 
Method 2
Method 3
Method 4
Method 5-

User enters right and left encroachment station
User enters a fIxed top width
User specifIes the percent reduction in conveyance
User specifIes a target water surface increase
User specifIes target water surface increase and
maximum change in energy

•

Set Selected Range. Once the encroachment method is selected, and its
corresponding data are entered, the user should press the Set Selected Range
button. Pressing this button will fIll in the table below with the selected range
of river stations; the selected method; and the corresponding data for the
method. Note that, if the selected method only has one data item, that
method's data will go under the Value 1 column of the table. If the selected
method has two data items, the fIrst goes into the Value 1 column and the
second goes into the Value 2 column. Once the data is put into the table, the
user can change the method and corresponding data values directly from the
table.

At this point the user should repeat these tasks until all of the encroachment
data are entered (i.e., for all the reaches and locations in the model, as well as
all of the profIles for which the user wants to perform the encroachment
analysis). Once all of the encroachment data are entered, the user presses the
OK button and the data will be applied and the window will close. The user
can return to the encroachment window and edit the data at any time. The
encroachment data are not saved to the hard disk at this time, they are only
saved in memory. To save the data to the hard disk, the user should either
select Save Project from the File menu of the main HEC-RAS window, or
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select Save Plan from the File menu of the Steady Flow Analysis window.

The Import Method 1 option, allows the user to transfer the computed
encroachment stations from a previous run (output file) to the input data for a
future run. For example, if the user performs a preliminary encroachment
analysis using any of the methods 2 through 5, they may want to convert the
results from one of the runs to a method 1 encroachment method. This will
allow the user to further defme the floodway, using method 1, without having
to enter all of the encroachment stations. The import of encroachment
stations, in this manner, is limited to the results of a single encroachment
profile for each reach.

Performing The Floodplain Encroachment Analysis

The HEC-RAS floodway procedure is based on calculating a natural profile
(no encroachments) as the first profile of a multiple profile run. Subsequent
profiles are calculated with the various encroachment options available in the
program.

In general, when performing a floodway analysis, encroachment methods 4
and 5 are normally used to get a first cut at the encroachment stations.
Recognizing that the initial floodway computations may provide changes in
water surface elevations greater, or less, than the "target" increase, initial
computer runs are usually made with several "target" values. The initial
computer results should then be analyzed for increases in water surface
elevations, changes in velocities, changes in top width, and other parameters.
Also, plotting the results with the X-Y-Z perspective plot, or onto a topo map,
is recommended. From these initial results, new estimates can be made and
tested.

After a few initial runs, the encroachment stations should become more
defined. Because portions of several computed profiles may be used, the
final computer runs are usually made with encroachment Method 1 defining
the specific encroachment stations at each cross section. Additional runs are
often made with Method 1, allowing the user to adjust encroachment stations
at specific cross sections to further define the floodway.

While the floodway analysis generally focuses on the change in water surface
elevation, it is important to remember that the floodway must be consistent
with local development plans and provide reasonable hydraulic transitions
through the study reach. Sometimes the computed floodway solution, that
provides computed water surfaces at or near the target maximum, may be
unreasonable when transferred to the map of the actual study reach. If this
occurs, the user may need to change some of the encroachment stations,
based on the visual inspection ofthe topo map. The floodway computations

should be re-run with the new encroachment stations to ensure that the target
maximum is not exceeded.
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Viewing the Floodplain Encroachment Results

Floodplain encroachment results can be viewed in both graphical and tabular
modes. Graphi<;:l:llly, the encro~chmentresults show up on the cross section
plots as well as the X-Y-Z Perspective plot. An example cross-section plot is
shown in Figure 10.3.
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Figure 10.3 Example Cross Section Plot With Encroachments

As shown in Figure 10.3, the encroachments are plotted as outlined blocks.
In this example, the water surface profile for the base run (first profile) is
plotted along with one of the encroached profiles. The user can plot as many
profiles as they wish, but it may become a little confusing with several sets of
encroachments plotted at they same time.

•
Another type of graphic that can be used to view the encroachments is the X
Y-Z perspective plot, an example is shown in Figure 10.4. In this example,
the base profile (profile 1) as well as one of the encroached profiles is plotted
at the same time over a range of cross sections. This type of plot allows the
user to get a reach view of the floodplain encroachment. The user can
quickly see if the encroachments transition smoothly or if they are erratic. In
general, the final encroachments should have a consistent and smooth
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transition from one cross section to the next. With the assistance of this type
ofplot, the user may want to further refine the final encroachment stations
and re-run the model.

Legend

VVS PF#1

VVS PF#2

Levee
•

Bank Sla

Encroachment

Ground..
Ineff

Ground
8

Floodway Determination • Example 6 Jhan: Method 5 Encroachment
Geom:Existing Cond~ions Flow: Base + 11t Ta,rgel Depth

Figure 10.4 Example X-Y-Z Perspective Plot with Base and Encroached Profiles

Encroachment results can also be viewed in a tabular mode from the Profile
Output Tables. Select Profile Table from the View menu of the main HEC
RAS window. When the table comes up, the user can select from three
different pre-defined encroachment tables. To bring up one of the
encroachment tables, select Encroachment 1 from the Std. Tables menu on
the Profile table window. An example of Encroachment 1 table is shown in
Figure 10.5. The table shows the basic encroachment results of: computed
water surface elevation; change in water surface from the base profile; the
computed energy; top width of the active flow area; the flow in the left
overbank, main channel, and right overbank; the left encroachment station;
the station of the left bank of the main channel; the station of the right bank of
the main channel; and the right encroachment station.
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217.44 217.68 1824.00 858.86 10867.73 2317.15 450.00
217.39 -0.04 217.79 807.60 67.29 12148.29 1784.38 420.85 450.00

215.61 216.04 1702.76 1073.43 10253.83 2672.74 450.00
216.35 0.73 216.86 807.60 113.48 11602.49 2284.04 420.85 450.00

214.63 214.77 1633.15 2336.07 2507.27 9156.67 200.30
215.63 r-···--·····iEi9 215.75 845.19 1922.36 2527.11 9550.53 101.99 200.30

213.33 213.761 1425.37 1102.78 4954.85 7942.37 155.00
214.34 1.01 214.92 535.14 212.93 5788.66 7998.41 145.00 155.00

212.55 212.89 1782.32 1624.48 5352.58 7022.95 274.50
213.54 0.99 214.03 642.15 167.70 6493.35 7338.95 264.50 274.50

Figure 10.5 Example of the Encroachment 1 Standard Table

Encroachment 2 table provides some additional information that is often used
when plotting the encroachments onto a map. This table includes: the change
in water surface elevations from the first profile; the top width of the active
flow area; the percentage ofconveyance reduction in the left overbank; the
left encroachment station; the distance from the center of the main channel to
the left encroachment station; the station of the center of the main channel;
the distance from the center of the main channel to the right encroachment
station; the right encroachment station; and the percentage of conveyance
reduction in the right overbank. An example of the Encroachment 2 standard
table is shown in Figure 10.6.
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1797.64 678.25
0.98 928.58 12.53 351.18 678.25 577.40 1255.65 12.56

1765.50 449.50
0.86 847.98 13.62 108.50 449.50 739.48 1188.98 14.84

1873.52 647.25
0.72 789.38 17.40 464.821 182.43 647.25 606.95 1254.20 16.00

I
1989.05 845.00

0.62 707.62 20.61 609.601 235.40 845.00 472.22 1317.22 16.20

1910.09 ! 647.00
0.43 752. 77 20.64 477.33 169.67 647.00 583.10 1230.10 15.40

548.50 I
-

1847.04
0.11 617.70 440.00, 108.50 548.50 509.20 1057.70

Figure 10.6 Example of the Encroachment 2 Standard Table

The last encroachment table, Encroachment 3, provides the minimum
floodway data for reporting. This table includes: the active flow top width;
the flow area (including any ineffective flow area); the average velocity of the
entire cross section; the computed water surface elevation; the base water
surface elevation (profile 1); and the change in water surface from the first
profile. An example of this table is shown in Figure 10.7
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1797.64 7068.82 1.98 218.99 218.99
928.58 5276.75 2.65 219.97 218.99

1765.50 9092.73 1.54 218.46 218.46
847.98 5913.15 2.37 219.32 218.46

1873.52 9248.86 1.51 218.23 218.23
789.38 5530.05 2.53 218.95 218.23

1989.05 9499.42 1.47 218.09 218.09
707.62 5352.12 2.62 218.71 218.09

1910.09 9447.83 1.48 217.91 217.91
752.77 5179.35 2.70 218.34 217.91

1847.04 8985.57 1.56 217.44 217.44

• 617.70 4043.15 3.46 217.54 217.44

1847.04 2533.60 5.53 217.44 217.44
617.70 1979.08 7.07 217.54 217.44

Figure 10.7 Example of the Encroachment 3 Standard Table

•
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CHAPTER 11

Troubleshooting With HEC-RAS

The HEC-RAS software is designed to continue its computations all the way
through completion, even when the user has entered poor data. Because of
this, the fact that the program executes a complete run does not necessarily
mean that the results are good. The user must carefully review the results to
ensure that they adequately represent the study reach and that they are
reasonable and consistent. The HEC-RAS software is an engineering tool, it
is by no means a replacement for sound engineering.

The HEC-RAS software contains several features to assist the user in the
development of a model; debugging problems; and the review of results.
These features include: built in data checking; an Errors, Warnings, and Notes
system; and a computational Log Output file. In addition to these features,
the user can use the graphical and tabular output to review the results and
check the data for reasonableness arid consistency.

Built in Data Checking

The HEC-RAS user interface has two types ofbuilt in data checking. The
first type of data checking is performed as the user enters the data. Each data
field of the data entry editors has some form of data checking. The second
type of data checking occurs when the user starts the steady flow or unsteady
flow computations. When the user presses the compute button, on the steady
flow or unsteady flow analysis window, the entire data set is processed
through several data checks before the computations begin. A detailed
discussion of each of these two data checking features is described below.

Checking the Data as it is Entered

This type of data checking occurs whenever the user enters data into a single
data field or table. Once the user leaves a particular data entry field or table,
the program will automatically check that data for reasonableness. The
following is a list of some of the types of data checks that are performed:

1. Minimum and maximum range checking for variables.

2. Alpha and numeric data checks. This is done to ensure that the right
type of data is entered in each field.

•
3. Increasing order of station for cross sections, bridge deck/roadway,

and abutments.
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4. Data consistency checks (i.e., when the main channel bank stations
are entered, the program checks to see if they exist in the cross section
station and elevation data).

5. Data deletion warnings. When you delete data the software will give
you a warning before it is deleted.

6. File management warnings (Le., program will give you a chance to
save the data to the hard disk before the program is closed, or a
different data set is opened).

7. Data geometry checks (Le., when a bridge deck/roadway is entered,
the program checks to ensure that the deck/roadway intersects with
the ground data).

Data Checking Before Computations are Performed

The second type of data checking is performed to evaluate the completeness
and consistency of the data. This type of data checking occurs before the
computations take place. When the user presses the Compute button on the
Steady Flow or Unsteady Flow Analysis window, the program will perform a
series of data checks before the computations are allowed to proceed. If any
data errors are found, the program will not perform the computations. The
following is a list of some of the types of checks that are made during this
time:

1. Data completeness. These data checks insure that all of the required
data exists for the entire data set. If any missing data are found, a
complete list of all the missing data and their specific locations is
displayed on the screen. An example of this is shown in Figure 11.1.

2. Data consistency.. This type ofdata checking is performed to ensure
that the data is consistent with the computations that are being
requested. For example, if the user asks to perform a mixed flow
regime computation, the program checks to ensure that upstream as
well as downstream boundary conditions have been specified.
Likewise, if an encroachment analysis is requested, the program
checks to ensure that the number ofprofiles lines up with the number
specified in the encroachment data. There are several other checks of
this type.
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• Channel Manning's n value not set.

River: "Critical Cr." Reach: "Upper Reach" RS:11.8"
• C.oefficient of Expansion not .set.

River: "Critical Cr." Reach: ''Upper Reach" RS:11.6"
•Main channel length not set.

River:Critical Cr." Reach: "Upper Reach" RS=8· has an undefU1ed flow Value.

Figure 11.1 Data Completeness Checking Window

Errors, Warnings, and Notes

The HEC-RAS software has a system ofErrors, Warnings, and Notes that are
passed from the computation programs to the user interface. During the
computations, the computation programs will set flags for at a particular node
(nodes are cross sections, bridges, culverts, or multiple openings) whenever it
is necessary. These message flags are written to the standard output file,
along with the computed results for that node. When the user interface reads
the computed results from the output file, if any errors, warnings, or notes
exist, they are interpreted and displayed in various locations from the
interface.

The user can request a summary of all the errors, warnings, and notes that
occurred during the computations. This is accomplished by selecting
Summary Errors, Warnings, and Notes from the View menu on the main
HEC-RAS window. Once this is selected, a window will pop up displaying
all of the messages. The user can select a specific River and Reach, as well
as which Profile and Plan to view. The user has the options of expanding the
window; printing the messages; or sending them to the windows clipboard.
An example of the Errors, Warnings, and Notes window is shown in Figure
11.2.

11-3



Chapter 11 Troub/eshooU'!a With HEC-RAS

Figure 11.2 Summary of Errors, Warnings, and Notes Window

Besides the summary window, messages will automatically appear on the
cross section specific tables. When a cross section or hydraulic structure is
being displayed, any errors, warnings, or notes for that location and proflle
will show up in the Errors, Warnings, and Notes message box at the bottom
of the table. An example of this table is shown in Figure 11.3.

In general, the errors, warnings, and notes messages should be self
explanatory. The three categories ofmessages are the following:

ERRORS: Error messages are only sent when there are problems that
prevent the program from being able to complete the run.

WARNINGS: Warning messages provide information to the user that may
or may not require action on the user's part. In general, whenever a warning
is set at a location, the user should review the hydraulic results at that location
to ensure that the results are reasonable. If the hydraulic results are found to
be reasonable, then the message can be ignored. However, in many instances,
a warning level message may require the user to take some action that will
cause the message to disappear on future runs. Many of the warning
messages are caused by either inadequate or bad data. Some common
problems that cause warning messages to occur are the following:

Cross sections spaced to far apart. This can cause several warning
messages to be set.

Cross sections starting and ending stations not high enough. If a
computed water surface is higher than either end point of the cross section, a
warning message will appear.
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Bad Starting Water Surface Elevation. If the user specifies a boundary
condition that is not possible for the specified flow regime, the program will
take action an set an appropriate warning message.

Bad Cross Section Data. This can cause several problems, but most often
the program will not be able to balance the energy equation and will default
to critical depth.

NOTES: Note level messages are set to provide ·information to the user
about how the program is performing the computations.

..~ ',: _~·t

0.100 0.040 0.100
500.00 500.00 500.00

2137.38 320.82 100.25 '
2137.38 320.82 100.25
5528.62 3370.57 100.81

• 6!:j8.04 45.00 135.57
2.59 10.51 1.01
3.06 7.13 0.74

66792.7 40720.8 1217.9
700.82 50.80 135.59

'1.30 2.70 0.32
3.37 28.38 0.32

225.35 41.64 10.88
79.05 6.43 7.75

Figure 11.3 Cross Section Table with Errors, Waqungs, and Notes

•
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Log Output

Steady Flow Log Output

This option allows the user to se.t the level of the Log file for a steady flow
analysis. This file contains infonnation tracing the program process. Log
levels can range between 0 and 10, with () resulting in no Log output and 10
resulting in the maximum Log output. In general, the Log file output level
should not be set unless the user gets an error during the computations. If an
error occurs in the computations, set the log file level to an appropriate value.
Re-run the Gpmputations and then re.view the log output, try to detennine why
the program got an error.

When the user selects Set Log File Output Level from the Options menu, a
window will appear as shown in Figure 11.4. The user can set a "Global Log
Level," which will be used for .all cross sections and every profile. The user
can also set log levels at specific locations for specific profiles. In general, it
is better to only set the log level at the locations where problems are
occurring in the computations. To set the specific location log level, first
select the desired reach and river station. Next select the log level and the
profile number (the log level can be turned on for all"profiles). Once you
have everything set, press the Set button and the log level will show up in the
window below. .Log levels can be set at several locations individually. Once
all of the Log Levels are set, press the OK button to close the window.

Warning III - setting the global log output level t.9 4 or 5 can result in very
large log file output. Global log level values of 6 or larger can result in
extremely large log files.

Figure 11.4 Log File Output Level window
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Unsteady Flow Log Output

The unsteady flow computation program can write out a detailed log file of its
computations. This file is very different from the steady flow program, but
serves the purpose of debugging computational problems. This option is
turned on by selecting Output Options from the Options menu on the
Unsteady Flow Analysis window. When this option is selected a window will
appear as shown in Figure 11.5.

Figure 11.5 Unsteady Flow Output Control Window

As shown in Figure 11.5, this option controls various types of output. To turn
on the detailed log output, the user must check the box labeled Write
Detailed Output for Debugging. After this option is selected, the
computations must be rerun in order for the output to be produced.

Viewing The Log File

This option allows the user to view the contents of the log file. For steady
flow analyses, the user brings up the log output by selecting View Log File
from the Options menu of the Steady Flow Analysis window. For unsteady
flow analyses, the user brings up the log output by selecting View
Computation Log File from the Options menu of the Unsteady Flow
Analysis window. The interface uses the Windows Write program to
accomplish viewing the output (unless the user has set a different program to
be used as the default file viewer). It is up to the user to set an appropriate
font in the Write program. lfthe user sets a font that uses proportional
spacing, the information in the log file will not line up correctly. Some fonts
that work well are: Line Printer; Courier (8 pt.); and Helvetica (8 pt.).
Consult your Windows user's manual for information on how to use the Write
program.
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.Reviewing and Debugging the Normal Output

After the user has successfully completed a run, and reviewed all the errors,
warnings, and notes, the normal output should be reviewed for consistency
and reasonableness.

Viewing Graphics

In general, the graphical output should be use,d as much as possible to get a
quick view of the results. The user should look at all of the cross sections
with the cross secti9n plotting capability. The cross section plots will assist
the user in fmding data mistakes, as well as possible modeling mistakes
(mistakes in ineffective flow areas, levees, n values, etc.).

The profile plotting capability is a good way to get a quick overview of the
entire study area. The user should look for sudden changes to the energy
grade line and the water surface. In general, these two variables should
transition smoothly along the channel. If the user finds rapid changes in the
energy or the water surface, the results at those locations should be reviewed
closely to ensure that they are correct.

The X-Y-Z Perspective Plot can also be used to get a quick view of an entire
reach. This plot is very helpful for viewing the top width of the flow area. If
the user finds dramatic changes in the top width from one cross section to the
next, then the results at those locations should be reviewed closely. Dramatic
changes in top width may indicate the need for additional cross sections.

Viewing Tabular Output

There are several types of tabular output. The user should try to make use of
all of them when viewing tabular results. In general, the profile summary
types of tables should be used to get an overview of some of the key variables
at several locations. If any problems are found, or any results that seem
suspect, the user should use the detailed output specific tables to get detailed
results at a single location.

The Occurrence of Critical Depth

During the. steady flow water surface profile calculations, the program may
default to critical depth at a cross section in order to continue the calculations.
Critical depth can occur for the following reasons:

1. Bad cross section data: If the energy equation can not balance because
of bad cross section data, the program defaults to critical depth.

2. Program can not balance the energy equation above or below the top
of a levee or ineffective flow area: On occasion, when the program is
balancing a water surface that is very close to the top of a levee, or an
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ineffective flow area, the program may go back and forth (above and
below the levee) without being able to balance the energy equation.
When this occurs, the program will default to critical depth.

3.

4.

Cross sections spaced too far apart: If the cross sections are spaced to
far apart, the program may not be able to calculate enough energy
losses to obtain a subcritical water surface at the upstream section.

Wrong flow regime: When calculating a subcritical profile, and the
program comes to a reach that is truly supercritical, the program will
default to critical depth.· Likewise, when calculating a supercritical
profile, if the reach is truly subcritical, the program will default to
critical depth.

•

•

Computational Program Does Not Run To Completion

While running the computational part of the software, when the program is
finished you should get the message "PROGRAM FINISHED
NORMALLY." If the user has entered bad data, the computational program
may not be able to run to completion. When this happens the program will
stop and write an error message to the screen. This mes~age may be a trapped
error by the program, or it could be just a generic Fortran error message.
Fortran error messages come from the Fortran compiler that was used to
develop the computational program. The message basically says that a math
error occurred and therefore the program could not continue. When this type
of error occurs, it is most often a data input problem. There is a possibility
that it could be a bug in the program, but the user should exhaust all the
possible data input errors before assuming that the program has a "Bug."

The first step in finding the problem is to realize where the error is occurring.
For a steady flow analysis, the program will display which cross section it is
working on, and for which profile. This means that the error occurred at that
cross section (or hydraulic structure, such as a bridge). Go to the Geometric
Data editor and review the input data closely at the problem location.

During an unsteady flow analysis, the program displays the time step that it is
working on and the number of iterations it took to solve the equations. As the
program is running, if it consistently goes to the maximum number of
iterations (20 is the default), the user should take not of the time step that this
started to occur. The user must turn on the detailed log output, and then
review that output in the vicinity of that particular time step, in order to figure
out what is going wrong.

Computational errors often occur at bridges. Check your data closely for any
inconsistencies in the bridge geometry. Many of the problems that occur at
bridges are due to bad DeckIRoadway data. Go to the Bridge/Culvert Data
editor and turn on the option Highlight Weir, Opening Lid and Ground
from the View menu. This option will assist you in finding any geometric
mistakes in the bridge data.
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C HAP T E R 12

Computing Scour at Bridges

The computation of scour at bridges within HEC-RAS is based upon the
methods outlined in Hydraulic Engineering Circular No. 18 (FHWA, 1995).
Before performing a scour analysis with the HEC-RAS software, the engineer
should thoroughly review the procedures outlined in the Hydraulic
Engineering Circular No. 18 (HEC 18) report. This chapter presents the data
input required for computing contraction scour and local scour at piers and
abutments.

For information on the bridge scour equations, please see Chapter 10 of the
HEC-RAS Hydraulic Reference Manual.

Contents

• General Modeling Guidelines

• Entering Bridge Scour Data

• Computing Total Bridge Scour
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General Modeling Guidelines

In order to perform a bridge scour analysis, the user must first develop a
hydraulic model of the river reach containing the bridge to be analyzed. This
model should include several cross sections downstream from the bridge,
such that any user defined downstream boundary condition does not affect the
hydraulic results inside and just upstream of the bridge. The model should
also include several cross sections upstream of the bridge, in order to evaluate
the long term effects of the bridge on the water surface profile upstream.

The hydraulic modeling, of the bridge should be based on the procedures
outlined in Chapter 5 of the Hydraulic Reference Manual. If observed data
are available, the model should be calibrated to the fullest extent possible.
Once the hydraulic model has been calibrated (if observed data are available),
the modeler can enter the design events to be used for the scour analysis. In
general, the design event, for a scour analysis is usually the 100 year (1
percent chance) event. In addition to this event, it is recommended that a 500
year (0.2 percent chance) event also be used in order to evaluate the bridge
foundation under a super-flood condition.

The next step is to turn on the flow distribution option in the HEC-RAS
software. This option allows for additional output showing the distribution of
flow for multiple subdivisions of the l'6ft arid right overbanks, as well as the
main channel. The output of the flow distribution option includes the
following items for each flow slice: percentage of flow; flow area; wetted
perimeter; conveyance; hydraulic depth; and average velocity. The user can
control the number of slices in each flow element (left overbank, main
channel, and right overbank), up to a maximum of 45 total slices. The flow
distribution output is controlled from the Options menu of the Steady Flow
Analysis window (see Chapter 7, Simulation Options).

The user must request the flow distribution output for the cross sections
inside the bridge, the cross section just upstream of the bridge, and the
approach section (cross section upstream of the bridge at a distance such that
the flow lines are parallel and the flow has not yet begun to contract due to
the bridge constriction). Flow distribution output can be requested at
additional cross sections, but these are the only cross sections that will be
used in the bridge scour computations. The flow distribution option must be
turned on in order to get more detailed estimates of the depth and velocity at
various locations within the cross section. Once the user has turned this
option on, the profile computations must be performed again in order for the
flow distribution output to be computed and included in the output file.

After performing the water surface profile calculations for the design events,
and computing the flow distribution output, the bridge scour can then be
evaluated. The total scour at a highway crossing is comprised of three
components: long-term aggradation and degradation; contraction scour; and
local scour at piers and abutments. The scour computations in the HEC-RAS
software allow the user to compute contraction scour and local scour at piers
and abutments. The current version of the HEC-RAS software does not allow
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the user to evaluate long-term aggradation and degradation. Long term
aggradation and degradation should be evaluated before performing the
bridge scour analysis. Procedures for performing this type of analyses are
outlined in the HEC No. 18 report.

Entering Bridge Scour Data

The bridge scour computations are performed by opening the Hydraulic
Design Functions window and selecting the Scour at Bridges function.
Once this option is selected the program will automatically go to the output
file and get the computed output for the <\pproach section, the section just
upstream of the bridge, and the sections inside of the bridge. The Hydraulic
Design window for Scour at Bridges will appear as shown in Figure 12-1.

o.;-.-.........,.......~.,..,..., ...........................,..,...,....................,......,
o 500 1000 1500 2000 2500 3000

station (ft)

Figure 12.1 Hydraulic Design Window For Scour at Bridges

25 Legend:.
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•
20 Ground..
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•
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15 I'

10

•
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As shown in Figure 12-1, the Scour at Bridges window contains the input
data, a graphic, and a window for summary results. Input data tabs are
available for contraction scour, pier scour, and abutment scour. The user is
required to enter only a minimal amount of input and the computations can be
performed. If the user does not agree with any of the data that the program
has selected from the output file, the user can override it by entering their
own values. This provides maximum flexibility in using the software.

Entering Contraction Scour Data

Contraction scour can be computed in HEC-RAS by either Laursen's clear
water (Laursen, 1963) or live-bed (Laursen, 1960) contraction scour
equations. Figure 12-2 shows all of the data for the contraction scour
computations. All of the variables except Kl and D50 are obtained
automatically from the' HEC-RAS output file. The user can change any
variable to whatever value they think is appropriate. To compute contraction
scour, the user is ~nly required to enter the D50 (mean size fraction of the bed
material) and a water temperature to compute the Kl factor. "

Ground...

Legend

WS PF 1
•

Ineff

•Bank Sta

Contr Scour

·1 !
I :1

I, !

" ;
" /... r

l~

5

o

-5 -+--"'T""""--.--...,---........--ro--,
o 500 1000 1500 2000 2500 3000

Station (ft)

Figure 12.2 Example Contraction Scour Calculation
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Each of the variables that are used in the computation of contraction scour are
defmed below, as well as a description of where each variable is obtained
from the output file.

YI: The average depth (hydraulic depth) in the left overbank, main channel,
and the right overbank, at the approach cross-section.

VI: The average velocity of flow in the left overbank, main channel, and
right overbank, at the approach section.

YO: The average depth in the left overbank, main channel, and right
overbank, at the contracted section. The contracted section is taken as the
cross section inside the bridge at the upstream end of the bridge (section BU).

Q2: The flow in the left overbank, main channel, and right overbank, at the
contracted section (section BU).

W2: The top width of the active flow area (not including ineffective flow
area), taken at the contracted section (section BU).

D50: The bed material particle size of which 50% are smaller, for the left
overbank, main channel, and the right overbank. These particle sizes must be
entered by the user.

Equation: The user has the option to allow the program to decide whether to
use the live-bed or clear-water contraction scour equations, or to select a
specific equation. If the user selects the Default option (program selects
which equation is most appropriate), the program must compute Yc, the
critical velocity that will transport bed material fmer than D50. Ifthe average
velocity at the approach cross section is greater than Yc, the program uses the
live-bed contraction scour equation. Otherwise, the clear-water contraction
scour equation will be used.

QI: The flow in the left overbank, main channel, and right overbank at the
approach cross-section.

WI: The top width of the active flow area (not including ineffective flow
area), taken at the approach cross section.

KI: An exponent for the live-bed contraction scour equation that accounts for
the mode ofbed material transport. The program can compute a value for K1
or the user can enter one. To have the program compute a value, the KI
button must be pressed. Figure 12-3 shows the window that comes up when
the K1 button is pressed. Once a water temperature is entered, and the user
presses the OK button, the K1 factor will be displayed on the main
contraction scour window. K1 is a function of the energy slope (S1) at the
approach section, the shear velocity (Y') at the approach section, water
temperature, and the fall velocity (w) of the D50 bed material.
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Figure 12.3 Computation of the Kl Factor

Approach XS River Sta.: The river station of what is being used as the
approach cross section. The approach cross section should be located at a
point upstream of the bridge just before the flow begins to contract do to the
constriction of the bridge opening. The program assumes that the second
cross section upstream of the bridge is the approach cross section. If this is
not the case, the user can select a different river station to be used as the
approach cross section.

As shown in Figure 12-2, the computation of contraction scour is performed
separately for the left overbank, main channel, and right overbank. For this
example, since there is no right overbank flow inside of the bridge, there is no
contraction scour for the right overbank. The summary results show that the
computed contraction scour, Ys, was 2.26 feet (0.69 m) for the left overbank,
and 6.67 feet (2.03 m) for the main channel. Also note that the graphic was
updated to show how far the bed would be scoured due to the contraction
scour.

Entering Pier Scour Data

Pier scour can be computed by either the Colorado State University (CSU)
equation (Richardson, et aI, 1990) or the Froehlich (1988) equation (the
Froehlich equation is not included in the HEC No.18 report). The CSU
equation is the default. As shown in Figure 12-4, the user is only required to
enter the pier nose shape (K1), the angle of attack for flow hitting the piers,
the condition of the bed (K3), and a D90 size fraction for the bed material.
All other values are automatically obtained from the HEC-RAS output file.
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As shown in Figure 12-4, the user has the option to use the maximum velocity
and depth in the main channel, or the local velocity and depth at each pier for
the calculation of the pier scour. In general, the maximum velocity and depth
are used in order to account for the potential of the main channel thalweg to
migrate back and forth within the bridge opening. The migration of the main
channel thalweg could cause the maximum potential scour to occur at anyone
of the bridge piers.

Each of the variables that are used in the computation ofpier scour are
defined below, as well as a description of where each variable is obtained
from the output file ..

Maximum VI Yl: If the user selects this option, the program will find the
maximum velocity and depth located in the cross section just upstream and
outside of the bridge. The program uses the flow distribution output to obtain
these values. The maximum VI and YI will then be used for all of the piers.

Legend
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Figure 12.4 Example Pier Scour Computation
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Local VI YI: If the user selects this option, the program will find the
velocity (VI) and depth (YI) at the cross section just upstream and outside of
the bridge that corresponds to the centerline stationing of each of the piers.

Method: The method option allows the user to choose between the CSU
equation and the Froehlich equation for the computation of local scour at
bridge piers. The CSU equation is the default method.

Pier #: This selection box controls how the data can be entered. When the
option "Apply to All Piers" is selected, any of the pier data entered by the
user will be applied to all of the piers. The user does not have to enter all of
the data in this mode, only the portion of the data that should be applied to all
of the piers. Optionally, the user can select a specific pier from this selection
box. When a specific pier is selected, any data that has already been entered,
or is applicable to that pier, will show up in each of the data fields. The user
can then enter any missing information for that pier, or change any data that
was already set.

Shape: This selection box is used to establish the pier nose (upstream end)
shape. The user can select between square nose, round nose, circular
cylinder, group of cylinders, or sharp nose (triangular) pier shapes. When the
user selects a shape, the KI factor for the CSU equation and the Phi factor for
the Froehlich equation are automatically set. The user can set the pier nose
shape for all piers, or a different shape can be entered for each pier.

a: This field is used to enter the width of the pier. The program automatically
puts a value in this field based on the bridge input data. The user can change
the value.

D50: Median diameter of the bed material of which 50 percent are smaller.
This value is automatically filled in for each pier, based on what was entered
for the left overbank, main channel; and right overbank, under the contraction
scour data. The user can change the value for all piers or any individual pier.

YI: This field is used to display the depth of water just upstream of each pier.
The value is taken from the flow distribution output at the cross section just
upstream and outside of the bridge. If the user has selected to use the
maximum YI and VI for the pier scour calculations, then this field will show
the maximum depth of water in the cross section for each pier. The user can
change this value directly for each or all piers.

VI: This field is used to display the average velocity just upstream of each
individual pier. The value is taken from the flow distribution output at the
cross section just upstream and outside of the bridge. If the user has selected
to use the maximum YI and VI for the pier scour calculations, then this field
will show the maximum velocity ofwater in the cross section for all piers.
The user can change this value directly for each or all piers.
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Angle: This field is used to enter the angle of attack of the flow approaching
the pier. lithe flow direction upstream of the pier is perpendicular to the pier
nose, then the angle would be entered as zero. If the flow is approaching the
pier nose at an angle, then that angle should be entered as a positive value in
degrees. When an angle is entered, the program automatically sets a value for
the K2 coefficient. When the angle is > 5 degrees, Kl is set to 1.0.

L: This field represents the length of the pier through the bridge. The field is
automatically set by the program to equal the width of the bridge. The user
can change the length for all piers or each individual pier. This length is used
in determining the magnitude of the K2 factor.

Kl: Correction factor for pier nose shape, used in the CSU equation. This
factor is automatically set when the user selects a pier nose shape. The user
can override the selected value and enter their own value.

K2: Correction factor for angle of attack of the flow on the pier, used in the
CSU equation. This factor is automatically calculated once the user enters the
pier width (a), the pier length (L), and the angle of attack (angle).

K3: Correction factor for bed condition, used in the CSU equation. The user
can select from: clear-water scour; plane bed and antidune flow; small dunes;
medium dunes; and large dunes.

D90: The median size of the bed material of which 90 percent is finer. The
D90 size fraction is used in the computation of the K4 factor, and must be
entered directly by the user.

K4: The K4 factor is used to decrease scour depths in order to account for
armoring of the scour hole. This factor is only applied when the D50 of the
bed material is greater than 0.2 feet (0.06 m). This factor is automatically
calculated by the program, and is a function of D50; D90; a; and the depth of
water just upstream of the pier. The K4 factor is used in the CSU equation.

a~The projected pier width with respect to the direction of the flow. This
factor should be calcula~ed by the user and is based on the pier width, shape,
angle, and length. This factor is specific to Froehlich's equation.

Phi: Correction factor for pier nose shape, used in the Froehlich equation.
This factor is automatically set when the user selects a pier nose shape. The
user can override the selected value and enter their own value.

For the example shown in Figure 12-4 the CSU equation was used, resulting
in a computed pier scour of 10.85 feet (3.31 m) at each pier (shown under
summary results in Figure 12-4). Also shown in Figure 12-4 is an updated
graphic with both contraction and pier scour shown.
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Entering Abutment Scour Data

Abutment scour can be computed by either the HIRE equation (Richardson,
1990) or Froehlich's equation (Froehlich, 1989). The input data and results
for abutment scour computations are shown in Figure 12-5.

Legend
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Figure 12.5 Example Abutment Scour Computations

As shown in Figure 12-5, abutment scour is computed separately for the left
and right abutment. The user is only required to enter the abutment type
(spill-through, vertical, vertical with wing walls). The program automatically
selects values for all of the other variables based on the hydraulic output and
default settings. However, the user can change any variable. The location of
the toe of the abutment is based on where the roadway embankment intersects
the natural ground. This stationing is very important because the hydraulic
variables used in the abutment scour computations will be obtained from the
flow distribution output at this cross section stationing. If the user does not
like the stationing that the model picks, they can override it by entering their
own value.
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Each of the variables that are used in the computation of abutment scour are
defined below, as well as a description of where each variable is obtained
from the output file.

Toe Sta at Bridge: This field is used to defme the stationing in the upstream
bridge cross section (section BU), where the toe of the abutment intersects the
natural ground. The program automatically selects a value for this stationing
at the point where the road embankment and/or abutment data intersects the
natural ground cross-section data. The location for the abutment toe
stationing can be changed directly in this field.

Toe Sta at App.: This field is used to defme the stationing in the approach
cross section (section 4), based on projecting the abutment toe station onto the
approach cross section. The location for this stationing can be changed
directly in this field.

Length: Length of the abutment and road embankment that is obstructing the
flow. The program automatically computes this value for both the left and
right embankments. The left embankment length is computed as the
stationing of the left abutment toe (projected up to the approach cross section)
minus the station of the left extent of the active water surface in the approach
cross section. The right embankment "length is computed as the stationing of
the right extent of the active water surface minus the stationing of the toe of
the right abutment (projected up to the approach cross section), at the
approach cross section. These lengths can be changed directly.

Yl: This value is the computed depth of water at the station of the toe of the
embankment, at the cross section just upstream of the bridge. The value is
computed by the program as the elevation of the water surface minus the
elevation of the ground at the abutment toe stationing. This value can also be
changed by the user. This value is used in the HIRE equation.

Kl: This value represents a correction factor accounting for abutment shape.
The user can choose among: vertical abutments; vertical with wing walls; and
spill-through abutments.

Skew: This field is used to enter the angle of attack of the flow against the
abutment. A value of 90 degrees should be entered for abutments that are
perpendicular to the flow (normal situation). A value less than 90 degrees
should be entered if the abutment is pointing in the downstream direction. A
value greater than 90 degrees should be entered if the abutments are pointing
in the upstream direction. The skew angle is used in computing the K2
factor.

K2: Correction factor for angle of attack of the flow on the abutments. This
factor is automatically computed by the program. As the skew angle becomes
greater than 90 degrees, this factor increases from a value of one. As the
skew angle becomes less than 90 degrees, this value becomes less than one.
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Equation: This field allows the user to select a specific equation (either the
HIRE or Froehlich equation), or select the default mode. When the default
mode is selected, the program will choose the equation that is the most
applicable to the situation. The selection is based on computing a factor of
the embankment length divided by the approach depth. If this factor is
greater that 25, the program will automatically use the HIRE equation. If the
factor is equal to or less than 25, the program will automatically use the
Froehlich equation.

V~·The length of the abutment (embankment) projected normal to the flow.
This value is automatically computed by the program once the user enters an
abutment length and a skew angle. This value can be changed by the user.

Ya: The average depth of flow (hydraulic depth) that is blocked by the
embankment at the approach cross section. This value is computed by
projecting the stationing of the abutment toe's up to the approach cross
section. From the flow distribution output, the program calculates the area
and top width left of the left abutment toe and right of the right abutment toe.
Ya is then computed as the area divided by the top width. This value can be
changed by the user directly.

Qe: The flow obstructed by the abutment and embankment at the approach
cross section. This value is computed by projecting the stationing of the
abutment toes onto the approach cross-section. From the flow distribution
output, the program calculates the percentage offlow left of the left abutment
toe and right of the right abutment toe. These percentages are multiplied by
the total flow to obtain the discharge blocked by each embankment. These
values can be changed by the user directly.

Ae: The flow area that is obstructed by the abutment and embankment at the
approach cross section. This value is .computed by projecting the stationing
of the abutment toes onto the approach cross-section. From the flow
distribution output, the program calculates the area left of the left abutment
toe and right of the right abutment toe. These values can be changed by the
user directly.

VI: The velocity at the toe of the abutment, taken from the cross section just
upstream and outside of the bridge. This velocity is obtained by finding the
velocity in the flow distribution output at the corresponding cross section
stationing of the abutment toe. These values can be changed by the user
directly.
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In addition to the abutment input data, once the compute button is pressed, the
bridge scour graphic is updated to include the abutment scour and the
summary results window displays the computed abutment results. For the
example shown in Figure 12-5, the program selected the HIRE equation and
computed 10.74 feet (3.27 m) oflocal scour for the left abutment and 14.90
feet (4.54 m) of local scour for the right abutment.

Computing Total Bridge Scour

The total scour is a combination of the contraction scour and the individual
pier and abutment scour at each location, Table 12.1 shows a summary of the
computed results, including the total scour.

Table 12.1
Summary of Scour Computations

Right a.B.
0.00 ft (0.0 m)

Contraction Scour
Main Channel
6.67 ft (2.03 m)
Live-Bed

Left a.B.
Ys = 2.26 ft (0.69 m)
Eqn = Clear-Water

Piers 1-6
Pier Scour
Ys = 10.85 ft (3.31 m)
Eqn. = CSU equation

Abutment Scour

Ys=
Eqn=

Left Right
10.74 ft (3.27 m) 14.90 ft (4.54 m)
HIRE equation HIRE equation

Total Scour
Left Abutment
Right abutment
Piers 1-2 (left a.B.)
Piers 3-6 (main ch.)

13.00 ft (3.96 m)
21.57 ft (6.58 m)
13.11 ft (4.00 m)
17.52 ft (5.34 m)

;e

ance all three types of scour data are entered, and the compute button is
pressed, the bridge scour graphic is updated to reflect the total computed
scour. Shown in Figure 12-6 is the graphic of the final results (the graphic
has been zoomed in to see more detail). The graphic and the tabular results
can be sent directly to the default printer, or they can be sent to the Windows
Clipboard in order to be pasted into a report. A detailed report can be
generated, which shows all of the input data, computations, and final results.
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The bridge scour input data can be saved by selecting Save Hydraulic
Design Data As from the File menu of the Hydraulic Design Function
window. The user is only required to enter a title for the data. The computed
bridge scour results are never saved to the hard disk. The computations can
be performed in a fraction of a second by simply pressing the compute button.
Therefore, when the Hydraulic Design Function window is closed, and later
re-opened, the user must press the compute button to get the results.

Bridge Scour RS =10.36
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CHAPTER 13

Performing Channel Modifications

The channel modification option in HEC-RAS allows the user to perform a
series of trapezoidal cuts into the existing channel geometry. In general, this
option is used for planning studies, but it can also be used for hydraulic
design of flood control channels.

This chapter does not cover the concepts of stable channel design. This
software is designed to evaluate the hydraulics ofvarious channel
modifications. It is up to the user to ensure that any channel modification will
not cause further scour of the channel bed and banks. Discussions on stable
channel design can be found in many hydraulic text books, as well the Corps
Engineering Manual "Hydraulic Design of Flood Control Channels"
(USACE, 1991).

This chapter discusses: general modeling guidelines for using the channel
modification option; how to enter the necessary input data; performing the
channel modifications; and how to compare existing condition and modified
condition results.

Contents

• General Modeling Guidelines

• Entering Channel Modification Data

• Performing The Channel Modifications

• Comparing Existing and Modified Conditions
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General Modeling Guidelines

In orderto perform a channel modification analysis, the user should first
develop a hydraulic model of the existing river reach containing the area in
which the channel modification will be analyzed. This model should include
several cross sections downstream from the study reach, such that any user
defined downstream boundary condition does not affect the hydraulic results
inside the channel modification region. The model should also include
several cross sections upstream of the study reach, in order to evaluate the
effects of the channel modification on the water surface profile upstream.

Once a model of the existing river system is completed, the user can use the
Channel Modification option to perform trapezoidal cuts and fills into the
existing geometry. Once the user has performed all of the desired channel
modifications, then the modified geometry data is saved into a new geometry
file. The user can then create a new plan, which contains the modified
geometry and the original flow data that was used under the existing
conditions plan. Computations can then be performed for the modified
condition, and the user can compare the water surface profiles for both
existing and modified conditions.

The channel modification option in HEC-RAS allows for:
• Multiple trapezoidal cuts (up to three)
• Independent specification of left and right trapezoidal side slopes
• Ability to change the Manning's n value for the trapezoidal cut
• Separate bottom widths for each trapezoidal cut
• Ability to set new channel reach lengths
• Multiple ways of locating the main channel centerline
• User can explicitly define the elevation of the new channel invert, or it

can be based on the original channel invert, or it can be based on
projecting a slope from a downstream cross section or an upstream cross
section

• The centerline of the trapezoidal cut can be entered directly, or it can be
located midway between the original main channel bank stations

• Option to fill the existing channel before performing cuts
• Cut and fill areas and volumes are computed

Entering Channel Modification Data

Within HEC-RAS, the data for performing a channel modification analysis
are entered from the Geometric Data window. The channel modification data
are stored within the geometry file of the base geometric data ( the geometric
data set in which the channel modification is being performed on).
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To bring up the Channel Modification Data window, select Channel
Modification from the Tools menu of the Geometric Data window. When
this option is selected, a Channel Modification window will appear as shown
in Figure 13.1 (except yours will not have any data in it the first time you
brin,g it up).

Figure 13.1 Channel Modification Data Editor

As shown in Figure 13.1, there are several pieces of data that the user must
enter in order to perform a channel modification analysis. The editor is
divided into three separate areas. Thetop portion of the window contains
selection boxes for the River and Reach; titles for the base geometry file and
the modified geometry file; buttons for performing the cuts and viewing cut
and fill volumes; and controls for rotating the graphic. The middle portion of
the window contains a data input area for entering channel modification
information over a range ofcross sections, as well as a graphic of the cross
sections that are being modified. The bottom portion of the window contains
a table that lists the channel modification data for all of the cross sections in
the selected Reach of a particular River.
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The first step in performing a channel modification is to select the River and
Reach in which you want to perform the analysis. This is accomplished from
the River and Reach selection boxes in the upper left corner ofthe window.
The next step is to select a range of cross sections in which you would like to
perform a channel modification. This is accomplished by first selecting a
cross section from the Starting Riv Sta box and then from the Ending Riv
Sta bqx. Once this is done, all of the cross sections within the range of the
specified starting and eliding river stations will appear in the graphic on the
right. The next step is to specify the channel modification data that you
would like to apply to this range of cross sections. This is accomplished by
entering information into the table contained in the "Set Range of Values"
area of$e window. This table allows the user to enter information for up to
three cuts, which can then be applied to the selected range of cross sections.
The information contained in this table is as follows:

Center Cuts (yin): This column in the table is used to define how the
trapezoidal cuts will be centered within the existing cross section data. If the
user enters a "y" in this column, then that particular cut will be centered
between the existing cross-section main channel bank stations. When all of
the cut information is entered, and the Apply Cuts to Selected Range button
is pressed, the program will automatically fill in the center stationing of the
trapezoidal cuts in the lower table. If an "n" is entered, then it is up to the
user to specify the center stationing for each cross section, and each cut, in
the table at the bottom of the window.

Bottom Width: This column is used for entering the bottom width of the
trapezoidal cuts. If this column is left blank, it is assumed that the bottom
width will be zero. The user always has the option of directly entering the
bottom width for each cross section in the table at the bottom of the window.

Invert Elevation: This column is used to specify the invert elevation of the
trapezoidal cuts. If this column is left blank for a particular cut, then it is
assumed that the invert elevation of that trapezoidal cut will be set equal to
the invert elevation of the existing channel. If the user wants to have invert
elevations that are not equal to the existing channel inverts, then they must
enter elevations into this column and select one of the slope projection
options below this table. The user has the option to use the specified invert
elevations for each of the cross sections in the selected range; or they can
enter elevations for the most upstream cross section and have the other invert
elevations computed by projecting the cuts on.a constant slope; or the
elevations entered can be applied to the most downstream cross section of the
range, and all others will be computed by projecting a user specified slope
upstream.
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Left Slope: This column is used to specify the slope of the left bank for each
of the trapezoidal cuts. The slope is entered in units ofhorizontal distance to
one unit in the vertical. (e.g., a value of2 means the left bank slope will
project 2 feet horizontally for every 1 foot vertically).

Right Slope: This column is used to specify the slope of the right bank for
each of the trapezoidal cuts. The slope is entered in units of horizontal
distance to one unit in the vertical. (e.g., a value of 2 means the right bank
slope will project 2 feet horizontally for every 1 foot vertically).

Cut n Val: This column is used to specify the new Manning's n value to be
applied to each of the trapezoidal cuts. If this column is left blank for any
cut, then the existing n values will be used for that cut.

Once this table has been filled out, the user must select one of the three slope
projection options listed below the table. The three options are:

Same Cut to all sections: If this option is selected, then the channel
modification data entered into the table will be applied to all of the cross
sections in the selected range.

Project cut from upper RS at slope: When this option is selected, the invert
elevations that were entered into the table will be applied to the most
upstream cross section in the selected range. The invert elevation of all of the
other cross sections will be based on projecting a user entered slope from the
most upstream cross section to each cross section downstream. The user must
enter a slope whim this option is selected. The elevations of each cross
sections trapezoidal cuts are based on the user entered slope times the
distance that each cross section is from the most upstream cross section. The
distance is the cumulative main channel reach length for each of the
individual cross sections. .

Project cut from lower RS at slope: When this option is selected, the invert
elevations that were entered into the table will be applied to the most
downstream cross section in the selected range. The invert elevation of all of
the other cross sections will be based on projecting a user entered slope from
the most downstream cross section to each cross section upstream. The user
must enter a slope when this option is selected. The elevations of each cross
section's trapezoidal cuts are based on the user entered slope times the
distance that ,each cross section is from the most downstream cross section.
The distance is the cumulative main channel reach length for each of the
individual cross sections.

A final option that can be applied to the selected range of cross sections is the
Fill Channel option. When this option is turned on, the main channel of the
base cross-section data will be filled before any of the trapezoidal cuts are
applied. The main channel is filled to an elevation equal to the elevation of
the lower of the two main channel bank stations.

13-5



Chapter 13 Performing Channel Modifications

Once the user has filled in all of the desired data in the "Set Range of Values"
data area, then the Apply Cuts to Selected Range button should be pressed.
When this button is pressed, the lower table is filled with the specific
information that will be applied to each of the cross sections in the selected
range. The cut information is then applied to each of the cross sections, and
the graphic is updated to show both the existing cross section and the
modified cross sections.

The user has the option ofentering and modifying the channel modification
data directly in the table at the bottom of the window, or they can use the "Set
Range of Values" data area to apply a set of channel cut properties to a range
of cross sections (this can be done several times for different ranges of cross
sections within the reach).

A final option available to the user is Cut cross section until cut daylights
once. This is a global option that will be applied to all of the channel
modification data. When this option is selected, as the program performs the
cutting of the trapezoidal channel, the left and right banks of the channel will
start at the bottom of the trapezoid and cut through the ground until they
reach open air, then the cutting will stop. If this option is turned off, the left
and right banks of the trapezoid will be projected to infinity, continually
cutting any ground that lies above them.

Performing the Channel Modifications

Once all of the desired channel modification data are entered for a reach, the
user should press the Compute Cuts button at the top of the graphic. When
this button is pressed, all of the channel modification data from the lower
table is applied and the graphic is updated to reflect the new cut information.
The user can continue to modify the data and press the Compute Cuts button
as many times as is necessary to get the desired cuts. The cut information is
always applied to the base geometry data.

Once the user has completed the desired channel modifications for the reach,
they can view the cut and fill quantities by pressing the Cut and Fill Areas
button. When this button is pressed, a window will appear as shown in
Figure 13.2.
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2 Cut 406 223 1053 ·7734 4398 23837 35969
Fill 0 0 0 0 0 0 0
Net 406 223 1053 7734 4398 23837 35969

Cut 429 243 1629 2301 0 0 0 0
Fill 0 0 0 0 0 ,0 0 o·
Net 429 243 1629 2301 0 0 0 0

Total

Figure 13.2 Channel Modification Cut and Fill Quantities

The cut and fill quantities table shows the cut, fill, and net areas and volumes
for each of the individual cross sections, as well as the totals for the reach.
The table shows the cut and fill quantities that were necessary in order to
transform the existing cross-section data into the modified cross-section data.
The areas and volumes are provided in the categories of left overbank, main
channel, right overbank, and total. These categories are based on the main
channel bank stations of the base geometry data. The volumes listed at a
particular cross section, represent the volume between that cross section and
the next downstream cross section. The total volume and area at a particular
cross section is the sum of the left overbank, main channel, and right
overbank quantities for that individual cross section only. Total volumes for
the entire reach are listed at the bottom of the table. The Cut and Fill
Quantities table can be printed, sent to a file, or copied to the clipboard, by
pressing the desired button at the bottom of the window.

The channel modification option has been set up to work with one Reach of
the model at a time. If the user needs to perform channel modifications to
more than one reach of a multiple reach model, they can simply select a new
reach at any time. While the information in the tables and the graphic only
show a single reach, the channel modification information is stored for all of
the reaches.
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Once the user has fInished all of the desir~cJ channelmod~fic_ations, for all of
the desired reaches, a new geometry fIle should be created fOf the modifIed
geometry. To create a modifIed geometry file, the user IIlust enter a title for
the modified g~ometry fIle in the upper right hand side of the window. Once
the new geometry file title is entered, the file can be created by pressing the
Create Modified Geometry button at the bottom of the window. When this
button is pressed, a Save Geometry Data As window will appear. The user
has the options to change the directory in which the geometry fIle will be
stored, change the name of the geometry fIle title, or select an existing
geometry fIle to over write. Once the user has decided on a title and a
directory, the OK button can be pressed to save the modifIed geometry to the
hard disk. However, the original geometry me is still the one that is in
memory. If the user wants to work with the new modifIed geometry fIle, they
will need to open it from the Geometric Data Editor window.

Note: the data entered into the channel modifIcation editor is saved as part of
the base geometry file (i.e., it is not saved with the modifIed geometry file).
This allows the user to open the base geometry me and recreate the modified
geometry. In order for this data to be saved, the user must select Save
Geometry Data from the file menu of the geometric data editor, after they
have entered the channel modification data.

Comparing Existing and Modified Conditions

Once a modified geometry file is created, the user can create a ~w la that
will incorporate the modified geometry and the previously defined flow data.
This is accomplished by first opening the modified geometry me from the
Geometric Data window. The next step is to open the Steady Flow Analysis
window and create a new Plan. Creating a plan is accomplished by selecting
New Plan from the File menu of the Steady Flow Analysis window. Once a
new plan is created, the computations can be performed.

After the water surface profile computations have been performed for the
modifIed channel conditions, the user can compare the results of the existing
and modified conditions on any of the graphics and tables. An example
cross-section plot of the two plans is shown in Figure 13.3. Figure 13.3
shows the geometry of the modified and existing conditions, along with the
computed water surface elevations from both the existing and modified plans.
To display the geometry and results from more than one plan on a graphic,
the user can select Plan from the Options menu on any of the graphics. At
the top of the plan selection window, turn on the option that says "Compare
Plan Results and Geometry." Select the two plans to be viewed and hit the
OK button. The geometry and output for both plans will be displayed.

In addition to graphical output, the user can review the computed results from
both plans in a tabular form. Figure 13.4 shows the computed results for both
plans in Standard Table 1 of the ProfIle Output table.
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Channel Moditicetion - Example 16 Plan: 1) Exist Cond
Geom: Base Geometry Data Flow: 100 Year Profile

Upstream Boundary· XSeo 12

Figure 13.3 Existing and Modified Geometry and Water Surface Elevations
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Figure 13.4 Standard Table 1 With Existing and Modified Conditions
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C HAP T E R 14

Using GIS Data With HEC-RAS

HEC-RAS has the ability to import three-dimensional (3D) river schematic
and cross section data created in a GIS or CADD system. While the HEC
RAS software only utilizes two-dimensional data during the computations,
the three-dimensional information is used in the program for display
purposes. After the user has completed a hydraulic analysis, the computed
water surface profiles can be exported back to the GIS or CADD system for
development and display of a flood inundation map.

The importing arid exporting of GIS or CADD data is accomplished through
the use of formatted ASCII text files. The text files provide a generic way of
exchanging data between GIS/CADD systems and HEC-RAS, without
adopting any single GIS/CADD system. Appendix B of this manual
provides a detailed description and examples of the fIle formats used for
importing and exporting GIS or CADD data.

The HEC has developed an ArcView GIS extension called GeoRAS, that was
specifically designed to process geospatial data for use with HEC-RAS. The
GeoRAS software allows a user to write geometric data to a file in the
required format for HEC-RAS. Additionally, the users can read the HEC
RAS results into GeoRAS and perform the flood inundation mapping. This
software is not part of the HEC-RAS program. The software and a user's
manual are provided as a separate program to be used with ArcView. Also,
the Intergraph Corporation has adding the capability to exchange data with
HEC-RAS in their Software package called Storm and Sewer Works
(Intergraph, 1999)

This chapter discusses how to import GIS or CADD data into HEC-RAS;
what additional information will need to be added to complete the data; and
how to export the results back to the GIS or CADD system.

Contents

• General Modeling Guidelines

• Importing GIS or CADD Data Into HEC-RAS

• Completing The Data and Performing The Computations

• Exporting Computed Results To The GIS or CADD
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Chapter.14 Using GIS Data With HEC-RAS

General Modeling Guidelines

The current version ofHEC-RAS has the ability to import the following
geometric data from a GIS/CADD system:

River System Schematic. The structure of the stream network as
represented by a series of interconnected reaches. Each reach is represented
as a multi-point line, which is assumed to follow the invert of the main
channel. The River and Reach labels, as well as the Junction labels, are also
imported from the GIS/CADD.

Cross Section Data. The following cross section data can be imported from
aGIS/CADD:

1. River, Reach, and River Station identifiers.

2. Cross Section Cut Lines (X and Y coordinates of the plan-view line
that represents the cross section). This is a multi-point line that can
have two or more points.

3. The cross section surface line. This line is sent to HEC-RAS as a
series of X, Y, Z coordinates for each point in the cross section.
HEC-RAS transforms these coordinates into station and elevation
points (X and y) for computational purposes. The first station of the
cross section is always set to zero. The true (real world) coordinates
of the cross section are recomputed from the cross section cut line for
the purposes of displaying the data (3D plot).

4. Cross section main channel bank stations.

5. Downstream reach lengths for the left overbank, main channel, and
right overbank.

6. Manning's n values.

7. Levee locations and elevations.

At· this time, contraction and expansion coefficients, optional cross section
properties (ineffective flow areas, blocked obstructions, etc.), and hydraulic
structure data (bridges, culverts, etc..) are not imported from a GIS/CADD
system. Many of these variables will be added in future versions of the
software.

The general procedure for utilizing GIS/CADD data with HEC-RAS is the
following:

1. The first step is to start a New Project. This is accomplished from the
File menu of the main HEC-RAS window.
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Once the user has a project that is utilizing GIS data, then additional data can
be imported directly into an existing HEC-RAS geometry file without starting
a new project. This allows the user to go back to the GIS and extract
additional cross sections on an as-needed basis. The HEC-RAS program will
automatically place the new cross sections into the appropriate River and
Reach, based on the identifiers defmed for each cross section in the GIS
import file. .

'.

2.

3.

4.

5.

6.

Chapter 14 /Ising GIS Data With HEC-RAS

The next step is to go to the Geometric Data editor and import the
GIS/CADD data into HEC-RAS. GIS/CADD data are imported by
selecting the Import GIS Data option from the File menu on the
Geometric Data window. This is assuming that you have already
used a GIS system to write the required geometry data into a text file,
using the required HEC-RAS format. The format of this file is
described in Appendix B of this manual.

After the GIS data are imported, the user will need to add any
additional geometric data that is needed to represent the physical
system.

The next step is to perform the water surface profile calculations for
the desired flow rates.

Once the water surface profiles are calculated, the user can then
output the results to a text file using the Export GIS Data option
from the File menu of the main HEC-RAS window.

The last step is to import the HEC-RAS results file into the
GIS/CADD system and develop the floodplain maps for each of the
profiles.

•

After the user has perforIned the hydraulic analyses, the computed water
surface profiles information can be written to a text file, which can then be
imported into the GIS for development and display of floodplain maps. HEC
RAS exports the cross section Cut Line coordinates (X aQc;l Y), as well as the
water surface elevation for each profile. This is done for every cross section
in the model. Additionally, the program exports a series of bounding
polygons (one per river reach) for each computed profile. For information
on the HEC-RAS GIS export file format, review the detailed write up found
in Appendix B of this manual.
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Importing GIS or CADD Data Into HEC-RAS

Within HEC-RAS, GIS data are imported from the Geometric Data Window.
To import geometric data from a GIS/CADD system into HEC-RAS, the
following steps should be followed:

1. The first step is to extract the necessary geometric information from a
GIS/CADD system and write it to a text file in the required HEC
RAS format. As mentioned previously, HEC has developed an
ArcView GIS extension called GeoRAS to help you do this.
Likewise, the Intergraph Corporation has added this capability to their
program called Stream and Storm Works. You have the option of
obtaining the GeoRAS software from HEC (for use in ArcView);
using the software developed by Intergraph; or developing your own
routines to extract this data from the GIS/CADD system ofyour
choice. The file formats for the required text file are outlined in
Appendix B of this manual.

2. The next step is to start a new project in HEC-RAS. This is
accomplished by selecting the New Project option from the File
menu of the main HEC-RAS window. This option will allow the user
to enter a project title and filename.

3. After a new project is started, the user should open the Geometric
Data Editor. Once the editor is opened, the user can import
GIS/CADD data into HEC-RAS by selecting the Import Geometry
Data - GIS Format option from the File menu of the Geometric Data
window. When this option is selected, a window will appear (Figure
14.1) in which the user can select the file that contains the geometry
data from the GIS.

Figure 14.1 Window for Selecting GIS Data File To Import
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Once the user selects the file containing the GIS data, and then
presses the OK button, the data will be imported and a schematic of
the river system will show up in the Geometric Data window (Figure
14.2). Once the importing of the data is completed, the user should
save the geometric data by selecting Save Geometry Data As from
the File menu of the Geometric Data window.

:.

:.,

Figure 14.2 River System Schematic of Imported GIS Data

14-5



Chapter 14 Using GIS Data With HEC-RAS

Completing The Data and Performing The
Computations

Completing The Geometric Data

Once the user has imported the geometric data from a GIS/CADD system, the
next step is to add any !ldditional data required to perform the analyses.
Depending on what data was extracted from the GIS (Le. ifo-values were not
extracted from the GIS), the user may be req)lired to enter Manning's n
values for all of the cross sections, and junction reach lengths if there are any
junctions in the data set. Manning's n values can be entered directly from the
cross section data editor (on a cross section by cross section basis) or through
the Manning's n-values table (this is the preferred way because the n values
can be entered more efficiently). The Manning's n value table is available
from the Tables menu on the Geometric Data window.

In addition to the Manning's n values, the user may need to enter the
following data to complete the geometry file: additional user entered cross
section data; interpolated cross sections; optional cross section properties
(ineffective flow areas, levees, blocked obstructions, etc.); and hydraulic
structures (bridges, culverts, weirs and spillways).

Importing Additional Geometry From The GIS·

The user also has the option of getting additional cross-section data from the
GIS. Additional cross sections can be extracted from the GIS and written to
the GIS text file for import into HEC-RAS. When this is done, if the original
cross section data as well as the new cross sections are contained in the GIS
file, the HEC-RAS software will ask the user if they want to completely clear
the existing geometry file and start a new one or if they want to update
currently opened geometry data. If the user chooses to update the currently
opened geometry data and if the GIS import file contains cross sections that
are already in the geometry file, the program will ask the user to select one of
the following three options pertaining to the duplicate cross sections only:

Clear existing XS and replace with new data. This option completely
eliminates the existing cross sections and replaces it with the new data found
in the GIS import file.

Update existing cross section with new data only. This option does not
clear the existing cross section, but it does update the cross section with any
of the data found in the GIS import file. Information like the ground points,
main channel bank stations, and downstream reach lengths will be updated.
Manning's n values, and optional cross section properties will not be changed
from the original data.
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Do not modify existing cross section data. This option tells the program not
to modify anything about the existing cross section data, and to only add any
new cross sections that are found in the GIS import file.

Entering Additional Cross Section Data

If additional cross sections are entered by the user from the cross section
editor (or through the HEC-2 import feature), the user will need to enter the
coordinates of the cross section strike line in order to maintain a geospatially
correct schematic and XYZ plot. The cross section strike line coordinates can
i?e eIl!~red by selecting X~ ~c.h~ma,tic Lines from the Edit menu on the
Geometric pata window. 'When t4.is opti,on is selec,ted a wmdow will appear
as show in Figure 14.3 .

Figure 14.3 Cross Section Schematic Line X and Y Coordinates

The coordinates that are entered for the cross section schematic lines must be
consistent with the previously entered GIS data (i.e., if the GIS data is in state
plane coordinates, then the user entered data must also be in state plane
coordinates). Once all ofthe cross section schematic lines have consistent
coordinates, the schematic and XYZ plot will provide a geospatially correct
display of the cross sections.
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Performing The Comp~tations and Viewing Results

Once the user has completed the geometric data file, flow data can be entered
and the computations can be performed. When utilizing GIS data, there are
no special requirements for entering flow data or performing the
computations. Once the hydraulic computations are completed, the user can
begin to review the output. When GIS data are utilized, the HEC-RAS XYZ
pe~spective plot has the ability to plot a true three dimensional perspective of
the river system and the water surface profiles. An example XYZ plot with
GIS data is shown in Figure 14.4.

Wailupe River with GI8 data -Example 17 Plan: Final Geometry Run
Geom: Final Geometry Data - GIS + Interp + Br Flow: 50,100,500 yr tlow data

Legend

, ,
I

Levee

Ground

Bank SIs

Ground
s
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VIIS 100 yr

VIIS 500 yr

j
;;;;;;.------------------~~_iI

Figure 14.4 XYZ Perspective Plot With GIS Data
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Exporting Computed Results To The GIS or CADD

Once the user has completed all of the hydraulic calculations, the computed
water surface profiles can be exported to the GIS/CADD in order to develop
floodplain maps. The HEC-RAS results are exported to an ASCII text file,
which can then be imported by the GIS/CADD system. The format of the
HEC-RAS results file is documented in Appendix B of this manual.

Exporting the HEC-RAS computed wliter surface-profiles to a GIS/CADD
system is accomplished by selecting Export GIS Data from the File menu on
the main HEC-RAS window. Once this option is selected, a window will
appear as shown in Figure 14.5.

Figure 14.5 Window to Enter a Filename For Exporting
Results to GIS

As shown in Figure 14.5, the user first enters a filename for the HEC-RAS
Export file. Next, the user can select what they would like to export.
Normally the user would select "Export Water Surfaces," and then select
which profiles to export by using the Select ProfIles to Export button. Once
these options are selected, the information can be exported by pressing the
Export Data button.

Additional options are available to export geometry data from HEC-RAS to
the GIS/CADD system. This option can be very useful for supplementing
terrain data with additional surveyed cross sections. It is a common
occurrence for terrain models to have good information in the overbank areas,
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but not as good, if at all, in the main channel. HEC-RASallows the user to
export the entire cross section, or just the main channel portion only. Also,
the user can send all cross sections, including interpolated sections, or they
can turn off the interpolated cross sections. Additionally, there are options to
send reach lengths, bank stations, levees, and ineffective flow areas to the
GIS system.

In order to use the feature of sending terrain data from HEC-RAS to the GIS,
the user must enter geospatial coordinates for all of the cross sections, and the
stream centerline before exporting the data. These coordinates are required in
order to correctly locate the data spatially within the terrain model.
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AppendixB

HEC-RAS Import/Export Files for
Geospatial Data

At version 2.0, HEC-RAS has introduced three-dimensional (3D)
geometry for the description of river networks and cross-sections. This
capability makes it possible to import channel geometry from CADD or
GIS programs without conversion from real-world coordinates to station
elevation descriptions for the cross sections, as HEC-2 required.
Similarly, water-surface elevations calculated at cross sections can be
exported to CADD or GIS programs, where they can be used to create
model water surfaces for inundation mapping.

Supported HEC-RAS Data Exchange

Using a formatted ASCII text file, HEC-RAS will import a basic
description of the channel geometry including:

• The structure of the stream network, as represented by
interconnected reaches.

• The location and description of cross sections.
• Manning's n values for each cross section.
• Levee alignment information for each cross section.
• Ineffective flow area locations for each cross section.
• Storage area information for each cross section.

Using the same file format, HEC-RAS can write a file exporting the
results of a hydraulic model run to a CADD or GIS program. At a
minimum, reported results include the locations of cross sections and the
calculated water-surface elevations at those cross sections.

The Import/Export Data File Structure

This section gives general rules for the construction of an HEC-RAS
. geometric data import or export file. It is not necessary to understand all

these rules to build an import file, but they may be useful when debugging
failed imports. The rules given here are a portion of the defmition of a
general-purpose geometric data exchange format being developed at HEC
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for its NexGen model programs. Note: These me formats are evolving,
in that additional data types will be added, and some of the existing
ones may be modified for future versions. If you are writing software
to read and write these file formats, please keep in mind that you may
need to modify your software to stay compatible with future versions
ofHEC-RAS.

Records and Keywords

The HEC-RAS geometric data import file is composed of records, which
in tum are composed of keywords and values. All records must contain
one keyword, and all keywords end with a colon (:). A record can also
contain a value or a set of values following the keyword, i.e., after the
colon. Spaces, tabs, or line ends can be placed between a keyword and
values within a record.

A record that contains a keyword and no value marks the beginning or the
end ofa group of related records (for example, the record "BEGIN
HEADER:" marks the beginning of the header section ofa data file). A
record that contains a keyword and a value assigns that value to the part of
the model named by the keyword.

When a keyword is read, all spaces up to the colon are removed and all
letters are capitalized. The keywords "Begin Header:", "Begin header:",
and" Be GiNH eadEr:" are all equivalent to "BEGINHEADER:". For
readability, keywords named in this manual will contain internal spaces.

Values

A record can assign a single value to a single variable, or multiple values
to an array. Values can be integers, floating point numbers, text strings, or
locations (X,Y,Z, label). A single value in an array of values is called an
"element" of that array.

A numerical value (integer or floating point) cannot contain internal
blanks. A floating point number can contain a decimal point; an integer
cannot. Elements in an array ofnumerical values can be separated by
commas, blanks, tabs, or line ends.

A text string can contain internal blanks, tabs, and commas, but cannot
contain internal line ends. Elements in an array of text strings must be
separated by line ends.

A location consists of three coordinate values and a label (X, Y, Z, label).
The first two coordinates are planar, the third gives elevation. The
coordinate values are floating point numbers, and the label can be any type
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of value (although the label can be restricted to a particular data type in a
particular context). In certain contexts, the elevation value or the label may
not be required. If a label is used, all three coordinate values must be
given; the value "NULL" is valid for the elevation coordinate only. The
coordinate values and the label can be separated by commas, blanks, or
tabs, but a location cannot contain intemalline ends. Elements in an array
of locations must be separated by line ends.

Data Groups

Records in the data file can be collected in two types of groups: objects
and file sections. An object is a group of records that combine to describe
an entity within the model, a cross-section for example. A file section is a
logical or functional grouping of data, the file header, for example, is a
section that contains a description of the whole file.

Objects and file sections begin and end with records that contain
keywords, but no values. A file section starts with a record containing a
keyword composed of the word "BEGIN" followed by the section name
and a colon, and ends with a keyword composed of the word "END"
followed by the section name and a colon. For example, records
containing only the keywords "BEGIN HEADER:" and "END HEADER:"
are used to start and end the header section of a file. An object starts with
a record containing a keyword naming the object type and ends with a
record containing the keyword "END:" only. For example, a cross-section
object begins and ends with records containing the keywords "CROSS
SECTION:" and "END:" only.

Comments

Hash characters (#) are used to identify comments. When a hash character
is encountered in the file, all data from the hash to the next line end are
ignored. A line that begins with a hash is equivalent to a blank line.

HEC-RAS Channel Geometry Import File

HEC-RAS reads channel geometry from a text file composed of three data
sections:
1. A header containing descriptions that apply to all data in the file.
2. A description of the stream network identifying reach locations and

connectivity.
3. A description of the model cross-sections containing their location

on the stream network and data required to support the HEC-RAS
model.
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An example HEC-RAS Channel Geometry Import file and HEC-RAS
model results export file is shown at the end of this appendix.

Header

The header is bounded by the records "BEGIN HEADER:" and "END
HEADER:" and must contain a record to identify the units system used in
the imported data set. The units system can be ENGLISH or METRlC.

I BEGIN HEADER:

I
UNITS: ENGLISH
END HEADER:

Records that may be included in the header are listed in the Table B.l:

Table B.t

Keyword Value Type Value

UNITS: string ENGLISH or METRlC

PROFILES: string array List ofprofiles exported from HEC-RAS.
Not used on import.

DTMTYPE: string type (e.g., TIN or raster)

DTM: string name of digital terrain model

STREAM LAYER: string name of stream layer in CADD or GIS

NUMBER OF REACHES integer number of hydraulic reaches contained in
the file.

CROSS-SECTION LAYER: string name of cross-section layer in CADD or
GIS

NUMBER OF CROSS- integer number of cross sections in the file
SECTIONS:

MAP PROJECTION: string projection (coordinate) system used (e.g.,
STATEPLANE)

PROJECTION ZONE: string projection zone (if applicable, e.g., 5101)

DATUM: string reference datum for planar coordinates

VERTICAL DATUM: string reference datum for vertical coordinates
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Stream Network

The stream network section is bounded by the records "BEGIN STREAM
NETWORK:" and "END STREAM NETWORK:" and contains records
describing reaches and reach endpoints. At a minimum, the stream
network section must contain at least two endpoints and one reach. The
minimum requirements for a stream network are shown below.

BEGIN STREAM NETWORK:
ENDPOINT: 476132.66, 65291.86, 155.28, 1
ENDPOINT: 478144.53, 64296.61, 123.72, 2

REACH:
STREAM ID: Below Springfield
REACH ID: Blue River
FROM POINT: 1
TO POINT: 2
CENTERLINE:

476132.66, 65291.86, 155.28, 23.13
476196.08, 65196.61, 154.47, 23.09

lines omitted
478144.53, 64296.61, 123.72, 22.41

END:
END STREAM NETWORK:

A reach endpoint is represented by a record containing the keyword
"ENDPOINT:" followed by four comma-delimited fields containing the
endpoints X,Y,Z coordinates and an integer ill.
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A reach is represented by a multi-record object that begins with a record
containing only the keyword "REACH:" and ends with a record containing
only the keyword "END:". At a minimum, a reach object must contain
records setting values for a stream ill, a reach ID, a FROM point, and a TO
point. A reach's FROM and TO point IDs must match IDs for endpoints
listed before the reach object in the file. The reach object must also contain
an array of locations defIning the stream centerline. This array begins with
a record containing only the keyword "CENTERLINE:" and ends when any
keyword is encountered. A location element in the array contains the X, Y,
and Z coordinates of a point on the stream centerline, and the point's river
station. In HEC-RAS, elevation and stationing are optional in the stream
network defmition. If a location element includes a station value, it must
occupy the fourth fIeld in the element. If the elevation is not known, the
word "null" must take its place.

Station values are assumed to be in miles for data sets in English units, and
in kilometers for data sets in metric units. Stationing is used for indexing
locations along reaches, and is not used to precisely locate objects in the
model.

Records that may be included in a stream network section are listed in
Table B.2:

Table B.2

Keyword Value Type Value

ENDPOINT: location coordinates and integer ID

REACH: none marks beginning of reach object

END: none marks end of reach object

The following records are required for a reach object.

STREAMID: string identifIes reach's membership in stream

REACHID: string unique ill for reach within stream

FROM POINT: string integer reference to upstream endpoint

TO POINT: string integer reference to downstream endpoint

CENTERLINE: location array array elements contain coordinates and
(optionally) floating point station value.
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Cross Sections

The cross-sectional file section begins with a record containing the only the
keyword "BEGIN CROSS-SECTIONS:" and ends with a record containing the
only the keyword "END CROSS-SECTIONS:." A cross section is represented
by multi-record object beginning with a record containing only the keyword
"CROSS-SECTION:" and ending with a record containing only the keyword
"END:."

A cross-sectional object must include records identifying the stream, reach, and
station value of the cross-section, a 2D cut line, and a series of 3D locations on
the cross section. A cut line is composed of the label "CUT LINE:" followed
by an array of2D locations. A cross-sectional polyline consists of the label
"SURFACE LINE:" plus 3D coordinates written as comma-delimited X,Y, Z
real-number triples, one triple to a line.

Records that may be included in the cross-section me section are listed in Table
B.3:

Table B.3

Keyword Value Type Value

CROSS-SECTION: none marks beginning of cross-section object

END: none marks end of cross-section object

The following records are required for a cross-section object.

STREAMID: string identifiers for stream and reach where cross-

REACHID: string section is located (must refer to existing
streams and reaches in the model)

STATION: floating point relative position of cross-section on stream

CUT LINE: location array array elements contain 2D coordinates of
cross sectione stike line

SURFACE LINE: location array array elements contain 3D coordinates of
cross section points

The following records are optional for a cross-section object.

BANK. POSITIONS: floating point Fraction of length along cut line where main
(2 elements) channel bank stations are located. (values 0.0

- 1.0)

REACH LENGTHS: floating point Distance along left overbank, center channel,
(3 elements) and right overbank flow paths to next cross-

section downstream (units are feet or meters).

NVALUES: floating point Manning's n values expressed as fraction
(n paired along cut line to start of n-value (fraction, n-
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Keyword Value Type Value
elements) value).

LEVEE POSITIONS: mixed array Levee positions expressed as a unique ill,
elements fraction along the cut line and levee elevation

(LeveejD, fraction, elevation)

LEVEEID: integer Unique integer value identifying a levee

INEFFECTIVE POSITIONS: floating point Ineffective flow area information along the
(paired cut line is specified by a unique ID, beginning
element and ending fraction along the cut line, and
arrays) elevation (IneffectivejD, BeginPct, EndPct,

Elevation)

INEFFECTIVE ID: integer Unique integer value identifying ineffective
flow area.

SAID: integer Unique integer value identifying a storage
area.

POLYGON: floating point Location of ineffective flow areas or storage
(n paired areas used for plotting.
elements)

ELEVATION-VOLUME: floating point Elevation-volume information for a storage
(n paired area (elevation, volume).
elements)

TERRAIN: floating point Elevation data describing the land surface at a
(n x,y,z storage area (X, Y,Z).
elements)

WATER ELEVATION: floating point Water surface elevation values. Used for
array export of model results. Not read on import.

HEC-RAS Model Results Export File

HEC-RAS exports model results to a text file using the same format as the
data import file. The contents of the files, however, are not identical. The
stream network section is not required for data export, and the surface line
may be omitted from the cross-section objects. An example HEC-RAS
model export file is shown at the end of this discussion. Model results are
reported with the following elements (Table B.4), which are not required
(and are not read) in the import file.
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Table B.4

Keyword Value Type Value I
The following record is optional in the Header section of the export file.

PROmE NAMES: string array name(s) ofwater surface profiles reported in
the file. This record is required if more than
one profile is reported.

The following record is required for each cross-section object.

WATER ELEVATIONS: floating point Elevation of water surface at the cross-
array section. The array must contain one value for

each profile.

The following records are optional for a cross-section object.

PROFll..EID: string Water surface profile name. This must match
a name in the Profile Names record in the
header.

VELOCITIES: floating point Fraction along cut line and value of velocity
(pair) (fraction, value). Velocities record must

follow Profile ID record.

The following records make up a section defming a bounding polygon of the water surface
limits.

BEGIN BOUNDARIES: none Marks start ofboundaries file section.

END BOUNDARIES: none Marks end ofboundaries file section.

PROFll..E LIMITS: none Marks start of an object defming the limits of
a single water surface profile.

PROFll..EID: string Name ofprofile. This must match a name in
the Profile Names record in the header.

POLYGON location array A series of2D locations marking the limits of
a water surface. A single prOfile limit can be
merged from multiple polygons.

1. HEC-RAS allows the user 16 character profile names. However,
profIle names can contain up to 9 characters for HEC-GeoRAS
ArcView Extension Version 3.0 or 11 characters for HEC
GeoRAS for ArcInfo. They must begin with a letter.

•
2. If no profile name is provided, only one water elevation will be

written for each cross section.
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Water Surface Bounding Polygon

In addition to a water surface elevation at each cross section (one for each
profile), the HEC-RAS program sends a bounding polygon for each
hydraulic reach in the model (the program outputs a new set of bounding
polygons for each profile computed). The bounding polygon is used as an
additional tool in assisting the GIS (or CADD) software to figure out the
boundary of the water surface on top of the terrain.

In most cases, the bounding polygon will represent the outer limits of the
cross section data, and the actual intersection of the water surface with the
terrain will be inside of the polygon. In this case, the GIS software will use
the water surface elevations at each cross section and create a surface that
extends out to the edges of the bounding polygon. That surface is then
intersected with the terrain data, and the actual water limits are found as the
location where the water depth is zero.

However, is some cases, the bounding polygon may not represent the
extents of the cross-section data. For example, ifthere are levees
represented in the HEC-RAS model, which limit the flow of water, then the
bounding polygon will only extend out to the levees at each cross section.
By doing this, when the information is sent to the GIS, the bounding
polygon will prevent the GIS system from allowing water to show up on
both sides of the levees.

In addition to levees, the bounding polygon is also used at hydraulic
structures such as bridges, culverts, weirs, and spillways. For example, if
all of the flow is going under a bridge, the bounding polygon is brought into
the edges of the bridge opening along the road embankment on the
upstream side, and then back out to the extent of the cross-section data on
the downstream side. By doing this, the GIS will be able to show the
contraction and expansion of the flow through the hydrualic structures,
even if the hydraulic structures are not geometricaly represented in the GIS.

Another application of the bounding polygon is in FEMA floodway studies.
When a floodway study is done, the first profile represents the existing
conditions of the flood plain. The second and subsequent profiles are run
by encroaching on the floodplain until some target increase in water surface
elevation is met. When the encroached profile is sent to the GIS, the
bounding polygon is set to the limits of the encroachment for each cross
section. This will allow the GIS to display the encroached water surface
(floodway) over the terrain, even though the water surface does not
intersect the ground.
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Import/Export Guidelines

The following rules apply to channel and cross-section import/export data.

Defining The Stream Network

1. The stream network is represented by a set of interconnected
reaches. A stream is a set of one or more connected reaches that
share a common stream ID.

2. A stream is composed of one or more reaches with the same stream
ID, and each reach in a stream must have a unique reach ill. Every
reach must be identified by a unique combination of stream and
reach IDs.

3. Stream IDs and Reach IDs are alphanumeric strings up to 16
characters long. Reach endpoint IDs are integers.

5. A reach is represented by an ordered series of 3D coordinates, and
identified by a stream ID, a reach ID, and IDs for its endpoints.

•
4. Streams cannot contain parallel flow paths. (If three reaches

cqnnect at a node, only two can have the same stream ID.) This
prevents ambiguity in stationing along a stream.

6. A reach endpoint is represented by its 3D coordinates and identified
by an integer ID.

7. Reaches are not allowed to cross, but can be connected at their
endpoints Uunctions) to form a network.

8. The normal direction of flow on a reach is indicated by the order of
its endpoints. One point marks the upstream or "from" end of the
reach, the other marks the downstream or "to" end of the reach.

Defining Cross Sections

1. Each cross section is defined by a series of 3D coordinates, and
identified by a stream name and reach name (which must refer to an
existing stream and reach) and a station, indicating the distance
from the cross-section to the downstream end of the stream.

• 2. Careful attention must be given to cross-sectional stationing.
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3. A cross-section line can cross a reach line exactly once, and cannot
cross another cross-section line.

Results of a water surface calculation are exported in a file that contains
cross-section locations in plane (2D) coordinates, water-surface elevations
for the cross-sections, and boundary polygons for the reaches.

The Following Rules Apply to Water-Surface Export Data

1. A cross-section is represented by a water surface elevation and a
series of 2D coordinates on the cross-section cut line. The full
width of the cross-section is included.

2. One bounding polygon is created for each reach in the stream
network, and for each profile.

3. A reach's bounding polygon is made up of the most upstream cross
section on the reach, the endpoints of all cross-sections on the reach,
and the most upstream cross-sections of reaches downstream of the
reach.

4. For purposes of defuiing bounding polygons only, the endpoints of a
cross-section are adjusted to the edge of the water surface at the
cross-section if the cross-section is part of a floodway, a leveed
section of the reach, or the water extent is controlled by a hydraulic
structure. This allows calculated water surfaces that are higher than
the land surface to be reported back to the CADD or GIS program.
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Sample HEC-RAS Geometry Import File

# RAS input file created on Thu Nov 18 13:12:37 1999
# by ArcView extension HEC-GeoRAS

BEGIN HEADER:

DTM TYPE: TIN
DTM: d:\georas\wailupe\wai_tin
STREAM LAYER: d:\georas\wailupe\stream3d.shp
NUMBER OF REACHES: 3
CROSS-SECTION LAYER: d:\georas\wailupe\xscutlines3d.shp
NUMBER OF CROSS-SECTIONS: 40
MAP PROJECTION: STATEPLANE
PROJECTION ZONE: 5103
DATUM: NAD27
UNITS: ENGLISH

END HEADER:

BEGIN STREAM NETWORK:

ENDPOINT: 582090.487, 49258.898, 218.609, 1
ENDPOINT: 582331.70/, 47063.536, 114.164, 2
ENDPOINT: 583735.405, 47715.344, 278.222, 3
ENDPOINT: 584138.295, 41249.225, 1.140, 4

REACH:
STREAM ID: Wailupe
REACH ID: Upper
FROM POINT: 1
TO POINT: 2
CENTERLINE:

582090.487, 49258.898, 218.609, 8640.151
many lines omitted

582331.707, 47063.536, 114.164, 6402.057
END:

REACH:
STREAM ID: Kulai Gorge
REACH ID: Tributary
FROM POINT: 3
TO POINT: 2
CENTERLINE:

583735.405, 47715.344, 278.222, 1813.116
many lines omitted

582331.707, 47063.536, 114.164, -0.000
END:

REACH:
STREAM ID: Wailupe
REACH ID: Lower
FROM POINT: 2
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TO POINT: 4
CENTERLINE:

582331.707, 47063.536, 114.164, 6402.057
many lines omitted

584138.295, 41249.225, 1.140, 0.000
END:

END STREAM NETWORK:

BEGIN CROSS-SECTIONS:

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Lower
STATION: 220.827
BANK POSITIONS: 0.503, 0.515
REACH LENGTHS: 87.418, 220.827, 159.365
NVALUES:

0.000, 0.150
0.501, 0.035
0.532, 0.150

LEVEE POSITIONS:
I, 0.312, 6.234

INEFFECTIVE POSITIONS:
I, 0.000, 0.478, 5.789

CUT LINE:
586214.122, 42127.918
581980.991, 40806.059

SURFACE LINE:
586214.122, 42127.918, 4.007

many lines omitted
581980.991, 40806.059, 6.390

END:

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Lower
STATION: 346.249
BANK POSITIONS: 0.506, 0.518
REACH LENGTHS: 128.209, 125.422, 199.366
NVALUES:

0.000, 0.066
0.021, 0.150
0.503, 0.035
0.532, 0.150

LEVEE POSITIONS:
I, 0.345, 7.123

INEFFECTIVE POSITIONS:
I, 0.000, 0.412,5.987

CUT LINE:
586190.939, 42248.509
583923.687, 41543.517
581883.624, 41116.812
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SURFACE LINE:
586190.939, 42248.509, 13.293

many lines omitted
581883.624, 41116.812, 7.145

END:

many cross sections omitted

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Lower
STATION: 6269.258
BANK POSITIONS: 0.524, 0.569
REACH LENGTHS: 170.100, 164.521, 158.965
NVALUES:

0.00, 0.066
0.19, 0.150
0.47, 0.035
0.56, 0.150
0.94, 0.066

CUT LINE:
582723.174, 46846.449
582426.438, 46878.916
581953.514, 47082.992

SURFACE LINE:
582723.174, 46846.449, 161.917

many lines omitted
581953.514, 47082.992, 165.010

END:

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Upper
STATION: 6822.378
BANK POSITIONS: 0.492, 0.555
REACH LENGTHS: 142.689, 139.905, 126.201
NVALUES:

0.00, 0.066
0.27, 0.150

CUT LINE:
582774.257, 47502.740
582593.433, 47493.464
582343.062, 47465.635
582083.418, 47502.740

SURFACE LINE:
582774.257, 47502.740, 170.548

many lines omitted
582083.418, 47502.740, 164.0~9

END:

many cross sections omitted

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Upper
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STATION: 6682.474
BANK POSITIONS: 0.380, 0.472
REACH LENGTHS: 454.362, 413.216, 375.704
NVALUES:

0.00, 0.150
CUT LINE:

582641.922, 47366.533
582444.447, 47335.449
582336.567, 47337.277
582062.296, 47381.161

SURFACE LINE:
582641.922, 47366.533, 149.810

many lines omitted
582062.296,47381.161,160.799

END:

CROSS-SECTION:
STREAM ID: Kulai Gorge
REACH ID: Tributary
STATION: 1089.584
BANK POSITIONS: 0.373, 0.579
REACH LENGTHS: 263.179, 255.877, 223.864
NVALUES:

0.00, 0.150
0.48, 0.055
0.59, 0.150
0.70, 0.066

CUT LINE:
583337.968, 47187.952
583207.930, 47327.062
583153.496, 47381.496
583126.279, 47608.306

SURFACE LINE:
583337.968, 47187.952, 257.736

many lines omitted
583126.279, 47608.306, 326.921

END:

CROSS-SECTION:
STREAM ID: Kulai Gorge
REACH ID: Tributary
STATION: 273.138
BANK POSITIONS: 0.541, 0.655
REACH LENGTHS: 139.815, 273.138, 79.293
NVALUES:

0.00, 0.150
0.37, 0.055
0.62, 0.035
0.64, 0.150

CUT LINE:
582546.842, 47088.605
582555.984, 47189.171
582550.499, 47240.368
582552.327, 47295.223

SURFACE LINE:
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582546.842, 47088.605, 145.787
many lines omitted

582552.327, 47295.223, 144.778
END:

END CROSS-SECTIONS:

BEGIN LEVEES:

LEVEE ID: 1
SURFACE LINE:

584579.800, 41808.166, 7.222
many lines omitted

584631.334, 41572.921, 5.922
END:

END LEVEES:

BEGIN INEFFECTIVE AREAS:

INEFFECTIVE ID: 1
POLYGON:

584422.114, 41883.166
584452.132, 41787.626

many lines omitted
584552.852, 41577.321

END:

END INEFFECTIVE AREAS:

BEGIN STORAGE AREAS:

SA ID: 1
POLYGON:

581919.014, 43565.358
many lines omitted

581895.224, 43443.864
END:

ELEVATION-VOLUME:
20.000, 0
22.000, 675000

many lines omitted
30.000, 421300

END:

TERRAIN:
581898.124, 43566.478, 33.442
582361.222, 43216.332, 20.369

many lines omitted
581867.484, 43432.612, 33.356

END:

END STORAGE AREAS:

B-17



Appendix B - HEC-RAS Import/Export Filesfor Geospatial Data

Sample HEC·RAS Geographic Data Export File

BEGIN HEADER:
UNITS: ENGLISH
DTM TYPE: TIN
DTM: d:\georas\wailupe\wai tin
STREAM LAYER: d:\georas\waIlupe\stream3d.shp
CROSS-SECTION LAYER: d:\georas\wailupe\xscutlines3d.shp
MAP PROJECTION: STATEPLANE
PROJECTION ZONE: 5103
DATUM: NAD27
VERTICAL DATUM:
NUMBER OF PROFILES: 3
PROFILE NAMES:

Big
Bigger
Biggest

NUMBER OF REACHES: 3
NUMBER OF CROSS-SECTIONS: 103

END HEADER:

BEGIN STREAM NETWORK:

ENDPOINT: 582090.487, 49258.898, 218.609, 1
ENDPOINT: 582331.707, 47063.536, 114.164, 2
ENDPOINT: 583735.405, 47715.344, 278.222, 3
ENDPOINT: 584138.295, 41249.225, 1.140, 4

REACH:
STREAM ID: Wailupe
REACH ID: Upper
FROM POINT: 1
TO POINT: 2
CENTERLINE:

582090.487, 49258.898, 218.609, 8640.151
many lines omitted

582331.707, 47063.536, 114.164, 6402.057
END:

REACH:
STREAM ID: Kulai Gorge
REACH ID: Tributary
FROM POINT: 3
TO POINT: 2
CENTERLINE:

583735.405, 47715.344, 278.222, 1813.116
many lines omitted

582331.707, 47063.536, 114.164, -0.000
END:

REACH:
STREAM ID: Wailupe
REACH ID: Lower
FROM POINT: 2
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TO POINT: 4
CENTERLINE:

582331.707, 47063.536, 114.164, 6402.057
many lines omitted

584138.295, 41249.225, 1.140, 0.000
END:

END STREAM NETWORK:

BEGIN CROSS-SECTIONS:

48663.49
48662.70
48659.49

582212.81,
582209.73,
582197.27,

3.61
6.82
13.32
13.44
12.59
6.09
3.64

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Upper
STATION: 8032.371
CUT LINE:

582496.067, 48736.476
582190.057, 48657.628
581893.321, 48625.161

BANK POSITIONS: 0.42600, 0.47700
WATER ELEVATION: 199.3957, 200.6774, 203.5746
WATER SURFACE EXTENTS:

582242.56, 48671.16,
582246.10, 48672.07,
582262.79, 48676.37,

PROFILE ID:Big
VELOCITIES:

0.43251, 5.29
0.44147, 11.31
0.45140, 11.48
0.46148, 10.50
0.46968, 4.35

PROFILE ID:Bigger
VELOCITIES:

0.42484, 1.25
0.43231, 5.93
0.44145, 12.24
0.45141, 12.40
0.46151, 11.44
0.47008, 4.88
0.47839, 1.21

PROFILE ID:Biggest
VELOCITIES:

0.41496,
0.43201,
0.44142,
0.45143,
0.46155,
0.47070,
0.48537,

•

END:
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many cross sections omitted

47336.59
47336.62
47336.69

582377.28,
582375.14,
582370.92,

2.52
5.05
10.10
10.52
7.84
3.38

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Upper
STATION: 6682.474
CUT LINE:

582641.922, 47366.533
582444.447, 47335.449
582336.567, 47337.277
582062.296, 47381.161

BANK POSITIONS:0.38000, 0.47199
WATER ELEVATION: 133.7104, 135.6018, 139.3349
WATER SURFACE EXTENTS:

582417.69, 47335.90,
582419.39, 47335.87,
582437.89, 47335.56,

PROFILE ID:Big
VELOCITIES:

0.39480, 4.79
0.40794, 10.33
0.42583, 11. 09
0.44240, 7.20
0.45444, 1.62

PROFILE ID:Bigger
VELOCITIES:

0.39368, 4.71
0.40788, 10.07
0.42586, 10.67
0.44287, 7.40
0.45565, 2.49

PROFILE ID:Biggest
VELOCITIES:

0.36681,
0.39108,
0.40781,
0.42589,
0.44336,
0.45805,

END:

CROSS-SECTION:
STREAM ID: Kulai Gorge
REACH ID: Tributary
STATION: 1089.584
CUT LINE:

583337.968, 47187.952
583207.93, 47327.062
583153.496, 47381.496
583126.279, 47608.306

BANK POSITIONS: 0.37300, 0.57900
WATER ELEVATION: 219.1924, 220.2025, 221.5454
WATER SURFACE EXTENTS:

B-20



Appendix B - HEC-RAS Import/Export Files for Geospatial Data• 583192.52, 47342.48,
583193.66, 47341.33,
583195.18, 47339.81,

PROFILE ID: Big
VELOCITIES:

0.44533, 10.34
0.46033, 8.44

PROFILE ID: Bigger
VELOCITIES:

0.44432, 11. 33
0.46129, 9.32

PROFILE ID: Biggest
VELOCITIES:

0.44296, 12.44
0.46257, 10.34

583177.65,
583176.64,
583175.29,

47357.34
47358.36
47359.70

END:

many cross sections omitted

47218.77
47219.30
47220.11

582552.81,
582552.76,
582552.67,

4.30
14.31
19.12
16.89

CROSS-SECTION:
STREAM ID: Kulai Gorge
REACH ID: Tributary
STATION: 273.138
CUT LINE:

582546.842, 47088.605
582555.984, 47189.171
582550.499, 47240.368
582552.327, 47295.223

BANK POSITIONS: 0.54099, 0.65500
WATER ELEVATION: 135.2666, 136 . .3284, 137.8818
WATER SURFACE EXTENTS:

582554.32, 47204.74,
582554.37, 47204.24,
582554.45, 47203.51,

PROFILE ID: Big
VELOCITIES:

0.56337, 1.54
0.57644, 10.95
0.59787, 15.34
0.61730, 13.10

PROFILE ID: Bigger
VELOCITIES:

0.56256, 2.97
0.57620, 12.59
0.59789, 17.18
0.61875, 14.67
0.63251, 1.86

PROFILE ID: Biggest
VELOCITIES:

0.56137,
0.57597,
0.59791,
0.61927,

•

•
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0.63330, 5.09
END:

46943.82
46943.87
46978.57

582276.02,
582275.92,
582195.49,

2.90
12.07
13.52
13.53
13.29
1. 42
1.12
0.35

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Lower
STATION: 6269.258
CUT LINE:

582723.174, 46846.449
582426.438, 46878.916
581953.514, 47082.992

BANK POSITIONS: 0.52401, 0.56900
WATER ELEVATION: 123.9078, 125.2825, 127.845
WATER SURFACE EXTENTS:

582309.53, 46929.36,
582309.55, 46929.35,
582326.40, 46922.09,

PROFILE ID: Big
VELOCITIES:

0.52365, 2.47
0.52857, 9.22
0.53762, 10.37
0.54643, 10.39
0.55542, 10.13
0.56408, 1.21

PROFILE ID: Bigger
VELOCITIES:

0.52363, 2.70
0.52856, 10.14
0.53761, 11.38
0.54644, 11.40
o.55543, 11. 15
0.56380, 1.27

PROFILE ID: Biggest
VELOCITIES:

0.51786,
0.52855,
0.53759,
0.54645,
0.55544,
0.56421,
0.60838,
0.66018,

END:

Many cross sections (and interpolated cross sections) omitted

CROSS-SECTION:
STREAM ID: Wailupe
REACH ID: Lower
STATION: 220.827
CUT LINE:

586214.122, 42127.918
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41159.95
41139.70
40806.06

583114.30,
583049.46,
581980.99,

0.55
omitted

0.11

581980.991, 40806.059
BANK POSITIONS: 0.50300, 0.51500
LEVEE POSITIONS:

I, 0.345, 7.123
INEFFECTIVE POSITIONS:

I, 0.000, 0.412,5.987
WATER ELEVATION: 5.503006, 5.881266, 6.600093
WATER SURFACE EXTENTS:

586214.12, 42127.92,
586214.12, 42127.92,
586214.12, 42127.92,

PROFILE ID: Big
VELOCITIES:

0.00851, 0.55
many lines omitted

0.71676, 0.18
PROFILE ID: Bigger

VELOCITIES:
0.00855, 0.63

many lines omitted
0.72186, 0.25

PROFILE ID: Biggest
VELOCITIES:

0.01783,
many lines

0.99398,•

••

END CROSS-SECTIONS:

BEGIN BOUNDS:

PROFILE LIMITS:
PROFILE ID: Big
POLYGON:

581893.32, 48625.16
many lines omitted

581908.77; 48563.31
POLYGON:

583126.27, 47608.3
many lines omitted

583090.99, 47539.75
POLYGON:

581953.51, 47082.99
many lines omitted

581934.96, 47008.78
END:

•
PROFILE LIMITS:

PROFILE ID: Bigger
581893.32, 48625.16

many lines omitted
581908.77, 48563.31
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POLYGON:
583126.27, 47608.3

many lines omitted
583090.99, 47539.75

POLYGON:
581953.51, 47082.99

many lines omitted
581934.96, 47008.78

END:

PROFILE LIMITS:
PROFILE ID: Biggest

581893.32, 48625.16
many lines omitted

581908.77, 48563.31
POLYGON:

583126.27, 47608.3
many lines omitted

583090.99, 47539.75
POLYGON:

581953.51, 47082.99
many lines omitted

581934.96, 47008.78
END:

END BOUNDS:

BEGIN LEVEES:

LEVEE ID: 1
SURFACE LINE:

584579.800, 41808.166, 7.222
many lines omitted

584631.334, 41572.921, 5.922
END:

END LEVEES:

BEGIN INEFFECTIVE AREAS:

INEFFECTIVE ID: 1
POLYGON:

584422.114, 41883.166
584452.132, 41787.626

many lines omitted
584552.852, 41577.321

END:

END INEFFECTIVE AREAS:

BEGIN STORAGE AREAS:

SA ID: 1
POLYGON:

581919.014, 43565.358
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many lines omitted
581895.224, 43443.864

END:

ELEVATION-VOLUME:
20.000, 0
22.000, 675000

many lines omitted
30.000, 421300

END:

TERRAIN:
581898.124, 43566.478, 33.442
582361.222, 43216.332, 20.369

many lines omitted
581867.484, 43432.612, 33.356

END:

END STORAGE AREAS:
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Appendix C

HEC-RAS Output Variables

••

•

Variable Name Units

# Barrels #
Alpha
Area sq ft

Area Channel sq ft
Area Left sq ft
Area Right sq ft
Base WS ft

Beta
BROpen Area sq ft
BR Open Vel fils

Br Sel Mthd
C &E Loss ft
Center Station ft
Ch Sta L ft
Ch Sta R ft
ClvEG No Wr ft

CoefofQ
Conv. Chnl cfs
Conv.Left cfs
Conv. Ratio

Conv. Right cfs
Conv. Total cfs
Crit Depth ft
Crit E.G. ft

Crit Eurgy 1 ft
Crit Eurgy 2 ft
Crit Eurgy 3 ft
CritNum #
Crit W.S. ft

Crit W.S. 1 ft
Crit W.S. 2 ft
Crit W.S. 3 ft
Culv Crt Depth ft
Culv EG In ft
Culv EG Out ft

Description

Number of barrels in a culvert.
Alpha - energy weighting coefficient.
Flow area of the entire cross section including ineffective
flow.
Flow area of the main channel including ineffective flow.
Flow area of the left overbank including ineffective flow.
Flow area of the right overbank including ineffective flow.
Water surface for first profile (used in comparison to
encroachment profiles).
Beta - momentum weighting coefficient.
Total area of the entire bridge opening.
Average velocity inside the bridge opening (Maximum of BU
and BD).
Selected bridge hydraulic modeling method.
Contraction or expansion loss between two cross sections.
Stationing of the center of the main channel.
Left station of main channel.
Right station ofmain channel.
Energy grade elevation at the culvert when calculated without
the weir.
WSPRO bridge method coefficient of discharge.
Conveyance ofmain channel.
Conveyance of left overbank.
Ratio of the conveyance of the current cross section to the
conveyance of the downstream cross section.
Conveyance of right overbank.
Conveyance of total cross section.
Critical depth. Corresponds to critical water surface.
Critical energy elevation. Minimum energy on the energy
versus depth curve.
Energy associated with first critical depth.
Energy associated with second critical depth.
Energy associated with third critical depth.
Number of critical depths found.
Critical water surface elevation. Water surface corresponding
to the minimum energy on the energy versus depth curve.
Water surface elevation of first critical depth.
Water surface elevation of second critical depth.
Water surface elevation of third critical depth.
Critical depth inside the culvert.
Energy gradeline inside the culvert at the inlet.

. Energy gradeline inside the culvert at the outlet.
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Culv EntLss
Culv ExtLss
Culv Frctn Ls
Culv Ful Lngh
Culv Inv El Dn
Culv Inv El Up
Culv Nml Depth
CulvQ
CulvVel DS
Culv Vel US
Culv WS In
Culv WS Out
Cum ChLen
Deck Width

DeltaEG
Delta WS
Dist Center L
Dist Center R
E.G. DS
E.G. Elev
E.G.IC
E.G.OC
E.G. Slope
E.G. US.

Enc Method
Enc Sta L
Enc Sta R
Enc Vall
Enc Val 2
EncrWD
Energy EG

EnergyWS

EnergylWr EG

EnergylWr WS

Flow Area
Flow Area Ch
Flow AreaL
Flow Area R
Frctn Loss
Frctn Slope
Frctn SIp Md
Froude # ChI
Froude #XS
Gate #Open

C-2

ft
ft
ft
ft
ft
ft
ft
cfs
ft/s
ft/s
ft
ft
ft
ft

ft
ft
ft
ft
ft
ft
ft
ft
ft/ft
ft

ft
ft
ft
ft
ft
ft

ft

ft

ft

sq ft
sq ft
sq ft
sq ft
ft
ft/ft

#

Culvert entrance loss (energy loss due only to entrance).
Culvert exit loss (energy loss due to exit).
Friction loss through the culvert barrel.
The length that the culvert flows full.
Culvert inside invert elevation downstream.
Culvert inside invert elevation upstream.
Normal depth for this culvert (and flow).
Flow through all barrels in a culvert group.
Velocity inside of culvert at inlet.
Velocity inside of culvert at outlet.
Water surface elevation inside the culvert at the inlet.
Water surface elevation inside the culvert at the outlet.
Cumulative Channel Length.
Width of bridge/culvert Deck (top of embankment), in
direction of flow.
Change in energy grade line through culvert(s) and bridge(s).
Change in water surface through culvert(s) and bridge(s).
Distance from center of channel to left encroachment.
Distance from center of channel to right encroachment.
Energy grade elevation at downsteam end of bridge or culvert.
Energy gradeline for calculated WS Elev.
Upstream energy gradeline at culvert based on inlet control.
Upstream energy gradeline at culvert based on outlet control.
Slope of the energy grade line.
Energy grade elevation at upstream end of bridge or culvert
(final answer).
Encroachment method used at this cross section.
Left station of encroachment.
Right station of encroachment.
Target for encroachment analysis.
Second target for encroachment analysis.
Top width between encroachments.
Energy grade elevation upstream ofbridge for energy only
method.
Water surface elevation upstream of bridge for energy only
method.
Energy grade elevation upstream ofbridge for low energy and
weir method.
Water surface elevation upstream of bridge for low flow
energy method and weir flow.
Total area of cross section active flow.
Area ofmain channelactive flow.
Area of left overbank active flow.
Area of right overbank active flow.
Friction loss between two cross sections.
Representative friction slope between two cross sections.
Friction slope averaging method used.
Froude number for the main channel.
Froude number for the entire cross section.
The number of gates opened in the current group.
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• Gate Area sq ft The flow area in an opened gate.
Gate Group Q cfs Flow through all gate openings in a gate group.
Gate Invert ft Gate spillway invert elevation.
Gate OpenHt ft Height of gate opening.
Gate 8ubmerg Degree of gate submergence. The ratio of the downstream

depth above the gate to the upstream depth above the gate.
Headloss ft Total energy loss between two cross sections.
Hydr Depth ft Hydraulic depth for cross section (AreafTopwidth of active

flow).
Hydr Depth C ft Hydraulic depth in channel {channel flow arealtopwidth of

channel flow).
Hydr Depth L ft Hydraulic depth in left overbank (left overbank flow

arealtopwirlth ofleft overbank flow).
Hydr Depth R ft Hydraulic depth for right over bank (right overbank flow

area/topwidth of right overbank flow).
Ice Btm Chan ft The bottom elevation of ice in the main channel.
Ice Btm LOB ft The bottom elevation of ice in the left overbank.
Ice BtmROB ft The bottom elevation of ice in the right overbank.
Ice Thick Chan ft Ice thickness in the main channel.
Ice Thick LOB ft Ice thickness in the left overbank.
Ice Thick ROB ft Ice thickness in the right overbank.
Ice Top Chan ft The top elevation of ice in the main channel.

• Ice Top LOB ft The top elevation of ice in the left overbank.
Ice Top ROB ft The top elevation of ice in the right overbank.
Ice Vol Total cu ft Cumulative volume of ice in an ice jam.
Ice Vol. Chan cu ft Cumulative volume of ice in the main channel for an ice jam.
Ice Vol. LOB cu ft Cumulative volume of ice in the left overbank for an ice jam.
Ice Vol. ROB cu ft Cumulative volume of ice in the right overbank for an ice

jam.
Ineff El Left ft The elevation of the left ineffective area.
Ineff El Right ft The elevation of the right ineffective area.
Invert Slope ft/ft The slope from the invert of this cross section to the next

cross section downstream.
IW Gate Flow cfs Total flow through all of the gate groups of an inline

weir/spillway.
KPerc L ft Conveyance reduction from left encroachment.
KPerc R ft Conveyance reduction from right encroachment.
L. Freeboard ft The freeboard in the main channel at the left bank (left bank

elevation minus water surface elevation).
L. Levee Frbrd ft The freeboard before the left levee is over-topped.
Left 8ta Eff ft Furthest left station where there is effective flow.
Length Cool ft Downstream reach length of the main channel.
Length Left ft Downstream reach length of the left overbank.
Length Rght ft Downstream reach length of the right overbank.
Length Wtd. ft Weighted cross section reach length, based on flow

distribution, in left bank, channel, and right bank.
Levee El Left ft The elevation of the left levee.

• Levee El Right ft The elevation of the right levee.
LOB Elev ft The ground elevation at the left bank of the main channel.
MannComp Composite Manning's n value for main channel.

C-3



Appendix C - HEC-RAS Output Variables

Mann Wtd Chnl
Mann Wtd Chnl
Mann Wtd Rght
Mann Wtd Total
Max ChlDpth ft
Min Ch El ft
MinEI ft
Min EI Prs ft
Min Error ft

Min El Weir Flow ft
Min Weir El ft
Momen.EG ft

Momen. WS ft

Num Trials #

ObsWS ft
Perc Q Leaving
Power Chan Ib/ft s

Power LOB lb/ft s

Power ROB Ib/ft s

Power Total Ib/ft s

Prof Delta EG ft

Prof Delta WS ft

Profile #
Prs 0 EG ft

Prs 0 WS ft

PrsIWrEG ft

Prs/WrWS ft

Q Barrel cfs
Q Bridge cfs
Q Channel cfs
QDS cfs
Q Leaving Total cfs

C-4

Conveyance weighted Manning's n for the main channel.
Conveyance weighted Manning's n for the left overbank.
Conveyance weighted Manning's n for the right overbank.
Manning's n value for the total main cross section.
Maximum main channel depth.
Minimum main channel elevation.
Minimum overall section elevation.
Elevation at the bridge when pressure flow begins.
The minimum error, between the calculated and assumed
water surfaces when balancing the energy equation.
Elevation where weir flow begins.
Minimum elevation of a weir.
Energy grade elevation upstream of bridge for momentum
method.
Water surface elevation upstream of bridge for momentum
method.
Current number (or fmal number) of trials attempted before
the energy equation is balanced.
Observed water surface elevation.
Percentage of flow leaving through a lateral weir.
Total stream power in main channel (main channel shear
stress times main channel average velocity). Used in Yang's
and other sediment transport equations.
Total stream power in left overbank (left overbank shear
stress times left overbank average velocity). Used in Yang's
and other sediment transport equations.
Total stream power in right overbank (right overbank shear
stress times right overbank average velocity). Used in Yang's
and other sediment transport equations.
Total stream power (total cross section shear stress times total
cross section average velocity). Used in Yang's and
other sediment transport equations.
Difference in EG between current profile and EG for first
profile.
Difference in WS between current profile and WS for first
profile.
Profile number.
Energy grade elevation upstream ofbridge for pressure only
method.
Water surface elevation upstream ofbridge for pressure only
method.
Energy grade elevation upstream ofbridge for pressure and/or
weir method.
Water surface elevation upstream ofbridge for pressure
and/or weir method.
Flow through one barrel in a culvert group.
Flow through the bridge opening.
Flow in main channel.
Flow in cross section downstream of lateral weir.
Total flow leaving in a lateral weir including all gates.



1 ADDend;x C - HEC-BAS Output Variables• Q Left cfs Flow in left overbank.
Q Perc Chan ft Percent of flow in main overbank.
Q Perc L ft Percent of flow in left overbank.
Q Perc R ft Percent of flow in right overbank.
Q Right cfs Flow in right overbank.
Q Total cfs Total flow in cross section.
QUS cfs Flow in cross section upstream of a lateral weir.
QWeir cfs Flow over the weir.
R. Freeboard ft The freeboard in the main channel at the right bank (right

bank elevation minus water surface elevation).
R. Levee Frbrd ft The freeboard before the right levee is over-topped.
Rght Sta Eff ft Furthest right station that still has effective flow.
ROB Elev ft The ground elevation at the right bank of the main channel.
SA Area acres Surface area of a storage area.
SA Chan acres Cumulative surface area for main channel from the bottom of

the reach.
SA Left acres Cumulative surface area for left overbank from the bottom of

the reach.
SA Min El ft Minimum elevation of a storage area.
SA Right acres Cumulative surface area for right overbank from the bottom

of the reach.
SA Total acres Cumulative surface area for entire cross section from the

• bottom of the reach.
SA Volume acre-ft Storage volume ofa storage area.
Shear Chan lb/sq ft Shear stress in main channel.( R.cH Sr).
Shear LOB lb/sq ft Shear stress in left overbank ( RWB Sf).
Shear ROB lb/sq ft Shear stress in right overbank ( RROB Sf).
Shear Total lb/sq ft Shear stress in total section! RTSf).
SpcForce PR cu ft Specific force prime. For mixed flow, the specific force at

this cross section for the flow regime that does not control.
SpecifForce cu ft The specific force for this cross section at the computed water

surface elevation. SF = ATYcent + (Q~)/(gAact)
Sta W.S. Lft ft Left station where water intersects the ground.
Sta W.S. Rgt ft Right station where water intersects the ground.
Std Stp Case # Standard step method used to determine WSEL (1 =

successful convergence, 2 = minimum error, 3 =resorted to
critical depth).

Top W Act Chan ft Top width of the wetted channel, not including ineffective
flow.

Top W Act Left ft Top width of the wetted left bank, not including ineffective
flow.

Top W Act Right ft Top width of the wetted right bank, not including ineffective
flow.

Top W Chnl ft Top width of the main channel. Does not include 'islands', but
it does include ineffective flow.

Top W Left ft Top width of the left overbank. Does not include 'islands', but.
it does include ineffective flow.

• Top WRight ft Top width of the right overbank. Does not include 'islands',
but it does include ineffective flow.
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Top Wdth Act ft

Top Wi~th ft
Total Gate Flow cfs

Trvl Tme Avg hrs

Trvl Tme ChI hrs

Vel Chnl ft/s
Vel Head ft
Vel Left ft/s
Vel Right ft/s
Vel Total ft/s
Vol Chan acre-ft

Vol Left acre-ft

Vol Right acre-ft

Volume acre-ft

W.P. Channel ft
W.P. Left ft
W.P. Right ft
W.P. Total ft
W.S.DS ft
W.S. Elev ft
W.S. Prime ft

W.S. US. ft
Weir Avg Depth ft
Weir Max Depth ft
Weir Sta DS ft
Weir Sta Lft ft
Weir Sta Rgt ft
Weir Sta US ft
Weir Submerg

WrFlw Area sq ft
WrTop Wdth ft
WS Air Entr. ft
WSPROEG ft

WSPROWS ft

Wtd. n Chnl
Wtd. n Left
Wtd. n Right
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Top width of the wetted cross section, not including
ineffective flow.
Top width of the wetted cross section.
Total flow through all of the gate groups of an inline/lateral
welT.
Cumulative travel time based on the average velocity of the
entire cross section, per reach.
Cumulative travel time based on the average velocity of the
main channel, per reach.
Average velocity of flow in main channel.
Velocity head.
Average velocity of flow in left overbank.
Average velocity of flow in right overbank.
Average velocity of flow in total cross section.
Cumulative volume of water in the channel (including
ineffective flow).
Cumulative volume of water in the left overbank (including
ineffective flow).
Cumulative volume of water in the right overbank (including
ineffective flow).
Cumuiative volume ofwater in the direction of computations
(including ineffective flow).
Wetted perimeter of main channel.
Wetted perimeter ofleft overbank.
Wetted perimeter of right overbank.
Wetted perimeter of total cross section.
Water surface downstream of a bridge, culvert, or weir.
Calculated water surface from energy equation.
Water surface prime. For mixed flow, the water surface of the
flow regime that does not control.
Water surface elevation upstream ofbridge or culvert.
The average depth of flow over the weir.
The maximum depth of flow over the weir.
Downstream station where weir flow ends.
Station where flow starts on the left side of weir.
Station where flow ends on the right side of weir.
Upstream station for weir flow starts.
The ratio of the downstream depth above the weir to the
upstream depth above the weir.
Area of the flow going over the weir.
Top width of water over the weir.
Water surface elevation accounting for air entrainment.
Energy grade elevation upstream ofbridge for the WSPRO
method.
Water surface elevation upstream of bridge for the WSPRO
method.
Conveyance weighted Manning's n for the main channel.
Conveyance weighted Manning's n for the left overbank.
Conveyance weighted Manning's n for the right overbank.



I.
XS DeltaEG ft

XS Delta WS ft

Yarnell EG ft

Yarnell WS ft

•

•
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Change in energy gradeline between current section and next
one downstream.
Change in water surface between current section and next one
downstream.
Energy grade elevation upstream ofbridge for Yarnell
method.
Water surface elevation upstream of bridge for Yarnell method.

C-7




